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About the User Guide
This user guide elucidates all the functions, features and capabilities of Everest 
CRM Studio. It is henceforth referred to as CRM Studio. 

Audience
This guide is designed to help you install, initially configure, and implement 
CRM Studio according to the specific needs of your organization. It is meant
to suit the needs of end-users who will be handling automated customer 
relationship management which includes a variety of functions. 
We recommend that you go through the manual before you start using the 
product, to familiarize yourself with the following:
• Installing and configuring CRM Studio 
• Creation of queries and events
• Alert Methods
• Subscriber Maintenance
• Visual Basic Scripting
• ERS (E-mail Response System)
• Scheduling of Crystal Reports
• Webcasting
• EventPaks

Assumptions
We assume that the user is conversant with:
• Microsoft Windows
• Everest
• Database Administration
• SQL (Structured Query Language) 
• Visual Basic and Scripting

Document Conventions
This section details the conventions used in this user guide. These conventions 
enable you to navigate easily through the information provided and help you 
accomplish your tasks quickly.
Note
The Note icon is used to denote important information.

Refer
The Refer icon is used to point to related topics within the chapter or across the 
user guide.

This icon appears on the left side of a page (aligned with the heading it 
forms a part of) with the text appearing adjacent to it.

This icon appears on the left side of a page (aligned with the heading it 
forms a part of) and the text appears adjacent to it.
Everest CRM Studio ix
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Example
The Example icon is used to depict examples.

Hint
The Hint icon is used to denote useful hints.

Warning
This icon is used to indicate salient information without which you cannot 
proceed with your intended operation.

Step-by-Step
The Step-by-Step icon is used to enumerate instructions to carry out a task.

Keywords
• Menu options, Windows/Dialog Boxes, Field names are highlighted in 

boldface.
• Navigation across menu options is indicated by the symbol “>”.

How this Guide is Organized
The CRM Studio User Guide comprises sixteen chapters. The user guide contains 
an Index and a Table of Contents, which help you look for topics across all 
chapters.

Example This icon appears on the left side of a page (aligned with the heading it 
forms a part of) and the example appears adjacent to it.

This icon appears on the left side of the page (aligned with the heading it 
forms a part of) and the text appears adjacent to it.

This icon appears on the left side of the page (aligned with the heading it 
forms a part of) and the text appears adjacent to it.

This icon appears on the left side along with the text. 

Example To view the Everest CRM Studio Administrator dialog box in CRM 
Studio, you must click the CRM option from the main menu bar. 
From the drop-down menu, highlight CRM Studio and click 
Administrator. This is illustrated in the document/online help as 
follows:
From the main menu bar, select CRM > CRM Studio > 
Administrator. You will see the Everest CRM Studio Administrator 
dialog box.
x Everest CRM Studio
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Chapter 
Number

Chapter Name Description

1 Installation and 
Configuration

Describes installation and initial 
configuration of CRM Studio.

2 Product Tutorial Brief tutorial on designing queries 
and events.

3 Administration Describes the Everest CRM 
Studio Administrator.

4 Query Designing Describes creation of record-level 
and aggregate queries.

5 Subscriber Maintenance Describes the creation and 
maintenance of subscribers and 
groups.

6 Event Designing Describes creation of events.
7 Visual Basic Scripting Describes creation and use of 

Visual Basic scripts.
8 Event Monitor Describes the Everest CRM 

Studio Event Monitor.
9 E-Mail Response System Describes configuration and use 

of ERS (E-mail Response System).
10 Event Triggered Reports Describes generation of Crystal 

Reports using event triggers.
11 Scheduling Crystal 

Reports
Describes scheduling and 
automation of Crystal Report 
generation.

12 Webcasting Describes configuration and use 
of webcasting.

13 EventPaks Describes creation and use of 
EventPaks.

14 Worksheets Contains worksheets to help you 
collect information required 
before setting up queries, events 
and subscribers.
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CRM Studio Installation and Configuration
Welcome to CRM Studio
Thank you for your interest in CRM Studio, the industry’s leading Alert 
Messaging technology for superior business intelligence.
CRM Studio provides you with advanced features in order to monitor your 
business activities in terms of administration, managing and monitoring events.
Using CRM Studio you can create companies, query definitions, define custom 
events, report definitions, schedule events, write basic scripts, add e-mail and fax 
accounts, add subscribers, assign the events to e-mail and fax accounts, assign 
events to subscribers or users. You can also import existing Everest users into 
CRM Studio. 
Other activities that you can perform in CRM Studio are:
• Configure hardware settings for fax, paging, and printing
• Configure software settings for e-mail, fax, paging, and holiday definitions
• Specify user authorizations for access to different Everest modules
• View (and take corrective actions for) any errors that were encountered when 

the application attempted to either execute an event, or send notifications 
about an event

• Monitor the status of application servers, events, e-mails, faxes, reports etc.

We hope that you will enjoy working with CRM Studio and we encourage you to 
send us your feedback. 

How does CRM Studio Work?
As said earlier, it is necessary that you are aware of the concepts of database 
administration activities and SQL to create and handle queries.
In order to work with CRM Studio, you need to configure it so that a link is 
established between the functions provided by the application. 
Everest Software gives you an EventPak containing 100 odd events and queries 
which cater to the usual business requirements of an organization. In addition to 

To use CRM Studio, it is necessary that you are aware of SQL and database 
administration activities. Hence, it is recommended that only trained 
personnel having proper security rights should be allowed to configure and 
work with CRM Studio. For additional security you need to specify an 
administrator password in the Configuration profile.

 “Configuration - CRM Studio” on page 20
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this you can create custom events, queries, schedule reports etc. to meet your 
business needs. 

Once these things are in place, it becomes necessary to configure the hardware 
and software settings in order to monitor the events. Use the Everest CRM Studio 
Administrator for this purpose. 

After this, you need to set up CRM Studio so that it works in tandem with the 
events created. Then depending on the settings, the actions and tasks get executed 
when the events are triggered. 

Advantages of CRM Studio
In addition to the system events defined in Everest, users can create custom 
events by defining conditions. In order to create a Custom Event, users must 
specify a condition using filters. Filters are specific conditions that you give in 
order to narrow down search and get a consolidated data.
The advantages of CRM Studio are:
• You can create and monitor exceptional events 

• You can attach Everest reports to e-mails dynamically 

• In a similar manner, reports that need to be sent on a periodic basis (like 
Account Receivable Aging, Best Customer report, Commission report etc.) can 
be sent on a “need to know” basis (i.e., the data in the report will be specific to 
the user/customer/vendor for whom it is intended for) at a predefined 
frequency like weekly, monthly, quarterly, etc.

“Sample Events” on page 355

“Hardware Setup” on page 92
“Software Setup” on page 95

Example In system events, you can track an event when sales invoice is created. 
In advanced events, you can track only those events (by specifying 
conditions) where sales invoices for amount greater than $1,000,000 
are created. This is an exceptional event.

Example When a sales invoice is created, you can generate the sales invoice 
report in PDF format and attach the report with the e-mail, and send it 
to the respective customer.
4 Everest CRM Studio
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CRM Studio Installation
Use the CRM Studio Installation CD to install CRM Studio. The CRM Studio 
client cannot be installed unless the Everest client has been installed. The CRM 
Studio server cannot be installed until the Everest application server has been 
installed. The versions of CRM Studio and Everest must be compatible with each 
other.

By default, CRM Studio and the data files install in the Everest directory. They 
must be located on the same drive as Everest.

• Insert the CRM Studio CD-ROM into your computer's CD-ROM tray. The CD 
automatically runs the setup.exe file which starts the Everest Advanced CRM 
Studio Installation Wizard. You will see the Preparing to Install screen and 
then you will see the Everest Advanced CRM Studio Installation Wizard  - 
Welcome dialog box.

Example To install the Everest Advanced CRM Studio version 5.0.0 client, the 
Everest Advanced Edition version 5.0.0 client must be installed. You 
cannot install the Everest Advanced CRM Studio version 5.0.0 client 
with the Everest Advanced Edition version 4.0.0 client installed.

Example If you install Everest on the C: drive, CRM Studio and the data files 
must also be located on the C: drive. Similarly, if you install Everest 
on the D: drive, CRM Studio and the data files must be located on the 
D: drive. 

It is recommended that you close any other programs running on your 
workstation before installing CRM Studio.

To install CRM Studio, do the following:
Everest CRM Studio 5
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Welcome

 Figure 1.1: Welcome
The Installation Wizard guides you through the installation process.
• Click Next. You will see the License Agreement dialog box.
It is important that you read the License and Services Agreement displayed in 
the dialog box and accept the terms to proceed with installation.

License Agreement

 Figure 1.2: License Agreement
• Select the option I accept the terms in the license agreement to agree with the 

terms and conditions.
6 Everest CRM Studio
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• To review a hard copy of the license agreement or keep a copy for your 
records, click the Print button.

• Click Next. You will see the Customer Information dialog box.

Customer Information

 Figure 1.3: Customer Information
User Name
Enter the name of the user.
Organization 
Enter the name of the organization.
You can install CRM Studio for any of the following users:
Anyone who uses this computer (all users)
Select this option to enable all the users (whose profiles have been defined in the 
operating system) to use CRM Studio on your computer. 

Only for me
Select this option to restrict other users from logging into CRM Studio installed 
on your computer. CRM Studio will be accessible only to you.

• Click Next. You will see the Setup Type dialog box.

If you select the option I do not accept the terms in the license agreement, 
you will not be able to proceed with the installation process. Click Cancel to 
terminate the installation.

Example If your computer is shared between different users, these users will be 
able to use CRM Studio.

A user profile is defined in the operating system’s environment and is 
loaded when the user logs on. This profile contains user-specific settings of 
the operating system’s environment such as program items, screen colors, 
network connections, printer connections, window size and position.
Everest CRM Studio 7
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Setup Type

 Figure 1.4: Setup Type
Use the Setup Type dialog box to specify the type of setup (Server and Client, 
Client Only or Server Only).
• Select Server and Client to install the CRM Studio server and client. A 

compatible Everest application server and the Everest client must be installed. 
Click Next. You will see the Everest Advanced Data Server dialog box.

• Select Client Only to install only the CRM Studio client. A compatible 
Everest client must be installed. Click Next. You will see the Ready to Install 
dialog box.

• Select Server Only to install only the CRM Studio server. A compatible 
Everest application server must be installed. Click Next. You will see the 
Everest Advanced Data Server dialog box.

You will receive an error message if a compatible Everest application server 
and/or Everest client is not installed. Click OK to exit the installation. 
8 Everest CRM Studio
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Everest Advanced Data Server
Use the Everest Advanced Data Server dialog box to provide information on the 
Everest database.

 Figure 1.5: Everest Advanced Data Server
• Specify the IP address or the machine name where Everest Data Server is 

installed. 

• Enter the system administrator password (SA) of the MS SQL Server. This is 
not the password for Everest. This is necessary so that the Everest Advanced 
CRM Studio Server can be configured.

• Click Next. You will see the Ready to Install the Program dialog box. 

If the Everest Data Server is installed on the same machine where you are 
installing CRM Studio, then you will not see the above dialog box.
Everest CRM Studio 9
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Ready to Install the Program

 Figure 1.6: Ready to Install the Program
• Click Install. You will see the Installing Everest Advanced CRM Studio 

dialog box. The Installation Wizard installs CRM Studio on your computer.

Installing Everest Advanced CRM Studio

 Figure 1.7: Installing Everest Advanced Edition CRM Studio
The Installation Wizard installs CRM Studio on your computer. 
• During installation, if other programs are running on the workstation, you 

will see the Files in Use dialog box. Shut down the programs and click Retry 
to continue the installation. Alternatively, you can click Ignore to continue the 
installation without shutting down the programs.
10 Everest CRM Studio
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• Once installation has been completed, you will see the Installation Wizard 
Completed dialog box.

Installation Wizard Completed

 Figure 1.8: Installation Wizard Completed
• Click Finish to exit the wizard.

The installation of CRM Studio is now complete. Your next steps are the 
activation and initial configuration of CRM Studio.

• After installation of CRM Studio server, the user should login to ASC 
company and invoke the Everest CRM Studio Architect. This will 
update the ASC sample company (for reference) with the latest 
EventPak. Later the user can access architect of his/her working 
company.

“Configuration - CRM Studio” on page 20
Everest CRM Studio 11
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Activation - CRM Studio
There are two sets of license keys used to activate CRM Studio. The first one is 
entered during the installation of CRM Studio and the second one is entered in 
the CRM Studio Architect.
CRM Studio activation codes are bound to the name of the server they are 
installed on. If you need to re-install CRM Studio on a different machine or 
rename it after the first 30 days, a re-licensing charge will be incurred.

• From the Everest main menu bar, select CRM > CRM Studio > Architect. You 
will see the Everest CRM Studio Architect dialog box.

• From the menu, select Help > About Everest CRM Studio Architect.

 Figure 1.9: Everest CRM Studio Architect
You will see the About Everest CRM Studio Architect dialog box.

To activate CRM Studio through CRM Studio Architect, do the 
following:
12 Everest CRM Studio
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 Figure 1.10: About Everest CRM Studio Architect Dialog Box
• Click the License button to view the License Code Management dialog box.

 Figure 1.11: Everest CRM Studio - License Code Management Dialog Box
• Enter your license information in the following fields:
License Owner
Enter the name of the person or organization that owns the CRM Studio license. 
License Expiration Date
Enter the date that your license will expire.
License Code
Enter your CRM Studio license code.
License Type
Select your license type from the drop-down list.
License Server Name
Enter the name of your CRM Studio Server.
Licensed DB Connections
Enter the number of your licensed database connections.
• Click OK to complete your CRM Studio activation. 
For more information on CRM Studio, refer to the CRM Studio Web Help.
Everest CRM Studio 13
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Modify, Repair, and Uninstall CRM Studio
Use the Modify, Repair, and Uninstall CRM Studio process to modify, repair, or 
uninstall CRM Studio separately from Everest. Access these options from Add/
Remove Programs in the Control Panel.

• From the Control Panel, double-click Add or Remove Programs. You will see 
the Add or Remove Programs dialog box.

• From the Add or Remove Programs dialog box, select Everest Advanced 
CRM Studio.

• Click Change. You will see the Welcome dialog box.

Welcome

 Figure 1.12: Welcome
• Click Next. You will see the Program Maintenance dialog box.

It is recommended that you close any other programs running on your 
workstation before modifying, repairing, or uninstalling CRM Studio.

To access the CRM Studio Modify, Repair, and Uninstall options, do the 
following:
14 Everest CRM Studio
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Program Maintenance

 Figure 1.13: Program Maintenance
The Program Maintenance dialog box allows you to specify the type of 
maintenance option (Add, Remove, Upgrade, Repair, or Uninstall).
Add or Remove Features
Select this option to add or remove features of the Everest Advanced CRM 
Studio application.

Upgrade or Repair
Select this option to repair installation errors in the CRM Studio program. You 
can also upgrade a previous version of CRM Studio already installed on your 
system.

Uninstall Everest Advanced CRM Studio
Select this option to uninstall the CRM Studio application from your computer.

Add or Remove Features
Use this option to add or remove Everest Advanced CRM Studio features.
• Select Add or Remove Features from the Program Maintenance dialog box.

•  Click Next. You will see the Custom Setup dialog box.

“Add or Remove Features” on page 15

“Upgrade or Repair” on page 17

“Remove the Program” on page 19

Program Maintenance
Everest CRM Studio 15
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Custom Setup

 Figure 1.14: Custom Setup
• Select the features/sub-features to add or remove.
• Click Next. You will see the Ready to Modify the Program dialog box.

Custom Setup Dialog Box Options
The options available in this dialog box are listed below:
• CRM Studio Client
• CRM Studio Server

- Sample Events
Select/Deselect Components

• To select/deselect components, click displayed beside each component. 
You will see the following options:

This feature will be installed on local hard drive
Choose this option to install the selected feature on your hard disk. Only the 
selected feature/sub-feature will be installed.
This feature will not be available 
Select this option to disable the feature (the feature will not be installed).
Space
Click Space to view the Disk Space Requirements dialog box.

The Disk Space Requirements dialog box displays the hard disk space statistics 
of your computer.

To view the description for a feature, click on it. The relevant description is 
displayed in the Feature Description box on the right side of the dialog box.

The Space button is enabled only if a component is selected for installation.
16 Everest CRM Studio
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Ready to Modify the Program

 Figure 1.15: Ready to Modify the Program
• Click Install. You will see the Installing Everest Advanced CRM Studio 

dialog box. The Installation Wizard installs CRM Studio on your computer.

• Once the installation is complete, you will see the Installation Wizard 
Completed dialog box.

• Click Finish to exit the wizard.

Upgrade or Repair
Use this option to upgrade or repair your Everest CRM Studio client or server.
• Select Upgrade or Repair from the Program Maintenance dialog box. This 

option upgrades or repairs the Everest component(s) that are installed on 
your computer.

• You will see the Ready to Repair the Program or Ready to Upgrade the 
Program dialog box.

“Installing Everest Advanced CRM Studio” on page 10

“Installation Wizard Completed” on page 11

“Program Maintenance” on page 15
Everest CRM Studio 17
User Guide



Installation and Configuration CRM Studio
Ready to Repair/Upgrade the Program
This window displays the version of Everest that you are ready to repair or 
upgrade and its corresponding features. You can go back and make any changes, 
if required.

 Figure 1.16: Ready to Repair the Program Dialog Box
• Click Install. You will see the Installing Everest Advanced CRM Studio 

dialog box.

• Once the installation is complete, you will see the Installation Wizard 
Completed dialog box.

• Click Finish to exit the wizard.

Uninstall Everest Advanced CRM Studio
Use this option to delete Everest Advanced CRM Studio completely from your 
computer.
• Select Uninstall Everest Advanced CRM Studio from the Program 

Maintenance dialog box. Click Next. You will see the Remove the Program 
dialog box.

“Installing Everest Advanced CRM Studio” on page 10

“Installation Wizard Completed” on page 11

“Program Maintenance” on page 15
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Remove the Program

 Figure 1.17: Remove the Program
• Click Remove to uninstall the application from your computer. You will see 

the Uninstalling Everest Advanced CRM Studio dialog box.

Uninstalling Everest Advanced CRM Studio

 Figure 1.18: Uninstalling Everest Advanced CRM Studio
• Once the uninstall process is complete, you will see the Installation Wizard 

Completed dialog box.
• Click Finish to exit the wizard.
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Configuration - CRM Studio
As a lights-out application, CRM Studio uses multiple server processes in its 
daily processing. These servers do everything from scheduling events for 
submission, and checking for triggered events, to sending out alerts via e-mail.
For a list of all the individual server processes that CRM Studio uses, you can log 
in to the Everest CRM Studio Administrator (path: CRM > CRM Studio > 
Administrator). Select Activity > Server Status from the Administration Folders 
panel in the center. The Server Status panel on the right displays all of CRM 
Studio’s servers and their current status.
Under Microsoft Windows 2000, all these servers run under an overall CRM 
Studio service, which you can check from the Service Manager.
Each individual CRM Studio server process may be enabled or disabled for 
running from the Everest CRM Studio Administrator dialog box. Double-click a 
server process name and check the option Allow Server to Process.
By default, some of CRM Studio’s delivery servers (such as the fax, page, and 
webcast servers) are pre-configured to not start when the Everest CRM Studio 
service (or server manager) is initialized. (The CRM Studio, scheduler, 
application event, and e-mail servers are enabled by default.)
You may wish to review the status of the various CRM Studio servers to see 
which servers are (and are not) configured to run. Please note that if you are using 
CRM Studio to perform a function related to one of the servers on this list, you 
must be sure that the server is enabled to run.
There are four steps in the initial configuration of Everest CRM:
• Connecting CRM Studio to an underlying company database and verifying 

that this connection is valid.

• Specifying the e-mail account that CRM Studio will use for the sending of e-
mail alert messages.

• Testing the operation of the e-mail account defined in the previous step.

• Creating a ‘subscriber’ record for yourself to use during initial event testing.

Authentication
You need to provide authentication details in order to access CRM Studio after 
installation. 

“Connect CRM Studio to the ASC Database” on page 22

“Set Up E-mail Account to send E-mails” on page 28

“Test the E-Mail Sending Account” on page 32

“Define a Subscriber” on page 33

To provide authentication details, do the following:
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• From the main menu bar, select CRM > CRM Studio > Configuration. You 
will see the Configuration - CRM Studio dialog box.

 Figure 1.19: Configuration - CRM Studio
User Code to be Used for Authentication *
Enter the user code for using CRM Studio to access Everest database. This is 
required for security purposes and it prevents any unauthorized updating of the 
Everest database using some of the events available in CRM Studio.
Administrator Password *
Enter the administrator password for accessing CRM Studio. This is required as 
an additional security right to access related modules in CRM Studio.
CRM Studio Server Name *
Enter the name of the CRM Studio server. This field defaults to the last CRM 
Studio server name. If you uninstall and reinstall CRM Studio, you must change 
the CRM Studio name to ensure proper functionality between Everest and CRM 
Studio.
Menu Option
Create Application
You can create an application for your registered company by selecting this 
option.
The Create Application option is disabled in the following scenarios:
• The sample company is installed.
• An application is already installed for the logged in company.

• From the main menu bar of the Everest window, select CRM > CRM Studio 
>Configuration. You will see the Configuration - CRM Studio dialog box.

• From the Configuration - CRM Studio dialog box, select Options > Create 
Application. A Confirmation window appears.

• Select one of the options: 

To create an application, do the following:
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- Create a blank application - Select this option to create an application 
without the sample events. This, however, does not affect the other 
activities of CRM Studio.

- Create an application and copy sample events - Select this option to create 
an application with all the sample events.

Install/Upgrade Reference Events
This option allows you to install sample events or upgrade existing sample events
whenever an update is available. You can use this option in the sample company 
as well as a registered company. 

• From the main menu bar of the Everest window, select CRM > CRM Studio > 
Configuration. You will see the Configuration - CRM Studio dialog box.

• From the Configuration - CRM Studio dialog box, select Options > Install/
Upgrade Sample Events. A Confirmation window appears.

• Click Yes to install/upgrade the sample events.
Whenever you upgrade Everest, if you have installed CRM Studio, Everest will 
prompt you to install the latest eventpak provided by Everest Software, when you 
try to access any feature of CRM Studio. If you do not opt to install it then you 
will still access the older version of the eventpak. You can use the Install/Upgrade 
Sample Events option from the menu at any point of time to install the latest 
upgraded events.

Choose the Everest CRM Studio Server
CRM Studio is designed to be installed on a single machine, a server from which 
it can access the database(s) of the company(s) to be monitored. 
All set-up and maintenance of CRM Studio is to be done from this server. 
However, if your hardware set-up dictates that CRM Studio administration and 
configuration be done from a remote client, contact Everest Software Technical 
Support for guidance in installing a remote client version of CRM Studio.

Connect CRM Studio to the ASC Database
The Accel Sample Company (ASC) is a sample database, shipped with Everest. 
You may use this sample company data to test, and familiarize yourself with the 
configuration and working of Everest’s features, such as CRM Studio. We 
recommend that you carry out these procedures on the ASC database to begin 
with. Later, you may follow the same procedures to configure CRM Studio for 

“Sample Events” on page 355

To install/upgrade sample events using the Install/Upgrade Sample 
Events option, do the following:

This option will be enabled only when the user does not have the latest 
sample events. This latest sample events will be installed in the /Everest/
ACRM folder. However, the same will not be updated in CRM Studio. 
Hence, in order to install the latest sample events the user has to either say 
'Yes' when prompted or select the menu option manually.
You need to have rights to upgrade the events.
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use with your actual company’s database. Alterations to sample data have no 
effect whatsoever on your real company’s data. 
CRM Studio uses Microsoft ODBC (Open Database Connectivity) to integrate 
with an underlying database. The first step is to check for, and test the ODBC 
source that allows CRM Studio to access the Accel Sample Company database.

Verify ASC’s ODBC Source 

• Open the ODBC Data Source Administrator (path: Control Panel > 
Administrative Tools > Data Sources (ODBC)).

• Click the System DSN tab. Your source will look like the following, 
depending on the type of database you are working with.

 Figure 1.20:  ODBC Data Source Administrator - System DSN tab
• In the list of ODBC system data sources, verify that a data source exists for 

ASC. The name of this source is ACRM_ASC_<name of the SQL server 
instance on your computer>. 

Test ASC’s ODBC Source

• Open the ODBC Data Source Administrator (path: Control Panel > 
Administrative Tools > Data Sources (ODBC)).

The ODBC System DSN for the Accel Sample Company is created by 
default during the installation of CRM Studio. You must verify that the 
ODBC source is fully operational.

“CRM Studio Installation” on page 5

To verify the existence of a System DSN source for the Accel Sample 
Company, do the following:

Example If the SQL server component installed on your machine is named 
comp-shopfloor1 (this is the name used by SQL Server to identify 
your machine on your network), the ODBC source will be 
ACRM_ASC_COMP-SHOPFLOOR1.

To test the ODBC source for the Accel Sample Company, do the 
following:
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• Click the System DSN tab. Highlight the name of the ODBC source defined 
for ASC (ACRM_ASC_<name of the SQL server instance on your computer>). 

• Click Configure. You will see the Microsoft SQL Server DSN Configuration 
dialog box.

 Figure 1.21: Microsoft SQL Server DSN Configuration
• Click Next until you get to the final screen. Each screen displays various 

details about the SQL Server DSN configured on your machine.

• Click Finish when you get to the final screen. You will see the ODBC 
Microsoft SQL Server Setup dialog box, displaying details of the SQL Server 
DSN.

 Figure 1.22: ODBC Microsoft SQL Server Setup

Altering the default configuration (if necessary) is best done by an 
advanced user or a network/systems administrator. 
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• Click Test Data Source. You will see the Test Results screen. If the data source 
is configured correctly, the message ‘Tests Completed Successfully!’ is 
displayed. 

• Click OK. You will see the ODBC Microsoft SQL Server Setup dialog box 
again.

• Click OK. You will see the ODBC Data Source Administrator dialog box 
again. Click OK.

Log In To Everest CRM Studio Architect

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

 Figure 1.23:  Everest CRM Studio Architect
You will see the Event Management Folders panel in the center, comprising two 
branches:
• Application Events
• Subscribers
 The branches below Application Events list all the companies that CRM Studio is 
currently configured to integrate with. These branches include: 
• Accel Sample Company: Sample database provided by Everest Software to 

familiarize you with the Everest application.
• E-Mail Response System: Enables CRM Studio to monitor, process, and 

respond to incoming e-mail messages.
• Sample Application: CRM database provided for evaluation, learning, and 

testing purposes.
Add an Everest Company

You may need to configure CRM Studio to work with the database of another 
company (such as your own company’s database) created in Everest, according to 

To log in to Everest CRM Studio Architect, do the following:

When you log in for the first time, the ASC database is updated with the 
latest EventPak.
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your requirements. 

• From the Everest CRM Studio Architect dialog box, click Application Events.
• Click the New Application button at the top-left of the Everest CRM Studio 

Architect dialog box. You will see the Everest CRM Studio - New 
Application dialog box.

• Enter the relevant data in the fields mentioned above. Leave the other fields 
with their default values, if any.

• Click Save and Close at the top-left of the dialog box. You will see the Everest 
CRM Studio - New Application dialog box again. 

• Click OK.

The Everest CRM Studio - New Application Dialog Box

 Figure 1.24:  Everest CRM Studio - New Application
New Application
Enter the name of the company.
Connection to Use for Database Access
Select a connection from the drop-down list.
Click New Connection. You will see the Everest CRM Studio - Edit Connection 
dialog box.

To configure CRM Studio to work with another company, do the 
following:

If you add to or change the definition of an ODBC source while you are 
in the Everest CRM Studio Architect, you will have to exit it and re-
enter for it to recognize the new or modified ODBC sources.
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The Everest CRM Studio - Edit Connection Dialog Box

 Figure 1.25: Everest CRM Studio - Edit Connection - General
Internal ID Number
This field displays the ID of the connection. You cannot modify it.
Connection Description
Enter a description of the ODBC source you will be using to connect CRM Studio 
to the company database.
ODBC Data Source Name (DSN)
From the drop-down list select the ODBC source that will allow CRM Studio to 
connect to the company database.
User Name and Password
Specify the user name and password that will allow CRM Studio access to this 
database.

Test ODBC Connection

• From the Everest CRM Studio Architect dialog box, double-click Accel 
Sample Company. Five sub-branches are displayed, the first of which is 
Query Definitions.

• Click Query Definitions.
• Click the New Query Definition button at the top-left of the dialog box. You 

will see the Everest CRM Studio - Application Events dialog box. 

To test if your ODBC connection is valid within CRM Studio, do the 
following:

If you get an error message, the ODBC source is incorrectly defined.
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• Click the Tables tab. From the Available Tables column on the left, highlight 
a database table that contains records and click the Add Table button. It is 
added to the Selected Tables column on the right. 

• Click the Columns tab. Check if the columns of the selected table are 
displayed in the Available Columns to Query section. 

• Click the Add All Columns to Query button. 
• Click the Preview tab. You will see a list of records from this table. 

If you execute these steps successfully, the integration test is complete. You can 
now specify the e-mail account that CRM Studio will use for sending e-mail alert 
messages.

Set Up E-mail Account to send E-mails
CRM Studio sends out alert messages via e-mail (among other methods). The 
first configuration step is to define the e-mail account that will be used for 
sending e-mail alert messages. This account is called the “E-mail Sending 
Account”.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

The Everest CRM Studio Administrator Dialog Box

 Figure 1.26: Everest CRM Studio Administrator
• From the Administration Folders panel in the center, double-click the 

Software Setup folder and click E-mail Accounts.

If no table names appear in the left column, the ODBC source is 
incorrectly defined.

If no column names appear in the list, the ODBC source is incorrectly 
defined.

If you receive an error message, the ODBC source may be incorrectly 
defined.

To define the e-mail account to be used for sending e-mail alert 
messages, do the following:
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• Click the New E-mail Account button at the top-left of the Studio 
Administrator dialog box. You will see the Everest CRM Studio - E-mail 
Accounts dialog box.

• Enter relevant data depending on the type of e-mail account.
• Ensure that you check the Active box (since only currently available accounts 

can be used for sending e-mail) and click Save and Close.

The Everest CRM Studio - E-mail Accounts Dialog Box - General

 Figure 1.27: Everest CRM Studio - E-mail Accounts
Internal ID number
This field displays the ID of the e-mail account. You cannot modify it.
E-mail Type
Select the type of e-mail account to be set up from the drop-down list.
E-mail Account Description
Enter a description for this e-mail account.
Login Name, Mailbox or Profile Name
Enter your login, mailbox or profile name, depending on the type of e-mail 
account being defined.

Password
Enter the password to log in to this account.
Postoffice (Exchange, Notes or VIM only)
Specify the post office, if you are defining an Exchange, Lotus Notes or VIM 

“The Everest CRM Studio - E-mail Accounts Dialog Box - General” on 
page 29

Enter the profile name for Mapi, the mailbox alias name for Exchange, and 
the login name for Internet.
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compliant e-mail system.

Active
Ensure that this box is checked if you want to use this account for sending e-mails.
SMTP/POP Internet E-mail Information

Outgoing Mail (SMTP) Server Name
Enter the SMTP server name.
SMTP From Name (required for Internet)
Enter the name that should appear in the ‘From’ field of outgoing e-mails.
SMTP Port (optional)
Specify the port for sending e-mails.

Incoming Mail (POP) Server Name
Enter the POP server name.
POP Port (optional)
Specify the port for receiving e-mails.

Notes
Enter any additional information that you want to keep track of.

E-mail Sending Account - Notes
Everest Software recommends using e-mail type Internet with Exchange if the 
exchange server is configured for SMTP and POP3. 
The ability to send HTML e-mail only works with e-mail type Internet. You gain 
ease-of-use and functionality if the Exchange server is configured for SMTP. 
If you use a Microsoft Exchange type of e-mail sending account, you must do the 
following depending on whether you are running Exchange under SMTP, or in its 
native environment.
Running Exchange under SMTP

• Stop the Everest CRM Studio service (path: Control Panel > Administrative 
Tools > Services).

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Software Setup folder and click E-mail Accounts.

For Lotus Notes and VIM, fill this in only if the post office you are using is 
different from the default post office for the Notes or VIM client. For 
Exchange, enter the exchange server name.

Specify relevant details in the following fields, if you are defining an 
Internet type of e-mail account.

This port is used to accommodate specific firewall security software. Leave 
this field blank unless otherwise instructed by Everest Software.

This port is used to accommodate specific firewall security software. Leave 
this field blank unless otherwise instructed by Everest Software.

To run Microsoft Exchange with SMTP, do the following:
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• The e-mail account you defined is displayed in the E-mail Accounts panel on 
the right. Highlight the account and select File > Open Selected Item. You 
will see the Everest CRM Studio - E-mail Accounts dialog box.

• Select Internet from the E-mail Type drop-down list. Ensure that the 
Postoffice (Exchange, Notes or VIM only) field is blank.

• Enter the default server name(s) of your site.

• Enter a valid e-mail account in the SMTP From Name (required for Internet) 
field.

• Restart the Everest CRM Studio service (path: Control Panel > 
Administrative Tools > Services). 

Running Exchange without SMTP
Identify the user account you will run CRM Studio from. This account must be a 
real user account - not the system account. Microsoft Collaboration Data Objects 
(CDO) requires a real user context when invoking the CDO components. If you 
have already set up an account, log in to that account for the next steps. 
Otherwise, create an account, log on to it and follow the steps below. 

• Stop the Everest CRM Studio service (path: Control Panel > Administrative 
Tools > Services).

• Go to Control Panel > Add/Remove Programs. From the list, highlight MS 
Office or MS Outlook and click the Change button. You will see the Setup 
dialog box.

• Select Add or Remove Features and click Next.
• Double-click Microsoft Outlook for Windows, and check if Collaboration 

Data Object has a red ‘x’ mark across it. If it does, you need to install it. If not, 
you must re-install/repair it.

• Ensure that, in Exchange Administration, the primary account for the mailbox 
you are using is configured for the NT user account you will be running CRM 
Studio from. Check the Primary NT Account option to verify this.

• Ensure that the Postoffice (Exchange, Notes or VIM only) field in the Everest 
CRM Studio - E-mail Accounts dialog box has your Exchange server name.

• Ensure that the Login Name, Mailbox or Profile Name field contains the 
mailbox alias or directory name. 

• Enter the password (usually the NT account password) to access the mailbox. 

Example server.[your_company].com.

If you have set up SMTP access to your Exchange server using SSL only, 
these steps will not work with CRM Studio. You must therefore execute 
the steps below.

To run Microsoft Exchange without SMTP, do the following:

Sometimes, the mailbox might be 'Bob Jones' but the real name is 
‘bjones’. You must specify the real name being used which should be 
devoid of spaces.
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• In your NT Services control panel, enter the Log On As information to enable 
Everest CRM Studio service to run from the NT user account you have 
created. 

• Start the Everest CRM Studio service (path: Control Panel > Administrative 
Tools > Services).

Test the E-Mail Sending Account

• Ensure that the Everest CRM Studio service (path: Control Panel > 
Administrative Tools > Services) is running. 

• From the Everest CRM Studio Administrator dialog box, click Software 
Setup > E-mail Accounts. The account you just set up is displayed in the right 
panel. Click this account.

• Click the Perform E-mail Test button at the top of the Everest CRM Studio 
Administrator dialog box. You will see the Everest CRM Studio 
Administrator - Perform E-mail Test dialog box.

 Figure 1.28: Everest CRM Studio Administrator - Perform E-mail Test
• Enter your own e-mail address and click OK.
• From the main menu bar, select CRM > CRM Studio > Monitor. You will see 

the Everest CRM Studio Event Monitor dialog box.

Ensure that MS Outlook and CRM Studio are not running 
simultaneously on the same server. CDO allows only one user context 
access to the mailbox at a time on one machine. 

To test the e-mail account, do the following:
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 Figure 1.29: Everest CRM Studio Event Monitor
• Verify if the e-mail has been successfully sent by selecting E-mail Delivery > 

Sent Today. If the e-mail appears in the Errors Today branch (or never leaves 
the Pending branch), there is an error in the configuration of the e-mail 
sending account.

• If the e-mail is not sent successfully, stop the Everest CRM Studio service and 
review the e-mail sending account set-up (contact Everest Software Technical 
Support, if needed). Once you have re-configured the account, you do not 
need to send another test mail, as the previous one is still pending. Restart the 
Everest CRM Studio service and verify if the pending message is sent.

Define a Subscriber
The final step in the initial configuration of CRM Studio is to define yourself as 
an event subscriber – a person who will receive an alert message. 

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Management Folders panel in the center, select Subscribers > 
Users > Sales Team.

• Click the New User button at the top-left of the Everest CRM Studio Architect 
dialog box. You will see the Description tab of the Everest CRM Studio - 
Subscribers\Users\Sales Team dialog box.

To define yourself as an event subscriber belonging to the sales team, do 
the following:

“The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - Description” on page 34
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• Enter the relevant details in the first six fields. Ensure that you check the 
Active box. Click the E-mail tab.

• Enter your primary e-mail address in the E-mail Address 1 field and 
secondary e-mail address in the E-mail Address 2 field.

• Click Save and Close.

The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - Description

 Figure 1.30:  Everest CRM Studio - Subscribers\Users\(group name) - 
Description

Internal ID Number
This field displays the ID of the subscriber. You cannot modify it.
Last Name and First Name
Enter the last and first names.
Full Name
The full name is displayed in this field. You can edit this field.
Job Title
Enter the job title of the user.
Company Name
Enter the name of the user’s company.
Phone Number
Enter the user’s phone number.
IP Address
Enter the IP address of the user’s computer.

“The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - E-mail” on page 38
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Computer Name
Enter the name of the user’s computer.
User Lookup Key
Specify a unique value/code that identifies this user. This key links the user to a 
database record.

Active
Ensure that this box is checked if you want to use this user to receive notifications.

User Lookup Key
Consider the following scenario:
You have a customer support application that tracks the calls assigned to various 
support representatives. Each support representative is identified by a unique ID 
as well as a non-unique group code (such as the Frontline group).
The support application does not store the corresponding representative’s e-mail 
and other notification addresses anywhere in the application.
When a support call meets a condition that warrants an alert to the corresponding 
support representative, the following occurs:
• CRM Studio looks at the triggered record and finds the corresponding 

representative’s ID and group name.
• CRM Studio looks up the matching CRM Studio subscriber record (based on 

the representative’s ID) and the matching subscriber group (based on the 
representative’s group name) in the CRM Studio subscriber database.

• CRM Studio alerts the corresponding support representative and/or group.
Thus, the User Lookup Key field allows you to designate a unique value that 
identifies and links this user to a database record.

The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - Copy

One of the methods by which you can receive notifications is via copied files. The 
copy method allows CRM Studio to move files and Crystal Reports (both of 
which may be attached to triggered events, or scheduled on a periodic basis) to 
specific locations.

“User Lookup Key” on page 35

“Use a Group Lookup Key” on page 163
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 Figure 1.31: Everest CRM Studio - Subscribers\Users\(group name) - Copy
Copy Location 1
Enter the primary copy location of the subscriber in this field.
Copy Location 2
Enter the secondary copy location of the subscriber in this field.

CRM Studio allows you to specify two locations for copied files. The reason for 
these two locations is that you might wish to use a different location based on the 
time of day (and day of the week) when the notification occurs.

The copy location should be specified using the standard UNC (Universal 
Naming Convention) format. On a network, the UNC is a method by which 
you can identify a shared file in a computer, without having to specify the 
storage device it is on. For Windows, the UNC name format is: 
//servername/sharename/path/filename. 
You can also specify an FTP address, using the format:
ftp://username:password@ftp.location.net/directory_name.

Example If a notification occurs during work hours (Monday through Friday, 
8:00 am to 5:00 pm), you can have files copied to a location inside your 
computer’s security firewall. However, if a notification occurs outside 
of work hours, you might have files copied to a location outside your 
computer’s firewall, and thus, have round-the-clock access to that 
data.
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Please select which copy location to use at the specified time
Specify the location of the file to be used at different times of the day (and on 
different days of the week) in this grid.

You may also use the grid to specify those times when both copy locations are to 
be used (place an asterisk in the corresponding time slots) and to specify those 
times when neither copy location is to be used (use the spacebar to place a blank 
in the corresponding time slots).
Restore Defaults
Click this button to restore the default settings.
Use Location1 for All
Click this button to use the primary location at all times.
Use Location2 for All
Click this button to use the secondary location at all times.
Use Both for All
Click this button to use the primary and secondary location together, at all times.

Primary and Secondary Copy Locations
The Please select which Copy Location to use at the specified time grid allows 
you to specify which location (primary or secondary) will be used, based upon the 
time of day and day of the week, when an alert occurs. The grid scrolls down to 
display the time segments after 6 AM.
The grid is divided into 30 minute segments for each day of the week. Within each 
segment, you can specify whether you wish to use the primary delivery location 
(‘1’), the secondary location (‘2’), both locations (‘*’), or neither (blank out the 
value).

The default grid values use Copy Location 1 for normal work hours 
(Monday through Friday, 8:00 am to 5:00 pm), and Copy Location 2 for all 
other times.

“Subscriber Alert Methods and Addresses” on page 156
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The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - E-mail

 Figure 1.32: Everest CRM Studio - Subscribers\Users\(group name) - E-mail
E-mail Address 1 
Enter the primary e-mail address of the subscriber in this field.
E-mail Address 2
Enter the secondary e-mail address of the subscriber in this field.
CRM Studio allows you to specify two addresses for e-mail; the reason for being 
that you might wish to use a different address based on the time of day (and day 
of the week) when the notification occurs.

Please select which Email Address to use at the specified time
Specify the address to be used at different times of the day (and on different days 
of the week) in this grid. 

You may also use the grid to specify those times when both addresses are to be 
used (place an asterisk in the corresponding time slots) and to specify those times 
when neither address is to be used (use the spacebar to place a blank in the 
corresponding time slots).
Restore Defaults
Click this button to restore the default settings.

Example If a notification occurs during work hours (Monday through Friday, 
8:00 am to 5:00 pm), you might have e-mail sent to your work address. 
However, if a notification occurs outside of work hours, you might 
have e-mail sent to your home address, and thus, have round-the-
clock access to that data.

The default grid values use address number one for normal work hours 
(Monday through Friday, 8:00 am to 5:00 pm), and address number two for 
all other times.
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Use Address1 for All
Click this button to use the primary e-mail address at all times.
Use Address2 for All
Click this button to use the secondary e-mail address at all times.
Use Both for All
Click this button to use the primary and secondary e-mail addresses together, at 
all times.

Primary and Secondary E-mail Addresses
The Please select which Email Address to use at the specified time grid allows 
you to specify which address (primary or secondary) will be used, based upon the 
time of day and day of the week, when an alert occurs. The grid scrolls down to 
display the time segments after 6 AM.
The grid is divided into 30 minute segments for each day of the week. Within each 
segment, you can specify whether you wish to use the primary delivery address 
(‘1’), the secondary address (‘2’), both addresses (‘*’), or neither address (blank out 
the value).

The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - Fax

 Figure 1.33: Everest CRM Studio - Subscribers\Users\(group name) - Fax
Fax Number 1 
Enter the primary fax number of the subscriber in this field.

“Subscriber Alert Methods and Addresses” on page 156
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Fax Number 2
Enter the secondary fax number of the subscriber in this field.
CRM Studio allows you to specify two phone numbers for faxing in case you 
wish to use a different number based on the time of day (and day of the week) 
when the notification occurs.

Please select which Fax Number to use at the specified time
Specify which numbers are to be used at different times of the day (and on 
different days of the week).

You may also use the grid to specify those times when both fax numbers are to be 
used (place an asterisk in the corresponding time slots) and to specify those times 
when neither fax number is to be used (use the spacebar to place a blank in the 
corresponding time slots). 
Restore Defaults
Click this button to restore the default settings.
Use Fax1 for All
Click this button to use the primary fax number at all times.
Use Fax2 for All
Click this button to use the secondary fax number at all times.
Use Both for All
Click this button to use the primary and secondary fax numbers together, at all 
times.

Primary and Secondary Fax Addresses
The Please select which Fax Number to use at the specified time grid allows you 
to specify which fax number (primary or secondary) will be used, based upon the 
time of day and day of the week when an alert occurs. The grid scrolls down to 
display the time segments after 6 AM.
The grid is divided into 30 minute segments for each day of the week. Within each 
segment, you can specify whether you wish to use the primary fax number (‘1’), 
the secondary fax number (‘2’), both numbers (‘*’), or neither address (blank out 
the value).

Example If a notification occurs during work hours (Monday through Friday, 
8:00 am to 5:00 pm), you might have a fax sent to your work address. 
However, if a notification occurs outside of work hours, you might 
have a fax sent to your home address, and thus, have round-the-clock 
access to that data.

The default grid values use fax number one for normal work hours 
(Monday through Friday, 8:00 am to 5:00 pm), and fax number two for all 
other times.

“Subscriber Alert Methods and Addresses” on page 156
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The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - Page

 Figure 1.34: Everest CRM Studio - Subscribers\Users\(group name) - Page
Paging Vendor 1 
Enter the primary pager number of the subscriber in this field.
Paging PIN 1
Enter the corresponding PIN for the first pager number.
Paging Vendor 2
Enter the secondary pager number of the subscriber in this field.
Paging PIN 2
Enter the corresponding PIN for the secondary pager number.
CRM Studio allows you to specify two phone numbers for paging in case you 
wish to use a different number based on the time of day (and day of the week) 
when the notification occurs.

Example If a notification occurs during work hours (Monday through Friday, 
8:00 am to 5:00 pm), you might have a page sent to your work pager 
number. However, if a notification occurs outside of work hours, you 
might have a page sent to your home pager number, and thus, have 
round-the-clock access to that data.
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Please select which Pager to use at the specified time
Specify the pager number to be used at different times of the day (and on different 
days of the week) in this grid. 

You may also use the grid to specify those times when both pager numbers are to 
be used (place an asterisk in the corresponding time slots), and to specify those 
times when neither address is to be used (use the spacebar to place a blank in the 
corresponding time slots).
Restore Defaults
Click this button to restore the default settings.
Use Pager1 for All
Click this button to use the primary pager number at all times.
Use Pager2 for All
Click this button to use the secondary pager number at all times.
Use Both for All
Click this button to use the primary and secondary pager numbers together, at all 
times.

Primary and Secondary Pager Numbers
The Please select which Pager to use at the specified time grid allows you to 
specify which pager number (primary or secondary) will be used, based upon the 
time of day and day of the week when an alert occurs. The grid scrolls down to 
display the time segments after 6 AM.
The grid is divided into 30 minute segments for each day of the week. Within each 
segment, you can specify whether you wish to use the primary pager number 
(‘1’), the secondary pager (‘2’), both pagers (‘*’), or neither address (blank out the 
value).

The default grid values use pager number one for normal work hours 
(Monday through Friday, 8:00 am to 5:00 pm), and pager number two for all 
other times.

“Subscriber Alert Methods and Addresses” on page 156
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The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - WebCast

 Figure 1.35: Everest CRM Studio - Subscribers\Users\(group name) - WebCast
WebCaster Name 1 
Enter the primary webcast server name to which notifications must be sent in this 
field.

Webcaster Location for Name 1
Enter the location of the webcast server in this field.
WebCaster Name 2
Enter the secondary webcast server name to which notifications must be sent in 
this field.
Webcaster Location for Name 2

The name you enter here is also used as the directory name to publish this 
subscriber’s alerts. It is very important that a directory for this user or group 
is created on the webserver or on a computer that the webserver has access 
to. If the webserver publishing location is \\MYSERVER\USERS\ and the 
webname is JONES, webcaster html file for user JONES will be created in 
the location \\MYSERVER\USERS\JONES.
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Enter the location of the webcast server in this field.
CRM Studio allows you to specify two webcast server names in case you wish to 
send messages to a different server based on the time of day (and day of the week) 
when the notification occurs.

Please select which name to use at the specified time
Specify the webcast server to be used at different times of the day (and on 
different days of the week) in this grid. 

You may also use the grid to specify those times when both servers are to be used 
(place an asterisk in the corresponding time slots), and to specify those times 
when neither server is to be used (use the spacebar to place a blank in the 
corresponding time slots).
Restore Defaults
Click this button to restore the default settings.
Use Name1 for All
Click this button to use the primary server at all times.
Use Name2 for All
Click this button to use the secondary server at all times.
Use Both for All
Click this button to use the primary and secondary servers together, at all times.

Primary and Secondary WebCast Servers
The Please select which Name to use at the specified time grid allows you to 
specify which server (primary or secondary) will be used, based upon the time of 
day and day of the week when an alert occurs. The grid scrolls down to display 
the time segments after 6 AM.
The grid is divided into 30 minute segments for each day of the week. Within each 
segment you can specify whether you wish to use the primary delivery address 
(‘1’), the secondary address (‘2’), both addresses (‘*’), or neither address (blank out 
the value).

The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - Subscriptions

The Subscriptions tab displays an informational listing of all the events that this 
subscriber is currently signed-up to receive alerts about. This list is purely 
informational; you cannot add or remove events to this list from here, nor can you 
alter the methods by which the subscriber is to be alerted about a given event.

Example If a notification occurs during work hours (Monday through Friday, 
8:00 am to 5:00 pm), you might have the webcast message sent to a 
server that you can access from work. However, if a notification 
occurs outside of work hours, you can have the webcast message sent 
to a server that you can access from home, and thus, have round-the-
clock access to that data.

The default grid values use webcast server number one for normal work 
hours (Monday through Friday, 8:00 am to 5:00 pm), and webcast server 
number two for all other times.

“Subscriber Alert Methods and Addresses” on page 156
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 Figure 1.36: Everest CRM Studio - Subscribers\Users\(group name) - 
Subscriptions

You have successfully completed the initial configuration of CRM Studio.

Before You Begin Designing Events
One of CRM Studio’s core capabilities is its ability to create and send alert 
messages. Based upon the steps that you have executed so far, CRM Studio is 
now configured to send out e-mail alerts only. Although CRM Studio can send 
out alerts via fax, pager, and webcast, we have not configured those components 
at this point.
Also, although CRM Studio can send out alerts to a wide variety of people 
(employees, clients, business partners, etc.), we have configured only a single 
subscriber within CRM Studio at this point – you.
You can add more subscribers to CRM Studio (as well as import or use 
subscribers from other applications), but this is not yet configured.
Everest Software suggests that your initial implementation and testing of CRM 
Studio not go beyond what has been configured thus far. Once you are able to 
create queries and events that send alerts – via e-mail – you should consider 
expanding both the means of alert delivery, and the subscribers who can receive 
alert messages.

Implementation: How to Proceed
There are many components of the CRM Studio application, and the best way to 
implement it is to approach it by module.
The most basic components of CRM Studio are queries and events; their primary 
use being to identify critical, time-sensitive data in a company database and send 
out alert messages. In this regard, the best way to begin implementing CRM 
Studio is to create a few queries and events that will trigger alert messages.

Tutorials
In the following chapter you may follow a tutorial that is designed for use with 
the Accel Sample Company data that is shipped with Everest.
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The Studio Architect - Overview 
Create a Record-Level Query 
Create an Event 
An Aggregate Query 
Create the Aggregate Event 





CRM Studio Product Tutorial
CRM Studio is an Alert Messaging application that enables organizations to 
monitor one or more company databases (and incoming e-mail messages) for 
critical, time-sensitive conditions of data.
When these conditions occur, CRM Studio can send out alert messages via e-
mail, it can generate Crystal Reports, and it can take appropriate response actions 
such as updating an underlying company database with history details and 
correction actions to address the situation.
This tutorial is meant to take you on a brief tour of CRM Studio. Those options 
and functions that are not discussed in this chapter will be elaborated in the 
chapters that follow.
For the purpose of this tutorial, you will be using the Accel Sample Company 
database provided with Everest.
This tutorial will guide you through the creation of two alert events: 
• An event that notifies you if any customer’s birthday falls on the current date.
• An event that notifies you about ‘x’ top selling items between ‘y’ and ‘z’ dates.

The Studio Architect - Overview

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

 Figure 2.1:  Everest CRM Studio Architect
• From the Event Management Folders panel in the center, select Application 

Events. You will see all the companies that CRM Studio is currently 
configured to integrate with.

Refer the chapter Query Designing for additional information on 
constructing queries.

To access the Studio Architect, do the following:

When you log in for the first time, the ASC database is updated with the 
latest EventPak.
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• Double-click Accel Sample Company. 
Within each company’s folder are branches where you can define queries, events, 
report definitions, scheduled reports, and Visual Basic scripts. 
A query identifies the data that will cause an event to be triggered. Once you have 
designed queries, you may use them in events. An event specifies such items as 
whom you wish to notify, what message you wish to send, and how often you 
wish to check for the event.

Create a Record-Level Query
As you proceed, you may either create a query, or simply use an existing query of 
the same name from the Accel Sample Company - Queries branch.
The first query (and event) that you are going to create is referred to as a record-
level query because it is triggered by the existence of individual data records that 
meet certain conditions. (In this example, it is customers whose birthday is today.)

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Manager Folders panel in the center, select Application 
Events > Accel Sample Company > Query Definitions.

• Click the New Query Definition button at the top-left. You will see the 
Everest CRM Studio - Application Events\Accel Sample Company\Query 
Definitions - Description tab.

• In the Query Description field, enter ‘CUSTOMERS: Whose Birthday is on the 
current date’. Press the Tab key to copy this into the Display Description 
field.

• Be sure to check the Active checkbox. Click Next. You will see the Everest 
CRM Studio - Application Events\Accel Sample Company\Query 
Definitions - Tables tab.

To create a record-level query, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Description” on page 51
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The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Description

 Figure 2.2: Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Description

Internal ID Number
This field displays the ID of the query. You cannot modify it.
Query Description
Enter a brief description of the query being defined.
Display Description
Enter a brief description of the query, for display purposes.
Active
Be sure to check this box.

Specify the Query’s Tables

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\Accel Sample Company\Query 
Definitions dialog box, click Next. You will see the Tables tab.

• From the Available Tables panel on the left, double-click the following tables 
to add them to the Selected Tables panel:
- dbo.ADDRESS
- dbo.CUST

“Query Description” on page 117

To specify the query’s tables, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Tables” on page 52
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- dbo.PERSONAL
• Click Next. You will see the Everest CRM Studio - Application Events\Accel 

Sample Company\Query Definitions - Links tab. 

The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Tables

 Figure 2.3:  Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Tables

Available Tables
This panel lists the available tables in the database you are connected to. 
Add Table
Click this button to move a selected table from the Available Tables panel to the 
Selected Tables panel.
Remove Table
Click this button to remove a selected table from the Selected Tables panel and 
send it back to the Available Tables panel.
Selected Tables
This panel lists the tables in the database that you have selected.

To include company data in an alert message, you must select the table(s) in 
which that data resides.

“Query Tables” on page 118
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Link the Tables

• After selecting tables from the Tables tab of the Everest CRM Studio - 
Application Events\Accel Sample Company\Query Definitions dialog box, 
click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Query Definitions - Links tab.

• Click the Add Table Link button. You will see the Everest CRM Studio - 
Tables Linked Together dialog box. 

• From the Table Name drop-down list, select dbo.CUST. From the Linked to 
Table Name drop-down list, select dbo.ADDRESS. 

• From the Column Name drop-down list, select CUST_CODE. The Linked To 
Column Name field displays CUST_CODE as well.

• From the Link Type drop-down list, select Left Outer Join. Click OK.
• You will see the Everest CRM Studio - Application Events\Accel Sample 

Company\Query Definitions - Links tab again. Click the Add Table Link 
button. You will see the Everest CRM Studio - Tables Linked Together 
dialog box again.

• From the Table Name drop-down list, select dbo.CUST. From the Linked to 
Table Name drop-down list, select dbo.PERSONAL. 

• From the Column Name drop-down list, select SALESPERSO. From the 
Linked To Column Name select IDNO.

• From the Link Type drop-down list, select Left Outer Join. Click OK. You will 
see the Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Links tab again, with the resulting linked 
tables displayed.

• Click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Query Definitions - Columns tab.

To link the tables, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Links” on page 54

“The Everest CRM Studio - Tables Linked Together Dialog Box” on 
page 54

When you link tables, the first table must be the query’s primary table - the 
table whose records the query reads first. 
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The Everest CRM Studio - Tables Linked Together Dialog Box

 Figure 2.4: Everest CRM Studio - Tables Linked Together 
Table Name
Select the table that you want to link to another.
Linked to Table Name
Select the table to link to.
Column Name
Select the column from the selected table (in the Table Name field) that you want 
to link to another.
Linked to Column Name
Select the column from the selected table (in the Linked to Table Name field) that 
you want to link to.
Link Type
Select the type of link to create.

The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Links

 Figure 2.5: Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Links (with resulting linked tables)
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Add Table Link
Click this button to display the Everest CRM Studio - Tables Linked Together 
dialog box, which allows you to link tables.
I would like to manually input the table linking
Select this option to link tables manually.
Remove Link
Click this button to remove a selected link.
Remove All Links
Click this button to remove all the links displayed.

 Select the Query’s Columns (Fields)
When constructing a query, select the fields you wish to include in your alert 
messages. 

• After linking the selected tables in the Links tab of the Everest CRM Studio - 
Application Events\Accel Sample Company\Query Definitions dialog box, 
click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Query Definitions - Columns tab.

• From the Available Columns to Query panel, select the following columns by 
double-clicking them:
- From the Address table: dbo.ADDRESS.ACCT_NAME, 

dbo.ADDRESS.ADDR_CODE, dbo.ADDRESS.CITY, 
dbo.ADDRESS.EMAIL, dbo.ADDRESS.DATE_OF_BIRTH, 
dbo.ADDRESS.CUST_CODE.

- From the Personal table: dbo.PERSONAL.DESIGNATION_CODE, 
dbo.PERSONAL.EMAIL.

• Place a check mark in the Unique column of the dbo.ADDRESS.CUST_CODE 
row.

• Using a new row, enter ISNULL(dbo.ADDRESS.FIRST_NAME, '') 
+SPACE(1)+ ISNULL(dbo.ADDRESS.LAST_NAME, '').

• Using a new row, enter ISNULL(dbo.PERSONAL.PFIRST, '') +SPACE(1)+ 
ISNULL(dbo.PERSONAL.PLAST, '').

• Using a new row, enter ISNULL(dbo.PERSONAL.PHPH,'') + (CASE 
ISNULL(dbo.PERSONAL.EXTN_TEL1,'') WHEN '' THEN SPACE(1) ELSE ' 
EXT. '+dbo.PERSONAL.EXTN_TEL1 END).

“Query Links” on page 119

To select the query’s columns (fields), do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Columns” on page 56

The preceding three steps detail the creation of calculated fields. Refer 
“Calculated Fields” on page 124 for additional details. 
Everest CRM Studio 55
User Guide



Product Tutorial CRM Studio
• Click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Query Definitions - Sorting tab.

The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Columns

 Figure 2.6: Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Columns (with selected columns)

Available Columns to Query
This panel displays all the columns (from the selected tables) available for 
constructing queries.
Add Column to Query
Click this button to add a selected column to the Query Columns Selected field.
Add All Columns to Query
Click this button to add all available columns to the Query Columns Selected 
field.
Query Columns Selected
This grid displays all the columns selected.

Remove Column from Query
Click this button to remove a selected column from the Query Columns Selected 
field.

If you do not identify a unique column, a single record is triggered over and 
over each time it meets the query’s criteria. If you do identify a unique 
column, you can opt for the record to trigger over and over or trigger only 
the first time it meets a query’s criteria. 

“The Query Columns Selected Grid” on page 123
“Calculated Fields” on page 124
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Remove All Columns from Query
Click this button to remove all the columns displayed in the Query Columns 
Selected field.
Return DISTINCT Rows of Data Only
Select this option to retrieve only unique (or distinct) records. 

Select the Query’s Sorting Order

• After selecting the query’s columns in the Columns tab of the Everest CRM 
Studio - Application Events\Accel Sample Company\Query Definitions 
dialog box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Query Definitions - Sorting tab.

• From the Available Columns for Sorting panel, double-click 
dbo.ADDRESS.ACCT_NAME. The column is added to the Columns Selected 
for Sorting panel.

• Ensure that the Sort Order column in the Columns Selected for Sorting panel 
displays Ascending.

• Click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Query Definitions - Filters tab.

“Return Distinct Rows of Data Only” on page 125
“Query Columns” on page 121

To select the query’s sorting order, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Sorting” on page 58

The customers will be listed in alphabetical sequence, based on the 
customer account codes.
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The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Sorting

The Sorting tab lets you specify the order in which retrieved records will be 
displayed. 

 Figure 2.7: Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Sorting

Available Columns for Sorting
This panel displays all the columns (from the selected tables) available for sorting.
Add Column to Sorting
Click this button to add a selected column to the Columns Selected for Sorting 
panel.
Add All Columns to Sorting
Click this button to add all available columns to the Columns Selected for 
Sorting panel.
Columns Selected for Sorting
This panel displays all the columns selected.
Remove Column from Sorting
Click this button to remove a selected column from the Columns Selected for 
Sorting panel.
Remove All Columns from Sorting
Click this button to remove all the columns displayed in the Columns Selected 
for Sorting panel.

 Specify the Filter
The Filters tab lets you specify the condition(s) that records must meet to be 
retrieved by the query. CRM Studio filters can test for such conditions as:
• Sale amount greater than ‘x’
• Customers in industry ‘y’
• Opportunities forecast to close today, tomorrow, next week, or next month
• Sale amount, multiplied by its probability, greater than ‘z’

“Query Sorting Order” on page 125
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• Order shipped date is later than the required date

• After selecting the query’s sorting order in the Sorting tab of the Everest CRM 
Studio - Application Events\Accel Sample Company\Query Definitions 
dialog box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Query Definitions - Filters tab.

• From the Available Columns to Filter panel, double-click 
dbo.ADDRESS.DATE_OF_BIRTH. The column is added to the Columns 
Selected for Filtering panel.

• Alter the column name to DATEPART(Month, 
dbo.ADDRESS.DATE_OF_BIRTH).

• Ensure that the Is or Is Not column in the Columns Selected for Filtering 
panel displays Is.

• Click the Operator column, click the drop-down arrow that appears, and 
select ‘equal to’.

• Click the Compare Value column, delete the ‘?’ and enter DATEPART(Month, 
getdate()) (without quotation marks).

• From the Available Columns to Filter panel, double-click 
dbo.ADDRESS.DATE_OF_BIRTH again. The column is added to the 
Columns Selected for Filtering panel.

• Alter the column name to 
DATEPART(DAY,dbo.ADDRESS.DATE_OF_BIRTH).

• Ensure that the Is or Is Not column in the Columns Selected for Filtering 
panel displays Is.

• Click the Operator column, click the drop-down arrow that appears, and 
select ‘equal to’.

• Click the Compare Value column, delete the ‘?’ and enter DATEPART(DAY, 
getdate()) (without quotation marks).

• From the Available Columns to Filter panel, double-click 
dbo.ADDRESS.TYPE. The column is added to the Columns Selected for 
Filtering panel.

• Ensure that the Is or Is Not column in the Columns Selected for Filtering 
panel displays Is.

• Click the Operator column, click the drop-down arrow that appears, and 
select ‘equal to’.

• Click the Compare Value column, delete the ‘?’ and enter 4.

To specify the filter, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Filters” on page 60

The steps that require alteration of the column name are related to 
calculated fields. Refer “Calculated Fields” on page 124 and “Using 
Calculated Fields in Filters” on page 135 for additional information.
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• From the Available Columns to Filter panel, double-click 
dbo.ADDRESS.SUB_TYPE. The column is added to the Columns Selected for 
Filtering panel.

• Ensure that the Is or Is Not column in the Columns Selected for Filtering 
panel displays Is.

• Click the Operator column, click the drop-down arrow that appears, and 
select ‘equal to’.

• Click the Compare Value column, delete the ‘?’ and enter 2.
• For all four rows, click the Type column, click the drop-down arrow that 

appears, and select Number.
• Leave the rest of the columns with their default values, if any.
• Click Next. You will see the Everest CRM Studio - Application Events\Accel 

Sample Company\Query Definitions - Sub Filters tab.

The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Filters

 Figure 2.8:  Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Filters

Available Columns to Filter
This panel displays all the columns (from the selected tables) available for sorting.
Add Column to Filter
Click this button to add a selected column to the Columns Selected for Filtering 
panel.
Add All Columns to Filter
Click this button to add all available columns to the Columns Selected for 
Filtering panel.

The Sub Filters tab is not used in the design of record-level queries; it is 
used only with an aggregate query which we will design a little later. Leave 
the Sub Filters tab blank.
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Columns Selected for Filtering
This panel displays all the columns selected.
Remove Column from Filter
Click this button to remove a selected column from the Columns Selected for 
Filtering panel.
Remove All Columns from Filter
Click this button to remove all the columns displayed in the Columns Selected 
for Filtering panel.

Preview the Results of the Query
The Preview tab displays the results of your query. 

• After selecting columns for filtering in the Filters tab of the Everest CRM 
Studio - Application Events\Accel Sample Company\Query Definitions 
dialog box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Query Definitions - Sub Filters tab.

• Leave this tab blank and click Next. You will see the SQL tab displaying the 
SQL query created. Click Next. You will see the Preview tab with the results 
of the query displayed.

• Click Save and Close at the top left of the dialog box to save the query. You 
will see the Everest CRM Studio Architect dialog box again.

• If you need to go back and make changes to the query information, click the 
appropriate tab.

“Query Filter Parameters” on page 127
“Compare Values” on page 128
“Operators - Notes” on page 132
“And/Or Logic” on page 135
“Query Filters” on page 126

To preview the results of the query, do the following:

“Query SQL” on page 136
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The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Preview

 Figure 2.9: Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Preview

Create an Event
CRM Studio separates queries and events so that a single query can be used in 
multiple events. 

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Manager Folders panel in the center, select Application 
Events > Accel Sample Company > Events.

• Click the New Event button at the top-left. You will see the Everest CRM 
Studio - Application Events\Accel Sample Company\Events - Description 
tab.

• Enter ‘CUSTOMERS: Birthday E-mails to customers’ in the Event Description 
field. 

• Select 1 in the Priority field.

“Query Preview” on page 137

Example A single query that identifies sales of greater than ‘x’ dollars could be 
used in the following three events:
• Sales of Greater than $10,000
• Sales of Greater than $25,000
• Sales of Greater than $50,000

Refer the chapter Query Designing for additional information on 
constructing queries.

To create an event, do the following:

“The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Description” on page 179
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• Check the option Keep only last checked record in Monitor. 

• Be sure to check the Active check box. Click Next. You will see the Everest 
CRM Studio - Application Events\Accel Sample Company\Events - 
Queries tab.

Select the Event’s Query

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\Accel Sample Company\Events dialog 
box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Events - Queries tab.

• Click the Add Query button. You will see the Everest CRM Studio - Add 
Query dialog box. 

• Select the query ‘CUSTOMERS: Whose Birthday is on the current date’. Click 
Select. 

• Similarly, select the query ‘COMPANY: Current Company Details’.

• Click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Events - Reports tab.

The Everest CRM Studio - Add Query Dialog Box

 Figure 2.10: Everest CRM Studio - Add Query

This ensures that CRM Studio retains minimum event history.

To link the query to the event, do the following:

“The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Queries” on page 182

“The Everest CRM Studio - Add Query Dialog Box” on page 63

• The grid at the bottom of this window remains empty as the query 
includes only a single filter and its compare values are identified at the 
query level. 

• You can design queries whose filter values can be identified at the event 
level as well.
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Select Another Application
Click this button to display the Everest CRM Studio - Select Another 
Application dialog box, which allows you to change the current company.

Select
Click this button to add a selected query to the Queries Selected panel in the 
Queries tab of the Everest CRM Studio - Application Events\(your 
company)\Events dialog box.

The Everest CRM Studio - Select Another Application Dialog Box

 Figure 2.11: Everest CRM Studio - Select Another Application
Select Another Application
This grid displays the companies that Everest CRM Studio is currently 
configured to work with.
Select
Click this button to switch to a selected company, from which you want to add a 
query. 

Specify the E-Mail Alert Message Text
One of the primary ways that CRM Studio can respond to a triggered event is to 
send out alert messages. Other responses include generating Crystal Reports and 
updating one or more company databases based on the triggered event. For this 
event, we will skip the Reports, Files, and Copy tabs, and will configure the event 
to send out e-mail alerts only.

• After linking the query to the event in the Queries tab of the Everest CRM 
Studio - Application Events\Accel Sample Company\Events dialog box, 
click Next until you see the Everest CRM Studio - Application Events\Accel 
Sample Company\Events - E-mail tab.

• Select an e-mail account from the E-mail Account to Send From drop-down 
list. 

• Enter ‘Happy Birthday!!!’ in the Message Subject field.
• Enter ‘Dear’ in the first line of the Message Text panel.

“The Everest CRM Studio - Select Another Application Dialog Box” on 
page 64

To specify e-mail alert message text, do the following:

“The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Email” on page 194
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• From the Available values for use in message content field, select {Customer 
Name}, so that it is added to the Message Text panel beside the ‘Dear’ in your 
alert message.

• Leave a blank line in the message text. From line 3, enter the following 
message:

• We wish you a very Happy Birthday!!! Please accept our hearty wishes for a 
prosperous year ahead. We take this opportunity to thank you for your 
continued support. We are privileged to have you as our customer. 

• Leave a blank line in the message text and enter ‘Congratulations again!’ in the 
next line. 

• From the Available values for use in message content field, select {Sales Rep 
Name}, so that it is added to the Message Text panel after the 
‘Congratulations again!’ in your alert message.

• Similarly, select the {Designation Code} and {Company Name} fields, so that 
they appear separately in the next two lines.

• In the next two lines, enter the following:
- E-mail:
- Tel: 

• Leave two spaces after each of these entries.
• From the Available values for use in message content field, select {Sales Rep 

E-mail}, so that it is added to the Message Text panel beside ‘E-mail:’ in your 
alert message.

• Similarly, from the Available values for use in message content field, select 
{Sales Rep Telephone}, so that it is added to the Message Text panel beside the 
Tel: in your alert message.

• Click Next until you see the Everest CRM Studio - Application Events\Accel 
Sample Company\Events - Subscribers - Standard tab.

Event Response Actions
CRM Studio can do much more than just send out alert messages when an event 
is triggered. It can:
• Generate one or more Crystal Reports and attach those reports to the outgoing 

alert message.
• Send product brochures, white papers, documentation, or other documents to 

specific recipients.
• FTP (file transfer protocol) specific files to pre-determined computers.
• Write triggered event data to a flat file for delivery to a specific computer or 

recipient.
• Create records in any front or back office application (such as creating a 

support ticket in an underlying help-desk application).
• Update records in any front or back office application (such as updating a 

contact’s record, or scheduling an activity for a sales representative).
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• Pass triggered event data to external technologies, such as a digital display 
board, or to a synthesized voice response unit.

For this event, you will not be configuring any response actions, and so, may 
move on to identifying the event’s subscribers.

Specify the Event’s Subscribers
Recipients of CRM Studio alerts are referred to as subscribers. For any single 
event, CRM Studio can send alerts to an unlimited number of subscribers. 
Subscribers may be retrieved from any number of external application databases.

• After specifying e-mail alert message text in the Email tab of the Everest CRM 
Studio - Application Events\Accel Sample Company\Events dialog box, 
and select the Subscribers - Standard tab.

• Click the Add Subscriber button. You will see the Everest CRM Studio - Add 
Subscriber dialog box.

• Click the plus sign beside Sales Team. Check the box beside your name. 
• Click the Add Subscriber button. You will see the Everest CRM Studio - 

Application Events\Accel Sample Company\Events - Subscribers - 
Standard tab again.

• Check the E-mail box beside your name to indicate that you wish to receive 
notifications via electronic mail. 

• Click Next. You will see the Schedule tab of the Everest CRM Studio - 
Application Events\Accel Sample Company\Events dialog box.

To configure the current event to send alerts to yourself, do the 
following:

“The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Subscribers - Standard” on page 226
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The Everest CRM Studio - Add Subscriber Dialog Box

 Figure 2.12: Everest CRM Studio - Add Subscriber
Add Subscriber
Click this button to add a selected user as a recipient of alerts. 

Specify the Event’s Schedule
The final step in the configuration of a CRM Studio event is to specify how often 
CRM Studio must check if that event has been triggered. 

• After specifying yourself as a recipient in the Subscribers tab of the Everest 
CRM Studio - Application Events\Accel Sample Company\Events dialog 
box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Events - Schedule tab.

• From the Choose a schedule to use drop-down list, select Daily at 09:00 AM. 

• Leave the rest of the fields with their default values, if any.
•  Click the Save and Close button at the top left of the dialog box to save the 

event you created.

To configure CRM Studio to check for events everyday at 9:00 am, do the 
following:

“The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Schedule” on page 234

CRM Studio is pre-configured with approximately a dozen schedules; 
you can create additional schedules of your own.
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An Aggregate Query
The first event you created used a query with just a single filter (condition) whose 
compare value was specified at the query level. 
The next event will use a query with three conditions and will allow the answers 
to two of these conditions to be specified at the event level.
In addition, this query will use a CRM Studio aggregate function. Aggregate 
functions allow CRM Studio to trigger an event based on the condition of a group 
of records. The following are examples of aggregate events:
• More than 10 orders in the evaluation stage of the sales pipeline.
• Fewer than 12 activities scheduled for any sales representative this week.
• Support reps whose average call length last week was greater than 30 minutes.
• More than $25,000 dollars lost to a specific competitor this month.

Create the Aggregate Query

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Manager Folders panel in the center, select Accel Sample 
Company > Query Definitions.

• Click the New Query Definition button at the top-left. You will see the 
Everest CRM Studio - Application Events\Accel Sample Company\Query 
Definitions - Description tab.

• In the Query Description field, enter INVENTORY: Top X fast moving items 
between Y and Z dates. Press the Tab key to copy the same description into 
the Display Description field.

• Be sure to check the Active checkbox. Click Next. You will see the Everest 
CRM Studio - Application Events\Accel Sample Company\Query 
Definitions - Tables tab.

Specify the Query’s Tables

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\Accel Sample Company\Query 
Definitions dialog box, click Next. You will see the Everest CRM Studio - 

Refer the chapter Query Designing for additional information on 
constructing queries.

To create an aggregate query, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Description” on page 51

“Aggregate Query Description” on page 141

To specify the query’s tables, do the following:
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Application Events\Accel Sample Company\Query Definitions - Tables 
tab.

• From the Available Tables panel on the left, double-click the tables 
dbo.INVOICES, dbo.ITEMS and dbo.X_INVOIC to add them to the Selected 
Tables panel. Click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Query Definitions - Links tab.

Link the Query’s Tables

• After selecting tables from the Tables tab of the Everest CRM Studio - 
Application Events\Accel Sample Company\Query Definitions dialog box, 
click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Query Definitions - Links tab.

• Click the Add Table Link button. You will see the Everest CRM Studio - 
Tables Linked Together dialog box. 

• From the Table Name drop-down list, select dbo.X_INVOIC. From the 
Linked to Table Name drop-down list, select dbo.ITEMS. 

• From the Column Name drop-down list, select dbo.X_INVOIC.ITEM_CODE. 
From the Linked To Column Name field, select dbo.ITEMS.ITEMNO.

• From the Link Type drop-down list, select Left Outer Join. Click OK. You will 
see the Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Links tab again, with the resulting linked 
tables displayed.

• Click the Add Table Link button again. You will see the Everest CRM Studio 
- Tables Linked Together dialog box. From the Table Name drop-down list, 
select dbo.X_INVOIC. From the Linked to Table Name drop-down list, select 
dbo.INVOICES. 

• From the Column Name drop-down list, select dbo.X_INVOIC.ORDER_NO. 
From the Linked To Column Name field, select dbo.INVOICES.DOC_NO.

• From the Link Type drop-down list, select Left Outer Join. Click OK. You will 
see the Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Links tab again, with the resulting linked 
tables displayed.

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Tables” on page 52

“Aggregate Query Tables” on page 141

To link the tables, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Links” on page 54

“The Everest CRM Studio - Tables Linked Together Dialog Box” on 
page 54
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• Click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Query Definitions - Columns tab.

Select the Query’s Columns (Fields)
Aggregate queries are different from record-level queries in that they perform one 
of five arithmetic functions (summarize, count, average, minimum, or maximum) 
on a specific database field.
As a result, aggregate queries do not require access to many of the detail fields 
that are commonly found in a record-level query. Since this query summarizes 
(totals) the sales for specific regions, first you need to select the column that 
contains the sales total for a specific order.

• After linking the selected tables in the Links tab of the Everest CRM Studio - 
Application Events\Accel Sample Company\Query Definitions dialog box, 
click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Query Definitions - Columns tab.

• From the Available Columns to Query panel, select the following columns by 
double-clicking them:
- From the dbo.ITEMS table: dbo.ITEMS.DESCRIPT, 

dbo.ITEMS.CATEGORY, dbo.ITEMS.QTY_STK, 
dbo.ITEMS.PURC_MEAS.

- From the dbo.X_INVOIC table: dbo.X_INVOIC.ITEM_CODE, 
dbo.X_INVOIC.QTY_SHIP, dbo.X_INVOIC.ITEM_CODE, 
dbo.X_INVOIC.AMOUNT.

• From the Query Columns Selected panel, click in the Column Type field for 
the dbo.X_INVOIC.QTY_SHIP row. From the drop-down list, select 
Summarize.

• Repeat the previous step for the dbo.X_INVOIC.AMOUNT row.
• Check the Unique column for the row containing 

dbo.X_INVOIC.ITEM_CODE.
• From the dbo.X_INVOIC table, select dbo.X_INVOIC.ITEM_CODE again.
• From the Query Columns Selected panel, click in the Column Type field for 

the dbo.X_INVOIC.ITEM_CODE row. From the drop-down list, select Count.
• Click Next. You will see the Everest CRM Studio - Application Events\Accel 

Sample Company\Query Definitions - Sorting tab.

“Aggregate Query Links” on page 142

To select the query’s columns (fields), do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Columns” on page 56

“Aggregate Query Columns” on page 142
70 Everest CRM Studio
User Guide



CRM Studio Product Tutorial
Sorting Order

• After selecting the query’s columns in the Columns tab of the Everest CRM 
Studio - Application Events\Accel Sample Company\Query Definitions 
dialog box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Query Definitions - Sorting tab.

• From the Available Columns for Sorting panel, double-click 
COUNT(dbo.X_INVOIC.ITEM_CODE). The column is added to the Columns 
Selected for Sorting panel.

• Ensure that the Sort Order column in the Columns Selected for Sorting panel 
displays Descending.

• Click Next. You will see the Everest CRM Studio - Application Events\Accel 
Sample Company\Query Definitions - Filters tab.

Specify the Filter
Similar to the first query, this query uses filters to restrict the records that are 
eligible to be retrieved. Unlike the first query, however, you need not hard-code 
the compare values in these filters to retrieve records with specific values.
Instead, you can design these two filters so that their compare values are filled in 
at the event level. This enables the query to be used in many different events.

• After selecting the query’s sorting order in the Sorting tab of the Everest CRM 
Studio - Application Events\Accel Sample Company\Query Definitions 
dialog box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Query Definitions - Filters tab.

• From the Available Columns to Filter panel, double-click 
dbo.INVOICES.ORDER_DATE. The column is added to the Columns 
Selected for Filtering panel.

• Ensure that the Is or Is Not column in the Columns Selected for Filtering 
panel displays Is.

• Click the Operator column, click the drop-down arrow that appears, and 
select ‘greater than or equal to’.

• Leave the Compare Value field as it is.

To select the query’s sorting order, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Sorting” on page 58

“Aggregate Query Sorting Order” on page 145

To specify the filter, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Filters” on page 60

The question mark in the Compare Value field allows the value of this filter 
to be specified at the event level.
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• Click the Type column, click the drop-down arrow that appears, and select 
Date.

• Click the And/Or column, click the drop-down arrow that appears, and select 
And.

• Scroll the Columns Selected for Filtering panel to the right. In the Optional 
Prompt column, enter ‘Enter From Date’.

• From the Available Columns to Filter panel, double-click 
dbo.INVOICES.ORDER_DATE again. The column is added to the Columns 
Selected for Filtering panel.

• Ensure that the Is or Is Not column in the Columns Selected for Filtering 
panel displays Is.

• Click the Operator column, click the drop-down arrow that appears, and 
select ‘less than or equal to’.

• Leave the Compare Value field as it is.

• Click the Type column, click the drop-down arrow that appears, and select 
Date.

• Click the And/Or column, click the drop-down arrow that appears, and select 
And.

• Scroll the Columns Selected for Filtering panel to the right. In the Optional 
Prompt column, enter ‘Enter To Date’.

•  From the Available Columns to Filter panel, double-click 
dbo.INVOICES.STATUS. The column is added to the Columns Selected for 
Filtering panel.

• Ensure that the Is or Is Not column in the Columns Selected for Filtering 
panel displays Is.

• Click the Operator column, click the drop-down arrow that appears, and 
select ‘equal to’.

• Enter 9 in the Compare Value field.
• Click the Type column, click the drop-down arrow that appears, and select 

Number.
• Click the And/Or column, click the drop-down arrow that appears, and select 

And.
• Leave the Optional Prompt field as it is.
• Click Next. You will see the Everest CRM Studio - Application Events\Accel 

Sample Company\Query Definitions - Sub Filters tab.

Specify the Sub-Filter
Only aggregate events use sub-filters. A sub-filter is what allows you to perform a 
test against the aggregate value. 

The question mark in the Compare Value field allows the value of this 
filter to be specified at the event level.

“Aggregate Query Filters” on page 145

To configure the aggregate sub-filter for this query, do the following:
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• After selecting the query’s filters in the Filters tab of the Everest CRM Studio 
- Application Events\Accel Sample Company\Query Definitions dialog 
box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Query Definitions - Sub Filters tab.

• From the Available Columns to Filter panel, double-click 
SUM(dbo.X_INVOIC.QTY_SHIP). The column is added to the Columns 
Selected for Sub-Filtering panel.

• Ensure that the Is or Is Not column in the Columns Selected for Sub-Filtering 
panel displays Is.

• Click the Operator column, click the drop-down arrow that appears, and 
select ‘greater than’.

• Leave the Compare Value field as it is.

• In the Type field, select Number.
• In the And/Or field, select And.
• Scroll the Columns Selected for Sub-Filtering panel to the right. In the 

Optional Prompt field, enter ‘Enter Item Count Exceeding X times’.
• Click the Save and Close button at the top left to save the query you created.

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Sub Filters” on page 74

The question mark in the Compare Value field allows the value of this 
filter to be specified at the event level.

“Aggregate Query Sub-Filters” on page 146
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The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Sub Filters

 Figure 2.13: Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions - Sub Filters

Available Columns to Filter
This panel displays all the columns (from the selected tables) available for sub-
filtering.
Add Column to Filter
Click this button to add a selected column to the Columns Selected for Sub-
Filtering panel.
Add All Columns to Filter
Click this button to add all available columns to the Columns Selected for Sub-
Filtering panel.
Columns Selected for Sub-Filtering
This panel displays all the columns selected.
Remove Column from Filter
Click this button to remove a selected column from the Columns Selected for 
Sub-Filtering panel.
Remove All Columns from Filtering
Click this button to remove all the columns displayed in the Columns Selected 
for Sub-Filtering panel.

Create the Aggregate Event

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

To create an aggregate event, do the following:
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• From the Event Manager Folders panel in the center, select Application 
Events > Accel Sample Company > Events.

• Click the New Event button at the top-left. You will see the Everest CRM 
Studio - Application Events\Accel Sample Company\Events - Description 
tab.

• In the Event Description field, enter ‘INVENTORY: E-mail relevant persons, 
list of items appearing more than X times in final documents, between Y and Z 
dates’. 

• In the Priority field, select 5. 
• Check the option Keep only last checked record in Monitor. 

• Be sure to check the Active check box.
• Click Next. You will see the Everest CRM Studio - Application Events\Accel 

Sample Company\Events - Queries tab.

Select the Event’s Query

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\Accel Sample Company\Events dialog 
box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Events - Queries tab.

• Click the Add Query button. You will see the Everest CRM Studio - Add 
Query dialog box. 

• Select the query INVENTORY: Top X fast moving items between Y and Z. 
Click Select. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Events - Queries tab again.

• The Event Trigger Parameters panel at the bottom prompts you to specify a 
value for the query’s filters that have a ‘?’ in their compare values. Fill in the 
answers to these questions as follows:
- Enter From Date: Click the Answer field. The Everest CRM Studio - 

Please supply a value dialog box is displayed. Select {%Last Month Start 
Date MM/DD/YYYY%} from the Available Substitution Variables drop-
down list.

- Enter To Date: Click the Answer field, and similarly select {%Last Month 
End Date MM/DD/YYYY%} from the list of Available Substitution 
Variables.

“The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Description” on page 179

This ensures that CRM Studio retains minimum event history.
To be notified only once when this event is triggered, do not check the 
Repeat notification for triggered items box.

To link the query to the event, do the following:

“The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Queries” on page 182
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• Click Next until you see the Everest CRM Studio - Application Events\Accel 
Sample Company\Events - E-mail tab.

Specify the E-Mail Message Text

• After linking the query to the event in the Queries tab of the Everest CRM 
Studio - Application Events\Accel Sample Company\Events dialog box, 
click Next until you see the Everest CRM Studio - Application Events\Accel 
Sample Company\Events - E-mail tab.

• Select the e-mail account from the E-mail Account to Send From drop-down 
list.

• In the Message Subject field, enter ‘List of fast moving items for the month of 
{%Last Month%}, {%Current Year%}’.

• In the first line of the Message Text panel, enter ‘The fast moving items, based 
on number of times they appear in final documents, are as follows:’. Leave a 
blank line in the message text. 

• In line three of your alert message, enter Item Code:
• In line four, enter Description:
• In line five, enter Number of Movements:
• In line six, enter Quantity:
• In line seven, enter Category:
• In line eight, enter Total Stock:
• In line nine, enter UOM:
• Leave two spaces after each of the entries above.
• From the Available values for use in message content field, select {Item 

Code}, so that it is added to the Message Text panel beside the Item Code: in 
your alert message.

• Repeat these steps for the other fields in the alert message.

• Leave a blank line in the message text. Click the second line of your alert 
message text (the blank line).

• From the Available values for use in message content field, scroll to the very 
end of the list, and double-click {BEGIN*REPEAT}.

To specify e-mail alert message text, do the following:

“The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Email” on page 194

In lines four to nine, select the following from the Available values for 
use in message content field: 
• {Item Description} 
• {Item Count Sold} 
• {Item Qty Sold} 
• {Category} 
• {Total Stock} 
• {UOM} 
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• Click the last line of your message text (the blank line after UOM:).
• From the Available values for use in message content field, scroll to the very 

end of the list, and double-click {END*REPEAT}.
• Click Next until you see the Everest CRM Studio - Application Events\Accel 

Sample Company\Events - Subscribers tab.

Specify the Event’s Subscribers

• After specifying e-mail alert message text in the E-mail tab of the Everest 
CRM Studio - Application Events\Accel Sample Company\Events dialog 
box, click Next until you see the Everest CRM Studio - Application 
Events\Accel Sample Company\Events - Subscribers - Standard tab.

• Click the Add Subscriber button. You will see the Everest CRM Studio - Add 
Subscriber dialog box.

• Click the plus sign beside Sales Team. Check the box beside your name. 
• Click the Add Subscriber button. You will see the Everest CRM Studio - 

Application Events\Accel Sample Company\Events - Subscribers - 
Standard tab again.

• Check the E-mail box beside your name to indicate that you wish to receive 
notifications via electronic mail. 

• Click Next. You will see the Schedule tab of the Everest CRM Studio - 
Application Events\Accel Sample Company\Events dialog box.

Specify the Event’s Schedule

• After specifying yourself as a recipient in the Subscribers tab of the Everest 
CRM Studio - Application Events\Accel Sample Company\Events dialog 
box, click Next. You will see the Everest CRM Studio - Application 
Events\Accel Sample Company\Events - Schedule tab.

• From the Choose a schedule to use drop-down list, select The 1st of the 
Month; 9:00 AM. 

• Leave the rest of the fields with their default values, if any.
•  Click the Save and Close button at the top left of the dialog box to save the 

event you created.

To specify the event’s subscribers, do the following:

“The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Subscribers - Standard” on page 226

“The Everest CRM Studio - Add Subscriber Dialog Box” on page 67

To specify the event’s schedule, do the following:
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Verify Everest CRM Studio Server Status
The Everest CRM Studio service (or server manager) must be running for CRM 
Studio to check events.

• Verify that the Everest CRM Studio service (path: Control Panel > 
Administrative Tools > Services) is running. If not, start the service.

• Log in to the Everest CRM Studio Administrator (path: CRM > CRM Studio 
> Administrator). 

• Select Activity > Server Status from the Administration Folders panel in the 
center. The Server Status panel on the right displays all of CRM Studio’s 
servers and their current status. The first four servers should be running.

Submit Your Two Events
Since your two events are scheduled to run at different times (one at 9:00 AM 
daily, and one at 9:00 AM on the first day of a month), you might wish to submit 
them to run right now, so that you can track their progress.

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Manager Folders panel in the center, select Application 
Events > Accel Sample Company > Events.

• The Application Events\Accel Sample Company\Events panel on the right 
displays all the events. Highlight the first event you created: CUSTOMERS: 
Birthday E-mails to customers.

• Click the Schedule This Now button at the top of the Studio Architect dialog 
box.

• You will be asked to confirm the submission of your selected event. Click Yes.
• The event will be scheduled for immediate execution, and may be tracked in 

the Everest CRM Studio Event Monitor.
• Repeat these steps for the second event.

Track Events in the Everest CRM Studio Event Monitor
The Everest CRM Studio Event Monitor is an excellent place from which to track 
the status of your events.

• From the main menu bar, select CRM > CRM Studio > Monitor. You will see 
the Everest CRM Studio Event Monitor dialog box.

• Double-click the Scheduler folder and click the Next Run Date/Times branch. 
You will see the events that are due to be submitted in the right panel. 

To verify the server status, do the following:

To submit the two events to run right now, do the following:

To track the progress of the events, do the following:
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• Once an event’s submission time arrives, you can track it from the 
Application Events folder. 

An event progresses from a pending state to a checked state, and then (if the 
event’s conditions are met), to a triggered state. If there is an error in an event’s 
configuration, the event appears in the Errors Today branch, and also remains in 
the Pending branch.
Depending on the number of records that trigger an event, you will see one or 
more triggered event records. To view the text of alert messages associated with 
the event, point your cursor at the columns that contain the e-mail, fax, pager, or 
webcast text.

• From the right panel of the Everest CRM Studio Event Monitor dialog box, 
position the cursor in the Message Text column of the message being 
monitored.

• CRM Studio automatically expands the contents of these fields to display the 
full contents of the outgoing alert message.

Everest CRM Studio Event Monitor - Contents of Outgoing Alert Message

• From the right panel of the Everest CRM Studio Event Monitor dialog box, 
highlight (click) a specific triggered record.

To view the text of alert messages associated with the event, do the 
following:

To see details about the delivery of alert messages for an event, do the 
following:
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• Click the Deliverables button at the bottom of the dialog box. 
The Deliverables button shows you who was notified about the event, and how 
and when they were notified.

 Figure 2.14: Everest CRM Studio Event Monitor - Deliverables

Remove History
After you have triggered some events, you might wish to clear the Everest CRM 
Studio Event Monitor of its history and start again. 

• Stop the Everest CRM Studio service (path: Control Panel > Administrative 
Tools > Services). Ensure that no users are logged in to CRM Studio.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• Select File > Database Tools > Remove Completed Items. You will see the 
Everest CRM Studio - Remove Completed Items from Database dialog box.

• In the Remove items dated before date: field, specify the date before which all 
items are to be deleted from the database.

• Click the Remove button. The items are deleted from the database.
• Click Close.
• Restart the Everest CRM Studio service. 

To clear Everest CRM Studio Event Monitor history, do the following:

You should always select the option Compact Database after you have 
removed completed items.
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You’re On Your Way!
Congratulations on completing the CRM Studio tutorial. There are lots of other 
functions that you can try in CRM Studio, including report distribution (via 
Crystal Reports), processing incoming e-mail messages, and cross-company alerts 
(events that are based on conditions that exist in multiple company databases).
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The Everest CRM Studio Administrator 
Activity 
Corrective Actions 
Hardware Setup 
Software Setup 
User Access - Logins 
Database Tools 





CRM Studio Administration
The Everest CRM Studio Administrator allows you to perform seven functions:
• View the status of application servers.
• View the names of all users logged in to CRM Studio modules.
• View (and take corrective actions for) any errors encountered when the CRM 

Studio attempted to either execute an event, or send notifications about an 
event.

• Configure hardware settings for printing.
• Configure software settings for e-mail, and holiday definitions.
• Specify user authorizations for access to different CRM Studio modules.
• Maintain and optimize the CRM Studio database.

The Everest CRM Studio Administrator
When you log in to the Everest CRM Studio Administrator (path: CRM > CRM 
Studio > Administrator), you will see the Administration Folders panel in the 
center, containing a branch titled Activity.

Everest CRM Studio Administrator - Navigation

• From the Administration Folders panel in the center, double-click the folder 
you wish to work in.

OR
• From the Outlook Bar on the left, click the folder you wish to work with. 
• To select a specific option, select the folder first, and then click the option you 

wish to work with. 

• Click the New button that appears on the top-left, under the Everest CRM 
Studio Administrator menu bar. 

• From the right panel, double-click the record you wish to view or modify.

• Select the record in the right panel. 

To select a folder, do the following:

Once you select a specific option, the right panel displays the records 
associated with that option.

To add a new record under a specific option, do the following: 

• The New button is displayed as New [xxx] where xxx refers to the type 
of record you can add.

• You can also select File > New from the menu bar, and select the type of 
record you wish to add.

To view or update an existing record, do the following:

To delete a record, do the following:
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• Click the Delete button displayed under the Everest CRM Studio 
Administrator menu bar.

Activity
The Everest CRM Studio Administrator - Activity folder tells you about the 
current processing and user activity occurring within CRM Studio. 

Server Status
This option displays the current status of all the servers used by CRM Studio. The 
possible server statuses are:
• Shutdown: The server is not running at this time. 

• Idle: The server is running, and is in memory, but is not processing any data. 
The server is in this state if there is no data to process.

• Processing: The server has been initialized and is processing.
• Startup: The server is in initialization and startup mode.

 Figure 3.1: Everest CRM Studio Administrator - Server Status

You can also delete a record after opening it for viewing or modification.

Among the possible reasons for this are:
The Everest CRM Studio service (path: Control Panel > Administrative 
Tools > Services) is not running. 
The server is disabled. This is done by double-clicking the specific server 
and clearing the Allow Server to Process option in the Server Status dialog 
box that is displayed. 
You can also specify which servers are allowed to run. If you do not require 
the delivery of notifications by a certain mode, you can disable the 
corresponding server to conserve system resources. 
By default, CRM Studio is shipped with all servers enabled except the 
Paging, Faxing, Reporting, Copying, Webcasting and Action servers.
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Everest CRM Studio - Server Descriptions
CRM Studio uses the following server manager and servers:
• Everest CRM Studio: Initiates all the other servers. 

• Scheduler: Keeps track of when events are scheduled to be executed. When an 
event is due for execution, this server sends the corresponding task to the 
relevant event server.

• Application Event: Executes application events.
• Report: Generates Crystal reports.
• E-mail: Delivers e-mail messages.
• Fax: Delivers fax messages.
• Page: Delivers pager messages.

• Webcast: Delivers webcast messages.
• Copy: Copies and sends files and reports, using FTP (File Transfer Protocol).
• Action: Executes event response actions.

Enabling/Disabling a Server

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Activity folder and click Server Status.

• From the right panel, double-click the server you wish to enable/disable. You 
will see the Everest CRM Studio - Server Status dialog box.

• To enable the server, check the option Allow Server to Process. To disable the 
server, clear this check box. 

• Click Save and Close.

If running under Windows 95 or 98, this is a server manager. If running 
under Windows NT or 2000, this is a service under Control Panel > 
Administrative Tools > Services.

If any of the first three servers are shut down or paused, CRM Studio 
cannot check for events and/or send notifications about triggered events.
If any of the notification servers (e-mail or copy) are shut down or paused, 
CRM Studio cannot send notifications via that particular delivery mode.
For each server, you can view its status, the error message (if any) that 
prevents the server from running, the name of the computer and user 
account from which the server is running, the server computer’s operating 
system and version, and the date and time the server was last started.

To enable or disable a server, do the following:
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Starting/Stopping a Server

• To start a server that is shut down, you must first enable the server.

• If the Everest CRM Studio service (path: Control Panel > Administrative 
Tools > Services) is running, pause (or stop) the service and subsequently 
restart it. This will start the server that was previously shut down. If the 
Everest CRM Studio service is not running, start the service.

• To stop a server that is currently running, clear the check box Allow Server to 
Process, in the relevant Server Status dialog box. The server displays the 
status ‘Paused’.

• To start a server that is paused, check the option Allow Server to Process, in 
the relevant Server Status dialog box.

• To stop all CRM Studio servers, stop the Everest CRM Studio service.

CRM Studio Servers - Login Information
By default, all CRM Studio servers log into the database without using a 
password. If you want to use Microsoft Access security to secure the database 
from unauthorized access, you must specify the user name and password when 
accessing the database. 

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Activity folder and click Server Status.

• Click the Server Login Information button under the Everest CRM Studio 
Administrator menu bar. You will see the Everest CRM Studio 
Administrator - Server Login Information dialog box.

• Enter the user name and password for the CRM Studio servers.
• Click OK. 

To start or stop a server, do the following:

“Enabling/Disabling a Server” on page 87

To specify the user name and password that enables a server to connect 
to the database (if utilizing Microsoft Access security), do the following: 

We recommend that you change this setting only if you are using Microsoft 
Access security, or want the servers to use a name other than Admin.
The server will not start properly if you are using Microsoft Access security 
and do not specify a user name and password in the Server Login 
Information dialog box.
You must perform the Everest CRM Studio server login administration on 
the computer where the servers are installed. When saved, this information 
is recorded in the local system’s registry.
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Current User Logins
The Current User Logins option tells you who is currently logged in to CRM 
Studio. When an individual user is selected, you can view the following 
information:
• The CRM Studio module the user is logged in to. This displays the 

Administrator, Event Monitor, or Studio Architect.
• The user’s computer and user names.
• The user’s operating system and platform.
• The date and time that the user last logged in to the company.
• The date and time of the user’s last activity.

Corrective Actions
When CRM Studio executes a specific function (such as checking for an event, 
sending an alert message, executing a response action), an error in configuration 
or a system-related error may prevent the function from executing successfully.
If such an error in execution does occur, CRM Studio not only tracks the type of 
error, it also allows you to take corrective action to rectify it. The type of corrective 
action will depend on the type of error that occurred.
CRM Studio lets you take corrective actions in response to the following error 
conditions:
• Application event errors (Errors when checking for triggered events)
• E-Mail delivery errors
• Fax delivery errors
• File copy (ftp) delivery errors
• Pager delivery errors
• Webcast delivery errors
• Report generation errors
• Action errors
When an error occurs, CRM Studio automatically places the error-causing record 
in a pending state (in the Everest CRM Studio Event Monitor). The error is also 
listed in the Everest CRM Studio Administrator, in the corresponding Errors 
sub-branch under Corrective Actions.
For every error record that appears in the corrective action branch, you can view:
• Error: The internal application database error number
• Error Message: The error message text
• Application: The name of the company to which the error-causing record 

belongs
• Description: The description of the record that caused the error

CRM Studio attempts to re-submit the error-causing record every minute until 
the record is either successfully processed, or is manually deleted or marked as 
completed by an authorized user.

You will also see additional data specific to the record that caused the error, 
such as an error-causing mail message recipient’s address, subject and 
message text.
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Application Event Errors
Application event errors are the most common type of error. These are usually 
caused by an application event that has a configuration error, such as an invalid 
query, but can also be caused by system problems, such as CRM Studio’s 
inability to access a database on a server.
Application event errors that are due to a configuration error within CRM Studio 
may be addressed simply by correcting the associated error (such as re-
configuring the related query). Once this condition is addressed, the error-causing 
event executes successfully the next time CRM Studio attempts to re-submit the 
error-causing record.

Message Delivery Errors
Delivery errors (such as e-mail, copy, fax, pager and webcast errors) often result 
from one of the three causes:
• CRM Studio is not configured properly to send out the corresponding alert.

• There is a system problem (such as your e-mail server being shut down) that 
prevents CRM Studio from sending a message.

• The recipient’s address contains invalid information (such as an invalid pager 
PIN number).

Like application event errors, CRM Studio attempts to re-send the error-causing 
delivery record every minute until the record is either successfully delivered, or is 
manually deleted or marked as completed by an authorized user. 
Unlike application event errors, the Corrective Actions option allows you to 
update (correct) the delivery address information for a delivery error that 
occurred. 

Report Generation Errors
Report generation errors are similar to application event errors because they are 
most often caused by an invalid report design, or by a system problem (such as a 
database server being unavailable).
If you correct the problem (such as correcting the report design), CRM Studio 
will successfully execute the report the next time it is submitted.
Note that if you have an event that generates a report, it is possible to have many 
notifications (e-mail messages) that are dependent on the successful generation of 
that report. If the report generation is unsuccessful, the resulting notification 
records do not appear in either a pending or error state since the report itself is 
never completed.

Example The e-mail sending account is incorrectly configured.

Example If a pager alert has an invalid PIN, or if an e-mail address has an 
invalid character within it, CRM Studio allows you to use the 
corresponding corrective actions option to modify the recipient’s 
delivery address, thus enabling you to successfully deliver the 
message.
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Action Errors
Action errors are due to problems that CRM Studio encountered when trying to 
submit a response action such as executing Visual Basic scripts, executing SQL 
statements, running a program, or writing event data out to an external file. 

Like all other types of errors, action errors are re-submitted every minute until 
they are either successfully completed, or are manually deleted or completed by 
an authorized user. Like application events, you can correct the associated error 
(such as modifying the related VB script) and once this condition is addressed, the 
error-causing action executes successfully the next time CRM Studio attempts to 
re-submit the error-causing record. 

Taking a Corrective Action

• From the Everest CRM Studio Administrator dialog box, double-click the 
Corrective Action folder, from the Administration Folders panel in the 
center.

• Click the corresponding corrective action option, and verify if there are any 
errors displayed in the right panel.

• If an error record does exist, double-click the record. You will see the Everest 
CRM Studio - Delivery Errors dialog box.

• Choose one of the options detailed below to rectify the error.

The Everest CRM Studio - Delivery Errors Dialog Box

 Figure 3.2: Everest CRM Studio - Delivery Errors
Three possible corrective actions are available:

Example An incorrect program file name or directory name.

To execute a corrective action, do the following:
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Complete the Record Manually 
Although the record is in error, you can flag the record as complete, and it will be 
retained in CRM Studio’s history as successfully completed. 

• From the Everest CRM Studio Administrator dialog box, double-click the 
Corrective Action folder from the Administration Folders panel in the center.

• Click the corresponding corrective action option. The erroneous record is 
displayed in the right panel.

• Double-click the record. You will see the Everest CRM Studio - Delivery 
Errors dialog box.

• Select the Completed option. Click Save and Close.
Delete the Record 

You can remove the record from the CRM Studio database.

• From the Everest CRM Studio Administrator dialog box, double-click the 
Corrective Action folder from the Administration Folders panel in the center.

• Click the corresponding corrective action option. The erroneous record is 
displayed in the right panel.

• Double-click the record. You will see the Everest CRM Studio - Delivery 
Errors dialog box.

• Click the Delete button at the top of the dialog box. You will be prompted for 
confirmation. Click Yes to delete the record. 

Correct the Record
Not all records may be corrected; this depends on the type of error that occurred. 

E-mail messages that are sent to undeliverable addresses are not recorded within 
CRM Studio as errors. 

Hardware Setup
You must configure two hardware components for use with CRM Studio:
• Defining Fax Ports
• Defining Pager Ports
If you use CRM Studio for sending messages via fax or pager, you must set up 
these options; otherwise, you may skip them.

To manually mark a record as completed, do the following:

To delete an error-causing record, do the following: 

Example Invalid pager PIN numbers can be corrected.

You may wish to use CRM Studio’s E-mail Response System to monitor 
undeliverable messages.
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Fax Serial Ports
To send messages via fax, CRM Studio requires the use of a modem that is 
reachable from the server on which it is installed. This modem may be shared by 
other applications and devices.

• From the main menu, select CRM > CRM Studio > Administrator. You will 
see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Hardware Setup folder and click Fax Serial Ports.

• Click the New Fax Communication Port button at the top-left corner of the 
dialog box. You will see the Everest CRM Studio - Fax Serial Ports dialog 
box.

The Everest CRM Studio - Fax Serial Ports Dialog Box

 Figure 3.3: Everest CRM Studio - Fax Serial Ports
Internal ID Number
This field displays the ID of the fax serial port. You cannot modify it.
COM Port Number
Select the port to use for sending faxes.
COM Port Description
Enter a description of this port.
Use Port for Faxing
Specify whether this port is currently available for faxing. You can configure a 
COM port for availability without enabling it for immediate use.
Pulse Dialing
Check this box if you use pulse dialing.

To configure CRM Studio for faxing, do the following:
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Dial Out Prefix
Enter the prefix, if any, that you use to reach an outside line (e.g., ‘9‘).
Modem Initialization String
Enter the command that you use to initialize this modem (e.g., ‘at‘).
Modem Dial String
Enter the command that you use to precede your dial-out number (e.g., ‘atdt‘).

Pager Serial Ports
To send messages via pager, CRM Studio requires the use of a modem that is 
reachable from the server on which it is installed. This modem may be shared by 
other applications and devices.

• From the main menu, select CRM > CRM Studio > Administrator. You will 
see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Hardware Setup folder and click Pager Serial Ports.

• Click the New Page Communication Port button from the top-left corner of 
the dialog box. You will see the Everest CRM Studio - Pager Serial Ports 
dialog box.

The Everest CRM Studio - Pager Serial Ports Dialog Box

 Figure 3.4: Everest CRM Studio - Pager Serial Ports
COM Port Number
Select the port to use for sending pages.

If you configure multiple fax communications ports, CRM Studio 
automatically scans the list of ports for the first available modem, when a 
fax message needs to be sent.

To configure CRM Studio for paging, do the following:
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COM Port Description
Enter a description of this port.
Use Port for Paging
Specify whether this port is currently available for paging. You can configure a 
COM port for availability without enabling it for immediate use.
Pulse Dialing
Check this box if you use pulse dialing.
Dial Out Prefix
Enter a prefix, if any, that you use to reach an outside line (e.g., ‘9‘).
Modem Initialization String
Enter the command that you use to initialize this modem (e.g., ‘at‘).
Modem Dial String
Enter the command that you use to precede your dial-out number (e.g., ‘atdt‘).
Paging Diagnostic File
This file is used to store diagnostic data from pages that are sent and can be used 
to track down the problems of any pages that are unsuccessfully executed. Leave 
this field blank unless otherwise instructed by Everest Software.

Software Setup
There are seven components in the configuration of CRM Studio before you can 
begin defining events:
• E-mail Sending Account Definition
• E-mail Response System Configuration*
• Fax Sending Account Definition
• Fax Cover Page Design
• Holiday Calendar Definition
• Paging Services Definition
• Webcast Location Definition**
* The configuration of the E-mail Response System (ERS) is located within the 
option for E-mail Account set up. As the E-mail Response System is a separate 
CRM Studio module, its configuration and use are detailed in the chapter titled 
E-mail Response System.
** Note that the configuration of the CRM Studio Webcasting module is detailed 
in the chapter on the set up and use of the webcast module; thus it is not covered 
in this chapter.

E-mail Accounts
Since CRM Studio sends out alert messages via e-mail, one of the most important 
configuration steps is to define the e-mail account that will be used for this 
purpose.

If you configure multiple pager communication ports, CRM Studio 
automatically scans the list of ports for the first available modem, when a 
pager message needs to be sent.

“Set Up E-mail Account to send E-mails” on page 28
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Using Dial-up Networking to Send E-mail
If your organization does not maintain a permanent connection to the Internet, 
you may use CRM Studio’s Dial-up Networking option to automatically dial a 
modem and connect to the Internet, when an event e-mail needs to be sent. 

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Software Setup folder and click E-mail Accounts.

• The right panel displays the e-mail accounts that you have set up. To modify 
an existing account to use Dial-up Networking, double-click that account. To 
set up a new account, click the New E-mail Account button at the top-left of 
the Everest CRM Studio Administrator dialog box. 

• You will see the Everest CRM Studio - E-mail Accounts dialog box. If you are 
setting up a new account, you must first specify the relevant details in the 
General tab of the E-mail Accounts dialog box.

• After specifying these details, click the Dial-up Networking tab.
• Specify relevant details in the fields in this tab and ensure that the Use Dial-

up Networking for E-mail option is checked.
• Click Save and Close.

The Everest CRM Studio - E-mail Accounts Dialog Box - Dial-up 
Networking 

 Figure 3.5: Everest CRM Studio - Email Accounts - Dial-up Networking
Dial-up Networking Profile Name to Use
Enter the name of the Dial-up Networking connection profile for CRM Studio to 
use when connecting to the Internet.
Username and Password
Enter the login user name and password for this account.

To configure CRM Studio to use Dial-up Networking for sending e-
mail, do the following:

“The Everest CRM Studio - E-mail Accounts Dialog Box - General” on 
page 29

CRM Studio uses dial-up networking only if it detects that an Internet 
connection is not currently present.
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After specifying these details, you must test the e-mail sending account.

Using Multiple E-mail Sending Accounts
You may wish to configure multiple e-mail sending accounts. The primary 
reasons for this are:
• To distribute the workload of sending many e-mail messages. Instead of 

sending all e-mail messages out via a single account, you can distribute this 
workload by configuring different events to use different e-mail sending 
accounts.

• To have different sending address names associated with different outgoing 
messages. Depending on the type of event that is triggering an event and the 
type of alert recipient, you may want some e-mail messages to come from an 
account called Employee Alerts, and other messages to come from an account 
called Customer Alerts.

• To send different replies to addresses associated with an e-mail message 
(some events should be replied to at alerts@yourcompany.com, whereas other 
events should be replied to at offers@yourcompany.com). 

Fax Accounts
In addition to e-mail, paging, and webcasting, CRM Studio can send out 
messages via facsimile (fax). 

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Software Setup folder and click Fax Accounts.

• Click the New Fax Account button at the top-left of the window. 
(To modify the details of an existing fax account, simply double-click the account 
in the right panel.)
• You will see the Everest CRM Studio - Fax Accounts dialog box.

“Test the E-Mail Sending Account” on page 32

To configure CRM Studio to send faxes, do the following:
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The Everest CRM Studio - Fax Accounts Dialog Box - General

 Figure 3.6: Everest CRM Studio - Fax Accounts
Internal ID Number
This field displays the ID of the fax account. You cannot modify it.
Fax Account Name
Enter a description of the account to be used for sending fax notifications.
Cover Page File Name
Enter the name of the cover page to be used with this fax. (Fax cover pages are 
defined separately under the “Fax Cover Pages” option.)
Active
Specify whether this account is currently available for sending faxes.
Fax Machine Identification
Enter the name of the fax machine from which the notifications are sent
Banner
Enter the heading that appears (typically with the date and time) on all pages that 
are faxed.
Sending Company Name
Enter your company’s name.
Sending Department/User
Enter the name of your department name or a user.
Sending Fax Number
Enter the number from which the fax is sent.
Voice Number
Enter the voice telephone number associated with the fax.
Notes about this account
Enter additional information about the fax account.
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Using Multiple Fax Sending Accounts
You may wish to configure multiple fax sending accounts. The primary reasons 
for this are:
• To have different fax machine identification names associated with different 

outgoing messages. Depending on the type of event that is triggering an event 
and the type of alert recipient, you may want some fax messages to come from 
an account called “Sales Fax,” and others from an account called “Support 
Fax.”

• To have different company, department, or voice numbers associated with a 
fax message.

Fax Cover Pages
Although CRM Studio has an option to create and design fax cover pages, this 
option is currently hard-coded with two types of cover page designs: one that 
uses a small font, and the other that uses a large font on the cover page.
In the current version of CRM Studio, you can neither edit these cover pages nor 
create additional cover pages of your own. The current extent of this option is 
your ability to “activate” or “deactivate” either of the two pre-configured cover 
pages for use with specific fax accounts.
Use the “Active” check box to activate or de-activate a fax cover page design.

Holiday Schedule
When CRM Studio events are configured, you have the option to specify whether 
or not the event will be submitted if its scheduled execution date falls on a 
holiday.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Software Setup folder and click Holiday Schedule.

• The right panel displays the holidays defined so far. To modify an existing 
holiday, double-click that record. To define a new holiday, click the New 
Holiday button at the top-left of the Everest CRM Studio Administrator 
dialog box. 

• You will see the Everest CRM Studio - Holiday Schedule dialog box.
• After specifying the details, click Save and Close.

To define a holiday, do the following:
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The Everest CRM Studio - Holiday Schedule Dialog Box - General

 Figure 3.7: Everest CRM Studio - Holiday Schedule
Internal ID number
This field displays the ID of the holiday. You cannot modify it.
Holiday Description
Enter a description for the holiday.

Holiday Date
Specify the date on which the holiday falls, in the format MM/DD/YYYY.
Same Day Every Year
Check this option to specify that the holiday falls on the same numeric date of 
every year.
Active
Check this option to indicate whether this holiday is currently available for 
observance by defined events.

Paging Services
If you use CRM Studio to send alerts via pager, you must identify the paging 
services that CRM Studio will need to communicate with, and, if needed, the site-
specific connection data that each service requires.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Software Setup folder and click Paging Services.

• The right panel displays the paging services set up so far. To modify an 
existing paging service, double-click that record. To add a paging service, 
click the New Paging Service button at the top-left of the Everest CRM 
Studio Administrator dialog box. 

Example New Year’s Day

Each event may be configured to either run or not run on a holiday.

To configure paging services, do the following:
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• You will see the Everest CRM Studio - Paging Services dialog box.

The Everest CRM Studio - Paging Services Dialog Box - General

 Figure 3.8: Everest CRM Studio - Paging Services Dialog Box
Internal ID Number
This field displays the ID of the paging service. You cannot modify it.
Paging Vendor
Enter the name of the paging vendor (e.g., Skytel).
Service Description
Enter a description of the paging service (e.g., Skytel Pager Service).
Paging Station TAP Phone Number
Enter the number required to access this paging service
Password
Enter the password, if any, required to access this paging service.
Baud Rate, Parity, Data Bits, Stop Bit and Characters Per Block
Contact your paging service for details on these fields.
Customer Support Number
Enter the support number of your paging service vendor. This number is for 
information purposes only.
Active
Check this box to indicate that this paging service is currently available for use in 
pager notifications.
Notes
Enter any additional information about this paging service.
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Webcast Locations
Refer to the chapter ‘Webcasting’ for complete details on the configuration and 
use of the webcasting module.

User Access - Logins
The last branch in the list of Administrative functions is titled User Access and 
contains a sub-branch called Logins. This is where you control the access 
privileges of the users who access CRM Studio.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the User 
Access folder and click Logins.

• The right panel displays the users set up so far. To modify an existing user’s 
access, double-click that record. To add a new user, click the New User Name 
button at the top-left of the Everest CRM Studio Administrator dialog box. 

• You will see the Everest CRM Studio - Logins dialog box.
• If you are adding a new user, specify relevant details in the General tab of the 

Logins dialog box.
• Select the access rights allowed to this user by checking the required options in 

the User Access tab. If you are modifying an existing user’s access rights, you 
can do so from this tab. 

• Click Save and Close.

The Everest CRM Studio - Logins Dialog Box - General

 Figure 3.9: Everest CRM Studio - Logins - General
Internal ID number
This field displays the ID of the user. You cannot modify it.
Login Name
Enter the name that the user will log in to CRM Studio with. 
Description
Enter the user’s full name. 

To configure user access, do the following:
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Active
Check this box to specify that this user is granted immediate access to the 
modules selected in the User Access tab. 
Set/Change Password...
Click this button to enable password protection for this user. Passwords may be 
up to 14 characters in length and are case sensitive. 

Set/Change User Password
You can specify or change the password for an existing user to guard against 
unauthorized access.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the User 
Access folder and click Logins. 

• The right panel displays the users that have been set up so far. To specify or 
modify an existing user’s password, double-click that record. 

• You will see the General tab of the Everest CRM Studio - Logins dialog box.
• Click the Set/Change Password... button. You will see the Set/Change 

Password dialog box.
• Specify the old password (if one has been defined previously) and the new 

password. 
• Click OK.

The Set/Change Password Dialog Box

 Figure 3.10: Set/Change Password Dialog Box
User Name
This field displays the user name for which the password is being specified/
modified. You cannot edit this field.

You cannot specify a password for the user name ‘Admin’.

To set or change a user’s password, do the following:
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Old Password
Specify the old password for the user name (if it was specified previously)
New Password
Specify a new password for the user name.
Verify Password
Enter the new password again.

The Everest CRM Studio - Logins Dialog Box - User Access
The User Access tab allows you to specify the modules and functions a specific 
user has access to. These options are divided by module into: 
• Administrator
• Event Monitor
• Event Manager

 Figure 3.11: Everest CRM Studio - Logins - User Access

Database Tools
The final administrative functions in CRM Studio can be accessed from the 
Everest CRM Studio Administrator dialog box > File > Database Tools menu. 
The options are:
• Remove Completed Items

• If you give a user access to the User Access option under the 
Administrator section, that user can modify the authorization settings 
for himself/herself and for any other users.

• It is strongly suggested that you limit the number of users who have 
access to the Event Manager, as this is where events are configured.

• Exercise extreme caution in allowing access to the Submit SQL and Run 
Program options as these functions allow CRM Studio to add, update, 
or delete data from other company databases.
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• Remove Pending Items
• Compact Database

Remove Completed Items
Depending on how many events you have configured CRM Studio to check, how 
often you are checking them, and how many alerts you are sending out, the 
amount of history that CRM Studio retains can grow to a large degree.
This option allows you to remove (delete) the history of completed items (events 
are checked, alerts that are sent, reports that are generated) from the CRM Studio 
database.
This removal process may be done on either an ad hoc manual basis, or you may 
schedule it to occur automatically within the CRM Studio database.

• Stop the Everest CRM Studio service (path: Control Panel > Administrative 
Tools > Services). Ensure that no users are logged in to CRM Studio.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• Select File > Database Tools > Remove Completed Items. You will see the 
Everest CRM Studio - Remove Completed Items from Database dialog box.

• In the Remove items dated before date: field, specify the date prior to which 
all items are to be deleted from the database.

• Click the Remove button. The items are deleted from the database.
• Click Close.
• Restart the Everest CRM Studio service. 

Automating the Removal of Completed Items

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• Select File > Database Tools > Remove Completed Items. You will see the 
Everest CRM Studio - Remove Completed Items from Database dialog box.

• Click the Automate This Task... button. You will see the Everest CRM Studio 
- Automatically remove completed items dialog box.

• Specify a schedule for this task and click OK.

To manually remove completed items from the database, do the 
following:

You should always select the option Compact Database after you have 
removed completed items.

 “Compact Database” on page 107

To automate the removal of completed items, do the following:
Everest CRM Studio 105
User Guide



Administration CRM Studio
The Everest CRM Studio - Automatically remove completed items 
Dialog Box

 Figure 3.12: Everest CRM Studio - Automatically remove completed items
Scheduled Time
Specify the time at which this procedure should run. 

Keep Records For
Specify how many days worth of history CRM Studio should retain in its 
database.
Schedule this Task
Ensure that this box is checked to enable automation of the task.

Remove Pending Items
This option allows you to remove (delete) selected items (such as pending e-mail 
messages, reports, actions) from the CRM Studio database.
This option is particularly useful if you have a large number of items that are 
pending because of an error, and you simply wish to delete the error-causing 
records.
However, you must use this option carefully, as once you remove a pending item, 
it cannot be executed by CRM Studio and there is no undo function for this 
option.

• Stop the Everest CRM Studio service (path: Control Panel > Administrative 
Tools > Services). Ensure that no users are logged in to CRM Studio.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• Select File > Database Tools > Remove Pending Items. You will see the 
Everest CRM Studio - Remove Pending Items from Database dialog box.

• Select the types of items you wish to remove and click the Remove button.
• You will be prompted for confirmation. Click Yes. The items are deleted from 

the database. 
• Click OK.

CRM Studio will run this process daily.

To remove pending items from the database, do the following:
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• Restart the Everest CRM Studio service. 

The Everest CRM Studio - Remove Pending Items from Database 
Dialog Box

 Figure 3.13: Everest CRM Studio - Remove Pending Items from Database
You can remove the following pending items:
• Actions
• Application events
• E-Mail, fax, pager, and webcast messages
• Report generation requests
• File delivery requests

Compact Database
Compacting the CRM Studio database is always advised after you delete records 
from the database as the compact function removes any unnecessary space from 
the CRM Studio database.

• Stop the Everest CRM Studio service (path: Control Panel > Administrative 
Tools > Services). Ensure that no users are logged in to CRM Studio.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• Select File > Database Tools > Compact Database. You will see the Everest 
CRM Studio - Compact Database dialog box.

• Click the Compact button. Click OK.

You should always select the option Compact Database after you remove 
completed items.

To compact your database, do the following:
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The Everest CRM Studio - Compact Database Dialog Box

 Figure 3.14: Everest CRM Studio - Compact Database
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Queries
A CRM Studio query is an object that retrieves specific information from an 
Everest company’s database. In CRM Studio, an event uses one or more queries 
to identify a condition that specific people need to know about. If the conditions 
of a query (or queries) that an event uses are met, the event is triggered and the 
resulting alerts and actions are executed.
The majority of events require only a single query, but some events require 
multiple queries; specifically, those events whose triggering is based on a 
combination of conditions that exist across multiple company databases. (Each 
query is associated with a single database.)
There are two types of queries. The first type is a record level query, and it checks 
for one or more records that meet certain conditions. 

The second type of query is an aggregate query, and it checks to see if a group of 
records collectively meet a certain condition. 

Designing a Query for Many Events
Consider an organization that wishes to receive the following alerts:
• Clients who have pending sales of more than $25,000
• Clients who have pending sales of more than $50,000
• Clients who have pending sales of more than $100,000
Each of these three events could be designed to use its own query, with each 
query checking for the corresponding dollar threshold. Or, all the three events 
could use the same query - one in which the dollar threshold is designed as a 
parameter, which is specified at the event level. The use of query parameters is 
very important, as it allows a single query to be re-used in multiple events.

Query Designing - Preparation
Although CRM Studio requires you to define queries before you design events, 
you will find the query design process easier if you begin by identifying the 
events that you wish to be notified about.
Unless you know the events that you wish to be alerted about, it can be somewhat 
challenging to define the queries that need to be designed in support of those 

Example • Open service calls with ‘critical’ as priority.
• Activities that are overdue for completion.
• Opportunities for more than $25,000 due to close within the next 

30 days.

Example • More than 10 open service calls with ‘critical’ as priority.
• Fewer than 5 scheduled activities per sales representative next 

week.
• Sales representatives with more than $500,000 in their pipeline.

Keep in mind that a query may require a parameter value only at the time 
of creating an event. CRM Studio does not prompt for the parameter value 
when the event is executed.
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events. To create queries corresponding to each condition (or scenario) that you 
wish CRM Studio to check for, you should take the following steps:

Record-Level Query Designing: Preparation
The steps preceding the creation of a record-level query are:
1. Identify Purpose: The first step is to identify the overall purpose of an event. 

When you identify an event, you should be sure to include the condition that 
you wish CRM Studio to check for (the receipt of a critical service call) as well 
as the person(s) who will receive an ensuing alert.

2. Consider Alert Message Content: The next step to consider is what you 
would like an alert message to look like. The best way to do this is to sketch 
out what you would like the actual alert message to say.

These steps are slightly different for record-level queries and aggregate 
queries.

Example Send an alert to an account manager when a ‘critical’ service call is 
logged for one of the customers.

Example In the case of the event we’ve been working with thus far, you 
might wish to have a corresponding alert message that looks like 
the following:
Hello, Don Farber:
The following critical support call was just logged for Acme 
Incorporated:
Contact: Tom Jones
Call Received: 09/14/2001 1:35 PM
Type of Problem: Fatal error message
Status: Open
Assigned to: Lisa MacKinnon
Description: Whenever the client tries to log in to the application, a 
fatal error message appears that says that an error has been 
encountered in module <module name>.
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3. Identify Alert Message Data Fields: If you look at the preceding alert 
message, you immediately notice that some of the fields in the message need 
to be filled in from one or more fields from the underlying database. 

4. Identify Database Tables: By virtue of looking at the data fields in the 
previous message, you will have a very good idea of the database tables that 
the query will need to retrieve information from. 

5. Identify the Condition: The next preparatory step is to identify the condition 
of the records (in this case, the call tickets) for them to cause the sending of 
alert messages.      

6. Identify Who’s to be Notified: The final step is to identify who will be 
notified about the event. In some cases, an event’s alert recipients (called 
subscribers in CRM Studio) are hard-coded; you might always want to send 
an alert to the CEO, CFO, or sales or support manager.
In other cases, however, you might want CRM Studio to send an alert to a 
person who is associated with a record that is causing an event to trigger.

Example The third preparatory step is to identify all the data fields that you 
wish to put into the message text:
Hello, [salesrep_name]:
The following critical support call was just logged for 
[customer_company]:
Contact: [customer_name]
Call Received: [ticket_log_date] [ticket_log_time]
Type of Problem: [ticket_type]
Status: [ticket_status]
Assigned to: [ticket_rep_name]
Description: [ticket_description]

Example This query will have to retrieve information from three database 
tables: the ticket table (for call details), the customer table (for the 
customer and contact name), and the sales representative table (for 
the name of the account manager).

Example If we look back upon the description of the event (Send an alert to 
an account manager when a ‘critical’ service call is logged for one 
of the customers) we can easily identify two key conditions:
• The call must have a priority of ‘critical’
• The call must have been received today

Example Send an alert to an account manager when a ‘critical’ service call is 
logged for one of the customers.
In this scenario, the recipient of the alert (the account manager) 
depends on the client for whom the critical call was logged. Everest 
CRM Studio has the ability to send an alert to a person associated 
with a triggered record.
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If we look back on the alert message (the version where we have identified the 
data fields), we can see that the person who should actually receive the alert 
message is [salesrep_name]. However, [salesrep_name] is not an e-mail address; 
it is simply someone’s name. If we look further into the sales representative table, 
we can find a field like [salesrep_mail_address] – this field contains the address 
we wish to send the alert to.
If you are designing a query for an event that will send an alert to an address 
derived from a triggered record, the query must include the recipient’s delivery 
address (mail address, pager number, etc).

Aggregate Query Designing - Preparation
Aggregate events are ones that are triggered by a group of records meeting 
certain conditions. CRM Studio supports five aggregate functions (the first three 
of which are most frequently used):
• Count (as in more than ‘x’ activities or fewer than ‘y’ leads)
• Summarize (as in more than ‘x’ dollars or less than ‘y’ minutes)
• Average (as in an average sale amount that drops below ‘x’)
• Minimum (as in the minimum days to delivery)
• Maximum (as in the maximum freight charge this week)
Follow the steps below in preparation for creating an aggregate query:
1. Identify Purpose: Like a record-level query, the first step in working with an 

aggregate event is to identify the overall purpose of the event. 

2. Consider Alert Message Content: The next step to consider is what you 
would like an alert message about this event to look like. 

3. Identify Alert Message Data Fields: With this message, you can identify the 
two data fields that you wish to put into the message text.

4. Identify Aggregate Field and Function: Looking at your aggregate event’s 
alert message, it is easy to tell that the aggregate function you are performing 
is: counting the number of activities. Whenever you have CRM Studio count 
the number of records in a table, you always use the table’s unique key as the 
field that counts the number of records (because this field is never blank). In 

Example Send an alert to a sales manager if any sales representative has 
fewer than 10 scheduled activities this week.

Example In the case of this aggregate event, you might wish the 
corresponding alert message to look like the following:
The following sales representatives have fewer than 10 scheduled 
activities this week:
Salesrep: Jim Ramey
Number of Scheduled Activities This Week: 7

Example The following salesreps have fewer than 10 scheduled activities 
this week:
Salesrep: [salesrep_name]
Number of Scheduled Activities This Week: [activity_count]
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this example, CRM Studio would count records using the activity ID field. 
The aggregate function for this query would be ‘count’.

5. Identify Aggregate Grouping Field: It is apparent from your aggregate 
event’s alert message that you are counting the number of activities per sales 
representative.
When you create an aggregate event (and query), you have the option to 
group the aggregate function by one or more fields. 

In this particular query, our aggregate grouping field would be 
[salesrep_name].

6. Identify Database Tables: Aggregate events (by their nature) often contain 
fewer fields of extensive information in an alert message and thus, require 
that fewer database tables be involved in the creation of the aggregate query.

7. Identify the Record-Level Condition: This is a key point where record-level 
queries and aggregates differ. In a record-level query, you need to include 
selection criteria that will enable CRM Studio to determine whether a record 
will trigger the event. 
In an aggregate query, you need to include selection criteria that will enable 
CRM Studio to determine whether an underlying record is eligible to be 
included in the aggregate. 

In an aggregate query, these conditions are referred to as the record-level 
conditions that must be met for those records to be included in the aggregate 
function. (The aggregate function in this example is the counting of eligible 
activities per salesrep.)

8. Identify the Aggregate Condition: In the previous step, we identified the 
conditions that would determine whether a record was eligible to be included 
in the aggregate function. Having done that, we need to identify the condition 
that the aggregate itself must be tested against.
If we consider the results of this aggregate query after step #7, we have a 
query that shows us how many activities are scheduled for each sales 
representative this week. The aggregate condition is where we can instruct 
CRM Studio to identify only those salesreps with fewer than 10 scheduled 
activities.
Thus, the aggregate condition for this query is:
Fewer than 10 scheduled activities

Example You could count the number of activities per salesrep and (within 
each salesrep) per activity type.

Example This query will have to retrieve information from two database 
tables: the activity table (to count the number of activities per 
salesrep) and the salesrep table (to retrieve the name of each 
salesrep with fewer than 10 activities).

Example For an activity to be counted as one that is assigned to a salesrep for 
this week, it must meet the following criteria:
• It must be open (not completed).
• It must be scheduled for completion this week.
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9. Identify Who’s to be Notified: As with record-level queries, the final step is to 
identify who will be notified about the event. An aggregate query can notify a 
specific individual, or an individual associated with a triggered record.

Query Design Worksheets
As illustrated in the preceding steps, the best way to approach designing queries 
is to identify the query elements you require before you log in to CRM Studio. In 
this regard, you can use the worksheets provided in the chapter ‘Worksheets’ to 
help you identify the necessary elements and thus, streamline the creation of 
queries within CRM Studio.

Before you begin designing queries within CRM Studio, you must successfully 
install Everest CRM Studio.
The remainder of this user guide assumes that you have successfully integrated 
CRM Studio with your companies of choice (via ODBC) and have verified this 
connectivity. If you have not taken these steps, please refer to the CRM Studio 
Installation Guide for assistance, and/or contact the Everest Software Technical 
Support department for assistance.

The Query Designer
Once you have completed one or more worksheets for the design of record-level queries, 
you are ready to log in to the Everest CRM Studio Architect and create such a query.

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

Example In the case of the current aggregate event, you could notify each 
sales representative who has fewer than 10 scheduled activities this 
week, by including the representative’s e-mail address as one of the 
fields in the underlying aggregate query.

“Query Design Worksheets” on page 361

To access the Query Designer in CRM Studio, do the following:

When you log in for the first time, the ASC database is updated with the 
latest EventPak.
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 Figure 4.1:  Everest CRM Studio Architect
• From the Event Management Folders panel in the center, select Application 

Events. You will see all the companies that CRM Studio is currently 
configured to integrate with.

• Select the company for which you want to design queries and click Query 
Definitions. You will see a list of queries (if any have been created) in the 
right panel.

• Click the New Query Definition button at the top-left. You will see the 
Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions dialog box, using which you can design 
queries for the selected company.

Record-Level Queries
The following sections outline the creation of record-level and aggregate queries. 

Query Description
Since most organizations using CRM Studio have a minimum of 25 to 30 queries, 
it is important to name your queries logically so that they can be easily located 
later. For example, consider the following query conditions:
• Overdue activities
• Fewer than 12 activities per salesrep next week
• Activities that are due for completion in the next 3 days
Such queries will be very hard to locate later on. It would be much easier to find 
them, if they were named in the following manner:
• Activities; Overdue for Completion

• The Aggregate Queries section goes over only the differences between 
designing record-level and aggregate queries; hence, it is necessary to 
review the record-level query section to become familiar with the basics 
of query designing.

• The following section assumes that you have successfully connected 
CRM Studio to the company database for which you are designing 
queries. This database is referred to as (your company).
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• Activities; Fewer than 12 per salesrep next week
• Activities; Due for Completion Within 3 days
As one possible naming convention, Everest Software suggests listing a query’s 
primary data object as the first word in a query’s description (e.g. Activities). You 
can then follow that with the appropriate condition being applied to that object.

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Manager Folders panel in the center, select Application 
Events > (your company) > Query Definitions.

• Click the New Query Definition button at the top-left. You will see the 
Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Description tab.

• In the Query Description field, enter a description of the query you are 
creating. Press the Tab key to copy the same into the Display Description 
field. 

• Ensure that you select the Active check box. Click Next. You will see the 
Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Tables tab.

Query Tables
From the Tables tab, you can choose what database tables this query will retrieve 
information from. There are three items you need to consider when identifying a 
query’s tables:
• What data do you wish to put into an alert message that results from this 

query’s condition being met?
As we discussed earlier (in the preparation steps), a query that retrieves 
something as straightforward as overdue activities usually needs to retrieve 
data from more than just the activity table. If you desire information about the 
account for whom the activity was created, you also need the account table. 
And if you desire information about the sales representative to whom the 
activity is assigned, you would also need the sales representative table.

• Do you need to include the table that contains the e-mail address of the person 
you wish to alert?
In many alert scenarios, you might wish to send an alert to a person who is 
associated with the record causing the event to trigger. (e.g., you might wish 
to send an alert to the sales representative to whom an overdue activity is 
assigned.) In this instance, you must include the table that contains the e-mail 
addresses of the desired alert recipients.

• Will an event that uses this query need to execute some sort of response action 
such as executing a VB script, a SQL statement, or an executable program?

To create a query, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Description” on page 51
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Since an event can execute a response action in addition to sending an alert 
message, you need to consider what data you wish to make available for 
transferring a corresponding program. For example, if you wish to allow an 
event using an Overdue Activities query to update contact data, you might 
wish to include the contact table as one of the tables for this query.

• After specifying relevant information in the Description tab of the Everest 
CRM Studio Architect - Application Events\(your company)\Query 
Definitions dialog box, click Next. You will see the Tables tab.

• From the Available Tables panel on the left, double-click the required tables, 
to add them to the Selected Tables panel.

• Click Next. You will see the Everest CRM Studio Architect - Application 
Events\(your company)\Query Definitions - Links tab.

Choosing the Same Table Multiple Times
You want to send an alert about activities that are overdue for completion. Each 
activity record contains the ID of the salesrep who is assigned to the activity (a 
field called activity.assignee_id), as well as the ID of the account manager who is 
responsible for the client for whom the activity was scheduled (a field called 
activity.acctmgr_id).
Since an employee’s ID [is simply a numeric field], you wish to put the name of 
the sales representative as well as the name of the account manager in a 
corresponding alert message. The names of these individuals reside in the 
employee table, in a field called employee.name.
To design this query so that it can retrieve the sales representative’s name, you 
would join the activity table activity.assignee_id field to the employee table 
employee.id field. However, to retrieve the account manager’s name, you would 
also need to join the activity table activity.acctmgr_id field to the employee table 
employee.id field. CRM Studio does not permit you to join one table to the same 
column in another table multiple times.
Instead, you must choose (or join to) the target table multiple times in the 
Columns tab.
When you select the same table two (or more) times in the Tables tab, you are 
presented with a pop-up window that informs you that you have already chosen 
this table and that you must specify an alias to select the table again.
Once you key in an alias (and press the return key), you will see the table’s alias, 
followed by an exclamation mark, and the table’s original name, in the list of 
selected tables. 

Query Links
You must be familiar with an Everest company’s database schema to link tables 
together in CRM Studio.

To specify the query’s tables, do the following:

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Tables” on page 52
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If you have chosen more than one table for a query, you must tell CRM Studio 
how those tables are linked (or joined) together.
It is very important that you identify a query’s primary database table before 
starting the linking process.
In the example of an Overdue Activities query that uses the activity, account, and 
sales representative tables, you would first identify that this query’s primary 
database table is the activity table.

• After selecting tables from the Tables tab of the Everest CRM Studio 
Architect - Application Events\(your company)\Query Definitions dialog 
box, click Next. You will see the Everest CRM Studio Architect - Application 
Events\(your company)\Query Definitions - Links tab.

• Click the Add Table Link button. You will see the Everest CRM Studio - 
Tables Linked Together dialog box. 

• From the Table Name drop-down list, select the query’s primary database 
table. From the Linked to Table Name drop-down list, select any of the 
query’s other tables. 

• From the Column Name drop-down list, select the field that allows the tables 
to be linked together. 

• The Link Type field defaults to Left Outer Join. You may leave it as is, unless 
your database schema specifically requires a different type of link.

• Click OK.
• If you have more than two tables that require linking, click the Add Table 

Link button again and repeat this process until all tables are linked. Click OK.
• You will see the Everest CRM Studio Architect - Application Events\(your 

company)\Query Definitions - Links tab again, with the resulting linked 
tables displayed.

• Click Next. You will see the Everest CRM Studio Architect - Application 
Events\(your company)\Query Definitions - Columns tab.

To link the tables, do the following:

“The Everest CRM Studio - Tables Linked Together Dialog Box” on 
page 54

• If CRM Studio is able to find a column in the Linked to Column 
Name field with the same name as the selected column in the 
Column Name field, that field name is automatically loaded in the 
Linked to Column Name field.

• If CRM Studio is not able to find a column in the Linked to Column 
Name field with the same name as the selected column in the 
Column Name field, the Linked to Column Name field is left blank 
and you may select the appropriate column from the drop-down list.

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Links” on page 54
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• From the Everest CRM Studio - Tables Linked Together dialog box, join the 
two tables together as detailed in the previous section.

• Click the SQL tab. Copy the join syntax (the part of the query that follows the 
word ‘From’, up to the word ‘Where’). 

• Click the Links tab and select the option I would like to manually input the 
table linking. A blank line appears beneath this check box.

• Paste the join syntax that you copied from the SQL tab into this line. Edit this 
syntax to perform the join exactly as you require.

• Click Next. You will see the Everest CRM Studio Architect - Application 
Events\(your company)\Query Definitions - Columns tab.

Query Columns
The next step in designing a record-level query is identifying the fields of data 
(columns) that this query should have access to. There are three items you need to 
consider when identifying a query’s tables:
• What data do you wish to put into an alert message that results from this 

query’s condition being met?
If, for example, you are designing a query that will identify activities that are 
overdue for completion, you might wish to include fields such as the activity 
description, the due date and time, the account name, and the name of the 
person to whom the activity is assigned.

• Do you need to include the field that contains the e-mail address(es) of the 
person you wish to alert?
This would require you to include the field that contains the e-mail address of 
the person to whom an activity is assigned.

• Will an event that uses this query need to execute some sort of response action 
such as executing a VB script, a SQL statement, or an executable program? If 
so, what fields of data might that response action require?

Depending on the companies, databases, and ODBC drivers you are using 
with CRM Studio, you may come across an instance where CRM Studio’s 
default linking syntax is not sufficient for the type of link you wish to 
create.

 Some companies require you to join two tables together by 
taking the first (or left) ‘x’ characters of a field in one table, and linking them 
to the first ‘x’ characters of another field in the second table. CRM Studio’s 
default linking syntax does not allow you to link using only ‘x’ characters of 
a specific field. To create a link such as this, you need to override CRM 
Studio’s default linking syntax.

To override the default linking syntax, do the following:

Do not include the words ‘From’ and ‘Where’ in the copy, and the 
parentheses that begin and end the join syntax.

Example
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If this query is used in a response action that automatically updates the 
contact record of the client for whom the activity is overdue, you might also 
wish to include the contact’s name as one of the query’s columns.

• If the results of this query are presented in a list, what order do you want these 
records listed in?
You may want the overdue activities listed first in the order of activity 
priority, and then (within each priority) in the chronological order of the 
activity’s due date. Be sure to include the activity priority field as one of the 
columns for this query.

• After linking the selected tables in the Links tab of the Everest CRM Studio 
Architect - Application Events\(your company)\Query Definitions dialog 
box, click Next. You will see the Everest CRM Studio Architect - Application 
Events\(your company)\Query Definitions - Columns tab.

• From the Available Columns to Query field, double-click the fields you wish 
to include in the query.

OR
• Select the field you wish to include and click the Add Column to Query 

button. The selected fields are displayed in the Query Columns Selected grid. 
• Repeat this process for each column you wish to select.

• Click Next. You will see the Everest CRM Studio Architect - Application 
Events\(your company)\Query Definitions - Sorting tab.

• In the Query Columns Selected grid, go to the extreme left column of the row 
that contains the field you wish to remove. The cursor changes into a right-
pointing arrow.

• Click the left mouse button.
• Click the Remove Column from Query button. The column is removed from 

the query.

To select the query’s columns (fields), do the following:

If you wish to include all the available columns within a query, you can 
click the button Add All Columns to Query.
Although this is an excellent technique for ensuring that you can 
retrieve data from all columns (as well as for verifying the data within 
each of these columns), this option is not suggested for normal query 
building as it makes it difficult for the person(s) designing alert 
messages to quickly and easily locate the specific fields whose values 
they wish to include in an outgoing alert message.

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Columns” on page 56

To remove a column from a query, do the following:

You may also click the button Remove All Columns from Query to 
delete all the columns selected for this query. 
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The Query Columns Selected Grid
Column Type
When designing a record-level query, this field should always be set to Normal 
for every column selected within a query.
Customized Name
When a query is used within an event, you can use the query’s columns in a 
number of ways, such as in the design of alert message text, and event response 
actions. Whenever you need to reference a query’s column, you can do so from 
the column’s Customized Name.
This is necessary, as some databases have rather cryptic names for their columns. 

You might know that a column called ‘ddate’ actually stores the activity’s due 
date, but the person designing an event’s alert message might not. Therefore, you 
can modify a column’s Customized Name so that when a person is designing an 
alert message for this query, a field called Due_Date rather than ddate is 
displayed.
By default, when you select a column for a query, CRM Studio automatically 
places the column name in the Customized Name field. You can then modify that 
field’s customized name. 

Unique Field
In CRM Studio, you have two choices as to how often you wish to be notified 
about an individual record that meets a query’s criteria (such as an overdue 
activity). You can:
• Be notified once about each record.
• Be notified over and over about a record until it no longer meets the query’s 

criteria.
Although this option is specified at the event level, if you do not tell CRM Studio 
how to uniquely remember each record that it has sent an alert about, it 
automatically uses the second option.

Example A sales application may have an activity table with a column that 
stores the activity’s due date, called ddate.

• Do not include blank spaces in a column’s customized name. Some 
databases and/or ODBC drivers accept blank spaces, others do not. 
Instead of using blank spaces (Due Date), use underscores (Due_Date).

• Try to keep your customized names under 20 – 25 characters. Some 
databases and/or ODBC drivers accept customized names of only up to 
‘x’ characters. 

• Do not begin a customized name with SQL reserved words, such as 
sum, sub, add, avg, min, max, trim, format, and so on. 

• Make sure you do not have multiple fields with the same customized 
names. (e.g., a contact name column and a sales representative name 
column may both show up with a customized value of ‘name’, so 
change the first value to contact_name and the second value to 
rep_name.)

• Use only letters and numbers in a customized name; do not use 
symbols.
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To indicate to CRM Studio how it can uniquely remember a record, you need to 
identify the column within a query that uniquely identifies each record.  

If this column has not already been selected as one of this query’s columns, check 
the Unique check box for that column.

Calculated Fields
One of the most important aspects of query designing is that you can create 
calculated fields. 

Calculated fields may be placed in alert messages, used as selection criteria to 
determine whether a record should be triggered, and used in an event’s response 
actions.

• Select the field that contains the opportunity’s forecast amount (a field called 
opportunity.amount). This field appears as a row in the Query Columns 
Selected grid.

• Position the cursor in the row containing opportunity.amount in the Column 
Name Selected column, and single-click at the end of the word amount.

• In this row, enter an asterisk (*) after the word amount. This denotes the 
multiplication symbol.

• Type in the name of the field that contains the opportunity’s probability of 
closing (such as, opportunity.probability). The Column Name Selected field 
now displays: opportunity.amount*opportunity.probability.

• Change the column’s customized name from amount to weighted_amt.
There’s no limit to the types of calculations that you can include in a column. You 
can include: any accepted arithmetic functions, parentheses to control the order of 

Example For a query that sends alerts about overdue activities, this would be a 
column such as the activity ID.

• It is recommended that you specify a unique field since you have the 
option to repeat (or not repeat) alerts on the event level.

• Every record-level event should have a unique column identified.
• Only a single column may be checked as a query’s unique column.
• If a query’s unique value is based on a combination of two or more 

fields, you can create a concatenated field that combines the values of 
multiple columns and then identify that column as unique.

Example • A field that calculates the number of days that an activity is 
overdue for completion.

• A field that calculates the weighted value of an opportunity by 
multiplying the opportunity amount by the forecast probability of 
its closing.

• A field that calculates the percentage of stock in-hand that is in 
excess of its desired maximum level.

Example The steps detailed below outline the creation of a field that stores an 
opportunity’s weighted value. 

To create a calculated field, do the following:
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arithmetic operations, and database (and driver) specific functions for even more 
advanced calculations. Here are a few guidelines on creating and using calculated 
fields:
• Use a query’s Preview mode to ensure that your calculation syntax is 

acceptable to the database, the ODBC driver, and to CRM Studio.
• Most databases (and drivers) support functions that allow you to calculate the 

difference between two dates. The syntax of these functions is very much 
dependent on the database (and driver) you are working with. Please see your 
database administrator (and/or SQL documentation) for details on how to use 
these functions.

• Be sure to change the Customized Name of a calculated field; since most 
calculated fields begin by identifying a single column, the customized name 
usually defaults to that column’s name.

• A single query can have multiple calculated fields within it.
• You can copy and paste the content of a grid’s Column Name Selected cell.

Return Distinct Rows of Data Only
By design, record-level queries return a list of all records that meet a query’s 
criteria. 

You may, however, wish to receive only a list of all customers who placed those 
orders. If your query retrieves data from the orders table, you will see one record 
for every order in that table, including multiple orders for the same customer.
However, based upon the columns that you select for a query, you can instruct 
CRM Studio to retrieve only unique (or distinct) records. 
Thus if you design your query to contain only the name of customers who made 
purchases last month, and you select the Return Distinct Rows of Data Only 
option, CRM Studio provides you with a list that shows a customer’s name only 
once, regardless of how many matching orders were retrieved.

Query Sorting Order
When a record-level query is executed, it retrieves matching data records. An 
event that uses this query can either send one alert message per matching record, 
or it can send a single alert message that contains all the corresponding records. 
A single alert message can roll up these records and display them all together. So 
you have the option to specify the order in which these records are to be listed in 
the associated alert messages. This is referred to as the query’s sorting order.

Example A query that scans orders placed last month generates a list of all of 
those orders. 

Be careful when using this option as the definition of what is (and is not) 
distinct is governed strictly by the columns you have chosen for your query. 

Example If the preceding query has just the customer name column, it returns 
one record per customer. But if you select customer name and order 
date as columns, the query returns one record daily per order per 
customer.
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Any field that you select in the Columns tab is available for use in the sorting 
order. 

• After selecting the query’s columns in the Columns tab of the Everest CRM 
Studio Architect - Application Events\(your company)\Query Definitions 
dialog box, click Next. You will see the Everest CRM Studio Architect - 
Application Events\(your company)\Query Definitions - Sorting tab.

• From the Available Columns for Sorting panel, double-click the field you 
wish to sort. The column is added to the Columns Selected for Sorting panel.

• Click in the Sort Direction column in the Columns Selected for Sorting panel, 
and select Ascending or Descending, according to your requirements. 

• Click Next. You will see the Everest CRM Studio Architect - Application 
Events\(your company)\Query Definitions - Filters tab. 

Query Filters
The most important part of designing a query is the identification of the 
conditions that will cause the query to trigger an event. These conditions are 
referred to as a query’s filters. There are three general concepts of query filter 
design that you should review before starting to create filters:
• What operators you can use in a query filter?
• What kinds of comparisons can a filter execute?
• Will any of your filters use parameters?
The following sections address each of these concepts.

Query Filter Operators
A filter can use all the standard operators that you are familiar with, such as 
Equal to, Not equal to, Greater than, Less than, Greater than or equal to, Less than 
or equal to, Between, Starting with, One of. 

Query Filter Compare Values
A filter can do much more than simply compare the value in one field against a 
pre-determined value. Here is a list of the types of tests that can be executed by a 
query filter:
• Test a field against a constant value (Priority equals High).
• Test a field against another field (Sale price is less than the cost of goods sold).

To select the query’s sorting order, do the following:

You can specify multiple levels of sorting (also called nested sorting). 
Once you have chosen your first sorting field you can simply repeat the 
preceding three steps to create an additional level of sorting.

Example To sort overdue activities first by priority and then by activity due 
date, you would select the activity priority column as your first 
sort field and the activity due date column as the second field.

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Sorting” on page 58
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• Test a calculated field against a constant value (Weighted value is greater than 
10,000).

• Test a calculated field against another calculated field (Percentage of damaged 
items is greater than percentage of undamaged items).

• Test a date field against a date or numeric range (Due date is between this 
Monday and this Friday; probability is between 60% and 90%).

• Test a date field against a date variable (Forecast close date is less than today).

Query Filter Parameters
Your organization wishes to receive alerts about pending sales opportunities. 
Your sales manager wishes to be alerted about any pending sales that are greater 
than $25,000. Your CFO wishes to be alerted about any pending sales that are 
greater than $50,000. And your CEO wishes to be alerted about any pending sales 
that are greater than $100,000. You could design three queries as follows:
Pending Sales > $25,000
Pending Sales > $50,000
Pending Sales > $100,000
You could also design a single query called Pending Sales > ‘x’ Dollars.
This is where a filter’s ability to accept a parameter is invaluable. You can create a 
filter that tests to see if a sales amount is greater than ‘x’ – and the value of ‘x’ is 
specified on the event level – at the time when this query is linked to an event.
An individual filter can consist of up to seven components. Although not all 
filters utilize all seven components, it is important to understand how they all 
function. The Columns Selected for Filtering grid displays each filter component 
as a row in the grid.
Column Name: The first part of a filter is the selection of the column whose value 
you wish to test. 
Is or Is Not: By default, CRM Studio checks a column to see if it meets a certain 
condition. By choosing the ‘Is Not’ function, you can instruct CRM Studio to 
check a column to see if it does not meet a certain condition. To change the ‘Is’ 
function to ‘Is Not’, click beside the word ‘Is’ and choose ‘Is Not’ from the drop-
down list.
Operator: CRM Studio provides 10 operators that you can choose from, when 
testing a field for a certain value. By default, the operator ‘Equal To’ is selected for 
you, but you can choose a different operator by clicking this field and selecting an 
option from the drop-down list. 
Compare Value: This column is where you place the value against which CRM 
Studio will compare the selected column’s value. The compare value field may 
contain a constant value, the value from another database field, a date 
substitution value, or the question mark. 
Type: The type field identifies the type of data that this filter is processing; this 
can include character based data (i.e., alphanumeric data), numeric data, or date-
formatted data. CRM Studio automatically fills in the value of this field for you. 
The literal data type is used only if you compare the value in one column with the 
value in another, or with an SQL function. 
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And/Or: Since a single query can include multiple filters, CRM Studio gives you 
the ability to specify the and/or logic in the sequence of those filters, as in “look 
for condition ‘a’ or condition ‘c’”). 

Optional Prompt: The optional prompt field is used only with query filters that 
are parameter driven (have a ‘?’ in the Compare Value column). 

Compare Values
As mentioned previously, you can compare the value of a column with a constant 
value, the value from another database field, a date or numeric range, a date 
substitution value, or the parameter indicator (the question mark). These are 
detailed in the following sections: 
Comparing a Column with a Constant Value

You have two ways to choose a constant as the compare value for a column:
• Manually type in the value, or 
• Choose that value from a database list
To manually type in a value, delete the default question mark that appears in the 
Compare Value column, and type in the value you wish to compare the column 
to. 

CRM Studio also allows you to directly query the database to retrieve potential 
values for a field. 

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click in the Compare Value 

column and click the list  button. You will see the Everest CRM Studio - 
Filters dialog box.

• Click the drop down button beside the field Type in a value or choose from 
drop-down list. You will see a list of possible entries for this field.

•  Choose the value that you wish to compare the column to and click OK.

• And/Or logic is sequential. The and/or that you select applies to the 
current filter in relation to the next filter. (e.g., if filter #1 has an ‘or’ in it, 
you are creating a query that will retrieve records if filter #1 or filter #2 
prove true. If filter #1 has an ‘and’ in it and filter #2 has an ‘or’ in it, the 
query will retrieve records if both, filters #1 and #2 prove true, or if filter 
#3 proves true.)

• Although this option does not allow for grouped or parenthetical 
expressions, this is also possible.

Example Activity priority is equal to ‘high’.

The comparison that CRM Studio performs is case-sensitive, so a compare 
value ‘high’ will not retrieve those records that have a value ‘High’.

To directly query the database to retrieve potential values for a field, do 
the following:

The drop-down list displays all the values that appear in this field, in the 
underlying database. It does not display every possible value that could 
appear in this field.
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Comparing a Column with Another Database Field

In this example, the Compare Value column contains the name of another 
database field. 

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click in the Compare Value 
column and delete the ‘?’.

• Type in the full name (table.column) of the field you wish to compare the 
selected column to (such as, opportunity.costofgoods).

• Click in the Type field and select Literal from the drop-down list.
Comparing a Column with a Date or Numeric Range

One of the most common CRM Studio query scenarios is to test to see if records 
fall within a date range. This is most typically used for identifying records whose 
dates or numeric values fall within a certain range. 
CRM Studio has two ways of creating filters that let you identify records whose 
values fall within a range. The first is with the use of the ‘between’ operator, as in:
Due date is between ‘x’ and ‘y’, or probability is between ‘a’ and ‘b’.
The second (and recommended) way is with the use of the ‘greater than or equal 
to’ and ‘less than or equal to’ operators, as in:
Due date is greater than or equal to ‘x’, and due date is less than or equal to ‘y’,
Or,
Probability is greater than or equal to ‘a’ and less than or equal to ‘b’.
Everest Software suggests the second approach (the use of ‘greater than or equal 
to’ and ‘less than or equal to’) for two reasons:
• Not all databases and/or ODBC drivers support the ‘between’ operator. 

‘Greater than or equal to’ and ‘less than or equal to’ are universally supported.
• The ‘between’ operator cannot be used with parameters, whereas ‘greater than 

or equal to’ and ‘less than or equal to’ can. (This allows you to create one 
query that can be used in multiple events with differing date or numeric 
ranges.)

To create a date or numeric range filter, you have to use two filters – a beginning 
range filter and an ending range filter. 

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Tables tab, choose the table that contains the 
date or numeric field that you wish to create a range filter for. 

• In the Links tab, carry out the process of linking tables.

Example Cost of goods sold is greater than the sale price.

To compare a column with another database field, do the following:

Example • Due date is between 10/15/2001 and 10/31/2001. 
• Probability is between 60 and 90 percent.

To create the beginning range filter, do the following:
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• In the Columns tab, select the date or numeric field that you wish to create a 
range filter for (such as, opportunity.probability).

• Specify the required sorting option in the Sorting tab. 
• In the Filters tab, click the Operator field for the row that contains the selected 

date or numeric field (opportunity.probability). From the drop-down list, 
select the operator ‘greater than or equal to’.

• Click the Compare Value column for the row that contains the selected date or 
numeric field, and do one of the following:
- Enter a specific beginning date. 

- Click the list  button to display the Everest CRM Studio - Filters dialog 
box. You can use a date substitution variable from the Available 
Substitution Variables field.

- Enter a ‘?’ to indicate that this filter will be parameter-driven. 

• Select the same field again in the Filters tab (opportunity.probability).
• Click the Operator field for the row that contains the selected date or numeric 

field. From the drop-down list, select the operator ‘less than or equal to’.
• Click the Compare Value column for the row that contains the selected date or 

numeric field, and do one of the following:
- Enter a specific ending date. 

- Click the list  button to display the Everest CRM Studio - Filters dialog 
box. You can use a date substitution variable from the Available 
Substitution Variables field.

- Enter a ‘?’ to indicate that this filter will be parameter-driven 
Comparing a Column with a Date Substitution Variable

In many CRM Studio queries, you will want to test the value of a date field 
against a value such as today, tomorrow, last week, or next month. To facilitate 
this, CRM Studio provides a wide variety of date substitution variables that can 
be used in the Compare Value column of a filter.

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click the Compare Value column 

for the row that contains the selected date field, and click the list  button. 
You will see the Everest CRM Studio - Filters dialog box. 

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Filters” on page 60

To create the ending range filter, do the following:

Example Due date is less than today.

To use a date substitution variable as a compare value, do the following:
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• You can use a date substitution variable from the Available Substitution 
Variables field.

• Select the value that you wish to compare the column to and click the Select 
this item to compare button.

• Click OK.

Creating a Parameter-Driven Filter

As was discussed in “Query Filter Parameters” on page 127, you can design a 
query so that its filters allow the query to be used in multiple events, as in a query 
that uses three events that check for sales greater than $25,000, $50,000, and 
$100,000 respectively.
The way to accomplish this is through the use of filter parameters.
A filter parameter – represented by the ‘?’ symbol – indicates that the compare 
value of a particular query filter is specified on the event level. This is what 
enables a single query to be used in multiple events, each with a different filter 
parameter value.

There is a wide variety of variables to choose from. For many variables 
(such as %Current Date%), you see multiple formats for the same value. 
The format without any suffix (as in %Current Date%) uses your 
system’s date format. The other formats contain a suffix (such as YYYY-
MM-DD) that indicates the format in which the corresponding date is 
returned.

Be careful when using the current date substitution variable, particularly if 
you are comparing a field that contains both the date and time to the 
current date variable.

 You create a filter that retrieves any activities whose creation 
datetime field is equal to the current date. You will not get any records 
because a field that contains today’s date plus a time will automatically be 
greater than a field that contains just today’s date. You can address this 
issue in two different ways:
• Make your filter check to see if the creation date time is greater than or 

equal to today’s date.
• Make your filter check to see if the creation date time is greater than 

{%Current Date%} 00:01 and less than {%Current Date%} 23:59.

Example Priority is equal to?.

It is important to note that any filter that is parameter-driven requires a 
compare value to be specified when that the query is linked to an event. 
This is typically done by the person who is configuring the CRM Studio 
event.

Example
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Once the event is fully configured and activated, the parameter value has a 
specific value that is used every time the event is executed.

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click the Compare Value column, 
for the row that contains the filter which is to be parameter-driven. 

• Ensure that a ‘?’ is displayed in the Compare Value column.
• In the Optional Prompt column of the Filters grid, delete the default text and 

enter your own text. 

Operators - Notes
Of CRM Studio’s ten operators, additional details are provided for the following 
five:
One Of 
This operator allows you to test a column for any one of multiple values. ‘One of’ 
tends to be most useful in ‘and/or’ situations such as: Send an alert for any calls 
that are open and have ‘A’ or ‘B, or ‘C’ priority.
The corresponding event would have one filter that checks to see if a call is open 
and a second filter (using the one of operator) that checks for any one of the three 
different priority codes.

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click the Operator field and select 
‘one of’ from the drop-down list.

• Click the Compare Value column and delete the ‘?’. 

• Click the list  button. You will see the Everest CRM Studio - Filters dialog 
box.

The following operators may not be used with parameters:
• One of
• Between
• Null 

To set up a filter to be parameter-driven, do the following:

The optional prompt is the text that appears (on the event level) when you 
select this query for use with an event. When a query that has one or more 
parameter-driven filters is selected for an event, the person configuring the 
event receives a prompt informing that a compare value needs to be 
supplied for this filter. The text of this prompt is defined here. Typical 
optional prompts include:
• Select a Priority:
• Status is:
• Forecast Date Range Begins:
• Sales of Greater than How Much?

To use the ‘one of’ operator, do the following:
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• In the One of the Following Values panel, click the ‘?’ and then click the 
Remove Compare button.

• You are now ready to enter your selected compare values. You may either 
type in the individual compare values (pressing ‘Enter’ after each entry), or 
you can select them from the Type in a value or choose from dropdown list 
field.

• Click OK.

Between

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click the Operator field and select 
‘between’ from the drop-down list.

• Click the Compare Value column and click the list  button. You will see the 
Everest CRM Studio - Filters dialog box.

• You will see an additional drop-down list under the Type in a value or choose 
from dropdown list field.

• Enter or select the first compare value from the first drop-down list.
• Enter or select the second compare value from the second drop-down list.
• Click OK.

Starting With
The ‘starting with’ operator enables you to locate any database records that have a 
field whose value starts with a certain string of letters, numbers, and/or symbols.

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click the Operator field and select 
‘starting with’ from the drop-down list.

The ‘one of’ operator may not be parameter-driven; you must specify the 
compare values for a filter using this operator on the query level.

Not all databases and/or ODBC drivers support the ‘between’ operator. 
Everest Software suggests that you use the combination of the ‘greater than 
or equal to’ and ‘less than or equal to’ operators instead, wherever possible.

To use the between operator, do the following:

The ‘between’ operator may not be parameter-driven; you must specify 
the compare values for a filter using this operator on the query level.

Example You can create a query to retrieve any clients whose mailing address 
postal code begins with 070. Or, you can create a query to retrieve any 
clients who purchased any products beginning with the characters 
Epak.

To use the starting with operator, follow these steps:
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• Click the Compare Value column and enter the first few characters of the 
string that you wish to use for matching purposes.

Like
The ‘like’ operator is similar to the ‘starting with’ operator except that it enables 
you to locate any database records that have a field whose value contains a certain 
string of letters, numbers, and/or symbols.

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click the Operator field and select 
‘like’ from the drop-down list.

• In the Compare Value column, enter the compare value using this format: 
%compare value%.

Null
When designing CRM Studio queries, you might find the need to check if a 
specific field value is blank. A blank value in a database field can often be 
interpreted in two ways: as blank, and as null.

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click the Compare Value column 
and delete the ‘?’. In other words, leave this field blank.

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Filters tab, click the Operator field and select 
‘null’ from the drop-down list.

• Delete the ‘?’ and leave the Compare Value column blank.

The ‘starting with’ operator may be parameter-driven simply by leaving 
the ‘?’ in the compare value field. If you do make this filter parameter-
driven, be sure to specify a helpful optional prompt, such as ‘Part 
Numbers Starting With:’.

Example • Starting with ‘brit’ retrieves Britain and Britannia, but not New 
Britain.

• Like ‘brit’ retrieves all three values.

To use the like operator, do the following:

• When you use the like operator you need to enclose the string of text 
that you are searching for within percent signs, as in %brit%.

• The ‘like’ operator may also be made parameter-driven simply by 
leaving the ‘?’ in the compare value field. If you do make this filter 
parameter-driven, be sure to specify a helpful optional prompt, such 
as ‘Part Numbers that Contain the Letters:’.

To test a field for a blank value, do the following:

To test a field for a null value, do the following:

If you are not sure how a specific company database identifies an empty 
field, you might want to create a query with two filters – one filter that 
tests the field for a blank value, and another that tests it for a null value.
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Using Calculated Fields in Filters
Using a calculated field in a filter is done in the same manner as creating a 
calculated field in a query column. 

• From the Available Columns to Filter field of the Filters tab, select the 
column that contains the opportunity’s forecast amount (a field called 
opportunity.amount). This field appears as a row in the Columns Selected for 
Filtering grid.

• In this row, enter an asterisk (*) after the word ‘amount’. This denotes the 
multiplication symbol.

• Enter the name of the field that contains the opportunity’s probability of 
closing (such as, opportunity.probability). The Column Name field now 
displays: opportunity.amount*opportunity.probability.

• You can now continue to specify the operator and compare value just like any 
other filter.

And/Or Logic
The combination of the ‘and/or’ selection in the Filters tab, plus the use of the 
‘one of’ operator in the same tab, covers most of the ‘and/or’ logic that you might 
require in your query. In some instances, however, you might need to specify 
more complex ‘and/or’ conditions such as:
Retrieve orders greater than $99 with freight charges less than $5,
Or, 
Orders with freight charges less than $5 shipping via Fedex
This type of and/or logic requires the ability to group filters together, using 
parenthetical expressions. This function is supported within the Filters tab, but 
requires a few extra steps.

• Create the four filters that the query will need:
1. Orders greater than $99
2. Freight charges less than $5
and:
3. Freight charges less than $5
4. Orders shipping via Fedex
• Filter 1 should have an ‘and’ (to link the first two conditions).

“Calculated Fields” on page 124

Example The steps detailed below outline the creation of a field that tests an 
opportunity’s weighted value. 

To create a calculated field, do the following:

Calculated fields can be used in both, the column name and compare 
value columns. Calculated fields may be parameter-driven (i.e., you can 
use them in conjunction with the ‘?’ in the compare value column).

To create this query, do the following:
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• Filter 2 should have an ‘or’ (to separate the first two conditions from the last 
two conditions).

• Filter 3 should have an ‘and’ (to link the last two conditions).
• Click the Column Name of filter 1 and enter a left parenthesis in front of the 

column name.
• Click the Compare Value of filter 2 and enter a right parenthesis after the 

compare value.
• Click the Column Name field of filter 3 and enter a left parentheses in front of 

the column name.
• Click the Compare Value of filter 4 and place the compare value within single 

quotation marks, only if the compare value is a character or date. 

• Enter a right parenthesis at the end of the compare value.
• If the compare value is a character or date, click the Type field for the fourth 

filter and select Literal from the drop-down list. 

The most important thing to remember about grouping filters for the ‘and/or’ 
logic is that if the last filter in a parenthetical group is testing the value of a 
character or date field, you must be sure to enclose the compare value in single 
quotation marks and to change the data type to Literal.
If the last filter in a parenthetical group is testing the value of a numeric field, (if 
in the previous example the ship via is identified by a numeric code instead of a 
name), the Type field for that filter should display Number.

Query Sub-Filters
Sub-filters are not used with record-level queries; they are used only with 
aggregate queries and thus, will be discussed in the section on aggregate queries.

Query SQL
The SQL tab allows you to review the SQL syntax that a query is executing. There 
is rarely the need to make any changes to a query’s SQL, and Everest Software 
recommends not using this tab to enter or modify a query’s SQL.
If you wish to manually edit the SQL syntax, you must select the I would like to 
manually edit the SQL for this query option. 
Once you activate the manual editing of SQL syntax, any modifications that you 
make to any of the other query definition tabs (Tables, Links, Columns, Sorting, 
Filters, and Sub Filters tabs) will not be retained. 
If you do edit a query’s SQL syntax and then deselect the I would like to 
manually edit the SQL for this query option, CRM Studio automatically re-

If the compare value is a number, you do not need the quotation marks.

If the data type is a number, do not change anything.

“Aggregate Query Sub-Filters” on page 146
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constitutes the SQL syntax based on the content from the other query definition 
tabs. 

If you need to manually edit a query’s SQL, here are a couple of suggestions about 
modifying the SQL syntax:
• Go through all the tabs in the Everest CRM Studio Architect - Application 

Events\(your company)\Query Definitions dialog box before you begin 
editing the SQL syntax. This way, you have a pre-built foundation of the SQL 
statement that you can edit, instead of having to build it from scratch.

• You can include database (and ODBC driver) specific functions in your SQL 
syntax.

Once you are done modifying the SQL syntax, be sure to select the Preview 
option to verify the successful execution of your query.

Query Preview
This tab helps you verify that the query you are designing will actually retrieve 
the required records.
Preview mode can be used as many times as you wish when building a query. 
Once you have selected some tables and columns, the preview mode will be 
available to you. 

When you click the Preview tab, CRM Studio automatically returns any records 
that meet your query’s filters criteria. If the preview tab is blank (containing no 
records), it means that CRM Studio was not able to locate any records that meet 
your query’s criteria. 

If you receive an error message when previewing a query, it means that CRM 
Studio was not able to successfully execute your query. The most common 
reasons for this are:
• The ODBC source for this company database was not correctly configured.
• Multiple tables for this query were not correctly linked.
• Your query includes one or more calculated fields that contain invalid SQL 

syntax.
• You have specified an invalid customized name for a query column.
• You have specified an invalid filter (such as trying to compare the value in an 

alphanumeric field to a date).
• You have edited the underlying SQL and introduced a syntax error.
Most of the error messages that the preview mode returns give you a clue as to 
where the error exists. To help pinpoint the error you can remove individual 

You will need to remove the check mark, select another tab, and then re-
enter the SQL tab to see the re-constituted SQL syntax.

Do not wait until you have built every aspect of a query to preview it; use 
the preview function repeatedly as you add more and more elements to a 
query and begin to refine its selection criteria. 

It is advisable to go into your underlying database and add a record (or two) 
that meets a query’s criteria, so that you can be sure that the query is 
working as required.
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query elements and try to preview the query after each removal. You will know 
exactly which component is causing the error.

The Everest CRM Studio - Please supply a value Dialog Box

 Figure 4.2: Everest CRM Studio - Please supply a value
Value
The top-most field displays a question/prompt, where you must supply the 
relevant value, by entering or selecting it from the Available Substitution 
Variables list.
Available Substitution Variables
This list displays the variables available for use.
Select This Item to compare
Click this button to add a selected variable from the Available Substitution 
Variables field to the Value (top-most) field.

Save a Query
To save your query, click the Save and Close button at the top of the Everest 
CRM Studio Architect - Application Events\(your company)\Query 
Definitions dialog box. To save this query and begin working on the next one, 
click the Save and New button.

Copy a Query
Many queries can be similar in design, so you must know how to copy one query 
to another. 

• From the Event Manager Folders panel of the Everest CRM Studio Architect 
dialog box, select Application Events > (your company) > Query Definitions. 
You will see all the queries displayed in the panel on the right.

If your query includes parameter-driven filters, you will be prompted to 
enter corresponding values for those filters. The Everest CRM Studio - 
Please supply a value dialog box is displayed in such a case. You can 
manually enter a value for such a filter, or you can choose a value from the 
drop-down list, or (if the filter requires a date value) you can choose any 
one of CRM Studio’s date substitution variables.

“The Everest CRM Studio - Application Events\Accel Sample 
Company\Query Definitions Dialog Box - Preview” on page 62

To copy one query to another, do the following:
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• Highlight the query you wish to copy and select Edit > Copy. 
• Select Edit > Paste. A duplicate of the query appears in the right panel. 
• Open either of the two (identical) queries and modify it as needed. Ensure that 

you change the query’s description.

Delete a Query
Before deleting a query, make sure there are no events that use the query you are 
about to delete. If you delete a query that is linked to an event, the event will fail 
to execute successfully the next time it is scheduled to run.

• From the Event Manager Folders panel of the Everest CRM Studio Architect 
dialog box, select Application Events > (your company) > Query Definitions. 
You will see all the queries displayed in the panel on the right.

• Highlight the query you wish to delete and click the Delete button at the top 
of the Everest CRM Studio Architect dialog box.

Or
• Open the query you wish to delete and click the Delete button at the top of the 

Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions dialog box.

Scroll Quickly Through The List of Queries
You might need to scroll sequentially through a list of queries (to activate or de-
activate a series of queries). Although you could select each query individually, 
edit it, save it, and then select the next query, there is a faster way to do this.

• Once you have selected and edited your first query, click the Previous or Next 
buttons at the top of the Query Definitions dialog box. 

• If you have made changes to the current query, you will be prompted to save 
(or abandon) your changes before proceeding. 

Aggregate Queries
As discussed at the start of this document, aggregate queries are queries that are 
triggered by a group of records that collectively meet a certain condition. 

To delete a query, do the following:

There is no Undo option to re-activate a deleted query.

To quickly scroll through queries, do the following:

Example • More than 10 open service calls with ‘critical’ as priority.
• Fewer than 5 scheduled activities per sales representative next 

week.
• Sales representatives with more than $500,000 in their pipeline.
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Unlike record-level queries, aggregate queries do not retrieve details about 
individual records that are triggered; instead, they are triggered by the aggregate 
condition being met. 

 The Results of an Aggregate Query
The results of an aggregate query look quite different from the results of a record-
level query for the simple reason that an aggregate query does not display record-
level details. Here are some samples of output that you might see from an 
aggregate query.

Example • An aggregate query that is designed to be triggered only if there 
are more than 10 open service calls with ‘critical’ as priority might 
retrieve simply the number 12 as its result. (The query shows the 
number of critical, open support calls.)

• An aggregate query that is designed to be triggered only if there 
are any sales representatives with fewer than five scheduled 
activities next week might retrieve Smith 4, Jones 1, and Davidson 
3 as its results. (The query shows the names and number of 
activities for each sales representative who has fewer than five 
scheduled activities.)

Query Result
More Than 5 Orders Over $10,000 
Today

“17”  (the number of orders over 
$10,000 today)

More Than 5 Orders Over $10,000 
Per Region Today

“6   Northwest”
“7   Southeast”
“26  Southwest”
(the number of orders over $10,000 
today from each region)

More Than 5 Orders Over $10,000 
Per Region and Representative 
Today 

“7    Southwest    Karen Chavez”
“11  Southwest    Mark Davidson”
“8    Southwest    John Langley”
(the number of orders over $10,000 
today from each region and each sales 
representative)

• Read the process of record-level query designing before proceeding 
with the following sections. The instructions on aggregate query 
configuration assume that you are familiar with record-level query 
design.

• Many of the steps involved in setting up an aggregate query are 
identical to those required for record-level queries. In such cases, you 
will need to refer to the corresponding section under record-level 
queries, where indicated.

“Record-Level Queries” on page 117
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Aggregate Query Description
Specifying the description for an aggregate query is done in the same manner as 
for a record-level query. 

Aggregate Query Naming Conventions
Just as with record-level queries, it is important to choose logical, easy-to-locate 
names for your aggregate queries. One standard approach is to follow the format: 
Data Object; Aggregate Function; Description.

You may also choose to use the actual aggregate function names such as count, 
summarize, average, minimum, and maximum in your query description.

Aggregate Query Tables
Unlike a record-level query, an aggregate query often requires fewer tables of 
information since its results do not include record-level details. There are, 
however, a few items you need to consider when identifying the tables for an 
aggregate query:
• What data will be evaluated by the aggregate function?

• Will the aggregate value be grouped by another field?
In many aggregate queries, the aggregate value is grouped by another field, 
such as sales per region or calls per product. If this type of grouping is to 
occur, be sure to identify the grouping field and to include its table in the 
query.

• Do you need to include the table that contains the e-mail address of the person 
you wish to alert?

Just like a record-level query, an aggregate query can also be designed to send an 
alert to a person who is associated with the triggered record. 

If this is the case, be sure to include the table that contains the delivery address(es) 
of the person(s) who is/are to be notified when this query is triggered.
Selecting tables for an aggregate query is done in the same manner as for a record-
level query. 

“Query Description” on page 117

Example • Opportunities; More Than 10; Overdue
• Opportunities; Average Price; Less Than $10,000
• Opportunities; Total Forecast This Month; More Than $250,000

Example You will need the call table to count support calls and the 
opportunity table to summarize (or accumulate) sales figures. 
Identify the value that the aggregate will be performed on, and be 
sure to select the table that contains that value.

Example You might wish to have an aggregate query such as ‘totals sales per 
region’ and ‘send an alert to the regional sales manager’.

“Query Tables” on page 118
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Aggregate Query Links
Linking (or joining) tables together for an aggregate query is done in the same 
manner as for a record-level query. 

Aggregate Query Columns
Unlike a record-level query where you choose columns based primarily on the 
fields of data that you wish to put in an outgoing alert message, an aggregate 
query’s columns are selected based primarily on the following two criteria:
• The field that the aggregate function will be performed on
• The group by field(s)

Aggregate Functions
CRM Studio supports five aggregate functions:
• Summarize
• Average
• Count
• Maximum
• Minimum
With the exception of the count function, all the aggregate functions must be 
applied to numeric fields only. 

Summarize
This function lets you accumulate (or total) the record amounts for a numeric 
field. It can be used for such queries as:
• Sales representatives with less than $50,000 in their pipeline
• More than 1,000 minutes of support calls this week
• Less than 500 widgets sold last month

Average
This function lets you derive the numeric average for a numeric field from 
multiple records. It can be used for such queries as:
• Sales representatives whose average sale price is less than $5,000
• Clients whose average support call is over 30 minutes long
• Suppliers who average more than 5% damaged goods

Count
This function lets you count the number of records that meet certain conditions. It 
can be used for such queries as:
• Salesreps with fewer than 10 scheduled activities this week
• Clients with more than 3 late payments this year
• More than 5 sales opportunities that are overdue for closing
The count function is handled a little differently from the other aggregate 
functions as you must always apply the count function to the field that uniquely 
identifies the records to be counted. Using the preceding three examples, this 
means that:

“Query Links” on page 119
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• For activities, you can apply the count function to the activity ID field
• For payments, you can apply the count function to the payment no field
• For sales, you can apply the count function to the sale ID field

Maximum and Minimum
The maximum and minimum functions let you identify the maximum or 
minimum record values for a numeric field. This function is for such queries as:
• The maximum sale closed last week
• The minimum order quantity this week
The following procedures outline the choosing of columns for a few different 
types of aggregate queries:

Summarize and Average

• After linking the selected tables in the Links tab of the Everest CRM Studio 
Architect - Application Events\(your company)\Query Definitions dialog 
box, click Next. You will see the Everest CRM Studio Architect - Application 
Events\(your company)\Query Definitions - Columns tab.

• From the Available Columns to Query field, double-click the numeric field 
whose value you wish to total or whose average you wish to derive. 

OR
• Select the field you wish to include and click the Add Column to Query 

button. The selected field is displayed in the Query Columns Selected grid. 

• Click in the Column Type column, for the selected row, beside the word 
‘Normal’. From the drop-down list, select either Summarize or Average.

• In the Customized Name column for the selected row, alter the name to reflect 
that this field contains an aggregate total (such as, amount_total or 
amount_avg).

• From the Available Columns to Query field, double-click the first group by 
field (such as, sales representative). This query will now total (or derive the 
average for) the amount in the first column (sales amount) and group it by the 
value in the second column (sales representative).

• If required, add more group by columns to this query.

To select columns for an aggregate summarize or average query, do the 
following:

The aggregate column should always be the first column selected.

Do not put the name of the aggregate function at the start of a 
customized name (such as, total_amount or avg_amount), as many 
ODBC drivers identify aggregate functions as reserved words and do 
not permit them to appear at the start of a customized name.
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Count

• From the Available Columns to Query field, double-click the unique or 
record-identifying column for the table whose records you wish to count. 

• Click in the Column Type column, for the selected row, beside the word 
‘Normal’. From the drop-down list, select Count.

• In the Customized Name column for the selected row, alter the name to reflect 
that this field contains an aggregate count.

• From the Available Columns to Query field, double-click the other group by 
fields you wish to include.

Minimum and Maximum
The aggregate functions minimum and maximum are configured in the same 
manner as both summarize and average. 

Additional Column Selections
Here are a few hints for choosing additional columns in your aggregate query:
Try to make your group by field as informative as possible. 

 You may wish to send the results of this query to the individuals that are 
identified within the query (i.e., if the query identifies Paul as a salesrep with a 
lower-than-expected pipeline, you may want to send an alert to Paul). To do so, 
you need to include the columns that contain the delivery address(es) that the 
alert will be sent to. (The fields that contain Paul’s e-mail address)
You can create a query with multiple aggregate fields. 

Aggregate Grouping
Consider this scenario:
You want to trigger an event if next week’s forecast sales is greater than $100,000.
Solution: Create an aggregate that summarizes all sales due to close next week.
But now consider this:

To select columns for an aggregate count query, do the following:

The aggregate column should always be the first column selected.

Example To display total sales per sales representative, you should not make 
your group by field the sales representative’s ID (which is probably 
some cryptic code), but rather the sales representative’s full name. 
This might require you to add another table to this query (such as the 
salesperson table), but it is well worth it as it will make the query’s 
output much more usable.

Example If you want to create a query to count the number of orders last 
month, and show the total of all those orders and the average order 
price, you can create a single query that uses the count, summarize, 
and average functions.
Another such example is to create a query that counts the number of 
regions whose total forecast sales for next month is below quota.
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You want to trigger an event if any sales representatives have forecast sales of 
greater than $100,000.
Solution: Create an aggregate that summarizes sales and groups them by sales 
representative.
The ability to create aggregates that group (or sort) resulting records by one or 
more specific fields is one of the most powerful aspects of aggregate queries. 
Consider how you can take an ordinary aggregate query such as total sales for 
next week and create the following just by adding one or more group by fields:
• Total sales by sales representative
• Total sales by region
• Total sales by product line
• Total sales by region and (within region) by product line
• Total sales by regional sales manager
All of CRM Studio’s aggregate functions support grouping, but grouping is most 
commonly used in summarize, average, and count aggregates.

Aggregates and Calculated Fields
Calculated fields may be used with aggregate queries in the same manner that 
they are used with record-level queries. 

For details on creating a calculated field, refer to the section “Calculated Fields” 
on page 124. Once you have created such a field, you may apply the appropriate 
aggregate function to it.

Aggregate Query Sorting Order
Sorting the order of an aggregate query’s matching records is done in the same 
manner as for a record-level query. 

Aggregate Query Filters
Consider the following condition:
Send an alert if there are more than six open, high priority support calls.
There are two levels of testing (or filtering) that need to occur in the underlying 
query. First, you need to make sure that only open and high priority calls are 
eligible to be considered by the query. This is referred to as testing the record-
level conditions and can be done by defining the query’s filters.
Second, you need to check if there are more than six open, high priority support 
calls. This is referred to as testing the aggregate condition, and is done by defining 
the query’s sub-filter.

Example • You could create a query that uses a calculated field to identify 
activities that are overdue by more than seven days, and then use 
the count function to identify the number of such activities. 

• You could create a query that uses a calculated field to identify the 
weighted value of an opportunity and then use the summarize 
function to identify the total weighted forecast for a sales 
representative.

“Query Sorting Order” on page 125
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Creating record-level filters for an aggregate query is done in the same manner as 
for a record-level query. 

Aggregate Query Sub-Filters
Sub-filters are used only with aggregate queries; they allow you to test the value 
of the aggregate condition. 

• From the Everest CRM Studio Architect - Application Events\(your 
company)\Query Definitions - Sub Filters tab, double-click the aggregate 
column you created earlier, from the list of Available Columns to Filter. The 
aggregate column is added to the Columns Selected for Sub Filtering grid.

• In the Is or Is Not column for the selected row, select the required function. 
• In the Operator column for the selected row, select the required operator.  

• In the Compare Value column for the selected row, select or enter the 
required value. The compare value field may contain a constant value, the 
value from another database field, a date substitution value, or the question 
mark. 

• CRM Studio automatically populates the Type field. This field identifies the 
type of data that this filter is processing; this can include character based (i.e., 
alphanumeric), numeric, or date-formatted data. 

• Specify the required and/or logic in the sequence of your sub-filters in the 
And/Or field.

“Query Filters” on page 126

Example By using a sub-filter, you can transform the following informational 
queries:
• Total forecast sales per sales representative next month
• Average sale price for widgets
• The number of open support calls per call agent
Into the following queries that pinpoint critical conditions:
• Total forecast sales of less than $10,000 per sales representative 

next month
• Average sale price of more than $25 for widgets
• More than 10 open support calls per call agent

To create a sub-filter for an aggregate query, do the following:

“Operators - Notes” on page 132

“Compare Values” on page 128

The Literal data type is used only if you are comparing the value of one 
column to the value of another column, or to an SQL function. 

“Comparing a Column with Another Database Field” on page 129
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• Specify an Optional Prompt if the query is parameter driven.

Aggregate Query SQL
Reviewing and/or modifying an aggregate query’s SQL syntax is done in the 
same manner as for a record-level query. 

Aggregate Query Preview
Previewing an aggregate query is done in the same manner as for a record-level 
query. 

Multi-Query Events
The use of filter parameters allows a single query to be used with various 
parameter thresholds in different events.
It is also possible, for a single event to use multiple queries. 

Each of these events requires two queries. 
• The first event requires an initial query that totals the forecast sales for the 

next quarter (to see if they are greater than $300,000), and a subsequent query 
that counts the number of sales over $20,000 (to see if there are more than 10).

• The second event requires an initial query to total a client’s pending sales (and 
see if they are less than $5,000), and a subsequent query to see if any of those 
customers have recorded more than 25 support calls.

• The third event requires an initial query to identify which clients have 
pending sales opportunities, and a subsequent query to see if any of those 
clients are also on credit hold.

The first example requires no linking between the queries; both queries merely 
need to prove true for the event to trigger.
In the second and third examples, however, it is imperative that the queries talk to 
each other; that is, data from the first query must be passed into the second query 
to determine whether there are any records that meet the conditions of both 
queries.

“Creating a Parameter-Driven Filter” on page 131

“Query SQL” on page 136

“Query Preview” on page 137

Example • An event is triggered if the total forecast sales for the next quarter 
are more than $300,000 and the count of pending sales valued at 
least $20,000 is more than 10.

• An event is triggered if a client has purchased less than $5,000 
worth of products over the last six months and has sought support 
more than 25 times.

• An event is triggered if a client has open sales opportunities in a 
CRM application and is also on credit hold in a financial 
application.
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Unlinked Multi-Query Events 
 To design more than one query to be used in a single event, you must determine 
whether the queries need to pass data between them. Consider the example given 
earlier:
• An event is triggered if the total forecast sales for next quarter are more than 

$300,000 and the count of pending sales of at least $20,000 is more than 10.
This event requires two queries, but they do not need to be linked to each 
other in any manner. Quite simply, both queries have to prove true (be 
triggered) for the event as a whole to be triggered.
An event of this nature would require you to create two aggregate queries. 
Once the queries are created, you could create the corresponding event and 
associate both queries with that event.

Linking Queries from the Same Company
When designing queries that identify more complex conditions of data, you will 
occasionally notice that you cannot configure a single query to handle every 
condition that you need it to check for.
Sometimes, this can result from a need to check for a combination of multiple 
aggregate conditions, such as:
• An event that is triggered if a client has purchased less than $5,000 worth of 

products over the last six months, and has also sought support more than 25 
times.
In this scenario, you would require one query that performs a summarize 
aggregate on a client’s sales and a second query that performs a count 
aggregate on the client’s number of support calls.
What differentiates this example from the one in the preceding section is that 
you need to take the records that result from the first query (clients who have 
purchased less than $5,000 worth of products) and ‘feed’ them into the second 
query to see if any of those clients have also called for support more than 25 
times.
This is what is meant by linking queries together; it is the process of ensuring 
that the records that are retrieved from query 1 are fed into query 2. Without 
this link, your queries would retrieve different sets of matching clients, and 
you would not be able to ascertain which clients met both conditions.

How To Link Queries from the Same Company
The first step required in linking queries from the same company is to identify the 
field of data that links records from both queries. Consider the following example 
again:
• An event that is triggered if a client has purchased less than $5,000 worth of 

products over the last six months, and has also called for support more than 
25 times.

When multiple queries are associated with an event, both queries must 
prove true (i.e., be triggered) for the event as a whole to be triggered. 
You cannot specify and/or logic for multiple queries chosen for an 
event.
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Clearly, it is the client field that links both the queries. In this case, CRM Studio 
will:
• Retrieve clients who have purchased less than $5,000 worth of products over 

the past six months.
• See if any of them have also called for support more than 25 times.
• Generate a set of clients who meet both conditions.

How To Design Linked Queries
Designing linked queries requires a couple of extra steps when creating the initial 
query (sometimes called the Link from query), and the secondary query 
(sometimes called the Link to query).
We will use the scenario detailed in the preceding section as our example in 
designing a linked query.
Design The Initial Query.

• The first query (such as Clients Who Have Purchased Less Than $5,000 worth 
of goods Over the Past Six Months) is designed just like any normal, aggregate 
query. 

• When you complete designing the query, click the Columns tab of the Everest 
CRM Studio Architect - Application Events\(your company)\Query 
Definitions dialog box.

• Ensure that you include the linking field as one of the columns for this query 
(the client ID column).

• Make a note of the Customized Name of the linking field (such as, 
CLIENTID).

• Click Save and Close.
Design The Link To Query

• The second query (such as Clients Who Have Called For Support More Than 
25 Times) is also designed just like any normal, aggregate query. 

• This query, however, requires an additional filter to restrict it to those records 
that are retrieved by the initial query. When you complete designing the 
query, click the Filters tab of the Everest CRM Studio Architect - Application 
Events\(your company)\Query Definitions dialog box.

• Select the linking field (i.e., for the Client ID field) from the Available 
Columns to Filter field.

• Click the Operator column for the row that contains the selected field, and 
select ‘equal to’ from the drop-down list.

To design the first query in the linked set, do the following:

“Aggregate Queries” on page 139

To design the query that will receive information from the first query, 
do the following:

“Aggregate Queries” on page 139
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• In the Compare Value column, enter the customized name of the linking field 
from the initial query, enclosed in curly brackets (such as, {CLIENTID}).

• Click Save and Close.
By designing the link to query in this manner, it automatically uses the results of 
query 1 as part of its selection criteria. 

Query Linking - Notes
• If you design your link to query in this manner, it executes successfully only if 

it follows a preceding query containing the appropriate customized name. Do 
not use this query alone in an event; it will not execute successfully.

• Make it a point to give your link to queries clearly identifiable names. In the 
preceding example, you might wish to call this query Clients Who Have 
Called For Support More Than 25 Times: Link To.

• In the Compare Value column, where we entered the customized name of the 
link to field, you might wish to enter a ‘?’ and make the value parameter-
driven. This allows you to test this query (by choosing a valid client ID) with 
greater ease, and you can always specify the link to field {CLIENTID} on the 
event level, when you are prompted to supply a value.

• You are not limited to just two levels of linking; you could, for example, have 
an event that checks for clients who have purchased less than $5,000 worth of 
products, have called for support more than 25 times, and whose average 
support call length is greater than 10 minutes. (This would require an event 
using three queries; you would have to link query 1 to query 2, and then query 
2 to query 3.)

Linking Queries from Different Companies
Linking queries from different company databases is one of CRM Studio’s 
unique strengths, as it enables you to check for a combination of conditions across 
multiple company databases that may have little (or no) integration between 
them.

This scenario requires one query to check for a client’s open sales, and a second 
query to see if that client is on credit hold.

How To Link Queries from Different Companies
Linking queries across companies is no different from linking queries within the 
same company. You still need to identify the common field that enables CRM 
Studio to take records from the first query and feed them into the second query.
Consider the example we are working with:
• An event is triggered if a client has open sales opportunities in a CRM 

application, and is also on credit hold in a financial application.
Clearly, it is the client field that links both queries.

Example An event is triggered if a client has open sales opportunities in a CRM 
application and is also on credit hold in a financial application.

Unlike two queries that retrieve information from the same company, you 
might have to do a little research to find a field from both companies that 
contain the same value.
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Using the previous example, you would need to locate a field containing the same 
value in both companies that uniquely identifies each client. This might be:
• The client’s account number
• The client’s phone number
• The client’s name
If the companies that you wish to link queries from, do not contain a common 
field of data, you should consider adding a field (such as an account number) to 
one or the other company.

Design The Initial Query
The first step in linking queries across companies is to design the first query in the 
linked set.

• The first query (such as Clients With Pending Sales) is designed just like any 
normal, record-level query. 

• When you complete designing the query, click the Columns tab of the Everest 
CRM Studio Architect - Application Events\(your company)\Query 
Definitions dialog box.

• Ensure that you include the linking field as one of the columns for this query 
(such as, Account Number).

• Make a note of the Customized Name of the linking field (such as, 
ACCOUNTNO).

• Click Save and Close.
Design The Link To Query

The second step in linking queries across companies is to design the query that 
will receive information from the first query.

• The second query (such as Clients On Credit Hold) is also designed just like 
any normal, record-level query. 

• This query, however, requires an additional filter to restrict it to only those 
records that are retrieved from the initial query. When you complete 
designing the query, click the Filters tab of the Everest CRM Studio Architect 
- Application Events\(your company)\Query Definitions dialog box.

• Select the linking field (i.e., for the Client ID field) from the Available 
Columns to Filter field.

The fields with common data need not have the same name; i.e., a field 
could be called client ID in one company and account number in another. 
As long as they contain the same value, CRM Studio can successfully link 
the queries.

To design the first query in the linked set, do the following:

“Aggregate Queries” on page 139

To design the query that will receive information from the first query, 
do the following:

“Aggregate Queries” on page 139
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• Click the Operator field for the row that contains the selected field, and select 
‘equal to’ from the drop-down list.

• In the Compare Value column, enter the customized name of the linking field 
from the initial query, enclosed in curly brackets (such as, {ACCOUNTNO}).

• Click Save and Close.
By designing the link to query in this manner, it automatically uses the results of 
query 1 as part of its selection criteria. 

“Query Linking - Notes” on page 150
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Who is a CRM Studio Subscriber ?
A CRM Studio subscriber is a person who is eligible to receive notifications about 
triggered events. Another word for a subscriber would be alert recipient. 
Subscribers may receive notifications via e-mail, fax, page, webcast and FTP 
(copied files).

Eligible Subscriber
Although most organizations think of using CRM Studio to send alerts to 
members of their own organization (employees), CRM Studio’s ability to send 
alerts surpasses that, to include such people as business partners, vendors and/or 
suppliers, customers, and prospects.
As you configure CRM Studio subscribers it is important to consider the types of 
events that you will be configuring and who the potential recipients of those 
events will include.

Using CRM Studio for Target Marketing
Since CRM Studio has this remarkable ability to reach out to a wide range of 
people in the business populace, it is well worth considering it as an aid in your 
direct marketing strategies.
Consider the following scenarios:
• Notify a client who is ‘x’ dollars away from being eligible for a bonus 

program.
• Notify a prospect of a limited-time offer about to expire.
• Notify all clients using product ‘x’ about a new add-on module ‘y’.
These are examples of events whose purpose is to keep clients and prospects 
better informed about marketing-related activities that are occurring within your 
organization. 
As you go through the configuration of subscribers, think upon how CRM 
Studio’s ability to intelligently (and selectively) contact customers and prospects 
alike can impact the success of your organization.

Designating a Computer as a Subscriber
In addition to setting up people as subscribers, CRM Studio also allows you to 
designate one or more computers as the recipients of information when an event 
is triggered.
Using CRM Studio’s FTP (copy) delivery method, you can instruct CRM Studio 
to move certain files and/or reports to specific disk and directory specifications 
on one or more computers when an event is triggered. 
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How Are Subscribers Categorized
You can categorize subscribers according to similar areas of work by creating 
subscriber groups.

There is no limit to the number of subscriber groups that can be configured within 
CRM Studio; so too can you create nested groups of subscribers, such as:
• Engineering
• Development

- New Products
- Maintenance

• Quality Assurance
• Documentation
One of the benefits of subscriber groups is that instead of configuring an event to 
send an alert to a multitude of users (each of whom you select manually), you can 
do so for all the members of one or more groups. 

Subscriber Alert Methods and Addresses
Each subscriber can be configured to receive alerts via:
• E-mail
• Fax
• Pager
• FTP (called Copy)
• Webcast
Additionally, each subscriber may have up to two delivery addresses per delivery 
method. The reason for this is to allow a subscriber to have different delivery 
addresses based on the time of day and day of the week.

Within CRM Studio, these two delivery addresses (per delivery method) are 
referred to as the primary and secondary addresses. If a subscriber does not have 
a secondary address for a given delivery method, you may wish to use the 
primary value in both the primary and secondary fields.

Example You might wish to create the following subscriber groups:
• Engineering
• Customer Service
• Executives
• Sales
• Clients in the State of California
• Prospects

A single event can send alerts to any combination of individual subscribers 
and groups of subscribers.

Example An employee named John Smith of Acme Incorporated may wish to 
receive e-mail alerts occurring between 8 AM and 5 PM, Monday 
through Friday at smith@acme.com. But outside of those hours and 
days, he may wish to receive e-mail alerts at jwsmith@hotmail.net.
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A Note About Webcasting
CRM Studio contains an alert method called “webcasting” – this is the ability for 
CRM Studio to generate alert messages and post them to a web page as opposed 
to (or in addition to) sending the messages via e-mail, fax, or pager.
The webcasting component of CRM Studio requires its own configuration and 
set-up for each recipient (or group of recipients) who will be receiving alerts via 
the web. The following pages will not discuss webcasting, as it is detailed in a 
separate chapter, ‘Webcasting’. 

Subscriber Entry Methods - Overview
There are three ways to configure subscribers within CRM Studio. You may 
choose to use one or any combination of these methods:
• Manual entry
• Subscriber import
• Subscriber linking

Manual Entry
CRM Studio contains a Subscriber Maintenance option which allows an 
authorized user to manually add, change, and delete subscriber profiles.

Subscriber Import
If you have a subscriber data that resides in one or more tables (within one or 
more ODBC-compliant databases), you can import that data into the CRM Studio 
subscriber database. Here are a few important notes about importing subscriber 
data:
• Data can be imported from multiple sources. 

• The table whose data you wish to import must itself reside within an ODBC-
compliant database.

• You can import data as often as you wish, but the import process is done 
manually (you cannot schedule it).

• Imported data should include a subscriber’s name and some information 
about the delivery addresses (such as the e-mail address).

Subscriber Linking
Linking to a subscriber database is very similar to importing subscriber data, 
except that instead of transferring data from an external application into CRM 

“Manually Entering Subscribers” on page 161

Example You might wish to import data from a users’ table within a sales 
application, from an employees’ table within a financial 
application, and from a suppliers’ table within a manufacturing 
application.

“Importing / Linking Subscribers” on page 165
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Studio, the linking function allows CRM Studio to directly read subscriber 
details from a table in another database.
Subscriber linking is very powerful as it rules out the need to maintain subscriber 
data within CRM Studio; subscriber data maintained in external applications 
(such as in sales, finance, or manufacturing applications) is available for use 
within CRM Studio.
This function is referred to as a dynamic link because CRM Studio retrieves the 
appropriate subscriber information (from the corresponding database(s)) at the 
precise moment when an event is triggered, and an alert message needs to be 
delivered to that subscriber. This ensures that CRM Studio always has the most 
up-to-date subscriber data to use with triggered events.
Linking subscriber data from an external database follows much the same 
guidelines as importing subscriber data.

Subscriber Definition - Preparation
The following steps should be followed in preparation for creating subscriber 
records.

Identify Means of Entry
The first step is to identify the means by which subscriber data will be entered 
into CRM Studio. As previously outlined, your choices are:

- Manual entry
- Import
- Link

Depending on the method you choose, you will need to follow the instructions in 
the following sections.
• Manual Entry
If you enter subscriber records via manual entry, you need to gather the following 
information for each subscriber:

- Subscriber’s name, company name, and title
- Subscriber’s primary and secondary e-mail, fax, pager, and FTP addresses
- The days of the week (and hours of the day) when the subscriber will 

receive alerts via the primary or the secondary method. 

• Imported / Linked Entry
If you enter subscriber records via the Import or Link methods, you need to do 
the following:

- Make sure the database that includes the external subscriber data is 
defined as a company within the Everest CRM Studio Architect.

“Importing / Linking Subscribers” on page 165

A subscriber can have different days and hours for the primary and 
secondary addresses of each delivery method.

“Add an Everest Company” on page 25
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- Identify the fields within the external subscriber table that contain the 
subscriber’s name, company name, title, and primary and secondary e-
mail and FTP addresses.

- Identify the days of the week (and hours of the day) when the subscriber 
will receive alerts via the primary or the secondary method.

Subscriber Entry Worksheets
You can use the worksheets provided in the chapter ‘Worksheets’ to help you 
identify the necessary elements required for the creation of CRM Studio 
subscribers.

Subscriber Maintenance
Once you compile the subscriber data (in the worksheets), you are ready to go 
into the Everest CRM Studio Architect and configure subscriber data.
Log in to the Everest CRM Studio Architect (path: CRM > CRM Studio > 
Architect). You will see the Everest CRM Studio Architect dialog box. The Event 
Management Folders panel in the center, comprises two branches:
• Application Events
• Subscribers
Double-click Subscribers to display the list of pre-configured subscriber groups.

 Figure 5.1: Everest CRM Studio - Subscriber Branches

“Subscriber Entry Worksheets” on page 364
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Subscriber Group Maintenance
You can organize your subscribers into logical groups; each group can contain 
individual subscribers, or one or more other groups.
Although you can add subscribers to the pre-configured groups defined within 
CRM Studio, you can also create and modify additional groups of your own. 

Adding a Subscriber Group

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• Click the Event Management Folders panel in the center and click 
Subscribers. Under Subscribers, you will see two branches: Computers and 
Users.

• To add a new group of computers (that will be eligible to receive alert 
content), click Computers. To add a new group of users (who will be eligible 
to receive alert messages), click Users.

• To add a group within a group, click the name of the group within which you 
wish to add a new group. 

• Click the New Group button at the top-left of the Everest CRM Studio 
Architect dialog box. You will see the Everest CRM Studio - Properties dialog 
box.

• In the Description field, enter a name or description of the new group and 
click OK.

Changing a Group’s Name

• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Subscribers.

• Click the group whose name you wish to change.
• Click the Properties button at the top-left of the Everest CRM Studio 

Architect dialog box. You will see the Everest CRM Studio - <branch name> 
Properties dialog box.

• In the Description field, enter a new name or description for the group and 
click OK.

If you plan to import and/or link to subscriber data, you should create 
additional subscriber groups for each link or import.

To add a subscriber group, do the following:

Example Add a group called West Coast Team under the Sales Team group.

To change the name of a subscriber group, do the following:
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Deleting a Subscriber Group

• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Subscribers.

• Click the group which you wish to delete.
• Click the Delete button at the top-left of the Everest CRM Studio Architect 

dialog box. 
• You will be prompted for confirmation. Click Yes.

Adding and Updating Subscribers

Manually Entering Subscribers
The first method of adding and maintaining subscribers in the CRM Studio 
database is through manual entry. You can configure the CRM Studio subscriber 
database to include a combination of manually-entered subscribers, imported 
subscribers, and linked subscribers.

Add a Subscriber (Computer)

• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Subscribers.

• To add a new computer subscriber (that will be eligible to receive alert 
content), click Computers, or the appropriate group within that branch.

• Click the New Computer button at the top-left. You will see the Everest CRM 
Studio - Subscribers\Computers\(group name) dialog box.

• Enter the relevant details for the computer, and click Save and Close.

Add a Subscriber (User)

• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Subscribers.

Before deleting a subscriber group, make sure no events are configured to 
send alerts to anyone within that group, or to the group as a whole. Also 
be certain to check if the subscriber group is either linking or importing 
subscribers, and remove the import or link before deleting the subscriber 
group.

To delete a subscriber group, do the following:

Even if you do not intend to enter subscribers manually into the CRM 
Studio database, it is recommended that you review the following sections.

To add a computer as a subscriber, do the following:

“The Everest CRM Studio - Subscribers\Computers\(group name) 
Dialog Box - Description” on page 162

To add an user as a subscriber, do the following:
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• To add a new user subscriber (who will be eligible to receive alert messages), 
click Users, or the appropriate group within that branch.

• Click the New User button at the top-left. You will see the Everest CRM 
Studio - Subscribers\Users\(group name) dialog box.

• Enter the relevant details for the user, and click Save and Close.
The Everest CRM Studio - Subscribers\Computers\(group name) Dialog 
Box - Description

 Figure 5.2: Everest CRM Studio - Subscribers\Computers\(group name) - 
Description

Internal ID Number
This field displays the ID of the computer subscriber. You cannot modify it.
Computer Name
Enter the name of the computer.
Computer Description
Enter a description for the computer.
IP Address
Specify the IP address of the computer.
User Lookup Key
Specify a unique value/code that identifies this computer for the purpose of 
linking it to a database record.

Active
Be sure to check this box.

“The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - Description” on page 34
“The Everest CRM Studio - Subscribers\Users\(group name) Dialog 
Box - E-mail” on page 38

“User Lookup Key” on page 35
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Use a Group Lookup Key
CRM Studio can also look at a field within a database record and identify the 
value of that field as equating to a CRM Studio subscriber group.

To do so, you simply have to make sure that the group names that exist in your 
support application are reflected (exactly) in the names of CRM Studio subscriber 
groups. (CRM Studio is case-sensitive.)
Thus, if an event detects that two out of the four support groups have more than 
20 open calls, CRM Studio attempts to search for the two groups in the subscriber 
group names. On finding a match, it sends alerts to every member of those 
groups.
Copy Method - Notes
The “copy” method allows CRM Studio to move files and Crystal Reports (both 
of which may be attached to triggered events, or scheduled on a periodic basis) to 
specific locations. The copy location should be specified using standard UNC 
format (as in “//computername/sharename”). You may also specify an FTP 
address, using the format “ftp://username:password@ftp.location.net/
directory_name.”
Paging Method - Notes
Before you can configure a subscriber to receive alerts via pager, you must 
configure CRM Studio to integrate with the various paging services that your 
organization uses. The configuration of these paging services consists of defining 
such information as the paging service vendor name, the access (or TAP) phone 
number for the paging service, an optional access password, and other modem 
configuration settings. 
Once you have defined these services, you may then go into a subscriber record 
and select a valid paging service, as well as that subscriber’s individual personal 
identification (or PIN) number.
Webcasting Method - Notes
The “webcasting” alert message delivery method requires a separate set of steps 
that you need to take in order to configure the webcasting module. 

Create a Template Subscriber Record
For organizations that manually enter subscriber records, it is evident that there 
are certain fields of data that remain the same from one subscriber to the next – 
fields such as company, active, and (most importantly) the grid that lists the 
delivery address to use for different dates and times.
Instead of editing each record you create, you can establish (one or more) 
subscriber templates and then use those templates each time you add a 
subscriber.

Example An organization might have four support groups and an event that 
identifies any group that has more than 20 open calls. If a group has 
more than 20 calls, you can send an alert to all the members of the 
corresponding CRM Studio subscriber group.

To create a subscriber template, do the following:
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• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Subscribers.

• Click Users, or the appropriate group within that branch.
• Click the New User button at the top-left. You will see the Description tab of 

the Everest CRM Studio - Subscribers\Users\(group name) dialog box.
• Enter ‘Template’ in the Last Name field and ‘User’ in the First Name field.
• Modify the fields in the Copy and E-mail tabs to reflect the common values 

that should be used in all new users. 
• Click Save and Close. 
The next time you create a subscriber and wish to use that template, simply copy 
that template instead of creating a user from scratch.

Copy Subscribers
Since many subscribers can be similar in design, it becomes important to know 
how to copy a subscriber record into another. 

• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Subscribers.

• Click Users (or the appropriate group within that branch). You will see all the 
subscribers displayed in the panel on the right.

• Highlight the subscriber you wish to copy and select Edit > Copy. 
• Select Edit > Paste. A duplicate of the subscriber appears in the right panel. 
• Open either of the two (identical) subscribers and modify it as needed. Ensure 

that you change the subscriber’s first and last names.

Delete Subscribers
Before deleting a subscriber, you should make sure that there are no events that 
send alerts to the subscriber. 

• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Subscribers.

• Click Users (or the appropriate group within that branch). You will see all the 
subscribers displayed in the panel on the right.

• Highlight the subscriber you wish to delete, and click the Delete button at the 
top of the Everest CRM Studio Architect dialog box.

Or
• Open the subscriber you wish to delete, and click the Delete button at the top 

of the Everest CRM Studio - Subscribers\Users\(group name) dialog box.

“Copy Subscribers” on page 164

To copy one subscriber to another, do the following:

To delete a subscriber, do the following:

There is no Undo option once you have deleted a subscriber.
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Scroll Quickly Through the List of Subscribers
In some instances, you might need to scroll sequentially through a list of 
subscribers (to activate/de-activate a series of subscribers by selecting/
deselecting the Active check box in the Description tab of the Everest CRM 
Studio - Subscribers\Users\(group name)\ dialog box). Although you could 
select each subscriber individually, edit it, save it, and then select the next 
subscriber, there is a faster way to achieve this.

• Once you have selected and edited your first subscriber, click the Previous or 
Next buttons at the top of the Everest CRM Studio - 
Subscribers\Users\(group name) dialog box. 

• If you have made changes to the current subscriber, you will be prompted to 
save (or abandon) your changes before proceeding. 

Importing / Linking Subscribers
The second and third methods of adding and maintaining subscribers is by 
importing or linking the subscribers from an external database to the CRM 
Studio database.
The configuration for importing versus linking subscribers in CRM Studio is 
almost identical; the only difference is that the import function actually transfers 
the data from an external application into CRM Studio, and the link function 
maintains a live link between the subscriber fields in the external application and 
the corresponding fields within CRM Studio. Follow the steps listed below to 
import or link subscribers:
• Create the import or link query
• Create the import or link group
• Activate the import link function
• Choose the import or link query
• Map the subscriber fields
• Choose either to link or import the subscriber records
These steps are detailed in the following sections.

Create the Import / Link Query
To import subscribers from (or link CRM Studio to) subscriber data in an external 
database, you need to have a means of retrieving the necessary data. This is done 
via a CRM Studio query.
You must design a CRM Studio query that retrieves the subscriber-related fields 
of data from your external application. The fields of data that you will need to 
retrieve (if available) are:
• Subscriber full name, last name, and first name.
• Subscriber title, company name, and phone number.
• Subscriber’s primary and secondary e-mail address(es), fax number(s), 

preferred copy locations, pager service TAP number and PIN, and (if 
applicable) preferred webcast locations.

To quickly scroll through subscribers, do the following:
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The corresponding query should be designed like any normal, record-level query. 
Typically the query includes just the one table that contains subscriber data, and 
the fields shown in the previous list. It may or may not contain filters.

To import or link to only those users with an active status, you could add a filter 
that performs this restriction.
It is important to preview this query to be sure that it retrieves the precise records 
you wish, along with the specific fields of subscriber data that you require.

Create the Import / Link Group
For each group of subscribers that you are importing or linking to, you should 
create a separate subscriber group. 

Activate the Import Link Function
Once you create the query that will retrieve the external subscriber data as well as 
the subscriber group that will contain the individual imported or linked 
subscriber records, you are ready to begin the import or link process.

• Highlight the name of the group that will contain the imported or linked 
subscribers.

• Click the Properties button at the top of the Everest CRM Studio Architect 
dialog box. You will see the Everest CRM Studio - (group name) Properties 
dialog box.

• Click the Subscriber Linking button. You will see the (group name) 
Subscriber Linking dialog box.

“Record-Level Queries” on page 117

Example If you are importing user data from an application called Sales First, 
you might wish to create a group called Sales First Users into which 
those subscribers will be placed.

A subscriber group that does a link or import also allows you to manually 
add additional subscribers to that group. Thus, you could have a Sales First 
Users group that imports 100 subscriber records from the Sales First 
application and yet, include six manually-entered subscriber records.

To import or link subscribers, do the following:
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The Everest CRM Studio - (group name) Properties Dialog Box

 Figure 5.3: Everest CRM Studio - (group name) Properties
Select Query
Click this button to select the query that will allow you to import/link 
subscribers.
Subscriber Linking Field Definition
Subscriber Field
This (left) panel displays a list of all of CRM Studio’s subscriber data fields.
Linked to Database Field
This (right) panel enables you to choose the field to be mapped from the related 
query to an individual field within CRM Studio.

Choose the Import or Link Query
The next step is the selection of the query that you designed earlier to retrieve the 
subscriber data from an external database. 

• From the (group name) Subscriber Linking dialog box, click the Select Query 
button. You will see the Everest CRM Studio - Select Another Application 
dialog box, displaying all the companies that are currently defined within the 
Everest CRM Studio Architect.

• Since you can import or link to subscribers from any company or application 
that is defined in CRM Studio, you first need to choose which application 
your query is associated with. Select the appropriate application and click 
Select. You will see the Everest CRM Studio - Add Query dialog box, 
displaying a list of queries for that application.

To select the import or link query, do the following:

“The Everest CRM Studio - Add Query Dialog Box” on page 63
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• Select the query designed to retrieve subscriber data.
Your next step is to map fields from your query to the corresponding fields in the 
CRM Studio subscriber database.

Map the Subscriber Fields
Now that you have chosen your query, you have to specify which fields in your 
query equate to specific fields in the CRM Studio subscriber database, using the 
Everest CRM Studio - (group name) Properties dialog box.

• From the row that contains the Subscriber Field you wish to map data to, 
move to the corresponding row in the Linked to Database Field panel. 

• Click in this row, and from the drop-down list choose the query field whose 
value you wish to map.

Choose to Link or Import
Once you finish the mapping process as detailed in the previous step, CRM 
Studio assumes that you wish to link subscriber records; that is, it will maintain a 
live link between this group of subscribers and the external database from which 
they were retrieved, so that any changes made to those subscribers in the external 
database will automatically be reflected within CRM Studio.
This also means that anytime CRM Studio needs to send an alert to one of these 
individuals, it will perform a link to the external database to retrieve that person’s 
most up-to-date address information.

• From the (group name) Subscriber Linking dialog box, click the Remove 
Subscriber Link button. You will see the (group name) Remove Subscriber 
Link dialog box.

• Select the second option (I would like to remove the subscriber link but leave 
the subscribers for this group in the database).

• Click OK. The live link is removed, but the subscribers whom you imported 
remain for you to send alerts to, and to maintain within CRM Studio.

“The Everest CRM Studio - (group name) Properties Dialog Box” on 
page 167

To map a specific query field to a subscriber data field, do the following:

The same query field may be mapped to multiple fields within the CRM 
Studio subscriber database. If your query contains only a single E-mail 
Address field, you should map it to both the CRM Studio subscriber E-
mail Address 1 and E-mail Address 2 fields.

If you do not wish CRM Studio to maintain such a link, but want records 
to be imported into the subscriber database, do the following:

You must save your subscriber link data before removing the link. This 
enables CRM Studio to import the corresponding subscriber records 
(executed by the save function). Thereafter, you may go back into the 
subscriber linking option and remove the link.
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Save the Link
When you save a subscriber link, CRM Studio automatically executes the link 
and retrieves the corresponding subscriber records from your external database. 
These records are displayed in the right panel of the Everest CRM Studio 
Architect dialog box.

Removing a Subscriber Link
When you remove a subscriber link, you have the option to retain the details of 
the individual subscribers, or remove both the link and the details of all 
corresponding subscribers.

• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Subscribers.

• Click Users. Highlight the subscriber group you wish to delete and click the 
Properties button at the top of the Everest CRM Studio Architect dialog box. 
You will see the Everest CRM Studio - (group name) Properties dialog box.

• Click the Subscriber Linking button. You will see the (group name) 
Subscriber Linking dialog box.

• Click the Remove Subscriber Link button. You will see the (group name) 
Remove Subscriber Link dialog box.

• Select the first option (I would like to remove the subscriber link and all 
subscribers in this group from the database.).

• Click OK.

Editing Imported or Linked Subscribers
If you create a group of imported subscribers (i.e., you create the link, retrieve the 
subscribers, and then remove the link but retain the subscribers), you can edit and 
modify those subscriber records just like any manually-entered subscriber record.
If you create a group of linked subscribers, however, only the grids of alert hours 
and days are available for editing. All the other fields of subscriber data appear 
gray, indicating that their values are being retrieved from an external database 
and thus, are unavailable for editing from within CRM Studio.

Creating Intelligent Subscriber Groups
Using CRM Studio queries you can create intelligent groups of subscribers. 

The linking or importing process may take a few seconds to execute. You 
will see an informational message at the bottom left-hand corner of your 
window telling you that the linking is in process, after which the 
corresponding subscriber records will appear.

To remove both the link and the related subscriber data, do the 
following:

Example • Clients in the state of California
• Prospects in the banking industry
• Suppliers who have pending back orders
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All these groups simply utilize queries that are designed to retrieve a specific sub-
set of records. Be careful about creating overly-complex subscriber groups, as 
CRM Studio evaluates the members of a group when an event is executed. An 
overly-complex subscriber query that runs through a database of thousands (or 
millions) of records could significantly slow down the execution time of that 
event.
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What is a CRM Studio Event?
A CRM Studio event is an object that uses one or more queries to test if certain 
conditions exist in an underlying database, and (if the test proves true) it executes 
corresponding alerts and other actions in response to the triggered condition. 
Events can generally be divided into the following five components:
• Query(ies): The condition that must occur for the event to be triggered.
• Alert Message Text: The messages that will be sent if the event is triggered.
• Actions: The actions (such as updating data within a company database) that 

will be executed if the event is triggered.
• Subscribers: The people who will be notified about a triggered event, and the 

method(s) by which they will be notified.
• Schedule: When (and how often) CRM Studio will check for the event’s 

specified conditions.
The following sections provide an overview of each of these components.

An Event’s Query(ies)
The means by which an event determines whether a specific condition has been 
met is through the use of one or more queries. A single event may use a single 
query or multiple queries, depending on the complexity of the condition that it 
has to check for. 
Additionally, a single query may be used in one or more events. Depending on 
how a query is designed (if the query uses parameter-driven filters), the person 
configuring the event may be prompted to specify certain threshold values (such 
as a date range or minimum numeric value) for the query, relative to the specific 
event that is being configured.

An Event’s Alert Message Text
Once you specify the query(ies) that an event will use to identify whether a 
specific condition has occurred, you may begin to design the text and format of 
the alert messages that CRM Studio will send when that event is triggered.
CRM Studio allows you to specify the alert message text and format for messages 
sent via:
• E-Mail
• Fax
• Pager
• Webcast
Additionally, it lets you specify that the contents of one or more files and Crystal 
Reports will also be sent along with an alert message.
All the fields of data that were selected as columns in an event’s associated 
query(ies) are made available for placement within the text of an alert message.

“Queries” on page 111
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An Event’s Actions
In addition to sending alert messages, CRM Studio can also execute one of five 
actions when an event is triggered. These actions are:
• Write triggered event data to an external (flat) file.
• Use triggered event data within one or more SQL statements.
• Use triggered event data within one or more executable programs.
• Use triggered event data within one or more Visual Basic (VB) scripts.
These actions are most typically used when an organization wishes to add or 
update records within a database as the result of an event being triggered.

An Event’s Subscribers
If an event will be sending alert messages to one or more people, you need to tell 
CRM Studio who those people are, and via what method they will be receiving 
their notifications. In CRM Studio, an alert recipient is referred to as a subscriber, 
who may receive alerts via any one – or any combination – of the following 
methods:
• E-Mail
• Fax
• Page
• Webcast
• Copy (FTP)
As detailed in the chapter Subscriber Maintenance, each event may be 
configured to send alerts to individual users, groups of users, and one or more 
computers (for the purpose of transferring files).
Additionally, events may be configured so that they automatically notify pre-
defined subscribers, or one or more people based on information in the database 
record that is causing the event to trigger. 

An Event’s Schedule
The final component of an event is its schedule; this lets you determine how often 
CRM Studio must check to see if the event is triggered. Each event has its own 
schedule. Some very critical events may have a very frequent schedule (such as 
‘every five minutes’), whereas, less critical events may be checked less frequently 
(such as once a day, week, or month).
CRM Studio can check for events as frequently as every minute. If an 
organization needs CRM Studio to trigger an event just when it occurs, it can use 
any of the two APIs (VB scripting and Microsoft COM) to accommodate this.

Checked Versus Triggered Events
As you begin to work with events, you will come across frequent references to an 
event being checked or triggered. It is, therefore, imperative that you understand 
the difference between these two functions.

Example Notify the support representative to whom an overdue call is 
assigned.
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• An event that is checked simply indicates that CRM Studio has successfully 
executed the event and has ‘checked’ to see if the corresponding condition 
proves true. The condition may or may not have proven true.

• An event that is triggered is one that has been checked and whose condition 
has proven true.

Monitoring the Status of Events
When an event is triggered, you can use the Everest CRM Studio Event Monitor 
(path: CRM > CRM Studio > Monitor) to track the status of the event’s execution.

 Figure 6.1: Everest CRM Studio Event Monitor
From the far left panel, select Application Events. Alternatively, you can also 
select it from the tree view under Monitor Folders. From here, you can track:
• Events for which execution is pending.
• Events that have been Checked but not triggered.
• Events that have been checked and Triggered.
• Events with Errors that have failed to complete successfully.
If an event fails to complete successfully because of an error, you can correct the 
event, mark it as complete, or manually delete this run of the event. 

An Event Without a Query
Consider the following scenarios:
• Every day at 2:00 PM you want to send an e-mail reminder to your VP of 

Marketing to look at your company’s newsgroup.

If an error in event is due to error in its configuration, you can modify the 
event and/or corresponding query(ies), and CRM Studio automatically 
uses the modified version the next time it runs that event. CRM Studio 
automatically attempts to re-submit an erroneous event every minute.
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• Every Monday at 8:55 AM you want to send a mail message to all managers to 
attend the 9:00 AM staff meeting.

• Every day at 5:00 PM you want to transfer an orders file to a specific database 
server.

• Every Friday at 6:00 PM you want to send an alert that the system backup will 
start at 6:30 and so people must have logged off.

These scenarios represent a special kind of event – an event without a query.
CRM Studio lets you create such events - events that send messages, execute 
programs or scripts, or procedures that simply must occur at a specific time. The 
only difference between an event such as this and a normal event is that there is 
no query associated with these events.

Before You Begin
Before you begin designing events, you should take the following preparatory 
steps:
Query Design: Since an event uses one or more queries to identify underlying 
database conditions, you must create your queries prior to creating events.
Subscriber Maintenance: Since an event also allows you to specify whom the 
alerts should be sent to, you should have (at least) one subscriber defined within 
your subscriber database.
E-Mail Sending Account: For sending e-mail alerts from an event, you must 
define (in the Everest CRM Studio Administrator) the e-mail account that CRM 
Studio should use when sending these messages.
Ensure that you have completed these steps prior to designing events.

Event Designing: Preparation
We recommend that you read through the entire chapter on Query Designing 
before proceeding any further.

Identify Purpose of Event
The first step is to identify the overall purpose of an event. 

Identify Related Query(ies)
Since every event uses one (or more) queries to identify a specific condition of 
data, you need to specify the name(s) of the query(ies) that this event should use. 

Identify Content of Alert Message(s)
This step was completed when designing the query. If not, you must now design 
the corresponding message for e-mail, fax, pager and webcast alerts.

Some of the steps listed in the following sections refer to information 
already identified on your query-level worksheets.

Example To send an alert to the account manager when a ‘critical’ service call is 
logged for one of the customers.

Example To accommodate an event such as the one described above, you might 
select a query called:
Support Calls; Open; Priority ‘x’
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Identify Alert Action(s)
In addition to sending alert messages, CRM Studio events can execute actions 
that include (but are not limited to) adding or updating data within a company’s 
database.
Although these actions require some additional event configuration, it is 
important to identify the action(s) you wish the event to execute so that you can 
see which of CRM Studio’s action options you need to invoke.
Identify Subscribers
If an event is to send out alert messages, you should be able to identify the 
individuals (or groups) who will be the recipients of those messages. There are 
three items to keep in mind when considering subscribers:
• A subscriber can be an individual or a group of individuals.
• A subscriber can be a computer (if it is to receive a file or report).
• A subscriber can be a specific person (John Smith), or it can be a person related 

to a database record (the representative assigned to the overdue call).
For each subscriber or group of subscribers that you identify, you need to indicate 
whether they will receive notifications via e-mail, fax, pager, webcast, or copy/
ftp. Remember that a subscriber may be alerted via any one, or both of these 
methods.
Identify the Schedule
The final step in preparation to creating an event is the identification of the 
frequency with which CRM Studio will check if the event’s conditions are met. 
Schedules can be as often as every minute, or as infrequently as once a year.

Event Design Worksheets
You can use the worksheets provided in the chapter ‘Worksheets’ to help you 
make the event set-up process quick and smooth. Once you become familiar with 
the event creation process, you can probably forego the use of these worksheets, 
and design the events directly in the Everest CRM Studio Architect.

Accessing the Event Designer in CRM Studio
Once you have the information that you need to begin designing events, you are 
ready to go into the Everest CRM Studio Architect and create such an event.

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

An event without an associated query is executed (and triggered) every 
time the event is run.

“Event Design Worksheets” on page 368

To access the Event Designer in CRM Studio, do the following:

When you log in for the first time, the ASC database is updated with the 
latest EventPak.
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• Select Application Events from the tree view under Event Management 
Folders. You will see all the companies that CRM Studio is currently 
configured to integrate with.

• Select the company for which you want to design events and click Events 
under it. You will see a list of events (if already created) in the right panel.

• Click the New Event button at the top-left. You will see the Everest CRM 
Studio - Application Events\(your company)\Events dialog box, using 
which you can design events for the selected company.

Record-Level Versus Aggregate Events
As was detailed in the chapter ‘Query Designing’, there are two basic types of 
queries; record-level queries and aggregate queries. Although the design of these 
two types of queries differs significantly, they are both utilized in the same 
manner within events. The following pages detail the creation of an event using 
either a record-level or an aggregate query.

Creating an Event

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Management Folders panel, select Application Events > 
(your company) > Events.

• Click the New Event button at the top-left. You will see the Everest CRM 
Studio - Application Events\(your company)\Events - Description tab.

• In the Event Description field, enter a description of the event you are 
creating. 

• If this event is meant to be dynamically triggered from within an external 
company (using one of CRM Studio’s APIs [VB script or Microsoft COM 
object]), enter a unique identifying value in the Lookup Key field. 

• Select a value from the Priority drop-down list, depending on the importance 
of the event.

• Ensure that the Active check box is selected.

To create an event, do the following:

“User Lookup Key” on page 35
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Description

 Figure 6.2: Everest CRM Studio - Application Events\(your company)\Events - 
Description

Internal ID Number
This field displays the ID of the event. You cannot modify it.
Event Description
Enter a brief description of the event being defined.
Lookup Key (Optional)
If this event is meant to be called from within an external company, enter a 
unique identifying value in this field.
Priority
This field is used to set the priority for events when multiple events are scheduled 
to be submitted at the same time. The event with the highest ranking priority 
(priority ‘0’ being the highest) will be submitted first.
Active
Ensure that this box is checked.

Repeat notification for triggered items
Select this option to send repeated alerts until the condition that triggers the 
sending of notifications no longer exists.

Keep only last checked record in Monitor
Select this option to retain the history of an event the last time it was checked, and 

If you leave this field blank, CRM Studio configures the event but will not 
submit it.

“Repeat Notification for Triggered Items” on page 180
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each time it was triggered.

Repeat Notification for Triggered Items
As an alert messaging application, CRM Studio identifies conditions that trigger 
the sending of notifications. Depending on the condition, however, an alert 
recipient might wish to receive just one alert about the related condition, or 
repeated alerts until the condition no longer exists.
Consider the following two examples:
A sales representative is notified at the end of every day about activities that are 
overdue for completion. If an activity due on Monday is still open on Tuesday, 
the representative is alerted. If it is still open on Wednesday (or beyond), the 
representative continues to receive an alert every day until the activity is closed 
(or is otherwise modified to be no longer overdue).
A CRM Studio event runs every hour to check if any clients with pending sales 
opportunities are also on credit hold. If such a condition exists, the corresponding 
account manager is notified. Account managers needs to be notified only once for 
each client who meets these conditions (i.e., don’t send alerts every hour about 
the same clients).
Select this option if the recipients of an event wish to be notified repeatedly about 
an individual record until that record no longer meets the event’s criteria.

Keep Only Last Checked Record in Monitor
As CRM Studio submits an event, the Everest CRM Studio Event Monitor keeps 
track of when the event was submitted, and whether it was successfully executed 
and triggered.
In many cases, an event is checked many times before it is triggered. For example, 
an event that performs an hourly check for clients who not only have pending 
sales opportunities but are also on credit hold, may run for many hours, days, or 
even weeks before it is triggered.
In the Everest CRM Studio Event Monitor, you will automatically see the history 
of an event every time it was triggered. Additionally, you can retain (and view) 
the history of an event every time it was checked – regardless of whether it was 
triggered as well. 
Especially in the case of frequently-checked events (such as those that run every 
few minutes), the history that can pile up in the Everest CRM Studio Event 
Monitor can be quite extensive. 
Although there is no limit to the amount of history that you can retain, the process 
of scrolling through a list of each submission of a given event can be tedious.

“Keep Only Last Checked Record in Monitor” on page 180

This option is enabled only if a query for this event has a Unique field 
identified within it. If no Unique field is identified, CRM Studio has no way 
of remembering the records that have previously been triggered, and thus, 
it continues to send out alerts until a record no longer meets that event’s 
criteria. 

“Unique Field” on page 123
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Select this option to avoid retaining the history for every submission of an event. 
As a result, CRM Studio retains the history of an event the last time it was 
checked, and every time it was triggered.
If you do not select this option, CRM Studio will retain the history of every time 
that an event was submitted, plus the history of every time that the event was 
triggered.

Select the Event’s Query
The most important part of designing an event is the identification of the query 
(or queries) that the event will use to determine whether a specific condition has 
occurred.
As was detailed in the chapter ‘Query Designing’, a single event can use one or 
more queries (most commonly seen in cross-company events). 
Depending on the filters that are configured within a query, you may be 
prompted to fill in some threshold values (also called event trigger parameters) 
when you select a specific query for an event.

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\(your company)\Events dialog box, click 
Next. You will see the Everest CRM Studio - Application Events\(your 
company)\Events - Queries tab.

• Click the Add Query button at the top-left of the Queries tab. You will see the 
Everest CRM Studio - Add Query dialog box.

• Select the query to be used with this event and click Select. The query is 
displayed in the Queries Selected For Content grid.

We recommend that you select this option.

To select a query for an event, do the following:

“The Everest CRM Studio - Add Query Dialog Box” on page 63
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Queries

 Figure 6.3: Everest CRM Studio - Application Events\(your company)\Events - 
Queries

Add Query
Click this button to display the Everest CRM Studio - Add Query dialog box, 
which enables you to select and add queries to the Queries Selected For Content 
grid.

Queries Selected for Content
This grid displays the selected queries.
Use Script instead of Query
Select this option if you intend to use a Visual Basic script instead of a query.

Script
This field displays the name of the selected Visual Basic script.
Select Script
Click this button to display the Everest CRM Studio - Select Basic Script dialog 
box, which enables you to select a Visual Basic script. This dialog box is similar to 
the Everest CRM Studio - Add Query dialog box.

Remove Query
Click this button to remove a selected query from the Queries Selected for 
Content grid.
Remove All Queries
Click this button to remove all queries from the Queries Selected for Content 

“The Everest CRM Studio - Add Query Dialog Box” on page 63

“Using a VB Script Instead of a Query” on page 184

This button is disabled until you select the Use Script instead of Query 
option.

“The Everest CRM Studio - Add Query Dialog Box” on page 63
182 Everest CRM Studio
User Guide



CRM Studio Event Designing
grid.
Event Trigger Parameters
If the event uses one or more queries that include parameter-driven filters, you 
must specify the threshold values for those filters.

Selecting Multiple Queries
Since a single event can use more than one query, you can select multiple queries 
for a given event. Multiple query events are typically required when you wish to 
check either for a sophisticated set of conditions or for conditions across multiple 
companies. 

Selecting Queries from Other Companies
As was detailed in the chapter ‘Query Designing’, CRM Studio allows you to 
create events that check for conditions across multiple companies. 

This kind of event requires two queries: one from the CRM database and one from 
the financial database. The order in which these queries must be selected is 
determined by the configuration of the queries themselves; one of the queries will 
have been designed as a ‘link from’ query, and the other will have been designed 
as a ‘link to’ query.
If you are creating an event that uses multiple queries from different databases, 
you must ensure that you select the queries in the appropriate order; the second 
query must be designed to include (filter) records only from the first; the third 
query (if there is one) must be designed to include records only from the second, 
and so on.
Once you know the order in which the queries are to be selected, you may 
proceed with selecting them for the corresponding event. 

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\(your company)\Events dialog box, click 
Next. You will see the Everest CRM Studio - Application Events\(your 
company)\Events - Queries tab.

• Click the Add Query button at the top-left of the Queries tab. You will see the 
Everest CRM Studio - Add Query dialog box.

“Event Trigger Parameters” on page 185

When you select multiple queries, CRM Studio automatically assumes an 
‘and’ condition between them; thus, the conditions of all selected queries 
must be met to trigger the related event.

Example Check for clients who have pending sales in a CRM database, and 
who are also on credit hold within a financial database.

To select a query from a company other than the one you are currently 
working in, do the following:

“The Everest CRM Studio - Add Query Dialog Box” on page 63
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• From the Everest CRM Studio - Add Query dialog box, click Select Another 
Application. You will see the Everest CRM Studio - Select Another 
Application dialog box.

• Highlight the company from which you want to select queries and click 
Select. You will again see the Everest CRM Studio - Add Query dialog box, 
displaying the queries associated with the selected company.

• Highlight the required query and click Select. The query is displayed in the 
Queries Selected For Content grid.

Using a VB Script Instead of a Query
Although the vast majority of CRM Studio events use one or more queries to 
identify conditions in an underlying database, there might be some conditions 
that cannot be accomplished via a CRM Studio query.
As CRM Studio queries rely upon Microsoft ODBC drivers for accessing data and 
determining whether a condition has been met, it is possible that certain sources 
of data are not accessible via an ODBC source. You would, nevertheless, like 
CRM Studio to check these data/conditions.
Prime examples of conditions that cannot be checked via an ODBC driver include:
• Low disk space or programs that are not running.
• Files that have been updated.
• Non ODBC-compliant application databases.
If you wish to utilize CRM Studio to check for such conditions, you will need to 
configure the corresponding events to use a Visual Basic (VB) script instead of a 
CRM Studio query to determine whether the corresponding condition has 
occurred.
This capability, referred to as Front-End Scripting, requires you to first create the 
VB scripts used to check for the related conditions. 

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\(your company)\Events dialog box, click 
Next. You will see the Everest CRM Studio - Application Events\(your 
company)\Events - Queries tab.

• Select the Use Script instead of Query option. Click the Select Script button. 
You will see the Everest CRM Studio - Select Basic Script dialog box.

• Select the script to be used with this event and click Select. The script is 
displayed in the Script field.

“The Everest CRM Studio - Select Another Application Dialog Box” on 
page 64

To link a Visual Basic Script to an event, do the following:

“The Everest CRM Studio - Add Query Dialog Box” on page 63

An event cannot use a combination of scripts and queries.
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Event Trigger Parameters
As was detailed in the chapter ‘Query Designing’, a query may be constructed to 
have one or more filters that are parameter-driven – a filter whose ‘compare 
value’ is specified on the event level.

Whenever an event uses one or more queries that include parameter-driven 
filters, you will be prompted (in the Event Trigger Parameter grid in the lower 
half of the Queries tab) to specify the threshold values for those filters.

If no Event Trigger Parameters appear after you have selected your queries, it 
simply indicates that your selected queries do not include any parameter-driven 
filters. If the Event Trigger Parameters grid includes one or more records, each 
record begins with a question or prompt that instructs you on the type of answer 
required.
You must supply an answer to each event trigger parameter using the options 
detailed in the following sections.

Parameter Answer
Most parameters can be answered by entering (or selecting) a specific value. 

You have two ways to select such an answer - either manually type in the value or 
choose the value by querying the underlying database.

• From the Event Trigger Parameters grid, click the Answer field and enter the 
value.

OR

• Click the Answer field and then the list  button. You will see the Everest 
CRM Studio - Please supply a value dialog box.

Example A query called Forecast Sales > ‘x’ Due to Close Between ‘y’ and ‘z’ 
would have three parameter-driven filters:
• The amount of the sale (Greater than How Much?)
• The starting date range (Sales Due to Close Starting On?)
• The ending date range (Sales Due to Close Ending On?)

These parameters cannot be left blank on the event level; you must specify a 
valid response for each when the event is configured and subsequently 
maintained. If a parameter is left blank and the event is submitted by CRM 
Studio, the event will not execute successfully.

Example Question: Activity priority is:
Answer:    High

To insert a specific value for an event trigger parameter, do the 
following:

CRM Studio is case-sensitive, so a compare value of “high” will not 
retrieve those records that have a value of “High”.

“The Everest CRM Studio - Please supply a value Dialog Box” on 
page 138
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• Choose the value that you wish to compare the column to, in the Available 
Substitution Variables list and click OK.

Using Date Substitution Variables
One of the most powerful aspects of designing date-driven events is the use of 
date substitution variables. Consider the following event:
• Send an alert if any sales greater than $20,000 are due to close next week.
This event most likely has event trigger parameters such as:
• Question: Sales Due to Close Starting on?
• Question: Sales Due to Close Ending on?
Although you could go into this event on a weekly basis and manually enter next 
week’s starting and ending dates, there is a simpler way to achieve this.
Using CRM Studio’s date substitution variables, you can instruct it to substitute 
next week’s starting and ending date whenever this event is run. This eliminates 
the need to manually update the date answers.

• From the Event Trigger Parameters grid, click the Answer field and then the 

list  button. You will see the Everest CRM Studio - Please supply a value 
dialog box.

• From the list of Available Substitution Variables, choose the value that you 
wish to use and click OK.

• The drop-down list displays all the values that have appeared in this 
field in the underlying database. This list does not display every 
possible value that could appear in this field.

• If you are entering dates as answers to one or more trigger parameters, 
make sure that you use the correct format (an application whose dates 
are stored in mm-dd-yyyy format will not recognize a trigger parameter 
date that is formatted as mm/dd/yyyy.).

To use a date substitution variable as an answer to a trigger parameter, 
do the following:

“The Everest CRM Studio - Please supply a value Dialog Box” on 
page 138

• For many variables (such as %Current Date%), you will see multiple 
formats for the same value. The format without any suffix (as in 
%Current Date%) uses your system’s date format. The other formats 
each contain a suffix (such as YYYY-MM-DD) that indicates the format 
in which the corresponding date is returned.

• Once you select a date substitution variable as an answer, you can edit 
that value to append specific values to that variable. For example, to 
include a specific time of day in the date variable, you could edit it to 
{%Current Date%} 00:01 (for one minute past midnight) or {%Current 
Date%} 23:59 (for 11:59 PM).
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Removing a Query from an Event

• From the Queries Selected for Content grid in the Everest CRM Studio - 
Application Events\(your company)\Events - Queries tab, select the query 
you wish to remove by clicking on the row header.

• Click the Remove Query button.

Schedule Crystal Reports
CRM Studio integrates with Crystal Reports in three ways:
• CRM Studio can generate one or more Crystal Reports at the time an event is 

triggered and e-mail, fax, copy/ftp, or webcast the report contents.

• CRM Studio can generate one or more Crystal Reports on a pre-defined 
schedule (e.g., every day at 9 AM), and e-mail, fax, copy/ftp, or webcast the 
report contents.

• CRM Studio can scan the contents of an incoming e-mail message and reply 
to that message by generating one or more Crystal Reports, and e-mail, fax, 
copy/ftp, or webcast the report contents back to the originator of the message.

As the process of integrating Crystal Reports with CRM Studio requires a few 
steps of preparation and (in some cases) modifications to an event’s queries, the 
details on this process are explained in the chapter ‘Event Triggered Reports’. 
Please refer to that chapter for details.

To remove a query from an event, do the following:

You can also click the button Remove All Queries to delete all of the 
queries that have been selected for this event. 

When designing an event, the Reports tab is used in this manner. 

You must be familiar with Crystal Reports (and basic report design 
principles) in order to utilize this function.
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Reports

 Figure 6.4:  Everest CRM Studio - Application Events\(your company)\Events 
- Reports

Add Report
Click this button to display the Everest CRM Studio - Add Report dialog box, 
which enables you to select and add reports to the Reports Selected For Content 
grid.
Reports Selected For Content
This grid displays the selected reports.
Remove Report
Click this button to remove a selected report from the Reports Selected For 
Content grid.
Remove All Reports
Click this button to remove all reports from the Reports Selected For Content 
grid.
Report Parameters
This grid displays the parameters of the selected reports. Specify parameters in 
the Answer column.

Enabling the Report Server
You must enable the reports server if you plan to use CRM Studio to generate 
reports for triggered events. 

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

To enable the report server, do the following:
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• From the tree view select Activity > Server Status under Administration 
Folders. You will see the CRM Studio servers and their respective status in 
the right panel.

• Double-click the Report Server. You will see the Everest CRM Studio - Server 
Status dialog box.

• Select the Allow Server to process option and click Save and Close.

File Attachments
In the same manner that CRM Studio allows you to associate one or more Crystal 
reports to an event, you can associate one or more files to a triggered event. Files 
that are associated with an event may be distributed by:
• E-mail (as attached files)
• Fax (file content embedded within the fax)
• Webcast (as a URL link)
• Copy / FTP
Typical uses of attached files include:
• Attaching a Policies and Procedures document to an alert message
• Attaching a product brochure to an alert message
• Attaching a newsletter to an alert message
• Attaching a spreadsheet to an alert message
• Attaching an HTML document to an alert message

• After specifying relevant information in the Reports tab of the Everest CRM 
Studio - Application Events\(your company)\Events dialog box, click Next. 
You will see the Everest CRM Studio - Application Events\(your 
company)\Events - Files tab.

• Click the Add File button. You will see the Everest CRM Studio - Add File 
dialog box, using which you can browse for and locate the required file(s).

• Enter a description of the file you are adding to this event, in the Files 
Selected For Content grid.

• Select the Ascii Text option if the associated file is in ASCII format. 

• Repeat these steps for each file you wish to add.

• To disable CRM Studio from generating Crystal reports, uncheck the 
Allow Server to process option.

• If you disable the report server and trigger events that are configured to 
generate reports, CRM Studio will pile up the pending reports (which 
you can review in the Everest CRM Studio Event Monitor). These 
pending reports may subsequently be deleted, or (if you enable the 
report server) they may be generated at a later time.

To attach one or more files to a specific event, do the following:

Only ASCII formatted files can be delivered via fax.
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Files

 Figure 6.5: Everest CRM Studio - Application Events\(your company)\Events - 
Files

Add File
Click this button to display the Everest CRM Studio - Add File dialog box, which 
enables you to select and add files to the Files Selected For Content grid.
Files Selected For Content
This grid displays the selected files.
Remove File
Click this button to remove a selected file from the Files Selected For Content 
grid.
Remove All Files
Click this button to remove all files from the Files Selected For Content grid.

File Alternative Text Options

If the event you are working with will be sending out e-mail alerts via an Internet 
e-mail based system (such as SMTP), you can specify that the text in an associated 
file will be used as the alternative text for an e-mail message.
One of the benefits of the alternative text option is that it allows you to create an 
event that sends an e-mail message that can be received by both HTML and non-
HTML based e-mail systems.
You can send both formatted text and a plain (unformatted) text version of the 
same message. In this way, the mail message can be read by all recipients.
Additionally, this function is useful if you use CRM Studio to periodically 
distribute an HTML file (such as a newsletter). In a scenario such as this, the 
alternative text option allows the HTML source file to be created outside CRM 
Studio and simply linked to an event.

This option is available only if CRM Studio is sending e-mail alerts via 
Internet mail. 

To send an alternative message (as the message text), do the following:
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• From the Files Selected For Content grid, click the Description column, for 
the row containing the file requiring a description. 

• Click the drop-down arrow and select HTML, rich text or enriched, as the 
format of the alternative file.

File Transfers
The copy tab is where you specify whether the reports and/or files that are 
associated with this event will be copied (or sent through FTP) to the event 
subscribers’ desired locations.
Files and reports may be distributed via four methods:
• Attached to e-mail messages
• Embedded within a fax message (as long as the file or report content is 

formatted as ASCII)
• Linked to a webcast page (via an URL link)
• Copied/sent through FTP to a recipient’s desired location
The first three options are controlled using the option boxes on the corresponding 
e-mail, fax, and webcast tabs; the fourth option is controlled using the two check 
boxes on the Copy tab.

• After specifying relevant information in the Files tab of the Everest CRM 
Studio - Application Events\(your company)\Events dialog box, click Next. 
You will see the Everest CRM Studio - Application Events\(your 
company)\Events - Copy tab.

• Select the required option(s).

The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Copy

 Figure 6.6: Everest CRM Studio - Application Events\(your company)\Events - 
Copy

Include Files on Copy operations
Select this option to enable transfer of files through FTP.

You can specify more than one alternative message file. The recipient’s e-
mail client will decide which one to use. Multiple alternative message files 
increase the overall size of the CRM Studio message being sent.

To copy/ftp files and/or reports to a recipient’s desired location, do the 
following:
Everest CRM Studio 191
User Guide



Event Designing CRM Studio
Include Reports on Copy operations
Select this option to enable transfer of reports through FTP.

Enabling the Copy Server
The Copy server must be enabled to process if you plan on using CRM Studio to 
copy or FTP files when an event is triggered. 

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the tree view select Activity > Server Status under Administration 
Folders. You will see the CRM Studio servers and their respective status in 
the right panel.

• Double-click the Copy Server. You will see the Everest CRM Studio - Server 
Status dialog box.

• Select the Allow Server to process option and click Save and Close.

Monitoring the Status of Copied Files
When an event triggers the copying of files and/or reports, you can use the 
Everest CRM Studio Event Monitor to track the status of the copying function.

In the Everest CRM Studio Event Monitor (path: CRM > CRM Studio > 
Monitor), select File Delivery. From here, you can track:
• Files whose status is Pending (via the copy method).
• Files that have been Sent successfully via the copy method.
• Files with Errors that are not delivered successfully via the copy method.
If any of your copied report and/or file deliveries have failed to complete 
successfully because of an error condition, you may attempt to correct the 
delivery, mark the delivery as complete, or manually delete the erroneous 
delivery.

To allow for the files and/or reports to be attached to outgoing e-mails, 
faxes, and webcasts (but not allow them to be copied or sent by FTP), do not 
select the corresponding option.

To enable the copy server, do the following:

• To disable any files or reports from being copied/sent by FTP, uncheck 
the Allow Server to Process option.

• If you disable the copy server and trigger events that are configured to 
copy reports or files, CRM Studio will pile up the pending copy 
requests (which you can review in the Everest CRM Studio Event 
Monitor). These pending copy requests may subsequently be deleted, 
or (if you enable the copy server) they may copied to the appropriate 
locations at a later time.

“Monitoring the Status of Events” on page 175

“Message Delivery Errors” on page 90
“Taking a Corrective Action” on page 91
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Formatting Your Alert Message
The methods by which you design message text for alerts sent via e-mail, fax, 
pager, and webcast are almost identical, with only a few minor differences 
specific to each method.
The following sections will discuss how to create an alert message for each 
delivery method. Within each section you will see items that addresses the unique 
components of each of those methods.

Sending E-mail
The most common method by which CRM Studio can send alert messages is 
electronic mail. 
CRM Studio can send e-mail alerts to virtually every type of e-mail system (such 
as those that rely on Microsoft Exchange, SMTP, and Lotus Notes), and the 
outgoing alert messages can contain an unlimited amount of information about 
the triggered event.
Before you begin designing e-mail alert messages, however, you need to be sure 
that CRM Studio is enabled to send out alerts via electronic mail.

CRM Studio will attempt to re-deliver an erroneous file delivery every 
minute.

As the process of designing an alert message is identical for all delivery 
methods, we will detail the specific steps that you need to take to format 
your message only in the E-mail section. Please be certain to read this 
section carefully, as it applies equally to the formatting of fax, pager, and 
webcast alert messages.
If you already have an idea of what the various alert messages should look 
like (using the worksheets from this and the previous chapter), you are 
ready to continue. If not, take a few minutes to write down the exact text 
and format of each alert message for each delivery method.
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Email

 Figure 6.7: Everest CRM Studio - Application Events\(your company)\Events - 
Email

Available values for use in message content
This field displays the available fields from the queries that are linked to the 
event, and can be used in the Message Subject and Message Text fields.
Use selected value in Text
Click this button to use a highlighted value from the Available values for use in 
message content field, in the Message Subject and/or Message Text fields.
Email Account to Send From
Select the e-mail account to be used for sending mail from the drop-down list.

Email Reply Address (Optional)
Specify a reply address to use a different address from that defined in the Email 
Account to Send From field.
Message Subject
Specify the subject of the e-mail alert.

Message Text
Specify the text of the e-mail alert.

Include reports as e-mail attachments 
Specify whether the associated reports are to be attached to the outgoing e-mail 
message.

“E-Mail Sending Account” on page 195

“E-Mail Subject Text” on page 195

“E-Mail Message Text” on page 196
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Include files as e-mail attachments
Specify whether the associated files are to be attached to the outgoing e-mail 
message.
E-mail notifications should wait until reports are completed
If an event has associated reports which are not attached to the outgoing e-mail, 
you can use this option to control the timing between the generation of reports 
and sending of e-mail.

Enabling the E-Mail Server
The E-mail server must be enabled to process if you plan on using CRM Studio to 
send out alerts via e-mail when an event is triggered. 

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the tree view select Activity > Server Status under Administration 
Folders. You will see the CRM Studio servers and their respective status in 
the right panel.

• Double-click the E-mail Server. You will see the Everest CRM Studio - Server 
Status dialog box.

• Select the Allow Server to process option and click Save and Close.

E-Mail Sending Account
Before you can begin defining this text, you need to identify which e-mail account 
CRM Studio will send this e-mail message from.

CRM Studio will not be able to send alerts via e-mail unless you have correctly 
configured (and selected) an e-mail sending account. Select an account from the 
E-Mail Account to Send From drop-down list.
The next step is to specify the subject of your outgoing alert message.

E-Mail Subject Text
In the Message Subject field, specify the subject of the outgoing alert message. 
Using an event that is triggered by late orders as an example, you could enter 
‘Orders Shipped Later Than Required Date’ as the message subject.
But you can also include data fields in the subject of an e-mail alert. For example, 

“E-mail Message Handling Options” on page 201

To enable the e-mail server, do the following:

• To disable any alerts from being sent via e-mail, uncheck the Allow 
Server to Process option.

• If you disable the e-mail server and trigger events that are configured to 
send e-mail alerts, CRM Studio will pile up the pending e-mail alerts 
(which you can review in the Everest CRM Studio Event Monitor). 
These pending alerts may subsequently be deleted, or (if you enable the 
e-mail server) sent to the appropriate recipients at a later time.

“Set Up E-mail Account to send E-mails” on page 28
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you want your subject field to read as follows:
Order # {OrderID} Shipped Later Than Required Date

• Type ‘Order #’ in the Message Subject field.
• From the Available values for use in message content list, select the order ID 

field. Your message subject now reads: Order # {OrderID}. 
• Enter the rest of the subject (Shipped Later Than Required Date).
Now consider an event with an e-mail subject such as the following:
Sales for Next Month < $100,000
The problem with a subject like this is that after a few months go by, you might 
have a few e-mail messages which all read:
• Sales for Next Month < $100,000
• Sales for Next Month < $100,000
• Sales for Next Month < $100,000
And to figure out exactly which next month each mail message is referring to 
would be a trying task.
The solution? Add a CRM Studio date substitution variable to the subject of your 
message and make it read as follows:
Sales for {%Next Month%} < $100,000

• Type ‘Sales for’ in the Message Subject field.
• From the Available values for use in message content list, scroll to the 

bottom and select %Next Month% from the date substitution variables. Your 
message subject now reads: Sales for {%Next Month%}

• Enter the rest of the subject (< $100,000).
You can use any combination of hard-coded text, field values, and date 
substitution variables in your e-mail subject.

E-Mail Message Text
In the Message Text field, specify the body text of an outgoing alert message. 
Since the text of an e-mail alert typically contains combination of hard-coded text 
and database field values, one approach for designing the text is to type all the 

To specify the above message subject, do the following:

To specify the above message subject, do the following:
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hard-coded text and then fill the database field values.

Text Formatting - Notes and Hints
Here are a few suggestions regarding the formatting of your message text:
• Do not try to line things up in a columnar format; the CRM Studio editor is 

not designed for that purpose. If you wish to receive the output in a columnar 
format, use an attached report to generate that output.

• Likewise, if you wish your e-mail to include sub-totals, totals, line and page 
breaks, headers, footers, etc., design this output using a Crystal Report and 
attach the report to the event.

• If you wish your e-mail message to include a blank line, be sure to enter that 
line in the message text.

Example To send an alert message about orders that were shipped later than 
their required date, you can begin by typing the following in the 
Message Text field:
The following order was shipped later than the customer's required 
date:
Order ID: 
Company: 
Required Date: 
Shipped Date: 
Salesperson: 
You could then do the following:
• Position your cursor next to the ‘Order ID:’ text, in the message 

body and leave a blank space. 
• From the list of Available values for use in message content, 

select the {OrderID} field. Your text will now look like: 
‘Order ID:’ {OrderID}

• Repeat this process for the remaining data field values you wish to 
include in your message.

When you are finished, your completed message text will look like:
The following order was shipped later than the customer's required 
date:
Order ID: {OrderID}
Company: {CompanyName}
Required Date: {RequiredDate}
Shipped Date: {ShippedDate}
Salesperson: {FirstName} {LastName}
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• If you are placing multiple field values next to each other (as in the previous 
example of {FirstName}{LastName}, you might wish to separate them with a 
single blank character.

• In addition to selecting field values from the list of available values, you can 
also manually type them.

• You can include CRM Studio date substitution variables within the body of 
an alert message.

Sample Alert Messages
Here are a few sample alert messages that show a variety of information in e-mail 
message text:
Event: Customers; More than 2 Late Shipments Last Quarter
The following customer had more than 2 shipments arrive late last quarter:
Company: {CompanyName}
Number of Late Orders: {Late_Order_Count}
Event: Customers; Shipment Confirmations for Today
Dear {ContactName}:
This message is to confirm that the following order has been shipped to you 
today:
Order Number: {OrderID}
Order Date: {OrderDate}
Company: {CompanyName}
Total Amount: {Total}
Salesperson: {Salesrep_FirstName}{Salesrep_LastName}
Event: Customers; Frequent Buyer Incentives
The following customer has placed more than four orders of at least $5,000 over 
the last quarter and is eligible for our frequent buyer incentive program:
Company: {CompanyName}
Number of Matching Orders Over the Last Quarter: {Sales_Count}

Repeat Message Text
Consider the following alert message:
The following orders were shipped later than the customer's required date:
Order ID: {OrderID}
Company: {CompanyName}
Required Date: {RequiredDate}
Shipped Date: {ShippedDate}
Salesperson: {FirstName} {LastName}
If the corresponding event is triggered by multiple matching records, you need to 
ask yourself the following question:
What part of the alert message do I want to repeat for each matching record?
In reviewing the message text, it is fairly clear that you do not need to repeat the 
opening line of the message – The following orders were shipped later than the 
customer’s required date – but you do need to repeat the following five lines for 
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each matching order.
To do this, you must specify the following:
The following order was shipped later than the customer's required date:
{BEGIN*REPEAT}
Order ID: {OrderID}
Company: {CompanyName}
Required Date: {RequiredDate}
Shipped Date: {ShippedDate}
Salesperson: {FirstName} {LastName}
{END*REPEAT}

• In the Message Text field, position the cursor immediately before the text that 
you wish to repeat.

• From the Available values for use in message content field, select 
{BEGIN*REPEAT}. 

• Position your cursor right after the end of text that you wish to repeat. 

The configuration of a rolled-up alert message is now complete.
Begin and End Repeat - Notes

There are some important notes regarding the use of the begin repeat and end 
repeat functions:
• The {BEGIN*REPEAT} and {END*REPEAT} labels may appear only once in an 

event’s message text.
• You can use the begin and end repeat functions for only one of an event’s 

delivery methods. 

If you do wish to use this function in more than one delivery method, you must 
make multiple copies of the same event and configure each copy to send out an 
alert via a single method that uses the begin and end repeat function.
• If the {BEGIN*REPEAT} and {END*REPEAT} labels do not appear in an event 

that is configured to roll up messages, CRM Studio will not perform the roll-
up function.

To configure an event to use the repeat labels, do the following:

• {BEGIN*REPEAT} does not need to be on a line by itself; it may be on 
the same line as hard-coded text or a field value.

• If {BEGIN*REPEAT} is on a line by itself, CRM Studio will insert a blank 
line before every repeated group of records.

• {END*REPEAT} does not need to be on a line by itself; it may be at the 
end of the same line as hard-coded text and/or a field value.

• {END*REPEAT} is on a line by itself, CRM Studio will insert a blank 
line after every repeated group of records.

Example If you use this function in an event’s e-mail message text, you cannot 
use it in the fax, page, or webcast text for the same event.
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• Do not use the repeat function if an event is configured to send individual 
alert messages to different recipients, based on information in each triggered 
record. 

The reason for this is that when the repeat function is turned on, CRM Studio 
processes the data from all triggered records in one unified group. This disables 
CRM Studio’s ability to evaluate each record independently and send out an alert 
to the recipient based on data in an individual triggered record.

• {BEGIN*REPEAT} must always precede {END*REPEAT}.

Use HTML E-Mail Message Text
Although CRM Studio’s default e-mail editor assumes that you wish to send 
alerts using an ASCII-formatted message text, you may also choose to send your 
alert message in an HTML format.
Just like using the {BEGIN*REPEAT} and {END*REPEAT} labels, CRM Studio 
provides you with two labels that indicate where your HTML text begins and 
ends.
These labels are {BEGIN*HTML} and {END*HTML}, and you may select them in 
the list of “Available values for use in message content”.
By embedding these tags within a mail message, you can define which part of an 
e-mail message should be sent as ASCII text, and which part should be sent as 
HTML.
It is important to remember that not all e-mail clients support HTML text. Hence, 
it is suggested that you define your message text to include both HTML and non-
HTML text. 
Thus you can create a single e-mail message that contains both HTML and non-
HTML text as in the following example:
The following customer had more than 2 shipments arrive late last quarter:
Company: {CompanyName}
Number of Late Orders:{Late_Order_Count}
At the same time, you can follow this text with the same content, formatted in 
HTML, and placed between the {BEGIN*HTML} and {END*HTML} labels.
So your message text would appear as follows:
The following customer had more than 2 shipments arrive late last quarter:
Company: {CompanyName}
Number of Late Orders:{Late_Order_Count}
{BEGIN*HTML} HTML content goes here {END*HTML}
If the alert recipients’ e-mail client does not support HTML, they will see only 
what is in the top section of this message, and the content of HTML section will 

Example Do not use it in an event that will notify the account manager of each 
order that is shipped later than its required date.

In an event that rolls up all the overdue activities for individual sales 
representatives and sends a single e-mail (with those activities) to each 
representative, use a Crystal report to generate the rolled-up activities, and 
then use CRM Studio’s event subscriber function to determine which sales 
representative each report must be sent to.
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appear as an e-mail attachment.
Conversely, if the alert recipients’ e-mail client does support HTML, they will not 
see the content of the top section and will see only what is between the 
{BEGIN*HTML} and {END*HTML} labels. 

HTML Message Editing
To create your HTML text for a CRM Studio e-mail alert message, you need to 
use a standard HTML editing tool, such as FrontPage or Microsoft Word.
Using a tool such as these, type in your message text along with the names of any 
field values (such as {OrderID}) and date substitution values (such as {%Current 
Date%}) that you wish to embed within your message text. For a list of the values 
that you can embed within your HTML message text, refer to the Available 
values for use in message content field in the Email tab.
Once you have created your HTML message text, you must copy the HTML 
source code from the HTML editor you are using and paste it between the 
{BEGIN*HTML} and {END*HTML} labels in the e-mail message text.

E-mail Message Handling Options
At the bottom of the E-Mail tab are three check boxes that allow you to further 
control the content of an outgoing alert message.
Include Reports as E-Mail Attachments 
If an event has one or more Crystal reports associated with it, check this option to 
specify whether the associated reports must be attached to the outgoing e-mail 
message.
Include Files as E-Mail Attachments
If an event has one or more files associated with it, check this option to specify 
whether the associated files must be attached to the outgoing e-mail message.

E-Mail Notifications Should Wait Until Reports Are Completed
If an event has associated reports which are not attached to the outgoing e-mail, 
you can control the timing between the report generation and sending of e-mails.

If the associated reports are not attached to the outgoing e-mail, delivery of e-mail 

You are limited to 30 kilobytes of data in the e-mail message text.

You may embed the {BEGIN*REPEAT} and {END*REPEAT} labels within 
your HTML text; be sure to include these labels in your source HTML text, 
and place each of these labels on a line by themselves.

There might be situations when you want to distribute one or more 
reports/files via an event, but you rather distribute them via the web or 
FTP. In such cases, you might just use the outgoing e-mail alert message to 
notify recipients of the webcast or FTP location that the reports/files were 
sent, without actually attaching them to the mail message. 
This is a very efficient way to distribute vast numbers of reports without 
dramatically impacting the load on your e-mail servers.

If an event has associated reports that are attached to an e-mail alert, CRM 
Studio will automatically wait for the reports to successfully complete 
before the e-mail message is sent.
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alert can depend on two things:
• The e-mail notification should wait until the reports are successfully generated 

before the e-mail is sent out (Option checked).
• The e-mail notification should NOT wait for the reports to successfully 

generate before the e-mail is sent out. (Option unchecked).

Monitoring the Status of E-Mail Alerts
When an event triggers the sending of an e-mail alert, you can use the Everest 
CRM Studio Event Monitor to track the status of delivery of those alerts.

In the Everest CRM Studio Event Monitor (path: CRM > CRM Studio > 
Monitor), select Email Delivery. From here, you can track:
• Mail messages whose status are Pending.
• Mail messages that have been Sent successfully.
• Mail messages with Errors that have failed to be delivered successfully.
If any of your e-mail alerts have failed to complete successfully because of an 
error condition, you may attempt to correct the message delivery, mark the 
delivery as complete, or manually delete the erroneous delivery.

Sending Faxes
The configuration of a fax alert message is almost identical to that of an e-mail 
message, and so the following sections will address only those aspects that are 
different from that of an e-mail message configuration.

Since you might have multiple accounts defined from which you can send fax 
alerts, the first step in configuring a fax alert message is to select which CRM 
Studio faxing account will be used for the sending this fax message.
CRM Studio will not be able to send alerts via fax unless you have correctly 
configured (and selected) a fax account.

• If this option is not checked, the e-mail message will be sent 
immediately, and the recipient of the message may not be able to access 
the associated report(s) if it takes a while to generate.

• If this option is checked and any of the associated report(s) fail to be 
completed successfully, the e-mail message will not be sent out.

• If associated reports are attached to the message and the reports fail to 
complete successfully, the e-mail message will not be sent out.

“Monitoring the Status of Events” on page 175

“Message Delivery Errors” on page 90
“Taking a Corrective Action” on page 91

CRM Studio will attempt to re-deliver an erroneous e-mail message every 
minute.

No additional hardware or software is required to enable CRM Studio’s 
faxing technology; your server simply needs the ability to dial out via a 
modem.
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Fax

 Figure 6.8: Everest CRM Studio - Application Events\(your company)\Events - 
Fax

Available values for use in message content
This field displays the available fields from the queries that are linked to the 
event, and can be used in the fax message content.
Use selected value in Text
Click this button to use a highlighted value from the Available values for use in 
message content field, in the Message Text fields.
Fax Account to Send From
Select the fax account to be used for sending faxes from the drop-down list.
Fax Subject
Specify the subject of the fax alert.

Include text reports as fax pages
Specify whether associated text-based reports must be included in the outgoing 
fax message.
Include text files as fax pages
Specify whether the associated text files must be included in the outgoing fax 
message.
Fax notification should wait until reports are completed
If an event has associated reports which are not attached to the outgoing fax, you 
can use this option to control the timing between the report generation and 
sending of fax.

“E-Mail Subject Text” on page 195
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Enabling the Fax Server
The Fax server must be enabled to process if you plan on using CRM Studio to 
send out alerts via fax when an event is triggered.

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the tree view select Activity > Server Status under Administration 
Folders. You will see the CRM Studio servers and their respective status in 
the right panel.

• Double-click the Fax Server. You will see the Everest CRM Studio - Server 
Status dialog box.

• Select the Allow Server to process option and click Save and Close.

Fax Cover Page, Subject and Message Text
When designing a fax alert message, you can choose to specify content for the 
fax’s cover page, the fax subject field, and the body of your fax message.
Just as in the design of an e-mail alert message, you can include hard-coded text, 
database field values, and date substitution variables in the fax’s cover page, 
subject field, and body text.

Fax Message Handling Options
At the bottom of the Fax tab there are three check boxes that allow you to further 
control the content of an outgoing alert message.
Include Text Reports as Fax Pages
If an event has one or more Crystal reports that are output to an ASCII format 
associated with it, check this option to specify whether the associated text-based 
reports must be included in the outgoing fax message.
Include Text Files as Fax Pages
If an event has one or more text files associated with it, check this option to 

To enable the fax server, do the following:

• To disable any alerts from being sent via fax, uncheck the Allow Server 
to Process field.

• If you disable the fax server and trigger events that are configured to 
send fax alerts, CRM Studio will pile up the pending fax alerts (which 
you can review in the Everest CRM Studio Event Monitor). These 
pending alerts may subsequently be deleted, or (if you enable the fax 
server) they may be sent to the appropriate recipients at a later time.

You can also use the {BEGIN*REPEAT} and {END*REPEAT} functions. 
Remember, however, that you cannot use the repeat function in the Fax tab 
of an event if you have already used it within any of the other delivery 
method tabs.

“Repeat Message Text” on page 198
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specify whether the associated files must be included in the outgoing fax message.

Fax Notifications Should Wait Until Reports Are Completed
If an event has associated reports which are not included in the outgoing fax, you 
can control the timing between report generation and sending of fax. 

If the associated reports are not included in the outgoing fax, delivery of fax alert 
can depend on two things:
• The fax notification should wait until the reports are successfully generated 

before the fax alert is sent out (Option checked).
• The fax notification should not wait for the reports to successfully generate 

before being sent out (Option unchecked).

Monitoring the Status of Fax Alerts
When an event triggers the sending of a fax alert, you can use the Everest CRM 
Studio Event Monitor to track the status of the delivery of those alerts.

In the Everest CRM Studio Event Monitor (path: CRM > CRM Studio > 
Monitor), select Fax Delivery. From here, you can track:
• Fax messages whose status are pending
• Fax messages that have been Sent successfully
• Fax messages with Errors that have failed to be delivered successfully
If any of your fax alerts have failed to complete successfully because of an error 
condition, you may attempt to correct the message delivery, mark the delivery as 
complete, or manually delete the erroneous delivery.  

There might be situations when you want to distribute one or more 
reports/files via an event, but you rather distribute them via the web or 
FTP. In such cases, you might just use the outgoing fax alert message to 
notify recipients of the webcast or FTP location that the reports/files were 
sent, without actually attaching them in the fax message. 

If an event has associated reports that are included in a fax alert, CRM 
Studio will automatically wait for the reports to successfully complete 
before the fax message is sent.

• If this option is not checked, the fax message will be sent immediately, 
and the recipient of the message may not be able to access the associated 
report(s) if it takes a while to generate.

• If this option is checked and any of the associated report(s) fail to be 
completed successfully, the fax message will not be sent out.

• If associated reports are included in the fax message and the reports fail 
to complete successfully, the fax message will not be sent out.

“Monitoring the Status of Events” on page 175

“Message Delivery Errors” on page 90
“Taking a Corrective Action” on page 91

CRM Studio will attempt to re-deliver an erroneous fax message every 
minute.
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Sending Pager Messages
The configuration of a pager alert message is very similar to that of a fax message, 
with the definition of the pager message text being identical to that of an e-mail 
message.

The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Page

 Figure 6.9: Everest CRM Studio - Application Events\(your company)\Events - 
Page

Available values for use in message content
This field displays the available fields from the queries that are linked to the 
event, and can be used in the Pager Message field.
Use selected value in Text
Click this button to use a selected value from the Available values for use in 
message content field, in the Pager Message field.
Pager Message
Specify the content of the pager alert/message.
Pager notification should wait until reports are completed
If an event has associated reports which are not attached to the outgoing pager 
message, you can use this option to control the timing between the report 
generation and sending of pager message.

Enabling the Page Server
The Page server must be enabled to process if you plan on using CRM Studio to 

“E-Mail Message Text” on page 196

• No additional hardware or software is required to enable CRM Studio’s 
paging technology; your server simply needs the ability to dial via a 
modem.

• CRM Studio’s paging technology supports SMS (Short Messaging 
Service).
206 Everest CRM Studio
User Guide



CRM Studio Event Designing
send out alerts via pager when an event is triggered. 

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the tree view select Activity > Server Status under Administration 
Folders. You will see the CRM Studio servers and their respective status in 
the right panel.

• Double-click the Page Server. You will see the Everest CRM Studio - Server 
Status dialog box.

• Select the Allow Server to process option and click Save and Close.

Pager Message Text
When designing the content of a pager alert message, you can place as much or as 
little text as you wish in the body of your pager message.
Just as in the design of an e-mail alert message, you can include hard-coded text, 
database field values, and date substitution variables in the pager message text.

Pager Message Handling Options
At the bottom of the Page tab there is one check box that allows you to further 
control the content of an outgoing alert message.
Pager Notifications Should Wait Until Reports Are Completed
If an event that is sending a pager alert has associated reports, you can control the 
timing between the report generation and sending of pager message.
There are two things that the delivery of pager message depends on:
• The pager notification should wait until the reports are successfully generated 

before the pager alert is sent out (Option checked).

To enable the page server, do the following:

• To disable any alerts from being sent via pager, uncheck the Allow 
Server to Process field.

• If you disable the page server and trigger events that are configured to 
send pager alerts, CRM Studio will pile up the pending pager alerts 
(which you can review in the Everest CRM Studio Event Monitor). 
These pending alerts may subsequently be deleted, or (if you enable the 
page server) sent to the appropriate recipients at a later time.

You can also use the {BEGIN*REPEAT} and {END*REPEAT} functions. 
Remember, however, that you cannot use the repeat function in the Page 
tab of an event if you have already used it in any of the other delivery 
method tabs.

“Repeat Message Text” on page 198
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• The pager notification should NOT wait for the reports to successfully 
generate before being sent out (Option unchecked).

Monitoring the Status of Pager Alerts
When an event triggers the sending of a pager alert, you can use the Everest CRM 
Studio Event Monitor to track the status of delivery of those alerts.

In the Everest CRM Studio Event Monitor (path: CRM > CRM Studio > 
Monitor), select Pager Delivery. From here, you can track:
• Pager messages whose status are Pending
• Pager messages that have been Sent successfully
• Pager messages with Errors that have failed to be delivered successfully
If any of your pager alerts have failed to complete successfully because of an error 
condition, you may attempt to correct the message delivery, mark the delivery as 
complete, or manually delete the erroneous delivery.  

Webcasting 

The configuration of a webcast alert message is almost identical to that of an e-
mail message, and so the following sections will address only those aspects of 
webcast alert message configuration that are different from e-mail message 
configuration.

• If this option is not checked, the pager message is sent immediately, and 
the recipient of the message may not be able to access the associated 
report(s) if it takes awhile to generate.

• If this option is checked and any of the associated report(s) fail to be 
completed successfully, the pager message will not be sent out.

“Monitoring the Status of Events” on page 175

“Message Delivery Errors” on page 90
“Taking a Corrective Action” on page 91

CRM Studio will attempt to re-deliver an erroneous pager message every 
minute.

CRM Studio’s webcasting module requires a few additional steps for initial 
configuration. 

“E-Mail Subject Text” on page 195
“E-Mail Message Text” on page 196
No additional hardware or software is required for the webcasting 
technology.
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Webcast

 Figure 6.10: Everest CRM Studio - Application Events\(your company)\Events 
- Webcast

Available values for use in message content
This field displays the available fields from the queries that are linked to the 
event, and can be used in the Webcaster Subject and Webcaster Message fields.
Use selected value in Text
Click this button to use a highlighted value from the Available values for use in 
message content field, in the Webcaster Subject and/or Webcaster Message 
fields.
Webcaster Subject
Specify the subject of the webcast.
Webcaster Message
Specify the content of the webcast.
Expiration Days
Specify the number of days that the alert message for a triggered event should 
remain on the webcast window.
Background Color
The subject of a triggered event alert message can appear in one of four colors to 
indicate the nature (or criticality) of the event. Your choices are:
• Default (Indicative of an event that is neither good nor bad)
• Green (Indicative of an event that conveys good news)
• Yellow (Indicative of an event that conveys a warning)
• Red (Indicative of an event that conveys bad news)
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Include reports as URL Links
Specify whether the associated reports must be attached to the webcast alert 
window via a URL link icon.
Include files as URL Links
Specify whether the associated files must be attached to the webcast alert window 
via a URL link icon.
Webcast notifications should wait until reports are completed
If an event has associated reports which are not linked to the corresponding 
webcast window, use this option to control the timing between the report 
generation and the publishing of webcast.

Sample Webcast Output
Since webcasting is a message delivery method that is unique to CRM Studio, 
you may find it helpful to see what a sample webcast output window looks like.
The following illustration is of a webcast screen. 

 Figure 6.11: Sample Webcast Screen

Each triggered event shows up as a separate line item in this window, and 
displays a brief description (or subject) as well as a detailed description of the 
event that was triggered.

Enabling the Webcast Server
The Webcast server must be enabled to process if you plan on using CRM Studio 
to send out alerts via webcast when an event is triggered. 

The template for this window can be customized, so you can include your 
organization’s logos, graphics, etc.

To enable the webcast server, do the following:
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• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the tree view select Activity > Server Status under Administration 
Folders. You will see the CRM Studio servers and their respective status in 
the right panel.

• Double-click the Webcast Server. You will see the Everest CRM Studio - 
Server Status dialog box.

• Select the Allow Server to process option and click Save and Close.

Webcast Subject and Message Text
When designing a webcast alert message, you can choose to specify content for 
the webcast subject field and for the body of your webcast message.
Do keep in mind that unlike an e-mail message, multiple webcast alert messages 
appear in a single browser window; thus, it is suggested that you keep the 
amount of webcast message text for a single event to a few lines (typically less 
than four), so that you can easily review all the triggered events on a single 
webcast window without excessive scrolling.
Just as in the design of an e-mail alert message, you can include hard-coded text, 
database field values, and date substitution variables in the webcast’s subject field 
and body text.

Webcast Message Handling Options
At the bottom of the Webcast tab there are five options that allow you to further 
control the content of an outgoing alert message.
Expiration Days
This number represents the number of days that the alert message for a triggered 
event should remain on the webcast window. The maximum number of days is ‘9’ 
and the minimum is end of today as indicated by the value ‘0’.
Background Color
The subject of a triggered event alert message may appear in one of four colors to 
indicate the nature (or criticality) of the event. Your choices are:
• Default (Indicative of an event that is neither good nor bad)

• To disable any alerts from being sent via webcast, uncheck the Allow 
Server to Process field.

• If you disable the webcast server and trigger events that are configured 
to send webcast alerts, CRM Studio will pile up the pending webcast 
alerts (which you can review in the Everest CRM Studio Event 
Monitor). These pending alerts may subsequently be deleted, or (if you 
enable the webcast server) sent to the appropriate recipients at a later 
time.

You can also use the {BEGIN*REPEAT} and {END*REPEAT} functions. 
Remember, however, that you cannot use the repeat function in the 
Webcast tab of an event if you have already used it in any of the other 
delivery method tabs.

“Repeat Message Text” on page 198
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• Green (Indicative of an event that conveys good news)
• Yellow (Indicative of an event that conveys a warning)
• Red (Indicative of an event that conveys bad news)
Include Reports as URL Links
If an event has one or more Crystal reports associated with it, check this option to 
specify whether the associated reports must be attached to the webcast alert 
window via a URL link icon.
Include Files as URL Links
If an event has one or more files associated with it, check this option to specify 
whether the associated files must be attached to the webcast alert window via a 
URL link icon.

Webcast Notifications Should Wait Until Reports are Completed
If an event has associated reports which are not linked to the corresponding 
webcast window, you can control the timing between the report generation and 
the publishing of webcast. 

If the associated reports are not included to the webcast message, the appearance 
of the webcast alert can depend on two things:
• The webcast notification should wait until the reports are successfully 

generated before being published (Option checked).
• The webcast notification should not wait for the reports to successfully 

generate before being published (Option unchecked).

Monitoring the Status of Webcast Alerts
When an event triggers the sending of a webcast alert, you can use the Everest 
CRM Studio Event Monitor to track the status of the delivery of those alerts.

In the Everest CRM Studio Event Monitor (path: CRM > CRM Studio > 
Monitor), select Webcast Delivery. From here, you can track:
• Webcast messages whose status are Pending.
• Webcast messages that have been Sent successfully.

CRM Studio’s webcast message delivery option is an excellent way to 
distribute reports and files to a large number of people, as they can all visit 
one webcast page and retrieve the desired reports.

If an event has associated reports that are linked to the webcast alert, CRM 
Studio will automatically wait for the reports to successfully complete 
before the webcast message is posted.

• If this option is not checked, the webcast message is sent immediately, 
and the recipient of the message may not be able to access the associated 
report(s) if it takes a while to generate.

• If this option is checked and any of the associated report(s) fail to be 
completed successfully, the webcast message will not be posted.

• If associated reports are linked to the webcast message and the reports 
fail to complete successfully, the webcast message will not be posted.

“Monitoring the Status of Events” on page 175
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• Webcast messages with Errors that have failed to be delivered successfully.
If any of your webcast alerts have failed to complete successfully because of an 
error condition, you may attempt to correct the message delivery, mark the 
delivery as complete, or manually delete the erroneous delivery.  

Response Actions
The Action tab allows you to respond to a triggered event and take any one (or a 
combination) of a variety of actions. These actions may include updating a 
company database as a result of (and with information from) a triggered event.

Enabling the Action Server
The Action server must be enabled to process if you plan on using any of the 
action functions. 

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the tree view select Activity > Server Status under Administration 
Folders. You will see the CRM Studio servers and their respective status in 
the right panel.

• Double-click the Action Server. You will see the Everest CRM Studio - Server 
Status dialog box.

• Select the Allow Server to process option and click Save and Close.

The Five Types of Actions
When an event is triggered, CRM Studio may execute any one or any 
combination of the following five types of actions:
• Create a file that contains content from a triggered event.

“Message Delivery Errors” on page 90
“Taking a Corrective Action” on page 91

CRM Studio will attempt to re-deliver an erroneous webcast message every 
minute.

Different databases have different requirements with respect to the means 
of upgradation. Exercise extreme caution in using any of these functions 
to update a database. Be certain that you are familiar with the database(s) 
you are updating, and make sure that actions you are executing are 
approved and supported by the databases you are integrating with.
It is suggested that you configure the User Access tab settings in the 
Everest CRM Studio - Logins dialog box (path: CRM > CRM Studio > 
Administrator > User Access > Logins) to disable the Action tab for any 
users who do not have the knowledge and permission to utilize such 
functions.

To enable the action server, do the following:

To disable any actions from being executed, uncheck the Allow Server to 
Process field.
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• Submit one or more SQL (structured query language) statements that add, 
update, or delete records from one or more underlying database(s).

• Run an executable program.
• Run a VB (Visual Basic) script.
All these actions may incorporate data from the corresponding triggered event.

The Order of Action Execution
The order in which CRM Studio actions will be executed is as follows:
• File creations
• SQL statements
• Programs 
• VB scripts

Monitoring the Status of Actions
When an action is triggered by an event, you can use the Everest CRM Studio 
Event Monitor to track its status.

In the Everest CRM Studio Event Monitor (path: CRM > CRM Studio > 
Monitor), select Actions Taken. From here, you can track:
• Actions whose status are Pending
• Action that are Completed successfully
• Actions with Errors that have failed to complete successfully
If any of your actions have failed to complete successfully because of an error 
condition, you may mark the action as complete, or manually delete it.  

Create a File Containing Event Data
The first type of action that CRM Studio can execute is to take information from a 
triggered event and write it into a file. You can use this action for the following:
• To create one or more files of data that will be imported into another company 

(such as files with today’s invoices).
• To create log files of triggered event data.
• To create a file that will be sent (e.g., e-mailed) to a business partner or mailing 

house for future processing.
Similar to designing an event’s alert message, the file that you create can contain 
hard-coded text, database field values (triggered event data), and even CRM 
Studio date substitution variables.
Before you can create the format of a file that will contain triggered event data, 
you need to fill in the following fields:
File Specification

“Monitoring the Status of Events” on page 175

“Action Errors” on page 91
“Taking a Corrective Action” on page 91

CRM Studio will attempt to execute the erroneous action every minute.
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Enter the location and name of the file you wish CRM Studio to create. 

Append content to file specification, if it already exists 
Select this check box to indicate CRM Studio to append content to the above 
specified file, if it already exists on disk.
Overwrite file specification, if it already exists
Select this check box to indicate CRM Studio to overwrite the above specified file, 
if it already exists.
Once you have responded to these fields, you are ready to begin formatting the 
file containing triggered event data. 

• After specifying relevant information in the Webcast tab of the Everest CRM 
Studio - Application Events\(your company)\Events dialog box, click Next. 
You will see the Everest CRM Studio - Application Events\(your 
company)\Events - Action tab - Create File tab.

• Place the cursor in the first row first column of the Contents of the File that 
will be Created field.

• If the file begins with hard-coded text (such as OrderID), enter that text 
directly into the file formatting box.

• If the file begins with a database field value or with a date substitution 
variable, select the appropriate value from the list of Available values for use 
as file content. 

• You can continue to add hard-coded text, field values, and date substitution 
variables until your file format is complete.

A file name may:
• Be hard-coded (e.g., orders.txt)
• Include field values (e.g., {OrderID}.dat)
• Include date substitution variables (e.g., orders_{%Current_Date%})

To format the file that will contain triggered event data, do the 
following:
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Action - Create File

 Figure 6.12: Everest CRM Studio - Application Events\(your company)\Events 
- Action - Create File

Available values for use as file content
This field displays the available fields from the queries that are linked to the 
event, and can be used in the File Specification and Contents of the file that will 
be created fields.
Use selected value
Click this button to use a highlighted value from the Available values for use in 
file content field, in the Contents of the file that will be created field.
File Specification
Enter the location and name of the file.
Append content to file specification if it already exists
Select this option to append the contents to the above mentioned file if it already 
exists on disk.
Overwrite file specification if it already exists
Select this option to overwrite the file, even if it already exists.
Contents of the file that will be created
Specify the file’s content.

File Creation - Notes
• You can use the {BEGIN*REPEAT} and {END*REPEAT} labels in your file. 

This will allow you to create a file that contains multiple records from a single 
triggered event.

You can use the repeat function in the creation of a file only if it is not being 
used in any of the corresponding alert messages.
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• You can create a comma separated file by manually entering a comma after 
each selected database field value.

• You can create a tab-delimited file by pressing the CTRL+Tab key after each 
selected database field value.

Execute a SQL Statement

Depending on the type of databases you are working with, the ability to issue 
SQL statements as the result of a triggered event can be one of the quickest and 
easiest ways to add or update a company database. SQL statements can be used to 
perform such actions as:
• To add order records to a financial database when an opportunity is closed in 

a sales database.
• To update a record in one database when the corresponding record is changed 

in another database.
It is very important to understand that the SQL statement(s) that you specify in 
this option will be executed once for every triggered record in the event. 

A single event may trigger the execution of one or multiple SQL statements. These 
statements may perform actions against the database in which the triggered event 
occurred, and/or against any other SQL-compliant databases.
All standard SQL commands (such as insert, update and delete) are supported in 
the Submit SQL tab.

Issuing SQL statements against a database can be extremely dangerous if 
they are not correctly formatted. Please verify the syntax of your SQL 
statement before submitting it against a live database.
Many databases depend on data synchronization to update both local and 
remote users. It is not advisable for an organization to use SQL statements 
to update such a database, as it may disrupt the synchronization process.

Example If an event runs and is triggered by 10 orders that were shipped later 
than their required date, each SQL statement that is associated with 
this event will be executed 10 times – once for each triggered record.
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Action - Submit SQL

 Figure 6.13: Everest CRM Studio - Application Events\(your company)\Events 
- Action - Submit SQL

Available values for use in the SQL Statement
This field displays the available fields from the queries that are linked to the 
event, and can be used in the SQL Statement to submit to the connection field.
Use selected value
Click this button to use a highlighted value from the Available values for use in 
the SQL Statement field, in the SQL Statement to submit to the connection field.
Enter the connection information and SQL Statement below to submit
Connection Information

Click this field and select a database to connect to, using the  button.
SQL Statement to submit to the connection
Specify the SQL statement to submit.
Wait for Reports to Complete
Specify if the SQL statement should be executed after or before the report 
generation. 

SQL ‘Where’ Clause
It is important to note that the SQL statements that CRM Studio executes from 
the Action tab have no implied ‘where’ clause.
Thus, even though an event’s query(ies) may restrict the records that are retrieved 
to a specific set, the conditions that the query(ies) have applied are not 
automatically applied to the SQL statements that are executed.
Therefore, to make sure that your SQL statement(s) act on the same record (or 

“Delaying SQL Execution Until Reports Are Complete” on page 220
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records) that an event’s query(ies) retrieves, you must include a ‘where’ clause in 
your SQL that identifies precisely which records will be affected.

Specifying the SQL ODBC Connection
The first step in defining a SQL statement that will be executed when an event is 
triggered is the specification of the ODBC connection that will be used when this 
statement is executed.

If you wish to use a SQL statement to update a database that is not currently 
defined within CRM Studio, you can configure a connection record for that 
database directly from the Submit SQL tab.

• Click the Connection Information column and click the list  button that is 
displayed. You will see the Everest CRM Studio - Select the Application 
Connection dialog box.

• Click the Please select the connection information for submitting SQL drop-
down list to display the existing connections.

• Choose the appropriate connection and click OK.

• Click the Connection Information column and click the list  button that is 
displayed. You will see the Everest CRM Studio - Select the Application 
Connection dialog box.

• Click the New Connection button. You will see the Everest CRM Studio - 
Edit Connection dialog box.

• Enter the relevant information required to set up an ODBC source for the 
execution of the SQL statement.

• Click Save and Close. You will again see the Everest CRM Studio - Select the 
Application Connection dialog box.

• Click OK. 

Entering the SQL Syntax
Once you have specified the ODBC connection that you will be using, you are 
ready to enter the syntax of the SQL statement. Here are some guidelines 
regarding the creation of SQL statements:
• You can use any of the data fields from the triggered event.
• You can use any of CRM Studio’s date substitution variables.

“Connect CRM Studio to the ASC Database” on page 22

To select a CRM Studio ODBC connection record that is already defined, 
do the following:

To create a CRM Studio ODBC connection, do the following:

“The Everest CRM Studio - Edit Connection Dialog Box” on page 27

If you add to or change the definition of an ODBC source while you are 
in the Everest CRM Studio Architect, you will have to exit the Studio 
Architect and re-enter for it to recognize the new or modified ODBC 
sources.
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• Do not forget to include a ‘where’ clause at the end of the SQL statement so 
that CRM Studio knows exactly which records to act on.

• You cannot use {BEGIN*REPEAT} or {END*REPEAT} in a SQL statement.
• Keep in mind that a SQL statement will execute once for each record that is 

triggered by an event.
Delaying SQL Execution Until Reports Are Complete

The last item you need to specify when configuring SQL statement actions 
pertains to whether the corresponding event has any Crystal reports associated 
with it.
If the corresponding event has no associated reports, you may leave the Wait for 
Reports to Complete check box blank, in the Enter the connection information 
and SQL Statement below to submit section of the Submit SQL tab.
If the corresponding event does have associated reports, you may wait for the 
reports to be generated before the execution of SQL statement, by checking the 
above option. 

Run a Program
The third action that CRM Studio can perform as a result of a triggered event is to 
run one or more executable programs. These programs, like SQL statement or VB 
script, are executed once for each triggered record in an event. By executing a 
program as a result of a triggered event, you can:
• Use the program to add or update data in an underlying database.
• Call an external company and pass the appropriate data to its database.
• Call an external utility (such as a synthesized voice unit) and pass the 

triggered event data it.

Example You may wish to run a report on triggered event data, and then 
modify that data using your SQL statement.

If this field is left blank, the SQL will be executed immediately.
If this option is checked and any of the associated report(s) fail to be 
completed successfully, the corresponding SQL statement will not be 
executed.
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Action - Run Program

 Figure 6.14: Everest CRM Studio - Application Events\(your company)\Events 
- Action - Run Program

Available values to use for running program or as command line parameters
This field displays the available fields from the queries that are linked to the 
event, and can be used in the Command Line Parameters field.
Use selected value
Click this button to use a highlighted value from the Available values to use for 
running program or as command line parameters field, in the Command Line 
Parameters field.
Enter the program(s) to run
Program to run
Select the program to be executed.

Allow Multiple Tasks
Check this option to allow multiple copies of this task to run simultaneously. If 
this option is not checked, then the server will allow only a single copy of this task 
to run at one time. 

Command Line Parameters
Specify the command line parameters to run the selected program.

Wait for Reports to Complete
Specify if the program should be executed after or before the report generation.

“Selecting a Program to Run” on page 222

“Allow Multiple Tasks” on page 222

“Command Line Parameters” on page 222
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Selecting a Program to Run

• From the Enter the program(s) to run grid, click the Program to Run field and 

click the list  button that is displayed. You will see the Everest CRM Studio 
- Program to Run dialog box from which you can select the program you wish 
CRM Studio to execute.

Allow Multiple Tasks
The Allow Multiple Tasks option allows you to run multiple copies of this task to 
run simultaneously. If this option is not checked, then the server will allow only a 
single copy of this task to run at one time.
This option should never be checked if there is a possibility of many external 
programs running at the same time. The primary concern here is system 
performance.

If, however, you have an event that will never return more than a couple of 
triggered records, and the program that you wish to run is relatively lightweight, 
you may choose to allow multiple instances of that program to run at the same 
time.

Command Line Parameters
The manner in which data from a triggered event can be passed to an executable 
program is via command line parameters. 
All the fields of data from a triggered event, plus all of CRM Studio’s date 
substitution variables, are available for use as command line parameters.

• From the Enter the program(s) to run grid, click the Command Line 

Parameters field and click the list  button that is displayed. You will see the 
Action - Edit Command Line Parameters dialog box.

• Enter or modify the parameters, based on your requirements.
• Click OK.

Delaying Program Execution Until Reports Are Complete
The last item you need to specify when configuring executable program actions 
pertains to whether the corresponding event has any Crystal reports associated 

To choose a program that CRM Studio should run when the 
corresponding event is triggered, do the following:

CRM Studio can run multiple programs in response to the triggering of a 
single event.

Example You have an event that is triggered by closed sales and you have an 
action that ran a program for each of those sales.
If the Allow Multiple Tasks option is enabled and the event is 
triggered by the presence of 10 matching sales, you will have 10 copies 
of the same program running in your system’s memory at the same 
time, thus, decreasing your server’s performance.

We recommend that you do not allow multiple tasks.

To add (or edit) command line parameters, do the following:
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with it.
If the corresponding event has no associated reports, you may leave the Wait for 
Reports to Complete check box blank, in the Enter the program(s) to run grid of 
the Run Program tab.
If the corresponding event does have associated reports, you may wait for the 
reports to be generated before the execution of SQL statement, by checking the 
above option.

If you want the selected program to wait for the report generation, check the Wait 
for Reports to Complete option. If you wish to execute the program immediately, 
leave this field blank.

Program Execution - Notes
It is suggested that you run program(s) that do not need any user intervention to 
complete.
If you are running CRM Studio under Windows NT or 2000 and want an event to 
run a program that requires desktop interaction, you must modify the Everest 
CRM Studio service to meet your requirements.

• From the Control Panel, select Administrative Tools > Services. 
• From the Services console, right-click Everest CRM Studio and select 

Properties. You will see the Everest CRM Studio Properties dialog box. 
• From the Log On tab, select the option Allow service to interact with desktop 

and Click OK.

Run a VB Script
Of all CRM Studio actions, the most powerful (and most-often used for updating 
databases) is the ability to execute Visual Basic (VB) scripts as the result of a 
triggered event.
VB scripts in CRM Studio are similar (in concept) to programs in that the scripts 
can use any data from a triggered event in the script’s execution.
Due to its sophistication, CRM Studio’s VB Scripting Module requires its own 
option where you can configure and test the scripts that you would execute from 
a triggered event. 

Example You may wish to run a report on triggered event data, and then 
modify that data using the selected program.

If this option is checked and any of the associated report(s) fail to be 
completed successfully, the corresponding program will not be executed.

To modify the Everest CRM Studio service to run a program that 
requires desktop interaction, do the following:

Please refer to the chapter ‘Visual Basic Scripting’ for complete details on 
how to configure these scripts.
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Action - Run Basic Script

 Figure 6.15: Everest CRM Studio - Application Events\(your company)\Events 
- Action - Run Basic Script

Link a Script to the Event
Once your scripts are defined you can link one or more of those scripts to a CRM 
Studio event. 

• From the Enter the Basic Script(s) to run grid, click the Basic Script Name 

field and then the list  button that is displayed. You will see the Everest 
CRM Studio - Select Basic Script dialog box, displaying all the scripts that are 
currently available for use as a response to a triggered event.

• Highlight the script you wish to use and click Select. The script gets added to 
the Enter the Basic Script(s) to run grid.

• Once selected, CRM Studio displays the name and file specification of the 
selected script.

• Repeat these steps for each script you wish to associate with an event.

VB Script - Notes
It is suggested that you run script(s) that do not need any user intervention to 
complete.
If you are running CRM Studio under Windows NT or 2000 and want an event to 
run a script that requires desktop interaction, you must modify the Everest CRM 
Studio service to meet your requirements. Refer to “Program Execution - Notes” 
on page 223 for this procedure.

To link a script to an event, do the following:

CRM Studio supports both front-end scripts (those that are used instead of 
a query) and back-end scripts (those that are used as an action in response 
to a triggered event). The list that you see includes only front-end scripts.

Like SQL statements and executable programs, a CRM Studio script will be 
submitted once for each record that is retrieved by a triggered event.

The CRM Studio Action Server will be held in a waiting state until the 
required interaction with the desktop is complete.
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Add Subscribers
The Subscribers tab allows you to specify who will receive alerts about a 
triggered event and via what means (e-mail, fax, pager, copy, or webcast). The 
Subscribers tab comprises two tabs:
• Standard (which is the default) 
• Advanced

Standard Subscribers

There are four types of standard subscribers:
• Individuals
• Groups of people
• Individual computers
• Groups of computers
People can be notified via e-mail, fax, copy/ftp, pager, and webcast.
Computers can be notified via copy/ftp only.

Adding a Standard Subscriber

• From the Everest CRM Studio - Application Events\(your company)\Events 
- Subscribers - Standard tab, click the Add Subscriber button. You will see 
the Everest CRM Studio - Add Subscriber dialog box.

• If you wish to send alerts to all the members of a specific group, select the 
check box to the left of the group’s name.

• If you wish to send alerts to specific subscribers, expand the group to which 
that subscriber belongs, and locate the subscriber’s name. Select the check box 
to the left of the subscriber’s name.

• Repeat this process for each group or subscriber you wish to notify. 

Before you select subscribers for an event, you must define them within the 
CRM Studio database.

Copy/ftp notifications refer to CRM Studio’s ability to copy (or ftp) reports 
and/or files that are associated with a triggered event.

To add a standard subscriber, do the following:

“The Everest CRM Studio - Add Subscriber Dialog Box” on page 67

If you select a group, all the members of the group will be notified via the 
same delivery method.

• A single event can notify any combination of groups and individual 
subscribers.

• If CRM Studio is configured to perform subscriber linking, you may 
have to wait a few seconds to display the members of a linked group, as 
CRM Studio must dynamically retrieve this information from an 
external database.
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• When you have selected the required subscribers, click the Add Subscriber 
button in the Everest CRM Studio - Add Subscriber dialog box. You will see 
the Everest CRM Studio - Application Events\(your company)\Events - 
Subscribers - Standard tab again.

The selected users are displayed in the Users Targeted For Delivery grid and 
computers in the Computers Targeted For Delivery grid.

Choosing a Subscriber’s Delivery Methods
Once you select your subscribers, choose the method(s) by which each subscriber 
will be alerted about the corresponding event.
By default, E-mail is selected as the only alert message delivery method for each 
subscriber. You can retain (or remove) this method, and you can add any of the 
other four methods for each subscriber. 

Be careful to select only those delivery methods that have alert message text 
associated with them. Also, be sure that the selected subscribers have a valid 
delivery address for the methods chosen for them.

Removing an Event’s Subscribers

• From the Users Targeted for Delivery (or Computers Targeted for Delivery) 
grid in the Everest CRM Studio - Application Events\(your 
company)\Events - Subscribers tab - Standard tab, select the row you wish to 
remove by clicking on the row header.

• Click the Remove Subscriber button.

The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Subscribers - Standard

This tab is used by an event to notify a pre-defined group of subscribers, such as 
John Smith, Mary Reynolds, and Pat Crowley.

Computers may be notified only via the copy/ftp method.

To remove a subscriber from an event, do the following:

You can also click the button Remove All Subscribers to delete all the 
subscribers that have been selected for this event. 
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 Figure 6.16: Everest CRM Studio - Application Events\(your company)\Events 
- Subscribers - Standard

Add Subscribers
Click this button to display the Everest CRM Studio - Add Subscribers dialog 
box, which allows you to add users to the Users Targeted For Delivery grid, and 
computers to the Computers Targeted For Delivery grid.

Users Targeted For Delivery
This grid displays the selected subscribers (users) and the alert modes they are 
subscribed to.
Computers Targeted For Delivery
This grid displays the selected subscribers (computers) and whether they are 
eligible to receive files by the Copy (FTP) mode.
Remove Subscriber
Click this button to remove a selected user from the Users Targeted For Delivery 
grid, or a selected computer from the Computers Targeted For Delivery grid.
Remove All Subscribers
Click this button to remove all users from the Users Targeted For Delivery grid, 
or all computers from the Computers Targeted For Delivery grid.

Advanced Subscribers
Advanced subscribers are divided into two groups:
• Subscribers who are identified through the presence of a unique database 

value within a triggered record.
• Subscribers whose address is contained in a field within a triggered record.

Delivering to Subscribers Using a Database Lookup Value
Consider the following scenario:
You have a customer support database that tracks calls assigned to various 

“The Everest CRM Studio - Add Subscriber Dialog Box” on page 67

A single event may send alerts to a combination of standard and advanced 
subscribers.
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support representatives. Each support representative is identified by a unique ID 
as well as a non-unique group code (such as the Frontline group).
The support database does not store the corresponding representative’s e-mail 
and other notification addresses anywhere in the database.
When a support call meets a condition that warrants an alert to the corresponding 
support representative, you need the following to occur:
• CRM Studio looks at the triggered record and finds the corresponding 

representative’s ID and group name.
• CRM Studio looks up the matching subscriber record (based on the 

representative’s ID) and the matching subscriber’s group (based on the 
representative’s group name) in the subscriber database.

• CRM Studio alerts the corresponding support representative and/or group.
If the database(s) that an event is linked to requires this look-up ability, you can 
specify the fields (in each triggered event record) that contain the subscriber’s ID 
and their group name in the Deliver to user or group in subscriber folder using 
database lookup value grid.

As long as these fields are present in the event’s associated query(ies), you can 
instruct CRM Studio to use these values.

• From the Deliver to user or group in subscriber folder using database 
lookup value grid in the Everest CRM Studio - Application Events\(your 
company)\Events - Subscribers - Advanced tab, click the first row of the 

Database Field column and click the list  button that is displayed.
• Choose the database field that contains a subscriber’s unique ID (the same 

value as present in the User Lookup Key field within the subscriber’s record 
in the CRM Studio database).

• Specify whether subscribers will be notified via one or any combination of e-
mail, fax, copy, page, or webcast, by selecting the appropriate options.

• From the Deliver to user or group in subscriber folder using database 
lookup value grid in the Everest CRM Studio - Application Events\(your 
company)\Events - Subscribers - Advanced tab, click the second row in the 

Database Field column and click the list  button that is displayed.

The database fields that contain the subscriber’s ID (also called user lookup 
key) and the subscriber’s group name must be included as one of the fields 
in an event’s associated query(ies). 

Example If the field that contains a support representative’s ID is called Rep ID, 
and the field that contains the representative’s group name is called 
Rep Group, you need to make sure that {Rep_ID} and {Rep_Group} 
are both selected as columns in the associated query.

To deliver an alert to an individual subscriber based on the subscriber’s 
unique ID, do the following:

“User Lookup Key” on page 35

To deliver an alert to all subscribers in a CRM Studio subscriber group 
based on the group value in a triggered record, do the following:
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• Choose the database field that contains the subscriber group’s name. 

• Specify whether subscribers will be notified via one or any combination of e-
mail, fax, copy, page, or webcast, by selecting the appropriate options.

• Choose whether the subscribers in a group will be notified via one or any 
combination of e-mail, fax, copy, page, or webcast, by selecting the 
appropriate options.

Delivering to Subscribers Using an Address in the Triggered Event
One of the most common CRM Studio alert scenarios is one where an alert 
message needs to be delivered to a person associated with a triggered event 
record. 

In all these cases, you cannot hard-code the alert recipient because the recipient 
will vary based on the records that are causing the event to trigger.
As long as the records that are causing the event to trigger contain the address (e-
mail address, fax number, pager number, etc.) of the person who should receive 
the notification, CRM Studio can send the alert accordingly.
To make this function work, you must be sure to include the field(s) that contain a 
recipient’s delivery address(es) within the query(ies) associated with the event.
In other words, if you wish to send e-mail alerts to a support representative, the 
first thing you need to do is identify what field contains the representative’s e-
mail address. As long as you include this field in the query for an event, the event 
can send the alert to that address.
The delivery of an alert to an address that is contained within a triggered event is 
done from the Deliver to specific e-mail, pager, fax or webcast name using 
database value grid of the Advanced tab. 
Depending on which method (or methods) you wish to send alerts by, you will 
need to map fields from your event’s query to supply each recipient’s e-mail 
address, fax number, pager number, pager PIN, and webcast name.

• From the Deliver to specific e-mail, pager, fax or webcast name using 
database value grid in the Everest CRM Studio - Application Events\(your 

“User Lookup Key” on page 35

The value must exactly match (including case) the name of a subscriber 
group in the CRM Studio database for all members of that group to be 
notified.

“Use a Group Lookup Key” on page 163

Example • Notify the support representative to whom an escalated call is 
assigned.

• Notify the sales representative who has an overdue activity.
• Notify the manager of a person who has not responded to a 

customer call.

To map fields from your event’s query to supply each recipient’s contact 
details, do the following:
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company)\Events - Subscribers - Advanced tab, click the first row of the 

Database Field column and click the list  button that is displayed.
• Choose the field(s) that contain the corresponding subscriber’s delivery 

addresses. 
For every address mapping field that you fill in, the corresponding subscribers (as 
determined by the triggered event) will get notified via those methods.

The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Subscribers - Advanced

This tab is used by an event to notify people based on the records that are 
triggered. 

 Figure 6.17: Everest CRM Studio - Application Events\(your company)\Events 
- Subscribers - Advanced

Deliver to user or group in subscriber folder using database lookup value
This grid allows you to specify users or groups eligible to receive alerts, based on 
a database lookup value.
Deliver to specific e-mail, pager, fax or webcast name using database value
This grid allows you to specify which e-mail address, pager number, fax number 
or webcast location to send alerts to, based on a database lookup value.

Monitoring the Status of Alert Messages
When an alert message is triggered by an event, you can use the Everest CRM 

Example An event that identifies all opportunities that are due to close this 
week and needs to send a separate alert to each sales representative 
associated with these events.

A single event may send alerts to a combination of standard and advanced 
subscribers.
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Studio Event Monitor to track the status of the message’s delivery.

• In the Everest CRM Studio Event Monitor (path: CRM > CRM Studio > 
Monitor), select Application Events. 

• Click any of the Triggered branches and locate the triggered event whose alert 
messages you wish to track.

• Highlight (click) the triggered event.
• Click the Deliverables button at the bottom-left of the dialog box. You will see 

a list of all the subscribers for that event in the right panel.
• Review the details of each subscriber; the person who was supposed to be 

notified, the method of notification and the time of delivery of the message. 
You will also see if the delivery was successful.

• Click the Close Deliverables button. 

Specify a Schedule
The last step in the configuration of a CRM Studio event is the specification of the 
schedule (or frequency) that determines how often you wish to check if the event 
is triggered.
 Every event has its own schedule; it can be triggered as often as every minute, 
and as infrequently as once a day, week, month, or year.
CRM Studio includes approximately a dozen pre-configured schedules. You may 
edit these schedules as well as create additional schedules of your own.

Choosing a Schedule

• From the Choose a schedule to use field in the Everest CRM Studio - 
Application Events\(your company)\Events - Schedule tab, click the drop-
down button to display pre-configured schedules.

“Monitoring the Status of Events” on page 175

To track the status of the message’s delivery, do the following:

You can also view the details (text) of the actual outgoing alert message by 
simply going up to the triggered event record and pointing your cursor at 
the appropriate column (in the grid) that contains the e-mail, fax, pager, or 
webcast text. The grid automatically expands to display the full text of the 
alert message.

“Action Errors” on page 91
“Taking a Corrective Action” on page 91

To select a schedule that will control how often CRM Studio checks if an 
event is triggered, do the following:
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• If you see a schedule that fits your requirements, select it; if not, you can create 
it.

Schedule Holiday Handling
In the Everest CRM Studio Administrator module you can identify those dates 
that are designated as holidays for your organization and specify (on an event-by-
event basis) whether or not an event should be submitted on a date identified as a 
holiday.
In the Schedule tab, select the option Should this run on a holiday if you want an 
event scheduled on a holiday to run. 

Event Dependencies
When configuring CRM Studio events, you may come across a situation such as 
the following:
• If event ‘a’ is triggered, submit event ‘b’ immediately to see if it is also 

triggered.
In this example, event ‘b’ is referred to as dependent on event ‘a’.
CRM Studio has two ways to accommodate this scenario; one is through the use 
of the Dependency function on the Schedule tab, and the other is by using a 
Visual Basic script to submit the execution of one or more subsequent events.
The following sections will address how to use the Dependency function within 
the Schedule tab.

How to Configure a Dependent Event
By definition, a dependent event (such as event ‘b’ in the preceding example) is 
one which you want to execute only if the event on which it is dependent (event 
‘a’) is triggered.
Consequently, event ‘b’ should not have its own schedule; Schedule event ‘b’ (the 
dependent event) as ‘None’ so that it will be submitted only if its dependency is 
met.
It is also important to note that a single event (such as event ‘b’) can be dependent 
on any one of a number of other events, but not on a combination of other events 
(e.g., event ‘c’ cannot be dependent on triggering of both events ‘a’ and ‘b’).

• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Application Events > (your company) > Events. You 
will see all the events in the right panel.

• Select and open the dependent event. You will see the Everest CRM Studio - 
Application Events\(your company)\Events dialog box. Click the Schedule 
tab.

• The schedule called When E-mail Arrives is reserved for use only with 
the CRM Studio E-Mail Response System.

• You can choose ‘None’ as a schedule if you wish to configure an event 
but do not want CRM Studio to actively schedule it. This is particularly 
useful for events that you wish to run on an ad-hoc or on-demand basis.

To specify that an event’s submission is dependent on triggering of 
another event, do the following:
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• From the Choose a schedule to use drop-down list, select None. Click the 
Add Dependency button. You will see the Everest CRM Studio - Add 
Dependency dialog box. This dialog box is similar to the Everest CRM Studio 
- Add Query dialog box.

• If you wish to make the current event dependent on another event within this 
database, select the event that the current event will be dependent on.

• If you wish to make the current event dependent on an event within a 
different database, click the Select Another Application button and select the 
database that contains the event you wish to make the current event 
dependent on.

• Select the event that the current event will be dependent on. The selected 
event is displayed in the The current event will be triggered if the following 
event(s) are triggered grid. 

• Repeat the above steps if you wish to add other events that the current event is 
dependent on. 

Removing an Event’s Dependencies

• From the The current event will be triggered if the following event(s) are 
triggered grid in the Everest CRM Studio - Application Events\(your 
company)\Events - Schedule tab, select the dependency you wish to remove 
by clicking on the row header.

• Click the Remove Dependency button.

“The Everest CRM Studio - Add Query Dialog Box” on page 63

“The Everest CRM Studio - Select Another Application Dialog Box” 
on page 64

You cannot make a single event dependent on multiple others.

To remove a dependency from an event, do the following:

You can also click the Remove All Dependencies button to delete all of the 
dependencies that have been selected for this event. 
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The Everest CRM Studio - Application Events\(your 
company)\Events Dialog Box - Schedule

 Figure 6.18: Everest CRM Studio - Application Events\(your company)\Events 
- Schedule

Choose a schedule to use
Select a pre-configured schedule from the drop-down list.
Edit This Schedule
Click this button to edit a schedule displayed in the Choose a schedule to use 
field. The Everest CRM Studio - Scheduled Report dialog box is displayed.
Create New Schedule
Click this button to configure a new schedule. The Everest CRM Studio - 
Scheduled Report dialog box is displayed.
Scheduling Information
Enter relevant information about the schedule, for the reference of other users.
Should this run on a holiday
Select this option if the schedule should be executed even on holidays. 

Add Dependency
Click this button to display the Everest CRM Studio - Add Dependency dialog 
box, which allows you to specify the event(s) on which this event is dependent.

The current event will be triggered if the following event(s) are triggered
This grid displays the other events that this event is dependent on.
Remove Dependency
Click this button to remove a selected event from the The current event will be 

“Schedule Holiday Handling” on page 232
“Holiday Schedule” on page 99

“Event Dependencies” on page 232
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triggered if the following event(s) are triggered grid.
Remove All Dependencies
Click this button to remove all events from the The current event will be 
triggered if the following event(s) are triggered grid.

Creating/Editing a Schedule

• From the Everest CRM Studio - Application Events\(your company)\Events 
- Schedule tab, click the Create New Schedule or Edit This Schedule button. 
You will see the Everest CRM Studio - Scheduled Report dialog box.

• Type in a description of the schedule you are creating or editing (e.g., 
Everyday at 3 PM)

• If you are creating a schedule for events that should not be submitted until 
after a specific date, enter the appropriate date (in the format XX/XX/YYYY 
HH:MM) in the field Should not run until after date/time. If events using this 
schedule are eligible to be submitted immediately (when this schedule is due 
to run next), leave this field blank.

• From the Frequency drop-down list, choose a recurring frequency for this 
schedule. Your choices are:
- Every ‘n’ minutes
- Hourly
- Daily
- Weekly
- Monthly
- Annually
- None (used only for events that have no schedule)

• Based on the frequency you choose, you will be prompted to supply 
additional scheduling details, such as the time of day to run, the day of the 
week, etc.

To create a schedule or edit an existing schedule, do the following:

Example A schedule for events that should not be submitted until January 2nd 
of the following year.

The frequency called When E-mail Arrives is reserved for use only with the 
CRM Studio E-Mail Response System.
Everest CRM Studio 235
User Guide



Event Designing CRM Studio
The Everest CRM Studio - Scheduled Report Dialog Box - Description

 Figure 6.19: Everest CRM Studio - Scheduled Report - Description
ID Number
This field displays the ID of the schedule. You cannot modify it.
Schedule
Specify a name for the schedule.
Should not run until after date/time
Enter the appropriate date (in the format XX/XX/YYYY HH:MM) if you are 
creating a schedule for events that should not be submitted until after a specific 
date.
Frequency Information
Frequency
Select a recurring frequency for this schedule from the drop-down list. Based on 
the selected option, additional fields are displayed, prompting you for additional 
information.
Notes
Enter any relevant notes about this schedule.

Configuring a Schedule’s Allowed Range
There are three components to the configuration of a schedule’s allowed range:
• The months of the year during which the schedule is eligible to be submitted 

(select the eligible months).
• The days of the week during which the schedule is eligible to be submitted 

(select the eligible days).
• The hours of the day during which the schedule is eligible to be submitted 

(specify the beginning and ending times between which the schedule may be 
submitted). These times are inclusive.
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The Everest CRM Studio - Scheduled Report Dialog Box - Allowed 
Range

The options in this tab allow you to define when the schedule will run. 

 Figure 6.20: Everest CRM Studio - Scheduled Report - Allowed Range

Monitoring the Status of Scheduled Events
When an event is scheduled to be checked by CRM Studio, you can use the 
Everest CRM Studio Event Monitor to track the status of its submission.

• In the Everest CRM Studio Event Monitor (path: CRM > CRM Studio > 
Monitor), select Scheduler > Next Run Date/Times. You will see a list of all 
scheduled events that are pending for execution in the right panel.

• Once an event is submitted by the CRM Studio Scheduler, click the 
Application Events branches and locate the event. Monitor whether the event 
has been successfully checked and/or triggered, and whether any error has 
occurred.

Triggered Items
This tab lets you see whether the current event has been checked and triggered. 
You can also view the unique IDs of all the triggered records.
 The primary use of this tab is to enable you to clear the triggered records for an 
event and thus enable it to be triggered again. You can clear all the triggered 
records or only selected records for an event.

“Monitoring the Status of Events” on page 175

To track the status of the message’s delivery, do the following:

The Triggered tab displays the date and time when the event was last 
checked, the date and time when the event was last triggered, and the value 
of the unique field (as defined in the event’s query) for each record that was 
triggered.
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Clearing Triggered Records

• From the Items triggered by this event grid in the Everest CRM Studio - 
Application Events\(your company)\Events - Triggered tab, select the row 
you wish to remove by clicking on the row header.

• Click the Remove Triggered Item button.

If Your Event Isn’t Triggering . . . 
The most common call that comes to Everest Software support is that an event is 
not getting triggered or the e-mail message is not getting sent.
If this happens, the first thing to do is to check the Everest CRM Studio Event 
Monitor and locate the event – see if it appears under Application Events that are 
pending, checked, triggered, or have recorded errors.
The most typical scenario is that an event is being checked, but it is not being 
triggered. Here is a list of most likely reasons:
• The ‘e-mail sending’ account is not correctly configured. Perform an e-mail 

test to see if this account is successfully sending an e-mail message.
• The event is already triggered. Many events are configured to send only one 

alert per triggered record. Go into the Triggered tab for the event and see if 
any triggered records are listed. If so, this may be why the event is not 
triggering again.

• The method by which the alert is being sent (e.g., e-mail) does not have any 
corresponding alert message text. If there is no text, no message can be sent.

• The subscriber (recipient) who is to receive the alert message does not have an 
address defined for the corresponding method (i.e., an event that sends an 
alert via e-mail requires that the subscriber not have a blank e-mail address)

• The event is not active (check the Description tab of the event).
• The event that is being triggered does not have a valid E-Mail Sending 

Account specified.
• There is no query specified for the event, or the query has some parameters 

associated with it that have been left blank.
• No delivery method (e.g., e-mail) has been specified for the subscribers 

selected for the event.

If Your Event Is Triggering Over and Over . . . 
Check out the event query’s Unique value. If a query does not have a unique 
value, the corresponding event triggers over and over again, until the query’s 
condition is no longer met. 
You might also look at the setting of the event’s Repeat Notification for 
Triggered Items option (in the event’s Description tab). If this box is checked, the 

To remove a triggered record, do the following:

• You can also click the Remove All Triggered Items button to delete all 
of the items that are triggered by this event. 

• You may need to exit the Triggered tab and re-enter, to verify that all 
triggered items have been removed.
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event continues to be triggered (and send alerts) over and over.

Schedule an Event to Run Right Now
As you configure CRM Studio events, one of the most frequently-used functions 
in the Studio Architect is the ability to run a specific event right now.
This is particularly useful, as you can configure an event to use a specific schedule 
(such as hourly, daily, or weekly), but still have the ability to submit the event 
right away to confirm that it will execute successfully.
The Schedule This Now function is also useful as it enables you to submit ad-hoc 
executions of a specific event. 

• Ensure that the Everest CRM Studio service (path: Control Panel > 
Administrative Tools > Services) is running.

• From the Everest CRM Studio Architect dialog box, select Event 
Management Folders > Application Events > (your company) > Events. You 
will see all the events in the right panel.

• Click (highlight) the event you wish to run right now.
• Click the Schedule This Now button at the top of the Everest CRM Studio 

Architect dialog box.
• You will be asked to confirm the submission of your selected event. Click Yes.
The event will be scheduled for immediate execution, and may be tracked in the 
Everest CRM Studio Event Monitor.

Example You may have an event that runs once a week (on Mondays), but your 
server might have been shut down (for maintenance) on that day. 
Using the Schedule This Now function, you could manually submit 
specific events to run on Tuesday that were originally scheduled to 
run on Monday.

To schedule an event to run right now, do the following:
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The key to the alerting process is the ability to not just notify people about events 
that require their attention, but to update the business databases that these people 
use with the details of the event that took place, and the follow-up actions that 
need to be executed. 
To facilitate the process whereby a time-critical event can not only trigger an alert, 
but also dynamically update one or more business databases, CRM Studio 
includes a VB (Visual Basic) and VBA (Visual Basic for Applications) scripting 
module. This module provides the ability to acquire information pertaining to a 
CRM Studio triggered event and use it to update data in one or more databases.
This chapter outlines the manner in which the VB/VBA scripting module is 
designed within the CRM Studio solution, and enunciates the benefits of this 
module to CRM Studio users.

Requirements
Although CRM Studio includes a number of sample scripts that an organization 
can use, the requirements of most companies necessitate the creation of one or 
more site-specific scripts.
CRM Studio includes a very robust VB script designing tool, complete with pre-
defined script templates, on-line documentation and help text, and script syntax 
testing facilities. 

Front-End Versus Back-End Scripts
CRM Studio scripts can be designed to be utilized in two ways:
• As an action that is executed after an event is triggered. Once an event is 

triggered, all the data related to the triggered event (including the field-level 
details of individual records) is made available to one or more scripts that you 
wish to execute. 

This is referred to as a back-end script because it executes after an event is 
triggered. 

• As the means to check for a condition that is not related to information in an 
ODBC-compliant database or in an incoming e-mail message. 

Although CRM Studio typically uses queries to identify an event’s trigger 
criteria, queries cannot identify data that resides outside an ODBC-compliant 
database, or outside an incoming e-mail message. To identify conditions such as 
low disk space, a process that is not running, or a file that has been updated, CRM 
Studio enables a VB script to be used in lieu of a query.
This is referred to as a front-end script because it determines whether or not an 
event will be triggered.

The scripting module should be reserved for use only by those 
individuals who are familiar with the Visual Basic language, and have 
some experience in writing VB scripts.

A single event may trigger the execution of one or more back-end scripts.

A single event that uses a front-end script can also use one (or more) back-
end scripts to respond to the triggered event.
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Sample Back-End Scripting Scenarios
Here are ten scenarios where CRM Studio’s back-end scripting functions could 
be used:

Sample Front-End Scripting Scenarios
Here are six scenarios where CRM Studio’s front-end scripting functions could 
check for conditions outside the ODBC-compliant databases, and to send alerts 
and take appropriate response actions:
• Check if available disk space on your database server drops below 55 MB.
• Check if SQL Server is still running.
• Check if critical files have been updated.
• Check if a Sync Server is still running.
• Check the NT Event Log for potential security breaches.
• Check for data conditions in a non-ODBC compliant database. 

Back-End Scripting Set-Up
The subsequent pages will guide you through the process of setting up a back-
end script and linking it to an event. This will be followed by a brief discussion on 
how you can configure front-end scripting within CRM Studio.

Condition Script
A client places more than two orders 
with you this month.

Update the client’s status to Active

A client has more than $50,000 in 90 
Days receivables

Change the client’s credit status to On 
Hold

A client requests support more than 
10 times in a month

Create a support call to offer the client 
training services

A client closes an opportunity in a 
CRM database

Create a sales order in a financial 
database

A client updates a contact in a 
financial database

Update the corresponding client in a 
CRM database

A client is placed on credit hold in a 
financial database

Update all of the client’s 
opportunities in a sales database

An account is de-activated Close all the open activities for that 
account

A client sends in a tech support e-
mail

Create the corresponding ticket in a 
support database

A client sends in an e-mail 
unsubscribe request

Remove the client from your mailing 
list

A new prospect sends e-mail 
requesting product information

Add the prospect to your CRM and 
financial databases
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Prepare Queries
To begin using back-end scripts in CRM Studio you must decide what you want 
the scripts to do. The best way to approach this is to look at your events and 
figure out which events need to write data back into one or more databases. 
Once you identify such an event, you are ready to begin thinking about the 
corresponding query(ies) and script(s) you will require.
The very first thing you should do is go to the query(ies) that the event uses and 
ensure that all fields (columns) that you might wish to use in your script are 
retrieved by the query.
This is a very important step – just as you must be careful (when designing 
queries) to choose those fields that you wish to place in an outgoing alert 
message, you must likewise be careful to choose those fields whose values you 
wish to pass into the script(s) that an event will trigger.
If you wish to have access to a field within an event’s script, you must be sure to 
select that field as a column for the queries that are associated to that event. 

Create the Back-End Script
Once you have ensured that the query(ies) that an event uses will make available 
the necessary information to the event’s script, you are ready to begin designing 
your script. 
Each company that is defined within the Everest CRM Studio Architect has a 
separate branch called Basic Scripts to store the scripts that are associated with 
that database.

 Figure 7.1: Everest CRM Studio - Basic Scripts

Adding a New Back-End Script

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

To add a new back-end script, do the following:
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• From the Event Management Folders panel in the center, select Application 
Events. You will see all the companies that CRM Studio is currently 
configured to integrate with.

• Select the company for which you want to design events and click Basic 
Scripts. You will see a list of scripts (if any have been created) in the right 
panel.

• Click the New Basic Script button at the top-left. You will see the Everest 
CRM Studio - Application Events\(your company)\Basic Scripts dialog 
box, using which you can design basic scripts for the selected company.

The Everest CRM Studio - Basic Scripts Dialog Box

 Figure 7.2: Everest CRM Studio - Basic Scripts 
Internal ID Number
This field displays the ID of the script. You cannot modify it.
Basic Script Name
Enter a name for this script.
Basic Script Description
Enter a description of this script.
Basic Script File Specification
Specify the location and name of the script file.
Browse
Click this button to display the Everest CRM Studio - Select a Basic Script File 
dialog box, which allows you to browse for, and select script files.
Check Script Syntax
Click this button to check your script for syntax errors. When you click this 
button, you will be informed of any script syntax errors that exist, or that your 
script’s syntax has been successfully verified.

By default, CRM Studio automatically stores your scripts in a special 
directory where the company is installed, but you may override this 
location according to your needs.
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Edit/Test Script
Click this button to edit and modify the script’s contents as well as test the script 
from the Cypress Enable Script Editor dialog box.
Output from Script
This section is automatically updated when you check the script syntax. You 
cannot modify it.

Editing a Script
Once you fill in the general information about the script you are creating, click the 
Edit/Test Script button to begin editing the content of your script. It is advised 
that you have a list of the customized names of all the fields of data that you wish 
to pass from the corresponding event into this script.
When you click the Edit/Test Script button, you will see the Cypress Enable 
Script Editor dialog box that begins with an area for script author details and 
general overview.
The script is described in the following sections, which are detailed below:
• General Information
• Retrieve General Event Data
• Retrieve Alert Message Text
• Retrieve Query SQL Syntax
• Retrieve Event Data Fields
• Run Subsequent Events
• Specify Return Status Codes
• Enter Your Script Syntax 

General Information
The first part of a script is where you can specify the purpose of the script, your 
name (as the script author), the date when the script was created and the date 
when it was last modified. This part of the script will look like the following:
' Script Name          : Template.bas
' Script Author        : Development
' Script Purpose       : This script serves as a template
' Script Creation Date : 2/5/2001
' Script Modified by   : 
' Script Modified Date : 
' Script Modifications : 
'
'
' The following declared functions are available
' to the script author in order to interact

' more closely with Everest CRM Studio. All are optional
'

' Scripts may be executed by Everest CRM Studio in two ways.
'
' 1) As an action to a triggered event.
'
' 2) In place of a query in order to have the script
'    trigger events.
'
' Please note, a script used as an action cannot trigger events.
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Retrieve General Event Data
The second section of a script instructs you on how you can retrieve general 
information about the triggered event such as the event’s description and the 
name of the database to which the event is associated. This part of the script will 
look like the following:
' The following functions are used when a script is executed
' as an action.
'
Declare Function KSGetEvent App ( ByVal s As String ) As String
'
' This function retrieves specific data about the event that
' has triggered.
'
' The available values that can be passed to KSGetEvent in
' order to retrieve data are as follows:
'
' lookup          Returns the Lookup key as defined in
'                 the Event Manager
' application     The application that the event belongs to
' description     The description of the event
' id              The id of the event
' dns             The ODBC datasource name of the application
' username          The username for the connection of the application
' password       The password used for the connection
' apiname           The optional API name set in the connection properties
' apiusername     The optional API username for the connection of the

                                  application
' apipassword    The optional API password used for the connection

Retrieve Alert Message Text
The third section of a script details how you can retrieve the texts contained in the 
various alert messages that are associated with the triggered event. This part of 
the script will look like the following:
'
Declare Function KSGetPackage App ( ByVal s As String ) As String
'
' This function retrieves data about the package that was

' created for delivery by KnowledgeSync. The values that
' can be passed to KSGetEvent in order to
' retrieve data are as follows:
'
' e-mail subject      The subject of the e-mail for delivery
' e-mail message      The e-mail message text for delivery
' page message        The pager message text for delivery
' fax subject         The fax subject text created for delivery
' fax message         The fax message text create for delivery
' fax comments        The fax comments text created for delivery
' webcast subject     The webcast subject text for delivery
' webcast message     The webcast message text for delivery

Retrieve Query SQL Syntax
The fourth section of a script details how you can retrieve the SQL syntax from 
the queries that are associated with the triggered event. If an event uses multiple 
queries, you can retrieve the SQL syntax from any one or all of the corresponding 
queries. This part of the script will look like the following:
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Declare Function KSGetSQL App ( ByVal l As Long ) As String
'
' This function retrieves the SQL from the query that was used
' to trigger the event.
' You pass a number of the query used.
' For example if the event has only one (1)
' query, then you would pass the number 1
' Example: mysql=ksgetsql(1)
' retrieves the sql from the first query
'

Retrieve Event Data Fields
The fifth section of a script describes the method by which you can retrieve the 
values from individual fields (columns) that were specified within the query(ies) 
associated with the triggered event. This part of the script will look like the 
following:
Declare Function KSGetData App ( ByVal s As String ) As String
'
' This function retrieves columns of data from the queries
' that triggered the event. You pass the customized
' column name as defined in the query builder to
' retrieve that information.
' Example: print ksgetdata(companyname) ' prints
' company name from the query data
'

Run Subsequent Events

The sixth section of a script allows you to call other events for execution. This is 
very useful, as it enables you to immediately run one or more other events upon 
conclusion of this script. This part of the script will look like the following:
Declare Function KSScheduleEvent App ( ByVal lookup As String) As String
'
' This function immediately schedules the event matching the 
'lookup string on the description Tab of the Event Manager.
'
' The parameters are as follows:
'
' lookup   The lookup string that uniquely identifies the Event in the '
'        Event Manager
'        Returns a string error message if unable to schedule
'        event. Returns empty string if Event is scheduled.
' 

Specify Return Status Codes
The seventh section of a script contains details on how you can specify what 
information the script will return to CRM Studio if the script fails to complete 
successfully. This part of the script will look like the following:
Global KSReturnStatus As Long
'
' Set this value if you want to return an error status number.
' If you don't set this value, then the script is assumed to
' have worked successfully and is stamped completed by KS.
'
Global KSReturnMessage As String

The section that refers to using a script to trigger an event is not applicable 
to back-end scripting.
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'
' Set this value if you want to return an error message
'
Global KSReturnComplete as long
'
' Set this value to -1 if you want the script to complete even 
' if there’s an error. Normally, when scripts error, the
' Action server will attempt to execute them again in 1 minute 
' until they complete without error.
'
On Error Resume Next
'
' Tell KS how things went by setting the return status
' Set this to a non-zero if there was an error. This will be
' Seen in the monitor in the errors section or corrective
' actions in the administrator

KSReturnStatus = 0

' Set return message string. Place error message in this
' variable if there was one, This will show up in the monitor

KSReturnMessage = Success

Enter Your Script Syntax
The final section of a script is where you can actually type in the syntax of the 
script you wish to execute. This part of your script will fall between the lines 
“Begin your script here” and “End your script here” as is shown below:
' Begin your script here

' End your script here
End

Link the Script to an Event
When you finish editing your script (and checking the script syntax for any 
errors), you are ready to link the script to one or more events. 

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Management Folders panel in the center, select Application 
Events. You will see all the companies that CRM Studio is currently 
configured to integrate with.

• Select the company for which you want to design scripts and click Events. You 
will see a list of events (if any have been created) in the right panel.

• Edit/Create (if necessary) the event you wish to link the script to.
• From the Action tab, select the Run Basic Script tab. 

A carefully constructed script can be used with multiple events, as long as 
the events make the necessary columns of data available to the script.

To link a script to an event, follow these steps:
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• From the Enter the Basic Script(s) to Run grid, click the Basic Script Name 

column and click the list  button. You will see the Everest CRM Studio - 
Select Basic Script dialog box, displaying all the scripts that are currently 
available for use as a response to a triggered event.

• Highlight the script you wish to use and click Select. The script is added to the 
Enter the Basic Script(s) to Run grid.

CRM Studio displays the name and file specification of the selected script.
Repeat these steps for each script you wish to associate with an event.

Front-End Scripting Set-Up
Front-end scripting is handled through the same Script Maintenance option as 
back-end scripting; the primary difference is that instead of passing information 
from an event’s query to a script, a front-end script contains the instructions to 
check for a specific condition of data and then identify those elements of data that 
need to be passed back into the event.

Identify the Script’s Database
When designing a front-end script, you must first decide which database you 
wish to associate the script to. If the script is associated with a specific database, 
you might wish to create that script within the Basic Scripts branch of that 
particular company. 
However, if that script is not related to a database currently in the Everest CRM 
Studio Architect, you might wish to create an entirely new company and store 
the script there.

Design the Front-End Script
As mentioned previously, a front-end script can perform multifarious functions 
like monitoring the status of hardware devices (such as disks that are low on free 
space), checking the revision dates of files, scanning for critical processes that 
must be running, or retrieving data from a database that is not ODBC-compliant.
So, the first step in using the front-end scripting module is to create the script that 
CRM Studio can use to check for a certain condition of data.

When you click the Edit/Test Script button, you will see the Cypress Enable 
Script Editor dialog box that begins with an area for script author details and 
general overview. 
The script is described in the following sections, which are detailed below:
• General Information
• Use the Script to Trigger an Event
• Specify Return Status Codes
• Enter Your Script Syntax

A single script cannot be used in both front-end scripting and back-end 
scripting. A script must be designed either for front-end or back-end use.

“The Everest CRM Studio - Basic Scripts Dialog Box” on page 246
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General Information
The first part of a script is where you can specify the purpose of the script, your 
name (as the script author), the date when the script was created, and the date 
when it was last modified. This part of the script will look like the following:
' Script Name          : vs_sample_diskspace.bas
' Script Author        : Development
' Script Purpose       : Check available disk space
' Script Creation Date : 2/20/2001
' Script Modified by   : 
' Script Modified Date : 
' Script Modifications : 
'
'
' The following declared functions are available
' to the script author in order to interact
' more closely with Everest CRM. All are optional
'
' Scripts may be executed by Everest CRM in two ways.
'
' 1) As an action to a triggered event.
'
' 2) In place of a query in order to have the script
'    trigger events.
'
' A script used as an action cannot trigger events.
'

Use the Script to Trigger an Event
Since some of the following sections in the template script contain information on 
designing a back-end script, they can be skipped during the creation of a front-
end script. The front-end scripting instructions begin in the following section:
' The following function is used to trigger events
'
' Scripts used to take action cannot trigger events.
' Only scripts used instead of queries can trigger events.
' Please see the Event Manager
' help file while on the QUERIES tab.
'
Declare Function KSTrigger( ByVal ukey As String) As Boolean
'
' This function triggers the event in the Application Server. 
' This function is called when the script is used instead of a
' query and you want to trigger an event.
'
' The parameters are as follows:
'
' ukey  The data that uniquely identifies this triggered item.
'       Passed as a string. You may pass an empty string if
'       you do not want KS to track triggered items.
' 

Specify Return Status Codes
The sixth section of a script contains details on how you can specify what 
information the script will return to CRM Studio if the script fails to complete 
successfully. This part of the script will look like the following:
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Global KSReturnStatus As Long
'
' Set this value if you want to return an error status number.
' If you don't set this value, the script is assumed to have
' worked successfully and is stamped completed by KS.
'
Global KSReturnMessage As String
'
' Set this value if you want to return an error message
'
Global KSReturnComplete as long
'
' Set this to -1 if you want the script to complete even if
' there is an error. Normally, when scripts error, the Action '
' server will attempt to execute them again in 1 minute until
' they complete without error.
'
On Error Resume Next
'
' Tell KS how things went by setting the return status
' Set this to a non-zero if there was an error. This will be
' seen in the monitor in the errors section or corrective
' actions in the administrator

KSReturnStatus = 0

' Set return message string. Place error message in this
' variable if there was one, This will show up in the monitor

KSReturnMessage = Success

Enter Your Script Syntax
The final section of a script is where you can actually type in the syntax of the 
script you wish to execute. This part of your script will fall between the lines 
“Begin your script here” and “End your script here” as is shown below:
' Begin your script here

' End of your script is here

End
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Sample Front-End Script
The following is an example of a script that checks for low disk space. 

Check for Low Disk Space
Declare Function GetDiskFreeSpace Lib kernel32 Alias GetDiskFreeSpaceA _
(ByVal lpRootPathName As String, lpSectorsPerCluster As Long, 
lpBytesPerSector As Long, lpNumberOfFreeClusters As Long, 
lpTtoalNumberOfClusters As Long) As Long
  
Dim strDrive As String
Dim lngSectorsPerCluster As Long
Dim lngBytesPerSector As Long
Dim lngNumberOfFreeClusters As Long
Dim lngTotalClusters As Long
Dim lngSts As Long
Dim DS
Dim IntLoop As Integer
Dim dblSpace As Double

'These variables can be 'seen' from the event e-mail message screen because they 
are global. By declaring these, they can be used as content when we send e-mail, 
faxes or pages...

Global DiskDrive As String
Global FreeSpaceBytes As Double
Global FreeSpaceMegs As Double
Global FreeSpaceFormatted As String
Global FreeSpaceMessage As String
Global MinMegs As Long

MinMegs=50000'This is our threshold. Less than 500 MB
  
For IntLoop = 67 To 90
    strDrive = Chr$(IntLoop) & :\     ' Ensure path is at the root.
    lngSectorsPerCluster=0
    lngBytesPerSector=0
    lngNumberOfFreeClusters=0
    lngTotalClusters=0
    lngSts = GetDiskFreeSpace(strDrive, lngSectorsPerCluster, 
lngBytesPerSector,  

About this front-end script:
• It identifies specific fields that contain information about the disks that 

are checked, and their available space.
• It does not check the CD-ROM drive (an organization might need to edit 

this script and specify the appropriate CD-ROM drive letter).
• It lets you assign script variables that contain information about the 

triggered event and thus, can be used both in the outgoing alert 
messages about this event and (if needed) can be passed into one or 
more back-end scripts that this event executes.

• It lets a script editor specify the disk space threshold (500 MB in this 
example).

• It loops through multiple disk drives.
• It sets a successful return status message if no errors are encountered.
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                                                         lngNumberOfFreeClusters, 
lngTotalClusters)
    If lngSts <> 0 Then
        FreeSpaceBytes = CDbl(lngSectorsPerCluster) * CDbl(lngBytesPerSector) 
* CDbl(lngNumberOfFreeClusters)
        FreeSpaceFormatted = Format$(FreeSpaceBytes, ###,###0)
             FreeSpaceFormatted = FreeSpaceFormatted &  bytes are free.
             FreeSpaceMegs = FreeSpaceBytes / 1000000
             If FreeSpaceMegs < MinMegs Then'Less than MinMegs is BAD
                 DiskDrive=chr$(intloop) & :
                 If DiskDrive <> D: Then        'Don't check the cdrom drive. 
                  FreeSpaceMessage = Disk  & DiskDrive &  has less than  & 
MinMegs & mb free.
                                           x= KSTrigger(DiskDrive)        'Low 
space on this drive
                 End If
          End If
   End If
Next IntLoop
'Tell Everest CRM no errors happened
KSReturnMessage=0    'Clean as a whistle.
End    'End of Script

Link the Script to an Event
Just as a back-end script, a front-end script must also be linked to an event. In the 
case of a front-end script, however, you need to indicate that the script will 
replace one or more queries that would normally be used to trigger an event.

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Management Folders panel in the center, select Application 
Events. You will see all the companies that CRM Studio is currently 
configured to integrate with.

• Select the company for which you want to design scripts and click Events. You 
will see a list of events (if any have been created) in the right panel.

• Edit/Create (if necessary) the event you wish to link the script to.
• From the Queries tab, select the option Use Script Instead of Query. 
• Click the Select Script button. You will see the Everest CRM Studio - Select 

Basic Script dialog box, displaying all the scripts that are currently available 
for use as a response to a triggered event.

• Highlight the script you wish to use and click Select. The script is added to the 
Script field.

CRM Studio displays the name and file specification of the selected script.
Repeat these steps for each script you wish to associate with an event.

With this step you are finished with the set-up of a CRM Studio event that uses a 
front-end script.

To link the script to an event, follow these steps:

Ensure that you choose a front-end script and not a back-end script.
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CRM Studio Event Monitor
You can use the Everest CRM Studio Event Monitor to track the status of events 
and alerts that have been (or need to be) delivered.
Use the Monitor to keep track of:
• Status of the application servers that CRM Studio uses to check for events and 

send alerts.
• Events that are scheduled to be checked and those that are triggered.
• Alerts that are sent out (or are about to be sent out), including whom they are 

sent to, via what means, and whether they were successfully delivered.
• The full text of the outgoing alert messages.
• Status of reports that are scheduled for distribution.
• Status of updates to underlying databases.
• Occurrence of any kind of errors that will prevent CRM Studio from either 

checking for events or responding to them.

The Event Monitor

• From the main menu bar, select CRM > CRM Studio > Monitor. You will see 
the Everest CRM Studio Event Monitor dialog box.

Everest CRM Studio Event Monitor

 Figure 8.1: Everest CRM Studio Event Monitor
Use the Event Monitor to:

The Event Monitor is for informational display only. You cannot modify 
any information that appears within it.

To log in to the Event Monitor, do the following:
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• View the status of application servers.
• View users logged in to CRM Studio modules.
• View the next scheduled times when the events will be run.
• View the status of events. 
• View the status of e-mails, faxes, copied files, pages, webcasts, and generated 

reports. 
The Monitor displays both report distribution data and generated report data. 
The report distribution option displays events that submit one or more reports for 
execution. The generated reports option displays the status of individual reports 
that are generated by both report, distribution events and triggered application 
events.
The different branches of the Event Monitor are detailed in the following 
sections.
Resizing the Display Grid
The grid displayed in the right panel of the Event Monitor is a standard CRM 
Studio component. You can expand or contract the width of specific columns 
within this grid. 

• In the column header of the grid (the line with the column titles in it), position 
the cursor at the vertical line dividing the columns whose width you wish to 
adjust. 

• The cursor will change into a two-headed arrow.
• Click the left mouse button and hold.
• Drag the mouse to the right or to the left to enlarge or reduce the width of the 

corresponding columns. Release the mouse button when the desired size is 
obtained.

Activity Folder
The Activity folder informs you about the current processing and user activity 
occurring within CRM Studio. 

Server Status
This folder displays the current status of all the servers used by CRM Studio. You 
can indicate which servers will be allowed to run. 

By default, CRM Studio is shipped with all servers enabled except those for 
Paging, Faxing, Copying, Reporting, Webcasting and Action.
A server’s status may be any of the following:

To expand or contract the width of specific columns within the grid, do 
the following

The re-sized grids remain in effect as long as you are in a specific branch in 
the Monitor. 

Example If you know that your site will not perform certain types of 
notifications (e.g., faxing), you can disable the corresponding server to 
conserve system resources. 
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• Shutdown - This indicates that the server is not running at this time. The 
possible reasons for this are:
- The Everest CRM Studio service (path: Control Panel > Administrative 

Tools > Services) is not running.
- The server is disabled. (path: CRM > CRM Studio > Administrator > 

Administration Folders > Activity > Server Status > double-click a server 
record in the right panel > Server Status dialog box > Deselect Allow 
Server to process). 

• Idle - The server is running in the background but is not currently processing 
any data. The server becomes idle when there is no data to process.

• Processing - The server is currently processing data.
• Startup - The server is in initialization and startup mode.

Current User Logins
The Current User Logins branch displays who is currently logged in to CRM 
Studio. Select an individual user in the right panel to view the following 
information:
• The CRM Studio module that the user is logged in to. This will display either 

the Administrator, Event Monitor, or Studio Architect.
• The computer and name of the user.
• The user’s operating system and platform.
• The date and time when the user last logged in.
• The date and time of the user’s last activity.

Scheduler Folder
The Scheduler informs you about the events that are next in line for submission. 
These include both unscheduled (or triggered) events and report distribution 
events.
To view details of individual records that are due for submission, select the Next 
Run Date/Time option. 
For each event that is shown, you can view:
• Event ID (internally-assigned by CRM Studio)
• Database to which the event belongs
• Name of the event
• Date and time when the event is next scheduled
• Frequency of submission of the event (such as Monthly)
• Description of the frequency (such as the First of the Month)

Application Events Folder
An application event is any event with the exception of reports that are scheduled 
for distribution. These reports are listed under the Report Distribution branch.
The Application Events folder enables you to track the status of application 
events that are due to run, have already run, or have failed to run successfully 
because of an error.
Application events are divided into four categories
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Pending
Application Events in a ‘pending’ state are those that are about to be executed. 
Events appear in this state due to one of the three reasons:
• The Everest Application Event Server is not running.
• The Everest Application Event Server is currently processing data. The 

number and complexity of submitted events may cause the subsequent events 
to be in a ‘pending’ state until their execution.

• The event failed to execute successfully (see “How to Handle Event Errors” 
on page 265.)

An event becomes ‘pending’ as soon as it is due to be submitted, and thus does 
not remain in a pending state for very long (unless an error occurs).
Everest automatically attempts to re-submit pending application events every 
minute. 
Once an event successfully executes, it is removed from the Pending list. Only one 
iteration of an event will ever appear in the Pending list, regardless of the number 
of errors that have occurred, or the period for which the application event server 
has been shut down. This is to avoid having multiple copies of the same event 
execute simultaneously when the error or server condition is rectified.

Checked
When an application event is executed by CRM Studio, one of the three things 
may happen:
• The event fails to execute successfully (i.e., it is in error).
• The event executes successfully, but is not triggered (i.e., the condition that it 

was testing for, was not met).
• The event executes successfully, and is triggered (i.e., the condition that it was 

testing for, was met).
Application events in a ‘checked’ state are those that are successfully executed 
and may (or may not) have been triggered. This option is useful for verifying that 
events you set up for execution are, in fact, successfully running.

Triggered
Application Events that are ‘Triggered’ have met the condition(s) they were 
checking for. 

Once an event is triggered, the corresponding alerts are initiated.
Triggering an event does not ensure that the corresponding alert(s) have been 
successfully executed, but rather that the resulting alert(s) have been initiated. To 

Checked events include every iteration of a successfully executed event. 

 An event that executes every 15 minutes will (over a two-hour 
time span) display eight (8) records in the checked events lists.

“Keeping Last Checked Record” on page 267

Example An event that finds ‘more than 10 high priority service calls’ or an 
event that finds ‘an order placed for a customer whose credit status is 
on hold.‘

Example
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ascertain whether the alert(s) have been successfully executed, review the 
corresponding ‘Deliverables’ for that event.

Deliverables Button
When an event is triggered, it often results in alerts being sent to one or more 
individuals. The Deliverables button allows you to view:
• The person to be notified about a triggered event.
• The method(s) by which each person is to be notified.
• The address to which the alert is sent.
• Attached files or reports (and their names), if any, included in the alert.
• Whether the message is successfully delivered to the recipient.
• The date and time when the message is delivered (if successful) or (if 

unsuccessful) when it was supposed to be delivered.

• From the Everest CRM Studio Event Monitor dialog box, select Application 
Events > Triggered (any one).

• Click the event whose deliverables you would like to see.
• Click the Deliverables button.

“Deliverables Button” on page 263

For each event that is triggered, the number of records that you will see in 
the ‘triggered events’ folder depends on whether:
• You are sending one alert for each record that meets the event's criteria, 

or
• You are sending one alert for all records that meet the event's criteria. If 

an event sends one alert per triggered record, you will see multiple 
triggered event records within this folder. The number of triggered 
event records displayed will correspond to the number of database 
records that met the event's trigger criteria.

Example You define the following event:
Send an alert to each support representative about any high priority 
call that has been open for longer than four hours.
When this event runs, it may identify multiple call records that meet 
this event’s criteria. 
If the event is configured to trigger once for each record that meets its 
criteria (and there are multiple records that meet those criteria), you 
will see multiple Triggered records in the Event Monitor for a single 
event.

To use the Deliverables function, do the following:
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 Figure 8.2: Event Deliverables
You can adjust the height of the deliverables window by clicking and dragging 
the horizontal line that separates the deliverables window from the triggered 
event listing.

Triggered Items Button
When an event is configured in CRM Studio, you can identify a single field of 
data that uniquely identifies each triggered record.

If an event is configured to store this unique identifying value, you can view this 
value for a triggered event from the Event Monitor. This value is referred to as an 
event’s triggered item.
A triggered event may have only a single triggered item (if the event is triggered 
once for all matching records), or multiple triggered items (if the event is 
triggered once for each matching record).
If an event is not configured to store a triggered event’s unique identifying value, 
the Triggered Items button is disabled.

• From the Everest CRM Studio Event Monitor dialog box, select Application 
Events > Triggered (any one). 

• Click the event whose triggered items you would like to see.
• Click the Triggered Items button.

Example For an event that is triggered by orders meeting certain criteria, this 
would most likely be the order number. 
For an event that is triggered by support calls meeting certain criteria, 
this would probably be the call ticket ID.

To use the Triggered Items function, do the following:
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 Figure 8.3: Event Triggered Items

For each event you will see the triggered items (such as an order number), along 
with the date when the event was last checked and triggered.

Errors
Application Events that appear under ‘Errors’ are those that have failed to execute 
successfully. Possible reasons for errors include the inability of Everest to reach a 
database (or server), or an event whose query contains incorrect syntax.
If an event encounters an error, it is placed in both the Errors and Pending folder. 
Everest continues to automatically submit the pending event until one of the two 
things happens:
• The event successfully executes (i.e., the condition that caused the error, is 

corrected).
• The error record is deleted or marked as ‘complete’ from the Administrator 

module.
Once an event executes successfully, or is deleted or completed via a corrective 
action, it is removed from both, the Pending and the Errors folders.

How to Handle Event Errors
Event errors can occur for a number of reasons, such as an error in the 
configuration of the event, or CRM Studio’s inability to access a database.
When an application event fails to complete successfully because of an error, 
three things happen:
• The event appears in the Errors branch under Application Events.
• The event appears in the Pending branch under Application Events.
• Everest re-submits the event every minute until:

- The event successfully executes.
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- The event error is corrected.
- This run of the event is deleted.

The possible errors and their solutions are given below:

If you simply wish to remove a particular run of the event, log in to the Everest 
CRM Studio Administrator (path: CRM > CRM Studio > Administrator), and 
remove the event in any of the following ways:
• Select Corrective Actions > Application Event Errors and manually delete (or 

mark as complete) this particular run of the event.
• Select File > Database Tools > Remove Pending Items. You will see the 

Everest CRM Studio - Remove Pending Items from Database dialog box. 
Select the Application Events Pending check box, and click Remove. 

Application Event Data
For each application event that appears in the Application Event branches of the 
Monitor, you will see the following:
• Event ID (internally-assigned by CRM Studio)
• The database to which the event belongs
• The name of the event
• Event priority
• When the event was checked, triggered, or failed due to an error
For triggered events:
• The pager alert message
• The e-mail alert message subject
• The e-mail alert message text
• The fax comments
For events in error:
• The error number

CRM Studio retains only one (1) iteration of an event that is in error. Thus, 
even if you have an event that runs every five minutes and it fails to run 
successfully for 30 minutes, CRM Studio retains only one copy of that event 
in the Pending and Error branches.

Cause of Error Solution
A condition that will correct 
itself (such as an application 
database server being shut 
down)

Leave the pending event until the condition is 
corrected, at which time the event will 
successfully execute.

An incorrect configuration 
in the event and/or its 
queries

Log into the Everest CRM Studio Architect 
and manually correct the corresponding error. 
Once you fix this error, CRM Studio will 
automatically use the updated version the next 
time it submits the event.

This will remove ALL pending application events including those that do 
not have any errors.
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• The error message

Keeping Last Checked Record
When configuring an event, you can indicate whether the Event Monitor should 
display details of all checks or only the last check on an event (path: Everest CRM 
Studio Architect dialog box > Event Management Folders panel > Application 
Events > Events > double-click an event in the right panel > Everest CRM Studio 
- Application Events\(your company)\Events dialog box > select/deselect Keep 
only last checked record in Monitor).

Thus, it is possible (if the current run of an event ends in error) that you will see 
no record of the last time that event was checked; you will see it listed only in the 
Pending and Error branches.

Displaying Full Message Text
Any column of information within the display grid (such as the e-mail alert 
message text) may be expanded to display the full text that it contains.
To display the full text of a field within the grid, point your cursor at that field. 
The Event Monitor automatically pops up a window that shows you the full 
content.

This option is only for records with the “Checked” status. Everest 
automatically retains the details every time an event is “Triggered”.

Example You define an event called ‘High Priority Support Calls’ that is 
checked every hour. If this event is configured to retain every checked 
record, you would see the following listing:

Help Desk Application High Priority Support Calls 05/03/01 8:00:00 AM
Help Desk Application High Priority Support Calls 05/03/01 9:00:00 AM
Help Desk Application High Priority Support Calls 05/03/01 10:00:00 AM
Help Desk Application High Priority Support Calls 05/03/01 11:00:00 AM

If this event is configured to retain only the last checked record, you 
will see the following:
Help Desk Application High Priority Support Calls 05/03/01 11:00:00 AM

If you retain only the last checked record, and a scheduled run of an event 
enters a ‘pending’ state, the last checked record is automatically removed 
from the pending list.
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 Figure 8.4: Displaying Alert Message Details

You can test your event alert messages by using this method. Instead of actually 
sending the messages via e-mail, fax, pager, etc., you can trigger the 
corresponding event and view the alert message details in the Event Monitor. 
You can use the Everest CRM Studio Administrator to delete pending items 
(path: File > Database Tools > Remove Pending Items) if you choose not to send 
them.

Report Distribution Folder
The Report Distribution folder pertains exclusively to reports that are scheduled 
for periodic generation and distribution in CRM Studio. It does not relate to 
reports that are linked to application events (see “Report Generation Folder” on 
page 278).
A Report Distribution event is an event that schedules the generation and 
distribution of one or more reports. Within the two sub-branches of this folder 
(Pending and Submitted), you can view the names of scheduled report events 
(such as Weekly Management Reports) and the date and time when they are to be 
submitted.
Pending
‘Pending’ Report distributions are those that are about to be executed. Report 
distributions appear in this state due to one of the two reasons:
• The Everest Report Server is not running.
• The Everest Report Server is currently processing data. The number and 

complexity of submitted report distributions may cause the subsequent 
records to be in a ‘pending’ state until their execution.

Once an event executes successfully, it is removed from the pending list.
268 Everest CRM Studio
User Guide



CRM Studio Event Monitor
Submitted
When a report distribution is executed, Everest generates the individual report(s) 
associated with the distribution record.
Report distributions in a ‘submitted’ state are those that are passed on to the 
report generation component of Everest. In other words, a submitted report 
distribution event indicates that the reports associated with this event are 
submitted for execution. After the reports are generated (see “Report Generation 
Folder” on page 278), they are delivered to the appropriate subscribers via e-mail, 
fax, file copy, and webcast.
This folder includes every iteration of a successfully executed distribution. 

Use the Report Generation branch to track the progress of the individual reports 
associated with the scheduled report event.

E-Mail Delivery Folder
Once an event is triggered or a report is generated, one of the ways in which the 
corresponding information can be delivered is via electronic mail. The E-mail 
Delivery options are useful for reviewing the status of these e-mail messages.

The E-mail Delivery folder is divided into three branches:
Pending
E-mail deliveries in a ‘pending’ state are those that are about to be sent. E-mails 
appear in this state for one of the four reasons:
• The Everest E-Mail Delivery Server is not running.
• The Everest E-Mail Delivery Server is currently processing data. The number 

and complexity of e-mails may cause subsequent messages to be in a 
‘pending’ state until their execution.

• Everest encountered an error while attempting to send the e-mail (see “How 
to Handle E-Mail Delivery Errors” on page 270).

Example A report distribution record that executes every hour (over a four-
hour time span) displays four records in the ‘Submitted’ folder.

• E-mail deliveries for triggered events without attached reports, appear 
directly in the ‘E-Mail Delivery’ branch.

• E-mail deliveries for triggered events with attached reports, generate the 
reports (see the Generated Reports branch) first, and then appear in this 
folder. The e-mail delivery is initiated after the attached reports are 
successfully generated.

• E-mail deliveries for report distributions generate the reports (see the 
Generated Reports branch) first, and then appear in this folder. The e-
mail delivery is initiated after the reports are successfully generated.

An e-mail message can also reference a related report without actually 
having the report attached. You can use this feature to notify users about a 
report that is generated in a central location. In such a case, you can specify 
(in the event) whether the e-mail delivery should wait until the related 
reports are produced. If you select the wait option, and the reports fail to 
generate, the error record appears under ‘Generated Reports‘, and not 
under ‘E-Mail Delivery.‘
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• Everest is unable to access the e-mail attachment(s) (attachments other than 
reports).

Everest automatically attempts to re-send ‘pending’ e-mails. When these e-mails 
are successfully sent, they are removed from the pending list. 
If an e-mail is in a pending state and the same event occurs again, Everest tries to 
send the second e-mail as well. If this also fails, you will see two pending records.
Sent
A sent mail message is one that is successfully delivered to its recipient. 

Errors
A mail message is displayed under the Errors branch if CRM Studio is unable to 
successfully send the message. 
An error would appear here if, for example, the e-mail account used for sending 
the notifications is set up with the wrong user name or password, or the 
recipient’s ISP is shut down.

If an e-mail delivery fails due to an error, it is placed in both, the Errors and 
Pending folders. Everest continues to automatically submit the pending e-mail 
until one of two things happens:
• The e-mail is successfully delivered (the condition that caused the error is 

corrected).
• The error record is deleted or marked as ‘complete’ from the Administrator 

module.
Once an e-mail is delivered successfully, or is deleted or completed via a 
corrective action, it is removed from both the Pending and Errors folders.

How to Handle E-Mail Delivery Errors
E-mail errors can occur for a number of reasons, such as an error in the recipient’s 
address, or CRM Studio’s inability to access the mail server.
When an e-mail message fails to be delivered successfully because of an error, 
three things happen:
• The message appears in the Errors branch under E-mail Delivery.
• The message appears in the Pending branch under E-mail Delivery.
• CRM Studio attempts to re-send the message every minute until:

- The message is successfully sent.
- The mail address error is corrected.

A mail message that results in an undeliverable reply message is still 
considered as successful by CRM Studio because the initial delivery of the 
message did succeed.

A recipient’s incorrect address would not result in an e-mail error; rather 
the e-mail message would be sent back to the sender of the notifications 
with information of the invalid address.

If the report attached to an e-mail is not generated successfully, the error is 
listed under ‘Report Generation’ errors. 
However, if Everest is unable to locate the file to be attached to an e-mail, 
the error is listed under ‘E-mail Delivery Errors.‘
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- The mail message is deleted.
If you wish to either correct an invalid address or delete the pending message, log 
in to the Everest CRM Studio Administrator (path: CRM > CRM Studio > 
Administrator). You have three further choices:
• Select Corrective Action > E-mail Delivery Errors and correct the invalid 

address.
• Select Corrective Action > E-mail Delivery Errors and manually delete (or 

mark as ‘successfully delivered’) this e-mail message.
• Select File > Database Tools > Remove Pending Items. You will see the 

Everest CRM Studio - Remove Pending Items from Database dialog box. 
Select the E-mail Pending check box and click Remove. 

Fax Delivery Folder
Once an event is triggered or a report is generated, one of the ways in which you 
can send the corresponding information is through fax. The Fax Delivery branch 
is useful for reviewing the status of these fax messages.
Everest uses fax deliveries for three types of events:
• Triggered events without attached reports
• Triggered events with attached reports
• Report distributions

The Fax Delivery folder is divided into three branches:
Pending
Fax deliveries in a ‘pending’ state are those that are about to be sent. They appear 
in this state for one of the four reasons:
• The Everest Fax Delivery Server is not running.
• The Everest Fax Delivery Server is currently processing data. The number and 

complexity of faxes may cause subsequent messages to be in a ‘pending’ state 
until their execution.

This will remove ALL pending e-mail messages including those that do not 
have any errors.

• Fax deliveries for triggered events without attached reports appear 
directly in the ‘Fax Delivery’ branch.

• Fax deliveries for triggered events with attached reports generate the 
reports (see the ‘Generated Reports’ branch) first, and then appear in 
this folder. The fax delivery is initiated after the attached reports are 
successfully generated.

• Fax deliveries for report distributions generate the reports (see the 
‘Generated Reports’ branch) first, and then appear in this branch. The 
fax delivery is initiated after the reports are successfully generated.

A fax message may reference a related report without actually attaching the 
report. You can use this feature to notify users about a report that is 
generated in a central location. In this case, you can specify (in the event) 
whether the fax delivery should wait until the related reports are produced. 
If you select the wait option, and the reports fail to generate, the error 
record appears under ‘Generated Reports‘, and not under ‘Fax Delivery.‘
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• Everest encounters an error while attempting to send the fax (see “How to 
Handle Fax Delivery Errors” on page 272).

• Everest is unable to access the fax attachment(s) (attachments other than 
reports).

If a fax is placed in a pending state, Everest automatically attempts to re-send it. 
When this fax is sent successfully, it is removed from the pending list. 
If a fax is in a pending state and the same event occurs again, Everest tries to send 
the second fax as well. If this also fails, you will see two pending records.
Sent
A sent fax message is one that is successfully delivered to its recipient.
Errors
A fax message shows up under the errors branch if CRM Studio is unable to 
successfully send the message. An error appears here if, for example, the fax 
phone number is invalid or the fax port is busy when accessed by Everest.
If a fax delivery fails due to an error, it is placed in both, the Errors and the 
Pending folders. Everest continues to automatically submit the pending fax until 
either of the following happens:
• The fax is delivered successfully (i.e., the condition that caused the error is 

corrected).
• The error record is deleted or marked as ‘complete’ from the Administrator 

module.
Once a fax is delivered successfully, or is deleted or completed via a corrective 
action, it is removed from both, the Pending and the Errors folders.

How to Handle Fax Delivery Errors
Fax errors can occur for a number of reasons, such as an error in the recipient’s 
address, or CRM Studio’s inability to access a fax modem. The most common 
reason why fax alerts do not get sent is because the fax server is not currently 
running.
When a fax message is not delivered successfully because of an error, three things 
happen:
• The message appears in the Errors branch under Fax Delivery.
• The message appears in the Pending branch under Fax Delivery.
• CRM Studio attempts to re-send the message every minute until:

- The message is successfully sent.
- The fax phone number error is corrected.
- The fax message is deleted.

To either correct an invalid address or delete the pending message, log in to the 
Everest CRM Studio Administrator (path: CRM > CRM Studio > 
Administrator). You have three further choices:

If the reports attached to a fax are not generated successfully, the error is 
listed under ‘Report Generation’ errors. 
However, if Everest fails to locate the files to be attached to a fax, the error is 
listed under ‘Fax Delivery Errors.‘
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• Select Corrective Action > Fax Delivery Errors and correct the invalid fax 
number.

• Select Corrective Actions > Fax Delivery Errors and manually delete (or mark 
as ‘successfully delivered’) this fax message.

• Select File > Database Tools > Remove Pending Items. You will see the 
Everest CRM Studio - Remove Pending Items from Database dialog box. 
Select the Faxes Pending check box, and click Remove. 

File Delivery Folder
Once an event is triggered or a report is generated, one of the ways in which you 
can send the corresponding information is by copying a file from one location 
(disk and directory) to another. The File Delivery folder is useful for reviewing 
the status of these copied files.
Everest uses the file copy delivery method for four types of events:
• Events that copy files.
• Events that copy reports.
• Report distributions that copy files.
• Report distributions that copy reports.

This folder is divided into three branches:
Pending
File deliveries in a ‘pending’ state are those that are about to be sent. Deliveries 
appear in this state for one of the four reasons:
• The Everest File Delivery Server is not running.
• The Everest File Delivery Server is currently processing data. The number and 

complexity of files may cause subsequent files to be in a ‘pending’ state until 
their execution.

• Everest encounters an error while attempting to send the file (see “How to 
Handle File Delivery Errors” on page 274).

• Everest is unable to access the file(s).
Everest automatically attempts to re-send ‘pending’ file deliveries. When files are 
sent successfully, they are removed from the pending list. 

This will remove ALL pending fax messages including those that do not 
have any errors.

• File deliveries for events, and report distributions that copy files appear 
directly in the ‘File Delivery’ branch.

• File deliveries for events that copy reports generate the reports (see the 
‘Generated Reports’ branch) first, and then appear in this folder. The file 
delivery is initiated after the attached reports are successfully 
generated.

• File deliveries for report distributions that copy reports generate the 
reports (see the ‘Generated Reports’ branch) first, and then appear in 
this folder. The file delivery is initiated after the reports are successfully 
generated.
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If a file delivery is in a pending state and the same event occurs again, Everest 
tries to send the second file as well. If this also fails, you will see two pending 
records.
Sent
A sent file is one that is successfully delivered to its recipient.
Errors
A file is displayed in the errors branch if CRM Studio is unable to successfully 
send the corresponding file. An error appears here if, for example, Everest is 
unable to access the destination for the copied file.
If a file delivery fails due to an error, it is placed in both, the Errors and the 
Pending folders. Everest continues to automatically submit the pending file 
delivery until one of the two things happens:
• The file is successfully delivered (the condition that caused the error is 

corrected)
• The error record is deleted or marked as ‘complete’ from the Administrator 

module.
Once a file is delivered successfully, or is deleted or completed via a corrective 
action, it is removed from both, the Pending and the Errors folders.

How to Handle File Delivery Errors
File delivery errors can occur for a number of reasons, such as an error in the file’s 
delivery address, or CRM Studio’s inability to access the file’s location. The most 
common reason why files do not get sent is because the server onto which it must 
be copied is not running currently.
When a file message is not delivered successfully because of an error, three things 
happen:
• The file appears in the Errors branch under File Delivery.
• The file appears in the Pending branch under File Delivery.
• CRM Studio attempts to re-send the file every minute until:

- The file is successfully sent.
- The file delivery request is deleted.

To delete the corresponding delivery, log in to the Everest CRM Studio 
Administrator (path: CRM > CRM Studio > Administrator). You have two 
further choices:
• Select Corrective Actions > File Delivery Errors and manually delete (or mark 

as ‘successfully delivered’) this file delivery request.

If the report attached to a file delivery is not generated successfully, the 
error is listed under ‘Report Generation’ errors. 
However, if Everest is unable to locate the file to be attached, the error is 
listed under ‘File Delivery Errors.‘
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• Select File > Database Tools > Remove Pending Items. You will see the 
Everest CRM Studio - Remove Pending Items from Database dialog box. 
Select the File Deliveries Pending check box, and click Remove. 

Pager Delivery Folder
Once an event is triggered or a report is generated, one of the ways in which you 
can send the corresponding messages is via pager. The Pager Delivery folder is 
useful for reviewing the status of your pages.
The Pager Delivery folder informs you about pager alerts that:
• Are pending (about to be sent).
• Were sent today, yesterday, or since auditing began (‘all‘).
• Were in error today, yesterday, or since auditing began (‘all‘).

The Pager Delivery folder is divided into three branches:
Pending
Pager deliveries in a ‘pending’ state are those that are about to be sent. Pager 
deliveries appear in this state for one of the three reasons:
• The Everest Pager Delivery Server is not running.
• The Everest Pager Delivery Server is currently processing data. The number 

and complexity of pages may cause subsequent alerts to be in a ‘pending’ state 
until their execution.

• Everest encounters an error while attempting to send the page (see “How to 
Handle Pager Delivery Errors” on page 276).

Everest automatically attempts to re-send ‘pending’ pager alerts. When these 
alerts are sent successfully, they are removed from the pending list. 
If a page is in a pending state and the same event occurs again, Everest tries to 
send the second page as well. If this also fails, you will see two pending records.
Sent
A sent pager message is one that is successfully delivered.
Errors
A pager message shows up under the errors branch if CRM Studio is unable to 
successfully send the message. An error appears here if, for example, the pager 
PIN number is invalid or the pager port is busy when accessed by Everest.
If a pager delivery fails due to an error, it is placed in both, the Errors and the 
Pending folders. Everest continues to automatically submit the pending page 
until one of the two things happens:

This will remove ALL pending file delivery requests including those that do 
not have any errors.

A pager message may reference a related report. You can use this feature to 
notify users about a report that is generated in a central location. In this 
case, you can specify (in the event) whether the page delivery should wait 
until the related reports are produced. If you select the wait option, and the 
reports fail to generate, the error record appears under ‘Generated Reports‘, 
and not under ‘Pager Delivery.‘
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• The alert is successfully delivered (the condition that caused the error is 
corrected)

• The error record is deleted, or marked as ‘complete’ from the Administrator 
module.

Once a page is delivered successfully, or is deleted or completed via a corrective 
action, it is removed from both, the Pending and the Errors folders.

How to Handle Pager Delivery Errors
Pager errors can occur for a number of reasons, such as an error in the recipient’s 
PIN number, or CRM Studio’s inability to access a modem from which to send 
the page. The most common reason why pager alerts do not get sent is because 
the pager server is not currently running.
When a pager alert fails due to an error, three things happen:
• The message appears in the Errors branch under Pager Delivery.
• The message appears in the Pending branch under Pager Delivery.
• CRM Studio attempts to re-send the message every minute until:

- The message is successfully sent.
- The pager PIN number is corrected.
- The pager message is deleted.

To either correct an invalid PIN number or delete the pending message, log in to 
the Everest CRM Studio Administrator (path: CRM > CRM Studio > 
Administrator). You have three further choices:
• Select Corrective Actions > Pager Delivery Errors and correct the invalid PIN 

number.
• Select Corrective Actions > Pager Delivery Errors and manually delete (or 

mark as ‘successfully delivered’) this pager message.
• Select File > Database Tools > Remove Pending Items. You will see the 

Everest CRM Studio - Remove Pending Items from Database dialog box. 
Select the Pages Pending check box, and click Remove. 

Webcast Delivery Folder
Once an event is triggered or a report is generated, one of the ways in which you 
can send the corresponding information is via webcast. The Webcast Delivery 
folder allows you to review the status of your webcasts.
Everest uses webcast deliveries for three types of events:
• Triggered events without attached reports
• Triggered events with attached reports

This will remove ALL pending pager messages including those that do not 
have any errors.
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• Report distributions

The Webcast Delivery folder is divided into three branches:
Pending
Webcast deliveries in a ‘pending’ state are those that are about to be sent. 
Deliveries will appear in this state for one of the four reasons:
• The Everest Webcast Delivery Server is not running.
• The Everest Webcast Delivery Server is currently processing data. The 

number and complexity of webcasts may cause subsequent messages to be in 
a ‘pending’ state until their execution.

• Everest encounters an error while attempting to send the webcast (see “How 
to Handle Webcast Delivery Errors” on page 278).

• Everest is unable to access the webcast attachment(s) (attachments other than 
reports).

Everest automatically attempts to re-send ‘pending’ webcast deliveries. When the 
webcast is successfully sent, it is removed from the pending list. 
If a webcast is in a pending state and the same event occurs again, Everest tries to 
send the second webcast as well. If this also fails, you will see two pending 
records.
Sent
A sent webcast message is one that is successfully delivered to its recipient.
Errors
A webcast message is displayed under the errors branch if CRM Studio is unable 
to successfully send the message. An error appears here if, for example, Everest is 
unable to access the web server.
If a webcast delivery fails due to an error, it is placed in both, the Errors and the 
Pending folders. Everest continues to automatically submit the pending webcast 
until one of the two things happens:
• The webcast is successful (the condition that caused the error is corrected).

• Webcast deliveries for triggered events without attached reports appear 
directly in the ‘Webcast Delivery’ branch.

• Webcast deliveries for triggered events with attached reports generate 
the reports (see the ‘Generated Reports’ branch) first, and then appear in 
this folder. The webcast delivery is initiated after the attached reports 
are successfully generated.

• Webcast deliveries for report distributions generate the reports (see the 
‘Generated Reports’ branch) first, and then appear in this folder. The 
webcast delivery is initiated after the reports are successfully generated.

A webcast message may reference a related report without actually 
attaching the report. You can use this feature to notify users about a report 
that is generated in a central location. In this case, you can specify (in the 
event) whether the webcast delivery should wait until the related reports 
are produced. If you select the wait option, and the reports fail to generate, 
the error record appears under ‘Generated Reports‘, and not under 
‘Webcast Delivery.‘
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• The error record is deleted, or marked as ‘complete’ from the Administrator 
module.

Once a webcast is delivered successfully, or is deleted or completed via a 
corrective action, it is removed from both, the Pending and the Errors folders.

How to Handle Webcast Delivery Errors
Webcast errors can occur for a number of reasons, such as an error in the 
recipient’s webcast name, or CRM Studio’s inability to access the server on which 
the webcast will be posted. The most common reason why webcast alerts do not 
get sent is because the webcast server is not currently running.
When a webcast message fails to be delivered successfully because of an error, 
three things happen:
• The message appears in the Errors branch under Webcast Delivery.
• The message appears in the Pending branch under Webcast Delivery.
• CRM Studio attempts to re-send the message every minute until:

- The message is successfully sent.
- The webcast name is corrected.
- The webcast message is deleted.

To either correct an invalid webcast name or delete the pending message, log in to 
the Everest CRM Studio Administrator (path: CRM > CRM Studio > 
Administrator). You have three further choices:
• Select Corrective Actions > Webcast Delivery Errors and correct the invalid 

webcast name.
• Select Corrective Actions > Webcast Delivery Errors and manually delete (or 

mark as successfully delivered) this webcast message.
• Select File > Database Tools > Remove Pending Items. You will see the 

Everest CRM Studio - Remove Pending Items from Database dialog box. 
Select the Webcast Pending check box, and click Remove. 

Report Generation Folder
Reports may be generated under one of two circumstances:
• As part of a scheduled report distribution
• As content for a triggered application event

If the report to be attached to a webcast is not generated, the error is listed 
under ‘Report Generation’ errors. 
However, if Everest is unable to locate the file to be attached to the webcast, 
the error is listed under ‘Webcast Delivery Errors.‘

This will remove ALL pending webcast messages including those that do 
not have any errors.
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Regardless of which of these two options initiates the generation of a report, the 
Report Generation option allows you to monitor the status of the creation of 
individual reports.

Report generation occurs after either a triggered event or a report distribution, 
but before the actual delivery of the related report(s).
The Report Generation folder is divided into three branches:
Pending
Report generations in a ‘pending’ state are those that are about to be created. 
Records appear in this state for one of the three reasons:
• The Everest Report Generation Server is not running.
• The Everest Report Generation Server is currently processing data. The 

number and complexity of reports may cause subsequent records to be in a 
‘pending’ state until their generation.

• Everest encounters an error while attempting to generate the report (see 
“How to Handle Report Generation Errors” on page 280).

Everest automatically attempts to resubmit ‘pending’ report generations. When 
the report is successfully generated, it is removed from the pending list. 
If a report is in a pending state and the same event occurs again, Everest tries to 
submit the second report as well. If this also fails, you will see two pending 
records.
Generated
A generated report is one that is successfully produced. 
Errors
A report is displayed under the errors branch if CRM Studio is unable to 
successfully generate the report. An error appears here if, for example, the report 
source file cannot be found or the selection parameters being passed to the report 
are invalid.
If a report fails due to an error, it is placed in both, the Errors and the Pending 
folders. Everest continues to automatically submit the pending report until one of 
the two things happens:
• The report is successfully generated (the condition that caused the error is 

corrected)
• The error record is deleted, or marked as ‘complete’ from the Administrator 

module.
Once a report is generated successfully, or is deleted or completed via a corrective 
action, it is removed from both, the Pending and the Errors folders.

If a report is generated, it does follow that the report is also successfully 
delivered. Once the generation is complete, the report must still be handed 
over to the appropriate delivery medium for distribution (such as E-mail, 
Fax, File, or Webcast).
You must thus, review the appropriate delivery record to check if the report 
is delivered to its intended recipients.
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How to Handle Report Generation Errors
Report generation errors can occur for a number of reasons, typically an error in 
the report’s design. The most common reason why reports do not get generated is 
because the report server is not currently running.
When a report is not generated because of an error, three things happen:
• The report appears in the Errors branch under Report Generation.
• The message appears in the Pending branch under Report Generation.
• CRM Studio attempts to re-generate the report every minute until:

- The report is successfully generated.
- The report generation request is deleted.

To delete the pending report, log in to the Everest CRM Studio Administrator 
(path: CRM > CRM Studio > Administrator). You have two further choices:
• Select Corrective Actions > Report Generation Errors and manually delete (or 

mark as ‘successfully delivered’) this report generation request.
• Select File > Database Tools > Remove Pending Items. You will see the 

Everest CRM Studio - Remove Pending Items from Database dialog box. 
Select the Reports Pending check box, and click Remove. 

Actions Taken Folder
The Actions Taken folder contains events that execute one or more response 
actions (such as updating a database) as a result of a triggered event. This folder is 
divided into three branches:
• Pending - A pending action is one that is not completed either because CRM 

Studio is busy executing other actions, or because the action failed to be 
executed successfully (see “How to Handle Action Errors” on page 280).

• Completed - A completed action is one that is successfully executed.
• Errors - An action shows up under the errors branch if CRM Studio is unable 

to successfully execute it. If an action fails due to an error, it is placed in both, 
the Errors and the Pending folders. 

How to Handle Action Errors
Action errors refer to CRM Studio’s inability to submit (or execute) the action. 
Action errors can occur for a number of reasons, including an error in the 
corresponding action file specification. The most common reason why actions do 
not get executed is because the action server is not currently running.
Action errors are not recorded in the Monitor if an action (such as a program or 
VB script) executes successfully, and returns an error status code.
When an action fails to be executed successfully because of an error, three things 
happen:
• The action appears in the Errors branch under Actions Taken.
• The action appears in the Pending branch under Actions Taken.
• CRM Studio attempts to re-execute the action every minute until:

- The action is successfully executed.

This will remove ALL pending report generation requests including those 
that do not have any errors.
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- This run of the action is deleted.
To delete the action, log in to the Everest CRM Studio Administrator (path: CRM 
> CRM Studio > Administrator). You have two further choices:
• Select Corrective Actions > Action Errors and manually delete (or mark as 

‘successfully delivered’) this action request.
• Select File > Database Tools > Remove Pending Items. You will see the 

Everest CRM Studio - Remove Pending Items from Database dialog box. 
Select the Actions Pending check box, and click Remove. 

E-Mail Response Folder
The E-mail Response folder is designed exclusively for use with the CRM Studio 
E-Mail Response System (ERS). This folder allows you to see:
• The e-mail accounts being checked for new messages.
• The number of messages received, if any, and loaded into CRM Studio.
• Errors, if any, encountered during this process.
Since ERS loads incoming mail messages into the internal CRM Studio ERS 
database, the E-mail Response branch monitors messages only until they are 
loaded into the ERS database. 
Once loaded, ERS events are treated just like any other application event, and 
thus you need to look at the Application Events folder to monitor the status of 
these events.
The E-mail Response folder is divided into three branches:
• Checked - A checked mail account is one that is not successfully monitored for 

incoming mail messages.
• Received - A received mail message is one that is successfully loaded into the 

CRM Studio ERS database.
• Errors - ERS records an error if CRM Studio is unable to successfully check 

one or more e-mail accounts for incoming mail messages.

This will remove ALL actions that are pending including those that do not 
have any errors.
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CRM Studio’s E-Mail Response System (abbreviated to ERS) lets you define 
events that monitor incoming e-mail messages in much the same way that you 
can monitor database records. If an e-mail message meets certain criteria, you can:
• Re-route the mail message to specific recipients.
• Use CRM Studio’s pager, fax, copy/ftp, and webcast alerts to notify people 

about the receipt of the message.
• Auto-reply to the sender of the e-mail message.
• Use the contents of the e-mail message to add or update records in an 

underlying database.
In addition, CRM Studio allows you to trigger events based on groups of e-mail 
messages, such as:
• More than 10 mail messages sent to support today
• Fewer than 25 responses to an e-mail marketing blast
• More than 100 units of product ‘x’ ordered by e-mail this week
• The average price of e-mail orders drops below $500 last week

Web Form Support
It is very important to note that the ERS can monitor e-mail messages that come 
from any source including e-mail messages that are generated as a result of data 
entered on a web form.
If you use web forms to capture data such as on-line orders, requests for 
information, support questions, et cetera, these forms can output the content 
entered into them in the form of an e-mail message.
Employing the ERS, you can use the contents of these mail messages to send 
alerts, auto-respond to the person who filled out the web form, and update 
underlying databases.
Supported E-Mail Systems
The E-Mail Response System supports all major e-mail systems, including those 
that are Internet, Mapi, Exchange, and Vim compliant.

How It Works
Here is an overview of how the E-Mail Response System works:
• Instruct CRM Studio which e-mail accounts to monitor for incoming 

messages.
• When a new message arrives in one of these accounts, CRM Studio loads all 

the data associated with that message into a record in an underlying (CRM 
Studio-internal) database.

During this loading process, CRM Studio parses data from specific parts of the 
incoming mail message to specific fields in the database record that is created.

ERS refers specifically to CRM Studio’s ability to monitor incoming e-mail 
messages and respond to them. If your interest is strictly in CRM Studio’s 
ability to send outgoing alert messages via e-mail, you do not need to use 
the ERS.
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• Create CRM Studio queries to evaluate the e-mail records (in the same way 
you use queries to evaluate database records).

• Create events with these queries. These events send out alerts, auto-respond to 
the e-mail sender, and (if appropriate), update underlying databases with the 
necessary data.

The key to this whole process is that CRM Studio takes each incoming e-mail 
message and creates a database record out of it. As a result, you can use the 
standard CRM Studio query and event design functions to process and respond 
to the incoming message.
Additionally, because CRM Studio stores e-mail messages in an internal 
database, you can run multiple events off the incoming messages. This allows you 
to create events that check for such things as more than ‘x’ mail messages received 
from an organization, or fewer than ‘y’ messages received in response to a 
marketing campaign.

What This Chapter Covers
Once CRM Studio loads incoming mail messages into individual records within 
its underlying database, the method of identifying the content of those mail 
messages (via queries) and the method of responding to those mail messages (via 
events) is the same as if you were working with any other kind of database 
records.
As a result, this chapter will detail the set-up of the e-mail response system and 
the method by which you can parse data from an incoming mail message into 
CRM Studio’s underlying mail message database.
Once the messages are successfully loaded into the underlying database, you 
should refer to the chapters ‘Query Designing’ and ‘Event Designing’ for details 
on how to identify and respond to those messages.

ERS Configuration
Before you begin using the E-Mail Response System, make sure you complete the 
following steps:
• Add ODBC Source for ERS Database
• Identify E-mail Accounts to Monitor
• Specify ODBC Source for ERS Application

Add ODBC Source for ERS Database
As was detailed previously, CRM Studio processes incoming e-mail messages by 
loading them into an internal database.
This internal database is a Microsoft Access database and is located in the CRM 
Studio data directory. It is called KS_INBOX.
Since CRM Studio needs to read the records in this database (just like it reads the 
records in any other database), you must first define an ODBC source for the 
Inbox database.

To define an ODBC source for the Inbox database, do the following:
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• Open the ODBC Data Source Administrator (path: Control Panel > 
Administrative Tools > Data Sources (ODBC)).

• Click the System DSN tab. Your source will look like the following, 
depending on the type of database you are working with.

 Figure 9.1:  ODBC Data Source Administrator - System DSN Tab
• Click Add. You will see the Create New Data Source dialog box.
• Select Microsoft Access Driver and click Finish. You will see the ODBC 

Microsoft Access Setup dialog box. 

 Figure 9.2: ODBC Microsoft Access Setup
• Enter KS_INBOX in the Data Source Name field. Enter E-mail Response 

System in the Description field. Click the Select button. You will see the 
Select Database dialog box.
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 Figure 9.3: Select Database
• Locate and select KS_Inbox.mdb (path: Icode\Everest\ACRM\Data).
• Click OK to save the source. You will see the ODBC Microsoft Access Setup 

dialog box again.
• Click OK. You will see the System DSN tab of the ODBC Data Source 

Administrator, with the newly created ODBC source.
• Click OK.

Identify E-mail Accounts to Monitor
The second step in the configuration of the ERS is the definition of the e-mail 
accounts that you wish CRM Studio to monitor. This is done in the Everest CRM 
Studio Administrator. 

• From the main menu bar, select CRM > CRM Studio > Administrator. You 
will see the Everest CRM Studio Administrator dialog box.

• From the Administration Folders panel in the center, double-click the 
Software Setup folder and click E-mail Accounts.

• If you wish CRM Studio to monitor messages that are sent to an account that 
is already defined in this option, double-click that account in the right panel. 
You will see the Everest CRM Studio - E-mail Accounts dialog box.

• If you wish to specify a new account that CRM Studio will monitor for 
incoming mail messages, click the New E-Mail Account button at the top-left 
of the Everest CRM Studio Administrator dialog box. You will see the 
Everest CRM Studio - E-mail Accounts dialog box.

• After creating (if necessary) the e-mail account by specifying relevant 
information in the General tab, click the E-mail Response Options 
(Incoming) tab.

To define the e-mail accounts that CRM Studio should monitor, do the 
following:

• This is where you define the e-mail accounts that CRM Studio will 
use when sending alert messages via e-mail.

• This is also where you define the ERS e-mail accounts that CRM 
Studio will monitor for incoming mail messages.

“Set Up E-mail Account to send E-mails” on page 28

You may ignore the Dial-Up Networking tab for ERS.
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• Specify relevant information and click Save and Close. 

The Everest CRM Studio - E-mail Accounts Dialog Box - E-mail 
Response Options (Incoming)

 Figure 9.4: Everest CRM Studio - E-mail Accounts - E-mail Response Options 
(Incoming)

Download incoming messages from this account 
Check this box to download messages from this account. If this e-mail account is 
used only for the sending CRM Studio alert messages, make sure this option is 
deselected.
The account is checked at specific times for new e-mail. If messages exist, they are 
downloaded to the CRM Studio ERS database.
Check for new messages every n minutes
Specify (in minutes) how often you would like CRM Studio to check for new 
messages sent to this account.
Refuse attachments for this account 
Check this box if you do not want CRM Studio to download e-mail attachments. 

• This option works with Internet mail systems only. 
• ERS cannot scan the contents of attached files.

Example You do not want to allow any attachments for mail messages sent to 
info@yourcompany.com, but you want to allow attachments for mail 
messages sent to support@yourcompany.com, since they contain 
valuable support information.
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Delete messages from the server after downloading
Check this box to remove downloaded messages from the e-mail server after they 
are stored in the CRM Studio ERS database. 

Remove records from the e-mail database after n days
Specify the number of days that CRM Studio will keep e-mail records in the ERS 
database. Enter ‘0’ to retain e-mail records indefinitely.

Subject and Message Text Processing Options
Search labels for field values
Use this grid to specify the values from incoming e-mails that you want to store in 
specific fields of the inbox database.

Message Posting Options
Post incoming messages to an alternative database
Select this option to specify an alternative database to transfer the mail message 
data to.
Post to Database Connection
Select the ODBC source that CRM Studio will use to access this alternative 
database
Post to Database Table
Enter the name of the table (within that database) to which the mail message data 
will be posted.

ERS and Attached Files
Although the ERS cannot scan the contents of attached files, it can identify 
whether or not a mail message has attachments, and it can reference the 
attachment name(s) in corresponding alerts and response actions.
Additionally, CRM Studio automatically places the attached files in the Everest 
CRM - Attachments folder (path: Icode\Everest\ACRM), and you may thus 
configure an ERS event to copy or move the attached file(s) to a location of your 
choice.

Everest Software suggests that you do not check this option unless you are 
absolutely sure that no other companies or e-mail clients need to download 
these mail messages.

Everest Software recommends 120 days for this field. 

“E-Mail Message Text Parsing Options” on page 291
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E-Mail Message Text Parsing Options
One of the strengths of CRM Studio’s E-Mail Response System is that it can parse 
the content of an incoming message and load individual elements of message data 
to specific fields in the underlying ERS database.

You could define CRM Studio’s message text parsing to do the following:
• Store the value that starts after the label ‘Company Name:’ and ends at the 

first carriage return in the ERS data field called Account.
• Store the value that starts after the label ‘Address:’ and ends at the first 

carriage return in the ERS data field called Address.
• Store the value that starts after the label ‘Contact Name:’ and ends at the first 

carriage return in the ERS data field called Full Name.
• Store the value that starts after the label ‘Phone:’ and ends at the first carriage 

return in the ERS data field called Phone Work.
• Store the value that starts after the label ‘Request:’ and ends at the end of the 

message text in the ERS data field called Request.
How To Specify ERS Parsing

• From the Search labels for field values grid in the E-mail Response Options 
(Incoming) tab of the Everest CRM Studio - E-mail Accounts dialog box, 
click the Value Starts After Label column.

• Enter the text that will precede the value in the mail message you wish to load 
into a specific ERS field (e.g., Contact Name:).

• Click the Value Ends At column and from the drop-down list, select the 
indicator that signifies the end of the value to be loaded. The options are:
- A carriage return
- A line feed
- A blank space
- The end of the subject field
- The end of the message field
- The end of the subject or message field

• Click the Store Value in Column column and from the drop-down list, select 
the ERS database field that you wish to load this e-mail text into. For the list of 
available database fields and their description, refer “ERS Loadable Database 
Fields” on page 292.

Example An organization uses e-mail (or a web form) to collect information 
from users. When this information appears in a mail message, it looks 
like the following:
Company Name: Acme Corporation
Address: 1 Main Street
Contact Name: Robert Smith
Phone: 800-555-1212
Request: Please send me information regarding your product.

To specify which fields from your incoming mail messages should be 
mapped to corresponding fields in the ERS database, follow these steps:
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• Repeat these steps for each field from an incoming e-mail message that you 
wish to pass into a corresponding field in the ERS database. 

ERS Loadable Database Fields
Since CRM Studio processes incoming e-mail messages by loading them into the 
ERS database, it is important to know in which fields you can load data.

All the following fields may contain data you wish to place in them from 
the corresponding incoming mail messages. The descriptions listed in the 
Purpose column are suggested by Everest Software.
You may use Microsoft Access 97 to rename any of the following ERS data 
fields. Please do not rename any fields other than the ones in the following 
list, and note that you cannot add more fields to the ERS database.

ERS Inbox Field (Column) Name Purpose
Account The sender’s account name
Account_no The sender’s account number
Address The sender’s address
Application The name of the application that the 

sender is writing about
Case_no The case number referenced in the 

message
City The sender’s city
Country The sender’s country
E-mail The sender’s preferred e-mail address 

for response messages (may be 
different than the sender’s address on 
the incoming message)

Fax The sender’s fax number
First_Name The sender’s first name
Full_Name The sender’s full name
Incident_No The incident number referenced in the 

message
Last_Name The sender’s last name
License_No The license number of the product 

referenced in the message
Mobile The sender’s mobile phone number
Notes Message notes
Order_No The order number referenced in the 

message
Pager The sender’s pager number
Phone_Home The sender’s home phone number
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E-Mail Message Posting Options
Finally, you need to specify whether you would like to post the downloaded e-
mail message records to another database for storage and/or historical reporting.
This option is useful in some cases (such as a high volume of e-mail being 
processed, or other databases that need access to incoming mail message data), 
where you may need to transfer the mail message data to an alternative database, 
such as a Microsoft SQL Server database. 

Phone_Work The sender’s work phone number
Postal The sender’s postal (zip) code
Problem The problem text (if the message 

contains a support problem)
Product The name of the product that the 

sender is writing about 
Question The question text (if the message 

contains a question)
Request The request details
Serial_No The product’s serial number
Service The description of the service 

required
Service_No The service number referenced in the 

message
Solution The solution text for a problem or 

question
State The sender’s state
Ticket_No The ticket number referenced in the 

message
Title The sender’s title
Tracking_No The tracking number referenced in 

the message
Ufld_Flag Integer-based user-definable field.
Ufld_Memo Memo-based (long text) user-

definable field.
Ufld1 – Ufld5 Five user-definable ERS data fields
User_Name The sender’s user name.
Version The version of the product referenced 

in the message
Web_Site The sender’s web site address

To specify an alternative database to transfer the mail message data to, 
do the following: 

ERS Inbox Field (Column) Name Purpose
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• From the Message Posting Options section in the E-mail Response Options 
(Incoming) tab of the Everest CRM Studio - E-mail Accounts dialog box, 
select the option Post incoming messages to an alternative database.

• Select the ODBC source that CRM Studio will use to access this alternative 
database from the Post to Database Connection drop-down list.

• In the Post to Database Connection field, enter the name of the table (within 
that database) to which the mail message data will be posted.

Specify ODBC Source for ERS
Once you create the ODBC source for the ERS database, you must associate it 
with the E-mail Response System in the Everest CRM Studio Architect. 

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Management Folders panel in the center, highlight (click) the 
E-mail Response System branch and click the Properties button at the top of 
the Everest CRM Studio Architect dialog box. You will see the Everest CRM 
Studio - E-mail Response System Properties dialog box.

• Click the Edit Connection button. You will see the Everest CRM Studio - Edit 
Connection dialog box.

• From the ODBC Data Source Name drop-down list, select the ODBC source 
that you created for the ERS database.

• Click Save and Close. You will again see the Everest CRM Studio - E-mail 
Response System Properties dialog box.

• Click OK.

ERS Queries and Events
Once you have completed the preceding steps, you are ready to begin designing 
events for the E-Mail Response System. Since ERS records are stored in a 
database, you can follow the instructions in the chapters ‘Query Designing’ and 
‘Event Designing’ for details on creating ERS queries and events.
There are, however, a few ERS-specific fields and functions that you should be 
aware of as you begin creating queries and events. These are detailed in the 
following sections.

• The alternative database table must be configured to include the 
same column names as the KS_Inbox table. If there are some fields 
within this table that you do not utilize (such as application, case_no, 
or serial_no), you do not need to replicate them.

• The alternative database table must have a unique (or primary) key 
specified. It is suggested that you create a column like 
‘mail_datetime’, which uses a data type of timestamp in which the 
current date and time will be uniquely stamped into each posted 
record.

To associate the ODBC source for the ERS database with the E-mail 
Response System do the following:
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ERS Query Tables
The CRM Studio E-Mail Response System uses only two tables: 
• Inbox
• Status
For the purpose of designing queries, all the data from the incoming e-mail 
message is stored in the Inbox table, and thus, that is the only table you need to 
select when creating an ERS query.

ERS Query Columns
The columns that you can choose from an ERS query fall into two categories:
ERS Loadable Database Fields 
These fields are shown in a table earlier in this chapter and represent all the fields 
that you can load data into from an incoming mail message.

ERS Pre-Loaded Fields
These are fields whose values are pre-loaded by CRM Studio with values from 
the incoming e-mail message. This includes such fields as the e-mail address of 
the sender and recipient, the subject of the message, the date and time that the 
message was sent, and the names of any attached files.
The following list describes all the ERS pre-loaded fields. Remember that a query 
may use any combination of ERS loadable and pre-loaded database fields.

“ERS Loadable Database Fields” on page 292

ERS Inbox Field (Column) Name Purpose
Attachment_Count Number of attachments downloaded
Attachment_Files Comma separated list of attachments 

file specifications. All attachments are 
stored in the attachments folder 
where CRM Studio was installed.

Attachment_Names The names of the attachments.
Attachment_Start Position of the first real attachment. 

Some e-mail clients send html 
message text as an alternative 
attachment. Such files are not 
considered real attachments.

CC_Names The carbon copy send to list of names.
Certified Whether the message was certified. 

Note, not all e-mail systems support 
this feature.

Created_dt The date when the mail record was 
created in the ERS database.
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E-mail_Account The name of the CRM Studio e-mail 
account (as defined in the 
Administrator module) that this 
message came in to.

E-mail_Account_Id The ID of the CRM Studio e-mail 
account (as defined in the 
Administrator module) that this 
message came in to.

From_Name The e-mail from name (if defined), 
such as ‘John Smith’.

From_Path The full path of the sender’s name, 
such as ‘John Smith 
<smith@mycompany.com>'.

From_Root The e-mail address of the sender, such 
as ‘smith@mycompany.com’.

ID ERS-assigned unique column.
Inet_Alt_Count The number of alternate attachments 

(for Internet type mail systems only).
Inet_Mail_Program The name of the e-mail client used to 

send the e-mail (for Internet type mail 
systems only).

Inet_Message_Length The length of the message (in bytes)
(for Internet type mail systems only).

Inet_Priority The priority of the message (for 
Internet type mail systems only).

Inet_Raw_Header The full header of the e-mail message
(for Internet type mail systems only).

Inet_UIDL Internal Internet mail identifier (for 
Internet type mail systems only).

Inet_Webform Values are ‘0’ (message was not from 
a web form) or ‘-1-’ (message was 
from a web form) (for Internet type 
mail systems only).

Inet_Webform_Fields The names of the web form’s fields
(for Internet type mail systems only).

Inet_Webform_Values The values of the web form’s fields
(for Internet type mail systems only).

Login_Name The login name of the account that 
this mail message was downloaded 
from.

ERS Inbox Field (Column) Name Purpose
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ERS Query Filters
Creating filters for ERS queries is done in the same manner as creating filters for 
application events. You must consider the following when you create a filter for 
messages sent from a specific company or to a specific e-mail address.
• When a message is sent from a specific company, it could be sent from any one 

of a number of people at a specific company. Therefore, your filter needs to 
use the ‘like’ operator.
- Filter Column: Inbox.from_path
- Operator: like
- Compare Value: %yourcompany.com%

• To send mail messages to a specific account (such as a support mailbox):
- Filter Column: Inbox.to_names
- Operator: like
- Compare Value: %support@mycompany.com%

Do not forget that since the e-mail messages are stored in the underlying ERS 
database, you may also wish to include a filter in both these cases that restricts the 
results to only those messages that were received today:

- Filter Column: Inbox.received
- Operator: is equal to
- Compare Value: {Current Date%}

Message The mail message text.
Message_Id The unique message id 

(for Internet type mail systems only).
Received The date the message was received.
Received_dt The date and time the message was 

received.
Sent_dt The date and time the message was 

sent.
Subject The subject of the message.
To_Names Who the e-mail was sent to.

ERS Inbox Field (Column) Name Purpose
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ERS Query Sub-Filters
Since the mail messages are stored as records in the ERS database, one of the most 
important benefits of the CRM Studio E-Mail Response System is that you can 
create aggregate queries (and events) that are triggered by groups of messages.

ERS Events
E-Mail Response System events are created just like a standard application event, 
with one exception: you typically want to link an incoming e-mail message to the 
corresponding contact record within a customer database. The reasons why you 
would want to do this are:
• To identify who the corresponding account manager is, and to send alerts to 

that person.
• To update the corresponding customer record with the details of the incoming 

mail message.
• To create a database record (such as a support ticket) and link that ticket back 

to the customer record.
• To identify if the sender of the e-mail is not already defined within your 

customer database.
To link an ERS record to a customer record in an underlying database, you need 
to use two queries in your ERS event: one query that retrieves the e-mail records, 
and a second one that links those records to your customer database. 
Your first requirement would be to identify a field in the ERS record that would 
allow it to uniquely identify the corresponding record in your customer database. 
This is often the sender’s e-mail address (ERS field from_root), but could also be 
any other field in the incoming message that uniquely maps to a matching field in 
your customer database.
Using such a field (as the sender’s address), your two queries would be as 
follows:
• A first query which retrieves the ERS records. Make sure you include the 

linking field (i.e., the sender’s address, from_root) as one of the fields in this 
query.

• A second query which retrieves customer information. This query would have 
a filter in it that compares the e-mail address in the customer database (e.g., 
customer.mail) to the customized name of the ERS sender address field (e.g., 
{From_Root}.

With a query configuration such as this, an event is triggered only if the sender of 
the e-mail address is also found to exist in the customer database. Once CRM 

Example • More than ‘x’ messages received from a certain company over a 
certain period of time

• Fewer than ‘x’ messages received in response to a specific 
marketing campaign

• More than ‘x’ messages received about product ‘y’
• More than ‘x’ dollars ordered for product ‘y’ via the web
• The average sales price for products ordered via the web drops 

below ‘x’
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Studio makes this match, all the fields of data associated with this event (both, 
data from the incoming message and from the customer database record) would 
be eligible to be used in alert messages and in response actions.

ERS Event Alerts and Actions
The first capability you need to consider as a response to an ERS event is the alert 
messages that CRM Studio can send out. It can send out messages to:
• The salesperson and/or support person associated with an account
• The sender of the incoming mail message
• Managers, partners, et cetera
These messages can include reports and/or files along with their traditional 
message content.

As a result of a triggered ERS event, CRM Studio can also execute response 
actions such as executing VB scripts, running programs, writing triggered event 
data to an external file, and submitting SQL statements.

ERS Events That Generate Reports
One particularly interesting use of CRM Studio’s E-Mail Response System is that 
it can generate one or more reports as a result of an incoming message. Consider 
this scenario:
You have customers who frequently ask for a report of their open support calls. 
Employing the ERS, you can use a web form to allow clients to enter a report 
request in which they fill out their customer ID and selection criteria for the report 
they wish to run.
This web form generates an e-mail message, which, in turn, generates a record in 
the ERS database. This record is then queried and identified as one that needs to 
generate an Open Call report. CRM Studio generates the report for the 
corresponding client and e-mails it back to them.
This is often referred to as a Report Auto-Request System.
All you need to do is to configure an ERS query to identify which report is being 
requested, and which selection criteria need to be passed to the corresponding 
report. CRM Studio then generates the report and (using the sender’s e-mail 
address from the original request) sends it right back to them.

This link allows you to know which database records to update and/or 
create using a CRM Studio event response action such as executing a VB 
script.

Example Here is a simple message that CRM Studio could send back to a 
person who logged a support question via e-mail:
Hello {from_name},
This is to confirm our receipt of your e-mail sent on {sent_dt} to 
{to_names}.
We will contact you shortly when we have an answer for you.
Thank You,
Support Team
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ERS Subscribers
Like a standard application event, an ERS event can send alerts to any recipient. 

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Management Folders panel in the center, select Application 
Events > (your company) > Events. You will see a list of events in the right 
panel.

• Open the event for which you want to specify recipients eligible to receive 
replies, and select the Subscribers > Advanced tab.

• From the Deliver to a specific email, pager, fax or webcast name using 
database value grid, click the Database Field column beside the row 
Contains Email Address to send to.

• From the drop-down list, select the {From_Root} field.

ERS Event Schedule
Since you want CRM Studio to respond to incoming mail messages as soon as 
they are received, all ERS events must use a suitable schedule.

• After configuring ERS to send a message back to the person from whom it was 
received (in the preceding steps), click the Schedule tab.

• From the Choose a schedule to use drop-down list, select When E-mail 
Arrives.

• Click Save and Close.

ERS in the Everest CRM Studio Event Monitor
To monitor the status of ERS events, you can use the Everest CRM Studio Event 
Monitor (path: CRM > CRM Studio > Monitor). ERS events are converted to 
standard application events and can be tracked from the Standard Applications 
branch. 
The E-mail Response branch allows you to view the ERS events that have been 
successfully checked by CRM Studio, and it also displays the individual e-mail 
messages that are received (and logged) into the ERS database.

Once an incoming message is successfully received and loaded into the ERS 
database, you can use the Application Event and E-mail Delivery branches to 
check if the ERS event was triggered, who was notified, and so on.

To send a message back to the person from whom the original message 
was received, do the following:

To define a suitable schedule for ERS events, do the following:

If the ERS module is unable to read the incoming messages or is unable to 
load the messages into the ERS database, an error appears in the E-mail 
Response error branches.
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CRM Studio Event Triggered Reports
CRM Studio integrates with Crystal Reports in two ways:
Event-Triggered Reports 
CRM Studio can generate one or more Crystal Reports when an event is triggered 
and e-mail, fax, copy/ftp, or webcast the report contents. 

Scheduled Reports
CRM Studio can generate one or more Crystal Reports on a pre-defined schedule 
(e.g., every day at 9 AM), and e-mail, fax, copy/ftp, or webcast the report 
contents. 

This chapter addresses the configuration and use of event-triggered reports.

Define Reports in CRM Studio
The first step in enabling event-triggered reports is to instruct CRM Studio which 
Crystal Reports you wish to generate, and the location of the corresponding 
source (*.rpt) files.
Just like traditional queries and events, Crystal Reports are organized according 
to the database they correspond with. Thus, you can segregate Crystal Reports for 
different Everest companies for easier organization and maintenance.

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• From the Event Management Folders panel in the center, select Application 
Events > (your company) > Report Definitions. You will see a list of reports 
in the right panel.

Example When more than ‘x’ units of product ‘y’ are sold over a specific time 
frame, CRM Studio automatically generates a sales history report and 
sends it to a sales manager.

Example Every Monday at 8 AM, CRM Studio automatically generates and 
distributes this week’s sales forecast reports and last week’s service 
statistics reports.

To define your Crystal Report sources, do the following:
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 Figure 10.1: Everest CRM Studio - Report Definitions

Add a New Report Definition

• From the Event Management Folders panel in the center of the Everest CRM 
Studio Architect dialog box, select Application Events > (your company) > 
Report Definitions.

• Click the New Report Definition button at the top-left. You will see the 
Everest CRM Studio - Report Definitions dialog box.

Repeat this process for each report that you generate for the corresponding 
database. 

The reports you use in CRM Studio must already have been created 
(designed) using Crystal Reports.

To add a new report definition to CRM Studio, do the following:
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The Everest CRM Studio - Report Definitions Dialog Box

 Figure 10.2: Everest CRM Studio - Report Definitions
Internal ID Number
This field displays the ID of the report. You cannot modify it.
Report Name
Enter the name of the report.
Report Description
Enter an informational description of the contents and use of the report.
Report File
Specify the location and source (*.rpt) file that corresponds to this Crystal report.
Browse
Click this button to display the Everest CRM Studio - Select a Report File dialog 
box, which you can use to locate and select reports.
Output File Name
Enter the name to be given to the output file that contains this report. If you leave 
this field blank, the report name will be randomly generated by CRM Studio.

Event-Triggered Reports
When an event is triggered, you can choose to have CRM Studio generate one or 
more Crystal Reports (typically containing information related to the event), and 
send those reports either with or without an associated alert message. Reports 
that are generated as a result of a triggered event fall into three categories:
• Reports that have no dynamic selection criteria
• Reports that have event-independent selection criteria
• Reports that have event-dependent selection criteria

If this report is to be generated multiple times by a single event (such as an 
event that generates separate Overdue Activities reports for multiple 
salesreps), you must leave this field blank.
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The following sections detail each of these reports, and how to associate them to a 
CRM Studio event.

The Event -> Report Correlation
One of the most important concepts in configuring event-triggered reports is that 
CRM Studio generates one report for each event record that is triggered.

If the event runs and finds 10 matching opportunities, you will receive 10 alert 
messages, each with an attached Crystal Report. (The event is considered to have 
been triggered 10 times.)

Regardless of the number of matching opportunities the event finds, you will 
receive one alert message, with a single attached Crystal Report. (The event is 
considered to have been triggered once.)

Since CRM Studio runs one report for each triggered record, this event will run 
one report for each sales representative with overdue activities. The only special 
characteristic of this event is that CRM Studio passes the name of each 
corresponding sales representative to Crystal so that the reports can be generated 
appropriately. 
The important thing to remember in all cases is that CRM Studio generates one 
Crystal Report each time an event is triggered, so be careful to evaluate the event 
you are working with to ensure that you are not unnecessarily sending the same 
report over and over to the alert recipients.

Reports With No Dynamic Selection Criteria
In Crystal Reports, you can design a report that includes or excludes specific 
records. The selection criteria that you choose can either be hard-coded into the 
report, or it can be created as report parameters that will accept input each time 
the report is run.
The simplest type of report that you can link to a CRM Studio event is one that is 
designed without any parameters that require input each time the report is run. In 
such a scenario, CRM Studio automatically generates the associated report each 
time the related event is triggered.

• From the Event Management Folders panel in the center of the Everest CRM 
Studio Architect dialog box, select Application Events > (your company) > 
Events. You will see a list of events in the right panel.

Example You have an event that runs every Monday at 9 AM and sends you a 
separate e-mail message for each opportunity that is due to close this 
week. 

Example You have an event that runs every Monday at 9 AM and sends you a 
single e-mail message with the details of all opportunities that are due 
to close this week.

Example You have an event that runs everyday at 5 PM and generates a list of 
sales representatives who have overdue activities. You want each 
sales representative to receive a report of only the overdue activities.

To link such a report to an event, do the following:
306 Everest CRM Studio
User Guide



CRM Studio Event Triggered Reports
• Open the event you wish to associate the report to. You will see the Everest 
CRM Studio - Application Events\(your company)\Events dialog box.

• Click the Reports tab and click the Add Report button. You will see the 
Everest CRM Studio - Add Report dialog box, using which you can select 
reports.

• Select the report you wish to associate with this event and click Select. You 
will again see the Everest CRM Studio - Application Events\(your 
company)\Events dialog box, with the selected report displayed in the 
Reports Selected For Content grid.

• From the Reports Selected For Content grid, click the Style column of the 
report just selected. Choose the output format of the report. Your choices are:
- ASCII
- HTML
- Rich Text
- Microsoft Excel
- Lotus
- Comma Delimited
- Tab Delimited

• Click Save and Close.
You may continue to select additional reports you wish to associate with this 
event.

Reports With Event-Independent Selection Criteria
The second type of Crystal Report that you may wish to link to an event requires 
the entry of some selection criteria, but these criteria are not generated from 
within the corresponding event.

The corresponding Crystal Report may have been designed with three parameter-
driven selection criteria: the opportunity amount, the beginning forecast close 
date, and the ending forecast close date.
Assuming that your event is designed to limit its retrieved records to only those 
opportunities that are for more than $20,000 and are due to close this week, you 
need to make sure that the corresponding report will retrieve the same records.
Fortunately, CRM Studio allows you to enter the values of these selection criteria 
when a report is linked to an event. 

The report(s) you select for an event may be delivered to the alert 
subscribers via the following methods:
• E-mail (attached to the message)
• Fax (the report must be output in ASCII format)
• Copy/FTP
• Webcast

Example You may have an event that retrieves opportunities worth more than 
$20,000 and are due to close this week.

To enter the values of selection criteria when a report is linked to an 
event, do the following:
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• After linking the report to an event as detailed in “Reports With No Dynamic 
Selection Criteria” on page 306, notice how the Report Parameters grid in the 
Reports tab of the Everest CRM Studio - Application Events\(your 
company)\Events dialog box is populated with the selection criteria 
previously configured for this report within Crystal Reports.

• For each parameter (or Question) that appears in this grid, you can supply a 
corresponding value to be used whenever CRM Studio generates this report. 

• For a report with event-independent selection criteria (i.e., selection criteria 
that does not vary based on the results of the event’s query), you can answer 
each question in two ways:
- You can manually enter a value in the Answer column. 

- You can click the Answer column, and click the list  button that is 
displayed. From the drop-down list, select any one of CRM Studio’s date 
substitution variables.   

You may continue to select additional reports you wish to associate with this 
event.

Reports With Event-Dependent Selection Criteria
The final type of Crystal Report that you can link to an event is dependent on the 
results of an event’s query(ies) to derive its selection criteria.

To make this scenario work, CRM Studio must pass the names of these sales 
representatives to the corresponding Crystal Report. Thus, the report is 
dependent on the data that an event retrieves.
This is explained in more detail in the following sections.

Example For a parameter that asks you to choose Opportunities that are Greater 
than How Much?, you could manually type in 20000.

Example For parameters that ask for a forecast for start and end dates, you 
could choose current date and next Friday’s date as the related values

The report(s) you select for an event may be delivered to the alert 
subscribers via the following methods:
• E-mail (attached to the message)
• Fax (the report must be output in ASCII format)
• Copy/FTP
• Webcast

Example An event that generates an Overdue Activities report for each sales 
representative who has overdue activities. The report would have a 
selection parameter that accepts the names (or IDs) of only those sales 
representatives who have overdue activities. The query for the 
corresponding CRM Studio event would be designed to retrieve 
those same sales representatives.
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Preparing for an Event-Dependent Report
As was detailed in the preceding sections, CRM Studio does not feed detailed 
information into a Crystal Report, but directly generates a Crystal Report with the 
appropriate selection criteria that the report needs to generate the desired output.
The key concept is that CRM Studio uses selection criteria to instruct Crystal 
which records to retrieve for a report. As mentioned in the Overdue Activities 
report, CRM Studio simply identifies which users have overdue activities, and 
then instructs Crystal to produce reports for each of these users.
This process entails two important design components: 
• First, in CRM Studio, you must carefully design a query so that it produces 

the appropriate selection criteria to be fed into the Crystal Report.
• Second, in Crystal, you must carefully design the corresponding report to 

accept selection criteria (called Report Parameters in Crystal) so that the 
appropriate output may be obtained.

Query Design for Event-Dependent Reports
The first part of creating an event that will feed information to a Crystal Report is 
the design of the underlying query. 
Most queries are suitable when sending information in an e-mail (or similar) 
format, but may not be appropriate for generating a Crystal Report. 
The problem with this format is that when a result set such as this one is passed to 
an event, CRM Studio generates one Crystal Report for each overdue activity in 
this result set – certainly not what you want.
Instead, what you want is a list of overdue activities grouped by each sales 
representative. 
This type of query most typically makes use of an aggregate function as the 
means to generate a list of records that can correctly feed a Crystal Report’s 
selection criteria. 

Query Design - Notes
Consider the following items when designing a query for use with an event-
dependent report:
Table/Column Selection
Choose tables and columns that contain the information you wish to feed into the 
report, and information about the recipient’s alert delivery address. 
Aggregate Selection
The easiest way to design a query that yields report selection criteria such as the 
names of users, products, regions, et cetera is through the use of the aggregate 
count function. You simply count the number of records per user, product, or 
region, and you end up with one record per selection criteria.

Report Design for Event-Dependent Reports
The design of a Crystal Report to be used in CRM Studio requires no unique 
configuration. Your first step is to design the report to produce the desired data, 
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and the second step is to ensure that the report is set up with selection parameters 
that allow CRM Studio to pass data from a triggered event into the report.
Thus, using the overdue activities report as an example, you would be sure to 
include the following selection parameters:
• A parameter that restricts the report to retrieving only those activities that are 

overdue.
• A parameter that prompts for the names (or IDs) of the sales representatives 

whose overdue activities you wish to report on.
In this example, the report automatically retrieves only overdue activities, and 
then (using information from the CRM Studio query) the report generates once 
for each sales representative who has overdue activities.
Once you have created the appropriate parameters for the Crystal Report to be 
generated by CRM Studio, you are ready to connect the report to the 
corresponding event.

Configure the Event-Dependent Report

• From the Event Management Folders panel in the center of the Everest CRM 
Studio Architect dialog box, select Application Events > (your company) > 
Events. You will see a list of events in the right panel.

• Open the event you wish to associate the report to. You will see the Everest 
CRM Studio - Application Events\(your company)\Events dialog box.

• Click the Reports tab and click the Add Report button. You will see the 
Everest CRM Studio - Add Report dialog box.

• Select the report you wish to associate with this event and click Select. You 
will see the Everest CRM Studio - Application Events\(your 
company)\Events dialog box again with the selected report displayed in the 
Reports Selected For Content grid.

• From the Reports Selected For Content grid, click the Style column of the 
report just selected. Choose the output format of the report. Your choices are:
- ASCII
- HTML
- Rich Text
- Microsoft Excel
- Lotus
- Comma Delimited
- Tab Delimited

• Notice how the Report Parameters grid in the Reports tab of the Everest CRM 
Studio - Application Events\(your company)\Events dialog box is 
populated with the selection criteria previously configured for this report 
within Crystal Reports.

• For each parameter (or Question) that appears in this grid, you can supply a 
corresponding value to be used whenever CRM Studio generates this report. 

• Just like a report with event-independent selection criteria, you can:

To link an event-dependent report to an event, follow these steps:
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- Manually enter a value in the Answer column. 

- Click the Answer column, and click the list  button that is displayed. 
From the drop-down list, select the name of the associated query’s data 
field that contains the selection criteria you wish to pass to the report. In 
the example of the Overdue Activities event, your query might have a 
field called User ID, which contains the names of the sales representatives 
who have overdue activities. By selecting this field as the answer to a 
report’s parameter, CRM Studio feeds the ID of an individual sales 
representative who has overdue activities for each iteration of the report 
that is generated. 

• Click Save and Close.
You may continue to select additional reports you wish to associate with this 
event.

Report Delivery Methods
Reports may be delivered to recipients via e-mail (as attached files), fax (ascii-
styled reports are embedded within the fax message), webcast (reports are linked 
to a web page via a URL link), and copy/ftp (report files are sent to a specific disk 
and directory).
You may wish to use one or more delivery methods to alert a recipient of the 
availability of a report, while delivering the actual report via another method.

Delivering a File Via Copy/FTP
One of the methods by which a report (and/or file) can be delivered to a recipient 
is via the copy/ftp method. This method is quite useful, as it allows you to move a 
report’s output to one or more locations that are easily accessible by the 
recipients.

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

If the query lists five sales representatives with overdue activities, CRM 
Studio triggers the corresponding event five times and generates five 
corresponding reports. 

The report(s) you select for an event may be delivered to the alert 
subscribers via the following methods:
• E-mail (attached to the message)
• Fax (the report must be output in ASCII format)
• Copy/FTP
• Webcast

Example You may wish to use an e-mail or pager message to alert a person of a 
report’s availability, but actually make the report available only from 
a webcast site.

To deliver a report (or file) via this method, do the following:
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• From the Event Management Folders panel in the center, select Application 
Events > (your company) > Events. You will see a list of events in the right 
panel.

• Open the event for which you want to deliver files/reports via copy/ftp.
• Click the Copy tab. Select either (or both) options to deliver the reports and/or 

files to the appropriate recipients.

• Click Save and Close. 

E-Mail Delivery Options
When a report or file is configured for delivery, CRM Studio enables you to 
specify whether it will be accompanied by an e-mail message. The mail message 
can be used in two ways:
• As a delivery method for the report/file. CRM Studio can automatically 

attach the selected reports/files to an outgoing e-mail message.
• As a notification message that informs the recipients that the corresponding 

reports/files are available to them. In this instance, the reports/files are not 
attached to the mail message. (The reports/files may have been sent by fax or 
ftp, or posted to a website.)

If you do not wish to use e-mail for either of these two purposes, you may leave 
blank the E-mail tab of the Everest CRM Studio - Application Events\(your 
company)\Events dialog box.
If you do wish to utilize either of the previous uses for an e-mail message, fill in 
the e-mail sending account, message subject, and text as you require. Pay special 
attention to the three check boxes at the bottom of this window.

Attaching Reports to an E-Mail Message
The first two check boxes at the bottom of the E-mail tab of the Everest CRM 
Studio - Application Events\(your company)\Events dialog box allow you to 
specify whether or not you wish to attach the selected reports/files to the 
outgoing e-mail message.
If you choose to attach reports to an e-mail message, CRM Studio automatically 
waits until the reports are successfully completed before sending the mail 
message. If an attached report fails to complete successfully, the e-mail message is 
not sent.
If you choose not to attach the reports to your mail message, you can specify that 
the e-mail message should wait (i.e., delay being sent) until all the associated 
reports are successfully generated. You can do so by selecting the option E-Mail 
notifications should wait until reports are generated.

“The Everest CRM Studio - Application Events\(your company)\Events 
Dialog Box - Copy” on page 191

The destination (or copy to) location of reports and files is determined 
within each subscriber’s profile in CRM Studio.

“The Everest CRM Studio - Application Events\(your company)\Events 
Dialog Box - Email” on page 194
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Checking this option ensures that the recipient of the mail message is able to 
access the referenced report when the message is received. If, however, the 
reports fail to be completed successfully, the e-mail message is not sent at all.
If this field is not checked, the e-mail message is sent immediately, and, 
depending on the amount of time required to generate the report(s), the recipient 
of the message may not be able to access them immediately.

Fax Delivery Options
When a report or file is configured for delivery, CRM Studio also enables you to 
specify whether it will be accompanied by a fax message. The fax message can be 
used in two ways:
• As a delivery method for the report/file. CRM Studio can automatically 

attach text-based reports/files to an outgoing fax message.
• As a notification message that informs the recipients that the corresponding 

reports/files are available to them. In this instance the reports/files are not 
attached to the fax message.

If you do not wish to use faxing for either of these two purposes, you may leave 
blank the Fax tab of the Everest CRM Studio - Application Events\(your 
company)\Events dialog box.
If you do wish to utilize either of the two previous uses for a fax message, fill in 
the fax sending account, subject, cover page text, and message text as you require. 
Pay special attention to the three check boxes at the bottom of this window.

Attaching Reports to a Fax Message
The first two check boxes at the bottom of the Fax tab of the Everest CRM Studio 
- Application Events\(your company)\Events dialog box allow you to specify 
whether or not you wish to attach the selected reports/files to the outgoing fax 
message.

If you choose to attach reports to the fax message, CRM Studio automatically 
waits until the reports are successfully completed before sending the fax. If an 
attached report fails to complete successfully, the fax is not sent.
If you choose not to attach the reports to your fax, you can specify that the fax 
should wait (i.e., delay being sent) until all the associated reports are successfully 
generated. You can do so by selecting the option Fax notifications should wait 
until reports are generated.
Checking this option ensures that the recipient of the fax is able to access the 
referenced report when the fax is received. If, however, the reports fail to be 
completed successfully, the fax is not sent at all.
If this field is not checked, the fax is sent immediately, and, depending on the 
amount of time required to generate the report(s), the recipient of the fax may not 
be able to access them immediately.

“The Everest CRM Studio - Application Events\(your company)\Events 
Dialog Box - Fax” on page 203

Only text-based reports and files can be attached to a fax message.
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Pager Delivery Options
When you have a report or file configured for delivery, CRM Studio enables you 
to send a pager alert to the recipients as means to notify them that the reports/
files are ready.
If you do not wish to send pager alerts about distributed reports/files, you may 
leave blank the Page tab of the Everest CRM Studio - Application Events\(your 
company)\Events dialog box.
If you send pager notifications, you can specify whether the pager message 
should wait (i.e., delay being sent) until all the associated reports are successfully 
generated. If you do wish CRM Studio to wait, select the option Pager 
notifications should wait until reports are generated.
Checking this option ensures that the recipient of the pager message is able to 
access the referenced report when the message is received. If, however, the 
report(s) fail to be completed successfully, the pager message is not sent at all.
If this field is not checked, the pager message is sent immediately, and, depending 
on the amount of time required to generate the reports, the recipient of the 
message may not be able to access them immediately.

Webcast Delivery Options
When a report or file is configured for delivery, CRM Studio enables you to 
specify whether it will be accompanied by a web (HTML) alert message. The web 
message can be used in two ways:
• As a delivery method for the report/file. CRM Studio can automatically 

attach (as URL links) the selected reports/files to the posted web message.
• As a notification message that informs the recipients that the corresponding 

reports/files are available to them. In this instance, the reports/files are not 
posted to the web message. (The reports/files may have been sent by fax, ftp, 
or e-mail.)

If you do not wish to use web alerts for either of these two purposes, you may 
leave blank the Webcast tab of the Everest CRM Studio - Application 
Events\(your company)\Events dialog box.
If you do wish to utilize either of the two previous uses for a web alert message, 
fill in the webcast message subject and text as you require. Pay special attention to 
the three check boxes at the bottom of this window.

Posting Reports to a Webcast Message
The first two check boxes at the bottom of the Webcast tab of the Everest CRM 
Studio - Application Events\(your company)\Events dialog box allow you to 
specify whether or not you wish to attach the selected reports/files to the posted 
web alert message.

“The Everest CRM Studio - Application Events\(your company)\Events 
Dialog Box - Page” on page 206

“The Everest CRM Studio - Application Events\(your company)\Events 
Dialog Box - Webcast” on page 209
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If you choose to attach reports to a webcast message, CRM Studio automatically 
waits until the reports are successfully completed before posting the webcast 
message. If an associated report fails to complete successfully, the webcast 
message is not sent.
If you choose not to attach the reports to your webcast message, you can specify 
whether the webcast message should wait (i.e., delay being sent) until all the 
associated reports are successfully generated. If you do wish CRM Studio to wait, 
select the option Webcast notifications should wait until reports are generated.
Checking this option ensures that the recipient of the webcast alert message is 
able to access the referenced report(s) when the message is received. If, however, 
the report(s) fail to be completed successfully, the webcast message is not sent at 
all.
If this field is not checked, the webcast message is sent immediately, and, 
depending on the amount of time required to generate the reports, the recipient of 
the message may not be able to access them immediately.

How Reports Appear in the Monitor
It is important to understand the sequence by which event-triggered reports 
appear in the Everest CRM Studio Event Monitor.
Like any other application event, an event with an associated report begins by 
appearing in the Application Events branch, from where you can track its status 
as checked and (if appropriate), triggered. It is only if an event is triggered that its 
associated report(s) is generated.
Once an event with associated reports is triggered, you may proceed to the 
Report Generation (and not the Report Distribution) branch. From this branch, 
you may track the progress of the event’s associated reports as they go from a 
pending to a generated state.
If a report fails to generate successfully, it appears under Errors in the Report 
Generation branch.
Assuming that the report generated successfully, the last step is for the report 
(and any associated alert messages) to be delivered. Depending on the method(s) 
by which the event is configured to deliver the report (e-mail, fax, copy, or 
webcast), you may click the corresponding Delivery branches within the Everest 
CRM Studio Event Monitor and check if the message and report are successfully 
delivered.

You may also click the relevant Triggered branch in the Application Events 
folder of the Everest CRM Studio Event Monitor and use the Deliverables 
button to see who was notified, and whether the alert message included the 
appropriate attached reports.

“Monitoring the Status of Alert Messages” on page 230
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CRM Studio Scheduling Crystal Reports
In addition to generating Crystal Reports as the result of a triggered event, CRM 
Studio can also generate and distribute Crystal Reports based on a pre-defined 
schedule.
This is a very important function within CRM Studio, as it allows you to 
automate report distribution – the process of generating reports and using e-mail, 
fax, ftp, and the web to automatically deliver them.

Define Reports in CRM Studio

Add a New Report Definition

Scheduled Report Examples
Examples of scheduled report events would be:
• A daily Activities report
• A weekly Forecast Sales report
• A monthly High Priority Support Calls report
These scheduled reports are automatically generated by CRM Studio at a specific 
date and time, and then are distributed to the appropriate recipients via any 
combination of e-mail, fax, copy/ftp, and webcast.

Definition - Scheduled Report Event
A scheduled report event has no associated queries, and its purpose is to generate 
and distribute one or more reports (and/or files).
A single scheduled report event may, in fact, generate and distribute multiple 
Crystal reports. 

Although this chapter is titled Scheduling Crystal Reports, the distribution 
capabilities detailed in this chapter apply equally to the distribution of files, 
such as weekly product updates, company newsletters, financial 
spreadsheets, and other important documents that need to be delivered to 
employees, business partners, and clients.

“Define Reports in CRM Studio” on page 303

“Add a New Report Definition” on page 304

The reports you define here for the purpose of scheduled report 
distribution may or may not include selection criteria (such as date range 
selections), as CRM Studio can pass values to these criteria when the report 
is generated.

Example Every Friday at 5:00 PM, your organization might need to distribute 
the following five reports to all the members of your executive team:
• Weekly sales report
• Next week’s forecasted sales
• Weekly receivables report
• Weekly payables report
• Sales representative commission report
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Although you could create a separate scheduled report event for each report, it is 
much easier to create a single report event (like End of Week Reports), and simply 
associate all five reports to that one event.
Thus, when the event is run, the recipients receive all the reports they require 
simultaneously, whether via e-mail, fax, copy, or webcast.

Create a Scheduled Report Event

• From the Event Management Folders panel in the center of the Everest CRM 
Studio Architect dialog box, select Application Events > (your company) > 
Scheduled Reports.

• Click the New Scheduled Report button at the top-left. You will see the 
Description tab of the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report dialog box.

• Enter a description of your scheduled report event in the Scheduled Report 
Description field.

• Select a value from the Priority drop-down list, depending on the importance 
of the event.

• Be sure to check the Active check box. 
• To retain the history of only the last time this event runs, check the Keep only 

last checked record in Monitor option.
• Click Next. You will see the Reports tab of the Everest CRM Studio - 

Application Events\(your company)\Scheduled Report dialog box.

To create a scheduled report event, do the following:
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The Everest CRM Studio - Application Events\(your 
company)\Scheduled Report Dialog Box - Description

 Figure 11.1: Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Description

Internal ID Number
This field displays the ID of the scheduled report event. You cannot modify it.
Scheduled Report Description
Enter a brief description of the report event being defined.
Lookup Key (Optional)
If this report event is meant to be called from within an external database, enter a 
unique identifying value in this field. 
Priority
This field is used to determine the order in which multiple scheduled report 
events will be submitted. The event with the highest ranking priority (priority ‘0’ 
being the highest) will be submitted first.
Active
Be sure to check this box.
Keep only last checked record in Monitor
Select this option to retain the history of the last time a scheduled report event 
was checked, and every time it was triggered.

“Keep Only Last Checked Record in Monitor” on page 180
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Link the Report(s) to the Event
Once you have specified a scheduled report event’s description, the next step is to 
link the corresponding report(s) to the event. 

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\(your company)\Scheduled Report 
dialog box, click Next. You will see the Reports tab. 

• Click the Add Report button. You will see the Everest CRM Studio - Add 
Report dialog box.

• Highlight the first report you wish this event to generate and click Select. The 
selected report is displayed in the Reports Selected For Content grid.

• From the Reports Selected For Content grid, click the Style column of the 
report just selected. Choose the output format of the report. Your choices are:
- ASCII
- HTML
- Rich Text
- Microsoft Excel
- Lotus
- Comma Delimited
- Tab Delimited

If you want this event to generate multiple reports, continue to click Add Report 
and specify additional reports.

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\(your company)\Scheduled Report 
dialog box, click Next. You will see the Reports tab. 

• Click the Add Report button. You will see the Everest CRM Studio - Add 
Report dialog box.

• Click the Select Another Application button. You will see the Everest CRM 
Studio - Select Another Application dialog box.

• Highlight the database that contains the report you wish to select and click 
Select. You will again see the Everest CRM Studio - Add Report dialog box.

• Select the report you wish this event to generate and click Select. 

The process of configuring a scheduled report event is similar to designing 
an application event; the exception being that a scheduled report event has 
no associated queries.

To link the corresponding scheduled report to the event, do the 
following:

A single scheduled report event may generate reports that are associated 
with multiple CRM Studio databases. 

To select a report that is associated with another database, do the 
following:
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The Everest CRM Studio - Application Events\(your 
company)\Scheduled Report Dialog Box - Reports

 Figure 11.2: Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Reports

Add Report
Click this button to display the Everest CRM Studio - Add Report dialog box, 
which enables you to select and add reports to the Reports Selected For Content 
grid.
Reports Selected For Content
This grid displays the selected reports.
Remove Report
Click this button to remove a selected report from the Reports Selected For 
Content grid.
Remove All Reports
Click this button to remove all reports from the Reports Selected For Content 
grid.
Report Parameters
The parameters for the selected reports are displayed in this section. Specify the 
report parameter values in the Answer column.

Specifying Report Parameter Values
Crystal Reports include parameters that accept selection criteria. These 
parameters enable the report to restrict the records that it retrieves to only those 
that meet specific criteria. Some of the output are:
• Only high priority support calls
• Sales forecast for next week
• Quotes for more than $25,000
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The parameters appear at the bottom of the Reports tab of the Everest CRM 
Studio - Application Events\(your company)\Scheduled Report dialog box.

• After linking the report to an event as detailed in “Link the Report(s) to the 
Event” on page 322, notice how the Report Parameters grid in the Reports tab 
of the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report dialog box is populated with the selection 
criteria previously configured for this report within Crystal Reports.

• For each parameter (or Question) that appears in this grid, you can supply a 
corresponding value to be used whenever CRM Studio generates this report. 

• For a report with event-independent selection criteria (i.e., selection criteria 
that does not vary based on the results of the event’s query), you can answer 
each question in two ways:
- You can manually enter a value in the Answer column. To generate a sales 

forecast report for the following week, you could type in specific dates in 
the beginning and ending order date parameters.

- You can click the Answer column, and then the list  button that is 
displayed. From the drop-down list, select any one of CRM Studio’s date 
substitution variables. You could choose {%Next Monday Date%} and 
{%Next Friday Date%} for the beginning and ending order dates.

• You may continue to select additional reports you wish to associate with this 
event.

Link File(s) to the Event
Besides reports, you can also link one or more files to a scheduled report event.
This is an excellent method for distributing needed files (such as weekly 
schedules, product brochures, newsletters, and spreadsheets) on a periodic basis. 

• After specifying relevant information in the Description tab of the Everest 
CRM Studio - Application Events\(your company)\Scheduled Report 
dialog box, select the Files tab.

• Click the Add File button. You will see the Everest CRM Studio - Add File 
dialog box, using which you can browse for and locate the required file(s).

• Enter a description of the file you are adding to this event, in the Files 
Selected For Content grid.

• Select the Ascii Text option if the associated file is in ASCII format. 

• Repeat these steps for each file you wish to add.

To enter the values of selection criteria when a scheduled report is 
linked to an event, do the following:

To attach one or more files to a scheduled report event, do the following:

Only ascii formatted files can be delivered via fax.
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The Everest CRM Studio - Application Events\(your 
company)\Scheduled Report Dialog Box - Files

 Figure 11.3: Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Files

Add File
Click this button to display the Everest CRM Studio - Add File dialog box, which 
enables you to select and add files to the Files Selected For Content grid.
Files Selected For Content
This grid displays the selected files.
Remove File
Click this button to remove a selected file from the Files Selected For Content 
grid.
Remove All Files
Click this button to remove all files from the Files Selected For Content grid.

Choose Report Delivery Methods
You may deliver Reports to recipients via e-mail (as attached files), fax (ascii-
styled reports are embedded within the fax message), webcast (reports are linked 
to a web page via a URL link), and copy/ftp (report files are sent to a specific disk 
and directory).
You may use one or more delivery methods to alert a recipient of the availability 
of a report, and deliver the actual report via another method.

Example You may use an e-mail or pager message to alert a person of a report’s 
availability, but actually make the report available from a webcast site.
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Delivering a File Via Copy/FTP
One of the methods by which a report (and/or file) can be delivered to a recipient 
is via the copy/ftp method.

• After specifying relevant information in the Description and Reports/Files tab 
of the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report dialog box, select the Copy tab.

• Select either (or both) options to deliver the reports and/or files to the 
appropriate recipients via this method.

• Click Next. You will see the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - E-mail tab.

The Everest CRM Studio - Application Events\(your 
company)\Scheduled Report Dialog Box - Copy

 Figure 11.4: Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Copy

Include Files on Copy operations
Select this option to enable transfer of files through FTP.
Include Reports on Copy operations
Select this option to enable transfer of reports through FTP.

E-Mail Delivery Options
When a report or file is configured for delivery, you can specify whether it will be 
accompanied by an e-mail message. The mail message can be used in two ways:
• As a delivery method for the report/file. CRM Studio can automatically 

attach the selected reports/files to an outgoing e-mail message.
• As a notification message that informs the recipients that the corresponding 

reports/files are available to them. In this instance, the reports/files are not 
attached to the mail message. (The reports/files may have been sent by fax or 
ftp, or posted to a website.)

If you do not wish to use e-mail for either of these two purposes, you may leave 
blank the E-mail tab of the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report dialog box.

To deliver a report (or file) via copy/ftp, do the following:

The destination (or copy to) location of reports and files is determined 
within each subscriber’s profile in CRM Studio.
326 Everest CRM Studio
User Guide



CRM Studio Scheduling Crystal Reports
The Everest CRM Studio - Application Events\(your 
company)\Scheduled Report Dialog Box - E-mail

 Figure 11.5: Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - E-mail

Available values for use in message content
This section displays the available fields from the queries that are linked to the 
event, and can be used in the Message Subject and Message Text fields.
Use selected value in Text
Click this button to use a highlighted value from the Available values for use in 
message content field, in the Message Subject and/or Message Text fields.
E-mail Account to Send From
From the drop-down list, select the e-mail account to be used for sending mail. 

E-mail Reply Address (Optional)
Specify a reply address to use one that is different from the address in the E-mail 
Account to Send From field.
Message Subject
Specify the subject of the e-mail alert.

Message Text
Specify the text of the e-mail alert.

Include reports as e-mail attachments 
Specify whether the associated reports are to be attached to the outgoing e-mail 
message.

“Set Up E-mail Account to send E-mails” on page 28

“E-Mail Subject Text” on page 195

“E-Mail Message Text” on page 196
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Include files as e-mail attachments
Specify whether the associated files are to be attached to the outgoing e-mail 
message.
E-mail notifications should wait until reports are completed
If an event has associated reports which are not attached to the outgoing e-mail, 
you can use this option to control the timing between the generation of the reports 
and the sending of the e-mail.
If you choose to attach reports to an e-mail message, CRM Studio automatically 
waits until the reports are successfully completed before sending the mail 
message. If an attached report fails to complete successfully, the e-mail message is 
not sent.
If you choose not to attach the reports to your mail message, you can specify 
whether the e-mail message should wait (i.e., delay being sent) until all the 
associated reports are successfully generated by selecting the option E-Mail 
notifications should wait until reports are completed.
Checking this option ensures that the recipient of the mail message can access the 
referenced report when the message is received. 

If this field is not checked, the e-mail message is sent immediately, and, 
depending on the amount of time required to generate the reports, the recipient of 
the message may not be able to access them immediately.

Fax Delivery Options
When a report or file is configured for delivery, CRM Studio also enables you to 
specify whether it will be accompanied by a fax message. The fax message can be 
used in two ways:
• As a delivery method for the report/file. CRM Studio can automatically 

attach text-based reports/files to an outgoing fax message.
• As a notification message that informs the recipient that the corresponding 

reports/files are available to them. In this instance, the reports/files are not 
attached to the fax message.

If you do not wish to use faxing for either of these two purposes, you may leave 
blank the Fax tab of the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report dialog box.

If you check this option and the report(s) fail to be completed successfully, 
the e-mail message is not sent at all.
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The Everest CRM Studio - Application Events\(your 
company)\Scheduled Report Dialog Box - Fax

 Figure 11.6: Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Fax

Available values for use in message content
This field displays the available fields from the queries that are linked to the 
event, and can be used in the Fax Subject and Message Text fields.
Use selected value in text
Click this button to use a highlighted value from the Available values for use in 
message content field, in the Message Subject and/or Message Text fields.
Fax Account to Send From
Select the fax account to be used for sending faxes from the drop-down list.
Fax Subject
Specify the subject of the fax alert.

Include a fax coverpage using the following text for the comment section
Specify whether the fax must have a coverpage and text must be included in it.
Include the following text as the first page (after coverpage if any)
Specify whether the fax must have an additional page after the first page and if 
text must be included in it.
Include text reports as fax pages
Specify whether associated text-based reports will be included in the outgoing fax 
message.
Include text files as fax pages
Specify whether the associated files will be included in the outgoing fax message.

“E-Mail Subject Text” on page 195
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Fax notification should wait until reports are completed
If an event has associated reports which are not attached to the outgoing fax, you 
can use this option to control the timing between the generation of the reports and 
the sending of the fax.

If you choose to attach reports to the fax message, CRM Studio automatically 
waits until the reports are successfully completed before sending the fax. If an 
attached report fails to complete successfully, the fax is not sent.
If you choose not to attach the reports to your fax, you can specify whether the fax 
should wait (i.e., delay being sent) until all the associated reports are successfully 
generated by selecting the option Fax notifications should wait until reports are 
completed.
Checking this option ensures that the recipient of the fax can access the referenced 
report when the fax is received. 

If this field is not checked, the fax is sent immediately, and, depending on the 
amount of time required to generate the reports, the recipient of the fax may not 
be able to access them immediately.

Pager Delivery Options
When you have a report or file configured for delivery, CRM Studio enables you 
to send a pager alert to the recipient(s) to notify them that the reports/files are 
ready.
If you do not wish to send pager alerts about distributed reports/files, you may 
leave blank the Page tab of the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report dialog box.
If you are sending pager notifications, you can specify whether the pager message 
should wait (i.e., delay being sent) until all the associated reports are successfully 
generated by selecting the option Pager notifications should wait until reports 
are generated.
Checking this option ensures that the recipient of the pager message can access 
the referenced report when the message is received. 

If this field is not checked, the pager message is sent immediately, and, depending 
on the amount of time required to generate the reports, the recipient of the 
message may not be able to access them immediately.

Only text-based reports and files can be attached to a fax message.

If you check this option and the report(s) fail to be completed successfully, 
the fax is not sent at all.

If you check this option and the report(s) fail to be completed successfully, 
the pager message is not sent at all.
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The Everest CRM Studio - Application Events\(your 
company)\Scheduled Report Dialog Box - Page

 Figure 11.7: Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Page

Available values for use in message content
This field displays the available fields from the queries that are linked to the 
event, and can be used in the Pager Message field.
Use selected value in Text
Click this button to use a highlighted value from the Available values for use in 
message content field, in the Pager Message field.
Pager Message
Specify the content of the pager alert/message.
Pager notification should wait until reports are completed
If an event has associated reports, which are not attached to the outgoing pager 
message, you can use this option to control the timing between the generation of 
the reports and the sending of the pager message.

Webcast Delivery Options
When a report or file is configured for delivery, CRM Studio enables you to 
specify whether it will be accompanied by a web (HTML) alert message. The web 
message can be used in two ways:
• As a delivery method for the report/file. CRM Studio can automatically 

attach (as URL links) the selected reports/files to the web message.
• As a notification message that informs the recipient that the corresponding 

reports/files are available to them. In this instance, the reports/files are not 
posted to the web message. (They may have been sent by fax, ftp, or e-mail.)

If you do not wish to use web alerts for either of these two purposes, you may 
leave blank the Webcast tab of the Everest CRM Studio - Application 
Events\(your company)\Scheduled Report dialog box.
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The Everest CRM Studio - Application Events\(your 
company)\Scheduled Report Dialog Box - Webcast

 Figure 11.8: Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Webcast

Available values for use in message content
This field displays the available fields from the queries that are linked to the 
event, and can be used in the Webcaster Subject and Webcaster Message fields.
Use selected value in Text
Click this button to use a highlighted value from the Available values for use in 
message content field, in the Webcaster Subject and/or Webcaster Message 
fields.
Webcaster Subject
Specify the subject of the webcast.
Webcaster Message
Specify the content of the webcast.
Expiration Days
Specify the number of days that the alert message for a triggered event should 
remain on the webcast window.
Background Color
The subject of a triggered event alert message can appear in one of four colors to 
indicate the nature (or criticality) of the event. Your choices are:
• Neutral (Indicative of an event that is neither good nor bad)
• Green (Indicative of an event that conveys good news)
• Yellow (Indicative of an event that conveys a warning)
• Red (Indicative of an event that conveys bad news)
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Include reports as URL Links
Specify whether the associated reports will be attached to the webcast alert 
window via a URL link icon.
Include files as URL Links
Specify whether the associated files will be attached to the webcast alert window 
via a URL link icon.
Webcast notifications should wait until reports are completed
If an event has associated reports, which are not linked to the corresponding 
webcast window, use this option to control the timing between the generation of 
the reports and the publishing of the webcast.
If you choose to attach reports to a webcast message, CRM Studio automatically 
waits until the reports are successfully completed before posting the webcast 
message. If an associated report fails to complete successfully, the webcast 
message is not sent.
If you choose not to attach the reports to your webcast message, you can specify 
whether the webcast message should wait (i.e., delay being sent) until all the 
associated reports are successfully generated by selecting the option Webcast 
notifications should wait until reports are completed.
Checking this option ensures that the recipient of the webcast alert message can 
access the referenced report(s) when the message is received. 

If this field is not checked, the webcast message is sent immediately, and, 
depending on the amount of time required to generate the reports, the recipient of 
the message may not be able to access them immediately.

Report Subscribers
The Subscribers tab allows you to specify the names of the recipients of the 
corresponding report(s), and the means of delivery and the means of notifying 
each subscriber (e-mail, fax, pager, copy, or webcast).

There are four types of subscribers:
• Individual people
• Groups of people
• Individual computers
• Groups of computers
Whereas people can be notified via e-mail, fax, copy/ftp, pager, and webcast, 
computers can be notified via copy/ftp only.

Adding a Report Subscriber

• From the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Subscribers - Standard tab, click the Add 

If you check this option and the reports fail to be completed successfully, 
the webcast message is not sent at all.

Before you select subscribers for a scheduled report event, you must define 
your subscribers within the CRM Studio database. 

To add a report subscriber, do the following:
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Subscriber button. You will see the Everest CRM Studio - Add Subscriber 
dialog box.

• To send alerts to all the members of a specific group, select the check box to 
the left of the group’s name.

• To send alerts to specific subscribers, expand the group to which that 
subscriber belongs, and locate the subscriber’s name. Select the check box to 
the left of the subscriber’s name.

• Repeat this process for each group or subscriber you wish to notify. 
• When you have selected the required subscribers, click the Add Subscriber 

button in the Everest CRM Studio - Add Subscriber dialog box.
The selected users are displayed in the Users Targeted For Delivery grid and 
computers are displayed in the Computers Targeted For Delivery grid.

Choosing a Subscriber’s Delivery Methods
Once you have selected your subscribers, you may proceed with choosing the 
method(s) by which each subscriber will receive the corresponding report(s).
By default, each selected subscriber has E-mail selected as the only delivery 
method. You can retain (or remove) e-mail as one of the selected methods as well 
as add any of the other four methods for each subscriber. 

Be careful to select only those delivery methods that have message text associated 
with them. Also, be sure that the subscribers you have selected have a valid 
delivery address for the methods you have chosen for them.

Removing a Report Event’s Subscribers

• From the Users Targeted for Delivery (or Computers Targeted for Delivery) 
grid in the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Subscribers tab - Standard tab, go to the 
extreme left column of the row that contains the subscriber you wish to 
remove.

“The Everest CRM Studio - Add Subscriber Dialog Box” on page 67

All the members of the group are notified via the same delivery method.

• A single scheduled report event can notify any combination of groups 
and individual subscribers.

• If CRM Studio is configured to perform subscriber linking, you may 
have to wait a few seconds to display the members of a linked group, as 
CRM Studio must dynamically retrieve this information from an 
external database.

“The Everest CRM Studio - Application Events\(your company)\Events 
Dialog Box - Subscribers - Standard” on page 226

Computers may be notified only via the copy/ftp method.

To remove subscribers from an event, do the following:
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• The cursor changes into a right-pointing arrow. Click once to highlight the 
row.

• Click the Remove Subscriber button.

Report Schedule
The last step in the configuration of a scheduled report event is the specification 
of the schedule (or frequency) that determines how often you wish to generate 
and distribute the corresponding reports.
Every report event has its own schedule; you can schedule reports for generation 
as often or as infrequently as you need. CRM Studio includes approximately a 
dozen pre-configured schedules; you may edit these schedules as well as create 
additional schedules of your own.

• From the Choose a schedule to use field in the Everest CRM Studio - 
Application Events\(your company)\Scheduled Report - Schedule tab, click 
the drop-down button to display pre-configured schedules.

• If you see a schedule that fits your requirements, select it. If not, you must 
create it.

Creating/Editing a Schedule

• From the Everest CRM Studio - Application Events\(your 
company)\Scheduled Report - Schedule tab, click the Create New Schedule 
or Edit This Schedule buttons. You will see the Everest CRM Studio - 
Scheduled Report dialog box.

• Type in a description of the schedule you are creating or editing (e.g., 
Everyday at 3 PM)

• If you are creating a schedule for events that should not be submitted until 
after a specific date, enter the appropriate date (in the format XX/XX/YYYY 
HH:MM) in the field Should not run until after date/time. If events using this 
schedule is eligible to be submitted immediately (when this schedule is next 
due to run), leave this field blank.

• From the Frequency drop-down list, choose a recurring frequency for this 
schedule. Your choices are:

Click the Remove All Subscribers button to delete all the subscribers 
selected for this event. 

To select a schedule that will control how often CRM Studio generates 
scheduled reports, do the following:

• The schedule called When E-mail Arrives is reserved for use only with 
the CRM Studio E-Mail Response System.

• You can choose None as a schedule if you wish to configure an event, 
but do not want CRM Studio to actively schedule it. This is particularly 
useful for events that you wish to run on an ad hoc or on-demand basis.

To create a schedule or edit an existing schedule, do the following:

Example A schedule for events that should not be submitted until January 
2nd of the following year.
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- Every ‘n’ minutes
- Hourly
- Daily
- Weekly
- Monthly
- Annually
- None (used only for events that have no schedule)

• Based on the frequency you choose, you is prompted to supply additional 
scheduling details, such as the time of day to run, the day of the week, et 
cetera.

• After specifying this information, click the Allowed Range tab.

Configuring a Schedule’s Allowed Range
There are three components to the configuration of a schedule’s allowed range:
• The months of the year during which the schedule is eligible to be submitted 

(place check marks in eligible months).
• The days of the week during which the schedule is eligible to be submitted 

(place check marks in eligible days).
• The hours of the day during which the schedule is eligible to be submitted 

(specify the beginning and ending times between which the schedule may be 
submitted). Note that these times are inclusive.

Schedule Holiday Handling
In the Everest CRM Studio Administrator module, you have the option to 
identify those dates that are designated as holidays for your organization. As a 
result, you can specify (on an event-by-event basis) whether or not a scheduled 
report event should be submitted on a date that is identified as a holiday.
In the Schedule tab, select the option Should this run on a holiday to run a 
scheduled report event if it is scheduled on a holiday. 

How Reports Appear in the Monitor
It is important to understand the sequence in which scheduled report events 
appear in the Everest CRM Studio Events Monitor.
Since a scheduled report event is not associated to an application event, it first 
appears under the branch Report Distribution. Here you will see your scheduled 
report event (such as Weekly Management Reports) submitted at the appropriate 
date and time.
Once a scheduled report event is submitted, you may track the progress of the 
individual reports associated with it from the Report Generation branch. These 
reports go from a pending to a generated state.

The frequency called When E-mail Arrives is reserved for use only with 
the CRM Studio E-Mail Response System.

“The Everest CRM Studio - Scheduled Report Dialog Box - Allowed 
Range” on page 237
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If a report fails to generate successfully, it appears under Errors in the Report 
Generation branch.
Assuming that the report is generated successfully, the last step is to deliver the 
report (and any associated alert messages). Depending on the method(s) by which 
the scheduled report event is configured to deliver the report (e-mail, fax, copy, or 
webcast), you may click the corresponding Delivery branches within the Everest 
CRM Studio Events Monitor and check if the message (and report) was 
successfully delivered.
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CRM Studio Webcasting
The webcasting alert messaging technology enables you to execute notifications 
that are critical and time-sensitive to one or more HTML pages. The webcast alert 
delivery method is particularly useful for:
• Organizations whose employees wish to have a dynamic, self-updating, 

personalized monitor of triggered events.
• Organizations that wish to post alert information for partners and clients.
• Remote sales and/or service personnel who do not have the time (or means) 

to download numerous e-mails, but can quickly and easily access a web 
browser.

• Organizations that wish to distribute reports or other documents via the Web.
The following instructions detail how to set up and use the webcasting alert 
delivery module.

How Does Webcasting Work
CRM Studio’s webcasting module delivers alert messages by creating and 
publishing HTML pages that contain the requisite data. A sample webcast is 
given below:

 
 Figure 12.1: Sample Webcast Output

The webcasting module does not require any specific web server technology or 
integration requirements. As long as you have the means to display an HTML 
page (e.g., via a web browser), you are fully prepared to use the webcasting 
module.

1. Create the master and recipient directories.

To set up and use the webcasting module, do the following:

“Create Webcast Publishing Directories” on page 342
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2. Identify the webcast template and publishing locations.

3. Specify the subscriber’s webcast address.

Create Webcast Publishing Directories
Since the webcast module dynamically creates and publishes HTML pages with 
triggered event data, you need to set up one or multiple locations (disks and 
directories) where the webcast HTML output files are published.

Create Master Directory
Typically, you will create a webcast publishing directory on your web server. 
Wherever you decide to create this directory, it should be easily accessible by 
anyone using a web browser.
You can call this directory “CRMStudio_Webcaster”, so you can easily identify it 
in the future.

Create Recipient Directories
Webcasting alerts may be correlated with e-mail alerts. Just as every alert 
recipient has an e-mail address, each webcasting alert recipient should have a 
webcasting recipient directory; just as events send e-mail alerts to different 
recipients, the same events must send webcast alerts to different recipients. To 
ensure that each recipient receives only applicable alerts, create a separate 
webcasting directory for each recipient.
Thus, the second step is to create sub-directories (within the webcast master 
directory) for each recipient who receives webcast alerts.

Webcast Template and Publishing Locations
Once you define the webcasting directories, the next step is to indicate the 
webcast template file and master publishing location to CRM Studio. 
The webcasting location refers to a master directory (configured previously). 
Under normal circumstances, you can set up only a single webcasting location. 
But if you have set up multiple webcast master directories (such as one directory 
inside your firewall for employee alerts, and another outside your firewall for 
partner alerts), you must set up one webcast location record for each master 
directory.

“Webcast Template and Publishing Locations” on page 342

“Specify Subscribers’ Webcast Addresses” on page 344

Example You have created a master webcast directory called ‘Ev_Webcaster’ 
and you want to send webcast alerts to three users named Smith, 
Jones, and Ford. 
Within the Ev_Webcaster directory, you must create three sub-
directories named Smith, Jones, and Ford.

To specify the webcast template and publishing locations, do the 
following:
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• From the main menu, select CRM > CRM Studio > Administrator. You will 
see the Everest CRM Studio Administrator dialog box.

• Select Administration Folders > Software Setup > Webcast Locations.
• Click the New Webcasting Location button in the top-left corner of the dialog 

box. You will see the Everest CRM Studio - Webcasting Locations dialog box.

 Figure 12.2: Webcasting Locations Dialog Box
Internal ID Number
This field displays the ID automatically generated by Everest for the location. You 
cannot modify it.
Description
Enter a description of the webcasting location.
HTML Template
Specify the location and name of the HTML template in this field. The HTML 
Template is the design file used when formatting the resulting webcast file. CRM 
Studio includes a default HTML template called KS_webcaster.htm, located in 
the webcaster directory (path: Program Files > Icode > Everest > ACRM > 
Webcaster).
Publishing Location
Specify the publishing location in this field. The Publishing Location is the 
webcaster master directory you created previously. 

Active
Click this checkbox to indicate that CRM Studio can publish HTML files to this 
location.
Notes
Enter any additional information you want to keep track of.

Publishing Location - Notes
Note the following about the webcast publishing location:

You must include a forward slash \ at the end of the publishing location 
directory specification.
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• Ensure that the computer you are running CRM Studio on, has write 
capability to the publishing location; if not, CRM Studio will be unable to 
create the webcast output files and links.

• You may specify a FTP address as the publishing location using the format 
ftp://username:password@ftp.location.net/directory_name.

Editing the HTML Template
All the fields that you can use in your webcast file are included in the template. 
You may modify the default design or wording associated with this template. 

• Make a copy of the existing template file (KS_webcaster.htm) 
• In the copied file, modify the text, add your organization’s logos, etc. 

You may use a WML file as a template to support WAP access for handheld 
devices.

Specify Subscribers’ Webcast Addresses
After creating the webcast directories and publishing location(s), you must define 
the webcasting address for each subscriber who receives alerts via webcast.

• From the main menu, select CRM > CRM Studio > Architect. You will see the 
Everest CRM Studio Architect dialog box.

• From the Event Management Folders panel in the center, double-click 
Subscribers.

• Click the branch that contains a subscriber for whom you wish to set up a 
webcast address. 

• Double-click the subscriber record in the right panel. You will see the Everest 
CRM Studio - Subscribers\Users\(group name) dialog box.

• Click the Webcast tab.

To edit the default HTML template, do the following:

The name of the output files created for webcast recipients is based on the 
name of the template.

 If you create a template called mytemplate.htm, the files copied 
to the publishing location are also called mytemplate.htm.

To specify the subscribers’ webcast addresses, do the following:

Example
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 Figure 12.3: Subscribers\Users\(group name) Dialog Box - Webcast Tab
Webcaster Name1
Enter the name of the webcast sub-directory that equates to this subscriber. 

Webcaster Location for Name1
Specify a valid webcast location.
Webcaster Name2
Enter the name of the secondary webcast sub-directory that equates to this 
subscriber. 
Webcaster Location for Name2
Specify a valid webcast location for the secondary webcaster.
The primary and secondary webcast locations can be the same. You may, 
however, have different locations based on whether a subscriber is accessing this 
data from inside or outside your organization.

When an Event is Triggered
When one or more events that send webcast alerts are triggered, CRM Studio 
automatically creates the corresponding webcast HTML file and publishes it to 
the corresponding location of each subscriber.
When additional events that send webcast alerts are triggered, CRM Studio 
automatically re-creates the webcast HTML file, including the existing alerts and 
the details of any newly triggered events. Existing alerts continue to be listed on a 
subscriber’s webcast window until the alert expires.
One of the most powerful aspects of webcast technology is that unlike e-mail, 
subscribers may keep a window (such as a web browser) open in their specific 
webcast location, and receive real-time updates about newly-triggered events.

Example If you create a webcast sub-directory for a subscriber called Jones, 
enter Jones in this field.
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To automatically update the webcast window contents when new events are 
triggered, you can either manually refresh the webcast window, or use Microsoft 
Active Desktop technology.

Webcasting for Report Distribution
In addition to using the webcast alert messaging component to send out alerts 
about triggered events, the webcast interface is also a unique and powerful tool 
for an organization to distribute reports and files to large numbers of recipients.

You can apply this same technique to the distribution of files, product data sheets, 
newsletters, spreadsheets, etc.
To use the webcasting module in this manner, specify one or more reports and/or 
files for an event you are working with. 
Then, on the event Webcast tab, check the box titled Include Reports as URL 
Links. 
Once you do so, the corresponding reports and/or files are automatically 
generated and posted to the resulting webcast window.

Example You use electronic mail to send 100 copies of a report to selected 
recipients. With CRM Studio, you could attach the report (as a URL 
link) to one or more webcast files. 
Additionally, you could use CRM Studio’s e-mail alerts to notify each 
recipient of the availability of the reports, and include the appropriate 
URL link.
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CRM Studio EventPaks
EventPaks are a collection (or bundle) of CRM Studio queries, events, report 
definitions, scheduled report events, and Visual Basic scripts.
EventPaks enable you to compile event-related data and ship it to another person 
or organization.
EventPaks have the following primary uses:
• You can easily distribute events to other members of your organization, move 

events from one system to another, and create back-ups of your configured 
events.

• You can pack up or compile events that you need assistance with, and send 
them to Everest Software for assistance.

This chapter details how to build, distribute, and install CRM Studio EventPaks.

Purpose of an EventPak
You must first decide the contents to be included in an EventPak. You should also 
decide the purpose of the EventPak. The most important consideration here is 
whether you wish to distribute the contents of an EventPak to other people and (if 
so) the degree of control you wish to retain over that EventPak.
CRM Studio provides three features that enable you to control the distribution of 
an EventPak:
• Branding - When an EventPak is created, you can include your organization’s 

name and contact information in it. This allows the people to whom you send 
the EventPak to know who created it, and whom to contact for questions or 
assistance.

• Encryption - You can also encrypt the queries that are included with an 
EventPak. Query encryption prohibits an EventPak recipient from viewing or 
modifying the design of the queries in the EventPak. The recipient can 
however, view and edit all other EventPak data, and can also create additional 
queries.

EventPak Functions

Define EventPak Vendor Identification
Regardless of whether or not you wish to resell EventPaks, it is a good idea to 
brand your EventPaks with your identification, so that users will know who 
created it, and whom to contact for assistance. You can brand the EventPak by 
using the Vendor Identification option.

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• Select File > EventPak > Vendor Identification. You will see the Everest 
CRM Studio - EventPak Vendor Information dialog box.

“Define EventPak Vendor Identification” on page 349

“Building an EventPak” on page 350

To enter the vendor identification, do the following:
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 Figure 13.1: EventPak Vendor Identification Dialog Box - General Tab
The General tab lets you specify the overall name and address information of 
your organization (along with notes about installing the EventPak). The other tabs 
allow you to specify the phone, fax, and e-mail contact information for the various 
departments of your organization.

Building an EventPak
Before you create an EventPak, you must identify the data to be included in the 
EventPak.
EventPaks are built by database. When you select a database defined in the 
Everest CRM Studio Architect (such as the Accel Sample Company database), 
CRM Studio automatically adds the queries, events, report definitions, scheduled 
reports, and Visual Basic scripts from that database to the EventPak you are 
building.
CRM Studio does not allow you to pick and choose queries, events, report 
definitions, scheduled reports, and scripts from a specific database; you must 
either select all or none.
This, however, does not mean that you cannot create an EventPak with only one 
or two queries and/or events within it. 

• Create a company in the Everest CRM Studio Architect. This folder will store 
the queries, events, etc., that you wish to include in the EventPak.

• Using the Studio Architect’s Edit menu functions for cut-and-paste, copy the 
desired queries, events, etc. from the database in which they currently reside 
to the company you just created.

To copy selected queries, events, etc., from different databases into an 
EventPak, do the following:

“Add an Everest Company” on page 25
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• Use the contents of your new company as the base for your EventPak.

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• Select File > EventPak > Builder. You will see the Everest CRM Studio - 
EventPak Builder dialog box.

 Figure 13.2: EventPak Builder Dialog Box
Select the applications to build
Select the databases (and corresponding components of data) to include in your 
EventPak by clicking the Include check box.
The grid displays a list of all of the databases that are currently defined in the 
Studio Architect.
For each database that you select, scroll to the right and select the elements of 
CRM Studio data you wish to include in the EventPak. You can choose the 
queries, events, report definitions, scheduled report events, and Visual Basic 
scripts of any database, in any combination.
Output File Name
Specify the name and location of the EventPak output file. By default, all 
EventPaks require a file suffix of .kse.
EventPak Description
Enter the name of the EventPak.
EventPak Version
Enter the EventPak’s version number. This information is useful to segregate 
EventPaks when you update them.
EventPak Release Date
Enter the date that the EventPak was created/released.

To build an EventPak, do the following:
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Encryption Password (Optional)
Enter the EventPak encryption password.

Brand EventPak items with vendor identity
Check this box to include your vendor identity in the EventPak. This vendor 
information is displayed on all profiles (related to queries, events, report 
definitions, scheduled reports, and scripts) in the database in which you install 
the EventPak when you select Help > About EventPak Vendor.
Installation Notes
Enter installation and configuration details about this EventPak. This information 
is displayed when a recipient executes the EventPak in preparation for its 
installation.
Licensing Information (Optional)
You can enter data in this section only if you enter an encryption password.
Licensed to Company
Enter the name of the company to whom you license the EventPak.
License Expiration Date
Enter the date on which the license for the EventPak expires. CRM Studio 
assumes that an encrypted EventPak will be resold, and by default, displays an 
evaluation license that expires in 30 days.
If you re-sell the EventPak, Everest Software recommends that you specify a 
license expiration date (in the format xx/xx/yyyy) that will allow a client to try 
out your EventPak for a certain amount of time (e.g., 30 or 60 days) before 
deciding to buy it.
If you do not re-sell the EventPak (but have chosen to encrypt it), you can specify 
a license expiration date sufficiently in the future (such as 01/01/9999), to provide 
a recipient with perpetual access to the EventPak.
If you assign a limited-time license code to an EventPak, you can use the 
EventPak License Generator dialog box to generate an extended or perpetual 
license code for that EventPak when a recipient requests it (or purchases the 
EventPak).

• From the Everest CRM Studio Architect dialog box, select a company that 
contains events from the EventPak.

• Double-click an Event and select Help > About EventPak Vendor. You will 
see the Everest CRM Studio - EventPak Vendor Identification dialog box.

The encryption password should be unique for every EventPak.

“Encrypt EventPaks” on page 353

If an EventPak’s license expires, the EventPak recipient can still add and 
modify the data in that EventPak. The recipient however, cannot 
successfully submit any of the events or reports in that EventPak and 
receives a message (in the Everest CRM Studio Event Monitor) stating that 
the license code has expired.

To view the EventPak license (and update it, if necessary), do the 
following:
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• Click the License button. You will see the Everest CRM Studio - EventPak 
License Code Management dialog box.

Build
Click the Build button after specifying the required details to create the EventPak.
CRM Studio creates the .kse file in the specified location and indicates the 
completion of the process at the bottom of this window.
The EventPak files tend to be quite small, and thus, are ideal for distributing via e-
mail.

Encrypt EventPaks
You can optionally encrypt an EventPak in order to prevent recipients from 
viewing or modifying the contents of the queries in the EventPak.
Encrypt an EventPak to prevent a recipient from double-clicking a query 
definition and:
• discovering how the query was created,
• modifying the query,
thereby, safeguarding your intellectual property.
Encrypting requires you to specify a license expiration date for the EventPak. 
You can use the encryption password to access the query designer and view the 
encrypted data. This comes in handy when you need to do work on an encrypted 
EventPak at a client’s site.
Encrypting an EventPak does not, however, prevent a recipient from:
• using the included queries in one or more events.
• viewing the details of (and modifying) the events, report definitions, 

scheduled reports, and scripts that are included in the EventPak.
• designing new queries.

Installing an EventPak

• From the main menu bar, select CRM > CRM Studio > Architect. You will see 
the Everest CRM Studio Architect dialog box.

• Select File > EventPak > Install. 
• Specify the location of the EventPak file (.kse). You will see the EventPak 

Installation dialog box.

A grayed out License button indicates that there is no license code 
associated with the corresponding EventPak.

To install an EventPak, do the following:
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 Figure 13.3: EventPak Installation Dialog Box
EventPak Description, EventPak Version, EventPak Release Date, Installation 
Notes
These fields display the EventPak details as specified in the Everest CRM Studio 
- EventPak Builder dialog box. You cannot edit these fields.
Company, Sales Contact Name, Sales Phone Number, Sales E-mail Address, Sales 
Website Address
These fields display your company details as specified in the Everest CRM 
Studio - EventPak Vendor Identification dialog box. You cannot edit these fields.
Applications installed in the Database
The grid at the bottom of this window displays a list of the databases that are 
included in this EventPak. You can either install the EventPak as a new database 
or add the EventPak application data to an existing database. Click the 
Destination Folder/Application column to select the installation type.

Thus, if you add the contents of an EventPak to a database that already has 
queries, events, etc., with names that are the same as those in the EventPak, you 
will end up with two sets of queries, events, etc., with the same name.
Click the Install button when you are ready to install the EventPak.

Installation - Notes
An EventPak does not include ODBC driver (or application properties) data 
within it. This means that after you install an EventPak, you must specify the 
ODBC connection data for each database from the Everest CRM Studio - Edit 
Connection dialog box.

CRM Studio does not overwrite any existing query, event, report 
definition, scheduled report, or VB script records.

“The Everest CRM Studio - Edit Connection Dialog Box” on page 27
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Sample Events
Everest Software provides you with sample events containing 100 odd events and 
queries which cater to the usual business requirements of an organization. In 
addition, CRM Studio allows you to create custom events, queries, schedule 
reports etc. to meet your business needs.
In order to use the sample events, create a new company and link the ODBC 
database to this database. This will allow you to access events from the database. 
You can customize the sample events according your business requirements.
When CRM Studio is installed, the sample events get installed for the Accel 
Sample Company. This database is named as Accel Sample Company (Only for 
Reference) 5.0.XXX, where 'XXX' is the version number of the EventPak. This 
version number may not be the same as the Everest client version number. You 
can use this as a reference and events can be copied into new companies created 
in CRM Studio. 

The events supported in the EventPak provided by Everest can be grouped as:
• Accounting events
• Customer/Vendor related events
• Document related events
• Sales opportunity related events
• Events pertaining to Point of Sale
• Events related to Inventory and work orders
• Events related to time clocking system
• E-commerce related events
In order to use the reference events for the working application, please note the
following points:
• Create a new working application.
• Copy the required events from the sample events to the working application.
• Copy the related query definitions, report definitions, scheduled reports and 

basic scripts (if any) associated with the event, to the working application.
• Existing queries, report definitions, basic scripts should be removed from the 

copied event and the same should be attached from the working application.
• After copying an event, select the Active check box in the Description tab of 

the event; otherwise, the event will not be active and cannot be used.

Creating an Application
CRM Studio options are not available if your company is in the evaluation mode. 

During a custom installation of Everest, you can install the sample events 
by selecting the option Sample Events. Even if you did not install the 
sample events while installing Everest, Everest verifies the existence of 
sample events when you select any of the CRM Studio menu options. You 
can choose to install the sample events at this stage also. It is then validated 
if the sample company is installed. If the sample company exists, the sample 
company database and the CRM Studio Application properties are 
automatically updated by Everest.
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For a registered company, you can create a CRM Studio Application. All the 
queries and events are copied from the sample events to the new application. It is 
advisable to create an application and copy the sample events into it so as not to 
lose any data when the sample company is upgraded to its newest version.
When you attempt to access any feature of the CRM Studio, you are informed that 
an application is required for the company. You can opt to do one of the 
following:
Create a blank application
Select this option to create an application without the sample events. This, 
however, does not affect the other activities of CRM Studio.
Create an application and copy sample events
Select this option to create an application with all the sample events.

Copying Events from the Sample Events Pack
Once you have created the new company, copy the required sample events from 
the reference EventPak. 

• Open the Everest CRM Studio Architect window and select Application 
Events.

• Select the sample company database and click on Events. You will see the list 
of existing sample events on the right panel.

• Select the event in the right panel and choose Edit > Copy from the menu.
• Now select Events under the new company you have created. Choose Edit > 

Paste. The event gets copied into the new company.
• Similarly, copy the required events one by one from the reference pack and 

paste them into the new database.
It is not enough if you copy only the event from the reference pack into another 
database. Copy the related query definitions, report definitions, scheduled 
reports and basic scripts (if any) associated with the event, in a similar way as said 
above.  

For example, you have created a new company APP1. You copy an event X and a 
query Y (associated with event X) from the sample events into APP1. Now 
double-click on the event X in APP1. In the Queries tab it is to be noted that the 
query selected for content is referring to the APP1 company. If not, select and 

To copy the events from the sample events pack into the new company, 
do the following:

All the associated queries, reports etc. should be referring to the new 
company that you created and not the sample company database. Hence, if 
a query is copied it has to be removed and again added using the new 
company.
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remove the query (use Remove Query) and add the query again (use Add Query) 
ensuring that you are adding it from the company APP1.

 Figure 13.4: Everest CRM Studio - Application Events - Queries Tab

Upgrading Events
When you upgrade Everest, the sample events installed previously are not 
automatically replaced by the latest sample events available. You are prompted to 
upgrade them when accessing any of the CRM Studio menu options.  

You should verify the Release Notes for changes related to the events used. 
If any of the events used has been mentioned in the Product Release Notes, 
then you should manually delete the respective events in the 'Company' 
database and copy the events again from the reference database (ASC).

Example You copy an event E1 from the reference pack (ASC) and use it in the 
company you created. During the next Everest upgrade if event E1 is 
modified in the reference pack (ASC), a mention will be made in the 
release notes. The user should verify this and copy E1 again into his 
company from the upgraded reference pack.
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CRM Studio Worksheets
Query Design Worksheets
The following two pages contain Query Design Worksheets; the first worksheet is 
designed for use with record-level queries, and the second worksheet is designed 
to assist in the definition of aggregate queries. Feel free to make copies of these 
worksheets.
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Record-Level Query Design Worksheet
Purpose of Query:  
________________________________________________________________________
________________________________________________________________________
E-Mail Alert Message Text to Send When Query Condition Occurs:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Data Fields Required for E-Mail Message: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Database Tables Needed: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Query Conditions: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Alert Recipients:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
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Aggregate Query Design Worksheet
Purpose of Query:  
________________________________________________________________________
________________________________________________________________________
E-Mail Alert Message Text to Send When Query Condition Occurs:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Data Fields Required for E-Mail Message: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Aggregate Field:  
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Aggregate Function:  
________________________________________________________________________
Aggregate Grouping Field(s):  
________________________________________________________________________
Database Tables Needed: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
_______________________________________________________________________
Record-Level Conditions: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
_______________________________________________________________________
Aggregate Condition: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
_______________________________________________________________________
Alert Recipients:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
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Subscriber Entry Worksheets
The following two worksheets are designed to help you identify the necessary 
elements that are required for the creation of CRM Studio subscribers. The first 
worksheet is designed for the manual entry of subscribers; the second is designed 
to help you identify the needed components for subscriber importing and/or 
linking. Feel free to make copies of these worksheets.
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Subscriber Data Worksheet
Subscriber Name: 
________________________________________________________________________
Company Name: 
________________________________________________________________________
________________________________________________________________________
Title:   
________________________________________________________________________
Phone: 
________________________________________________________________________
________________________________________________________________________
E-Mail Address (Primary): 
________________________________________________________________________
Days and Hours to Use Primary: 
________________________________________________________________________
E-Mail Address (Secondary): 
________________________________________________________________________
Days and Hours to Use Secondary: 
________________________________________________________________________

Fax Number (Primary): 
________________________________________________________________________
Days and Hours to Use Primary: 
________________________________________________________________________
Fax Number (Secondary):
________________________________________________________________________
Days and Hours to Use Secondary: 
________________________________________________________________________

Pager Vendor (Primary): 
________________________________________________________________________
Pager PIN (Primary): 
________________________________________________________________________
Days and Hours to Use Primary: 
________________________________________________________________________
Pager Vendor (Secondary): 
________________________________________________________________________
Pager PIN (Secondary): 
________________________________________________________________________
Days & Hours to Use Secondary: 
________________________________________________________________________
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Copy/FTP Location: (Primary): 
________________________________________________________________________
Days and Hours to Use Primary: 
________________________________________________________________________
Copy/FTP Location: (Secondary): 
________________________________________________________________________
Days and Hours to Use Secondary: 
________________________________________________________________________
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Subscriber Importing / Linking Worksheet
Database That Contains Subscriber Data: 
________________________________________________________________________
Table That Contains Subscriber Data: 
________________________________________________________________________

Field That Contains:
Subscriber Name: 
________________________________________________________________________
Company Name: 
________________________________________________________________________
________________________________________________________________________
Title: 
________________________________________________________________________
Phone: 
________________________________________________________________________
________________________________________________________________________

E-Mail Address (Primary): 
________________________________________________________________________
E-Mail Address (Secondary): 
________________________________________________________________________
Fax Number (Primary): 
________________________________________________________________________
Fax Number (Secondary): 
________________________________________________________________________

Pager Vendor (Primary): 
________________________________________________________________________
Pager PIN (Primary): 
________________________________________________________________________
Pager Vendor (Secondary): 
________________________________________________________________________
Pager PIN (Secondary): 
________________________________________________________________________

Copy/FTP Location: (Primary): 
________________________________________________________________________
Copy/FTP Location: (Secondary): 
________________________________________________________________________
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Event Design Worksheets
If you take the time to fill out the information on the following worksheet for each 
event you are creating, the event set-up process will be quick and smooth. 
Once you become familiar with the event creation process, you can probably 
forego the use of these worksheets, and design the events directly in the Everest 
CRM Studio Architect.

Please take the time to design each corresponding alert message and attach it to 
the event worksheet. Feel free to make copies of the following worksheets.

The worksheets have a series of questions for you to specify whether the 
associated event will be configured to send alerts via e-mail, and if the alerts 
include Crystal Reports or files attached to them.
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Event Design Worksheet
Name of Event:  
________________________________________________________________________
________________________________________________________________________
Query #1:
________________________________________________________________________
Query #2 (If Needed):
________________________________________________________________________
Query #3 (If Needed):
________________________________________________________________________
Alerts to be Sent Via 
E-mail: Yes   /   No
Fax: Yes   /   No
Pager: Yes   /   No
Webcast: Yes   /   No

Alerts to Include:
Crystal Reports: Yes   /   No
If ‘Yes’, List Reports:
________________________________________________________________________
Attached Files: Yes   /   No
If ‘Yes’, List Files:
________________________________________________________________________

Will Event Trigger Action: Yes   /   No
If ‘Yes’, Describe Action:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Subscribers and Delivery Methods:
Name         Mail(Y/N) Send File/Report(Y/N) Fax(Y/N) Pager(Y/N) Webcast (Y/N)
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Schedule: 
________________________________________________________________________ 
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E-mail Message Design Worksheet
Name of Event:
________________________________________________________________________
________________________________________________________________________

E-mail Alert Message Subject: 
________________________________________________________________________
________________________________________________________________________

E-mail Alert Message Text: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Attach Related Files and/or Reports to E-mail: 
Yes   /   No
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Fax Message Design Worksheet
Name of Event:
________________________________________________________________________
________________________________________________________________________

Fax Alert Message Coverpage Text:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Fax Alert Message Text: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Include Related Files and/or Reports In Fax:
Yes  /    No
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Pager Message Design Worksheet
Name of Event:
________________________________________________________________________
________________________________________________________________________

Pager Alert Message Text: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
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Webcast Message Design Worksheet
Name of Event:
________________________________________________________________________
________________________________________________________________________

Webcast Alert Message Subject Text:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Webcast Alert Message Text: 
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Provide a Link to Related Files and/or Reports:
Yes  /    No
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